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Audience for This Guide

Welcome to Release 11i of the Oracle Public Sector Purchasing User’s
Guide.

This guide assumes you have a working knowledge of the following:
e The principles and customary practices of your business area.
e Oracle Public Sector Purchasing

If you have never used Oracle Public Sector Purchasing, we
suggest you attend one or more of the Oracle Public Sector
Purchasing training classes available through Oracle University.

e The Oracle Applications graphical user interface.

To learn more about the Oracle Applications graphical user
interface, read the Oracle Applications User Guide.

See Other Information Sources for more information about Oracle
Applications product information.

How To Use This Guide

This guide contains the information you need to understand and use
Oracle Public Sector Purchasing.

This preface explains how this user guide is organized and introduces
other sources of information that can help you. This guide contains the
following chapters:

e Chapter 1 provides an overview of all the setup steps for Oracle
Public Sector Purchasing and describes how Oracle Public Sector
Purchasing can be tailored to your needs.

Note: Implementation information and procedures are
contained in this chapter.

e Chapter 2 contains information on the document approval
process, security, and document control. It also describes how
Oracle Public Sector Purchasing uses Oracle Workflow
technology to route documents for approval.

o Chapter 3 contains information about requisitions, including
internal requisitions, and explains how to create requisitions.

e Chapter 4 fully explains the creation and details pertaining to
purchase orders. It also describes how Oracle Public Sector
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Purchasing uses Oracle Workflow technology to create purchase
orders and releases from approved requisitions.

e Chapter 5 describes how to manage your supply base through
agreements, sourcing rules, and approved supplier lists. It also
describes how to create requests for quotation (RFQs) and
guotations, and manage buyer workload.

e Chapter 6 describes the AutoCreate process for purchasing
documents.

e Chapter 7 contains full information about receiving, including
inspections, returns, and corrections.

e Chapter 8 describes how to view the action history for specific
purchasing documents or document lines.

e Chapter 9 describes Oracle Public Sector Purchasing reports and
processes.

e Appendices A through D include information on navigating to
windows in Oracle Public Sector Purchasing, using Oracle Alert,
and customizing procurement workflows.

Finding Out What’s New

From the HTML help window for Oracle Public Sector Purchasing,
choose the section that describes new features or what’s new from the
expandable menu. This section describes:

e New features in 11i. This information is updated for each new
release of Oracle Public Sector Purchasing.

¢ Information about any features that were not yet available when
this user guide was printed. For example, if your system
administrator has installed software from a mini pack as an
upgrade, this document describes the new features.

Other Information Sources

You can choose from many sources of information, including online
documentation, training, and support services, to increase your
knowledge and understanding of Oracle Public Sector Purchasing.
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Online Documentation

Related User Guides

If this guide refers you to other Oracle Applications documentation,
use only the Release 11i versions of those guides unless we specify
otherwise.

All Oracle Applications documentation is available online (HTML and
PDF). The technical reference guides are available in paper format only.
Note that the HTML documentation is translated into over twenty
languages.

The HTML version of this guide is optimized for onscreen reading, and
you can use it to follow hypertext links for easy access to other HTML
guides in the library. When you have an HTML window open, you can
use the features on the left side of the window to navigate freely
throughout all Oracle Applications documentation.

e You can use the Search feature to search by words or phrases.

e You can use the expandable menu to search for topics in the
menu structure we provide. The Library option on the menu
expands to show all Oracle Applications HTML documentation.

You can view HTML help in the following ways:

e From an application window, use the help icon or the help menu
to open a new Web browser and display help about that window.

e Use the documentation CD.

e Use a URL provided by your system administrator.

Your HTML help may contain information that was not available when
this guide was printed.

Oracle Public Sector Purchasing shares business and setup information
with other Oracle Applications products. Therefore, you may want to
refer to other user guides when you set up and use Oracle Public Sector
Purchasing.

You can read the guides online by choosing Library from the
expandable menu on your HTML help window, by reading from the
Oracle Applications Document Library CD included in your media
pack, or by using a Web browser with a URL that your system
administrator provides.
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If you require printed guides, you can purchase them from the Oracle
store at http://oraclestore.oracle.com.

User Guides Related to All Products

Oracle Applications User Guide

This guide explains how to navigate the system, enter data, and query
information, and introduces other basic features of the GUI available
with this release of Oracle Public Sector Purchasing (and any other
Oracle Applications product).

You can also access this user guide online by choosing “Getting Started
and Using Oracle Applications” from the Oracle Applications help
system.

Oracle Alert User Guide

Use this guide to define periodic and event alerts that monitor the
status of your Oracle Applications data.

Oracle Applications Implementation Wizard User Guide

If you are implementing more than one Oracle product, you can use the
Oracle Applications Implementation Wizard to coordinate your setup
activities. This guide describes how to use the wizard.

Oracle Applications Developer’s Guide

This guide contains the coding standards followed by the Oracle
Applications development staff. It describes the Oracle Application
Object Library components needed to implement the Oracle
Applications user interface described in the Oracle Applications User
Interface Standards. It also provides information to help you build your
custom Oracle Developer forms so that they integrate with Oracle
Applications.

Oracle Applications User Interface Standards

This guide contains the user interface (Ul) standards followed by the
Oracle Applications development staff. It describes the Ul for the
Oracle Applications products and how to apply this Ul to the design of
an application built by using Oracle Forms.
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User Guides Related to This Product

XVvi

Oracle Applications Flexfields Guide

This guide provides flexfields planning, setup, and reference
information for the Oracle Public Sector Purchasing implementation
team, as well as for users responsible for the ongoing maintenance of
Oracle Applications product data. This guide also provides information
on creating custom reports on flexfields data.

Oracle Bills of Material User’s Guide

This guide describes how to create various bills of materials to
maximize efficiency, improve quality and lower cost for the most
sophisticated manufacturing environments. By detailing integrated
product structures and processes, flexible product and process
definition, and configuration management, this guide enables you to
manage product details within and across multiple manufacturing
sites.

Oracle Business Intelligence System Implementation Guide

This guide provides information about implementing Oracle Business
Intelligence (BIS) in your environment.

BIS 11i User Guide Online Help

This guide is provided as online help only from the BIS application and
includes information about intelligence reports, Discoverer workbooks,
and the Performance Management Framework.

Oracle e-Commerce Gateway User’s Guide

This guide describes how Oracle e-Commerce Gateway provides a
means to conduct business with trading partners via Electronic Data
Interchange (EDI). Data files are exchanged in a standard format to
minimize manual effort, speed data processing, and ensure accuracy.

Oracle Public Sector General Ledger User’s Guide

This guide explains how to plan and define your chart of accounts,
accounting period types and accounting calendar, functional currency;,
and set of books. It also describes how to define journal entry sources
and categories so you can create journal entries for your general ledger.
If you use multiple currencies, use this manual when you define
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additional rate types, and enter daily rates. This manual also includes
complete information on implementing Budgetary Control.

Oracle HRMS Documentation Set

This documentation set includes the following volumes:

e Using Oracle HRMS - The Fundamentals, which explains how to
set up organizations and site locations.

e Managing People Using Oracle HRMS, which explains how to
enter employees and track employee data.

e Running Your Payroll Using Oracle HRMS, which explains how to
set up payroll, do withholding, run statutory reports, and pay
employees.

e Managing Compensation and Benefits Using Oracle HRMS, which
explains how to set up total compensation, including 401(k),
health, and insurance plans.

e Customizing, Reporting, and System Administration in Oracle
HRMS, which explains how to customize the system and design
reports.

Oracle Inventory User’s Guide

This guide describes how to define items and item information,
perform receiving and inventory transactions, maintain cost control,
plan items, perform cycle counting and physical inventories, and set up
Oracle Inventory.

Oracle Public Sector Payables User’s Guide

This guide describes how accounts payable transactions are created
and entered in Oracle Public Sector Payables. This guide also contains
detailed setup information for Oracle Public Sector Payables.

Oracle Quality User’s Guide

This guide describes how Oracle Quality can be used to meet your
quality data collection and analysis needs. This guide also explains
how Oracle Quality interfaces with other Oracle Manufacturing
applications to provide a closed loop quality control system.
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Oracle Public Sector Receivables User’s Guide

Use this manual to learn how to implement flexible address formats for
different countries. You can use flexible address formats in the
suppliers, banks, invoices, and payments windows.

Oracle Supplier Scheduling User’s Guide

This guide describes how you can use Oracle Supplier Scheduling to
calculate and maintain planning and shipping schedules and
communicate them to your suppliers.

Oracle Work in Process User’s Guide

This guide describes how Oracle Work in Process provides a complete
production management system. Specifically this guide describes how
discrete, repetitive, assemble-to—order, project, flow, and mixed
manufacturing environments are supported.

Installation and System Administration Guides

Xviii

Oracle Applications Concepts

This guide provides an introduction to the concepts, features,
technology stack, architecture, and terminology for Oracle Applications
Release 11i. It provides a useful first book to read before an installation
of Oracle Applications. This guide also introduces the concepts behind,
and major issues, for Applications—wide features such as Business
Intelligence (BIS), languages and character sets, and self-service
applications.

Installing Oracle Applications

This guide provides instructions for managing the installation of Oracle
Applications products. In Release 11i, much of the installation process
is handled using Oracle One-Hour Install, which minimizes the time it
takes to install Oracle Applications and the Oracle 8i Server technology
stack by automating many of the required steps. This guide contains
instructions for using Oracle One-Hour Install and lists the tasks you
need to perform to finish your installation. You should use this guide in
conjunction with individual product user guides and implementation
guides.
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Upgrading Oracle Applications

Refer to this guide if you are upgrading your Oracle Applications
Release 10.7 or Release 11.0 products to Release 11i. This guide
describes the upgrade process in general and lists database upgrade
and product-specific upgrade tasks. You must be at either Release 10.7
(NCA, SmartClient, or character mode) or Release 11.0 to upgrade to
Release 11i. You cannot upgrade to Release 11i directly from releases
prior to 10.7.

Using the AD Utilities

Use this guide to help you run the various AD utilities, such as
Autolnstall, AutoPatch, AD Administration, AD Controller, Relink,
and others. It contains how-to steps, screenshots, and other
information that you need to run the AD utilities.

Oracle Applications Product Update Notes

Use this guide as a reference if you are responsible for upgrading an
installation of Oracle Applications. It provides a history of the changes
to individual Oracle Applications products between Release 11.0 and
Release 11i. It includes new features and enhancements and changes
made to database objects, profile options, and seed data for this
interval.

Oracle Applications System Administrator’s Guide

This guide provides planning and reference information for the Oracle
Applications System Administrator. It contains information on how to
define security, customize menus and online help, and manage
processing.

Oracle Purchasing Applications Technical Reference Manual

This reference manual contains database diagrams and a detailed
description of database tables, forms, reports, and programs for Oracle
Public Sector Purchasing and related applications. This information
helps you convert data from your existing applications, integrate
Oracle Public Sector Purchasing with non-Oracle applications, and
write custom reports for Oracle Public Sector Purchasing.

You can order a technical reference manual for any product you have
licensed. Technical reference manuals are available in paper format
only.
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Training and Support

Oracle Self Service Purchasing Implementation Manual

This manual describes how to set up Oracle Self Service Purchasing.
Self-Service Purchasing enables employees to requisition items through
a self-service, Web interface.

Oracle Workflow Guide

This guide explains how to define new workflow business processes as
well as customize existing Oracle Applications—embedded workflow
processes. You also use this guide to complete the setup steps necessary
for any Oracle Applications product that includes workflow-enabled
processes.

Training

We offer a complete set of training courses to help you and your staff
master Oracle Applications. We can help you develop a training plan
that provides thorough training for both your project team and your
end users. We will work with you to organize courses appropriate to
your job or area of responsibility.

Training professionals can show you how to plan your training
throughout the implementation process so that the right amount of
information is delivered to key people when they need it the most. You
can attend courses at any one of our many Educational Centers, or you
can arrange for our trainers to teach at your facility. We also offer Net
classes, where training is delivered over the Internet, and many
multimedia—based courses on CD. In addition, we can tailor standard
courses or develop custom courses to meet your needs.

Support

From on-site support to central support, our team of experienced
professionals provides the help and information you need to keep
Oracle Public Sector Purchasing working for you. This team includes
your Technical Representative, Account Manager, and Oracle’s large
staff of consultants and support specialists with expertise in your
business area, managing an Oracle server, and your hardware and
software environment.
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Do Not Use Database Tools to Modify Oracle Applications Data

We STRONGLY RECOMMEND that you never use SQL*Plus, Oracle
Data Browser, database triggers, or any other tool to modify Oracle
Applications tables, unless we tell you to do so in our guides.

Oracle provides powerful tools you can use to create, store, change,
retrieve, and maintain information in an Oracle database. But if you use
Oracle tools such as SQL*Plus to modify Oracle Applications data, you
risk destroying the integrity of your data and you lose the ability to
audit changes to your data.

Because Oracle Applications tables are interrelated, any change you
make using an Oracle Applications form can update many tables at
once. But when you modify Oracle Applications data using anything
other than Oracle Applications forms, you might change a row in one
table without making corresponding changes in related tables. If your
tables get out of synchronization with each other, you risk retrieving
erroneous information and you risk unpredictable results throughout
Oracle Applications.

When you use Oracle Applications forms to modify your data, Oracle
Applications automatically checks that your changes are valid. Oracle
Applications also keeps track of who changes information. But, if you
enter information into database tables using database tools, you may
store invalid information. You also lose the ability to track who has
changed your information because SQL*Plus and other database tools
do not keep a record of changes.

About Oracle

Oracle Corporation develops and markets an integrated line of
software products for database management, applications
development, decision support and office automation, as well as Oracle
Applications. Oracle Applications provides the E-business Suite, a fully
integrated suite of more than 70 software modules for financial
management, Internet procurement, business intelligence, supply chain
management, manufacturing, project systems, human resources and
sales, and service management.

Oracle products are available for mainframes, minicomputers, personal
computers, network computers, and personal digital assistants,
enabling organizations to integrate different computers, different
operating systems, different networks, and even different database
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Your Feedback

management systems, into a single, unified computing and information
resource.

Oracle is the world’s leading supplier of software for information
management, and the world’s second largest software company. Oracle
offers its database, tools, and application products, along with related
consulting, education, and support services, in over 145 countries
around the world.

Thank you for using Oracle Public Sector Purchasing and this user
guide.

We value your comments and feedback. This guide contains a Reader’s
Comment Form you can use to explain what you like or dislike about
Oracle Public Sector Purchasing or this user guide. Mail your
comments to the following address or call us directly at (650) 506-8968.

Oracle Public Sector Applications Documentation Manager
Oracle Corporation

500 Oracle Parkway, M/S 3op7

Redwood Shores, CA 94065

US.A.

Or, send electronic mail to gepddoc@us.oracle.com.
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CHAPTER

Setting Up

T his chapter tells you everything you need to know about setting
up, including:

e Overview: page 1 -2

e Defining Locations: page 1 —24

e Defining Buyers: page 1 —27

e Defining Approval Groups: page 1 —29

e Assigning Approval Groups: page 1 - 33

e Annotating Purchasing Documents: page 1 — 36
¢ Defining Purchasing Options: page 1 —45

¢ Defining Receiving Options: page 1 —58

e Defining Requisition Templates: page 1 — 62

e Purchasing Hazardous Materials: page 1 — 67

e Defining Lookup Codes: page 1 —74

e Purchasing Services: page 1 —79

e Defining Document Types: page 1 —87

e Controlling Purchasing Periods: page 1 —93

e Choosing Workflow Options: page 1 —95

e Self-Service Purchasing Setup Windows: page 1 — 102
¢ Profile Options in Purchasing: page 1 - 103
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Overview of Setting Up

See Also

This section contains an overview of each step you need to complete to
set up Oracle Purchasing. For instructions on how to complete each
task, see the setup sections indicated in each step.

This section contains an overview of each step you need to complete to
set up Oracle Public Sector Purchasing. For instructions on how to
complete each task, see the setup sections indicated in each step.

Oracle Applications Implementation Wizard

If you are implementing more than one Oracle Applications product, it
is recommended that you use the Oracle Applications Implementation
Wizard (AIW) to coordinate your setup activities. The Wizard guides
you through the setup steps for the applications you have installed,
suggesting a logical sequence that satisfies cross—product
implementation dependencies and reduces redundant setup steps.

You can use the Wizard to see a graphical overview of setup steps, read
online help for a setup activity, and open the appropriate setup
window. You can also document your implementation, for further
reference and review, by using the Wizard to record comments for each
step.

Multiple Reporting Currencies

If you plan to use Multiple Reporting Currencies (MRC) with Oracle
Public Sector Purchasing, additional setup steps are required. See:
Multiple Reporting Currencies in Oracle Applications.

Oracle Applications Implementation Wizard User’s Guide
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Setup Flowchart

Some of the steps outlined in this flowchart and setup checklist are
Required, and some are Optional. Required Step With Defaults means
that the setup functionality comes with pre-seeded, default values in
the database; however, you should review those defaults and decide
whether to change them to suit your public sector needs. If you want
or need to change them, you should perform that setup step. You need
to perform Optional steps only if you plan to use the related feature or
complete certain business functions.

Some of the setup steps you may not need to perform if you've already
performed a common-application setup (setting up multiple Oracle
Applications products).
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Setup Checklist

The following table lists setup steps and a reference to their location
within the Wizard. For a detailed description of AIW reference levels,
see the Oracle Applications Implementation Wizard User’s Guide. After you
log on to Oracle Applications, complete these steps to implement

Public Sector Purchasing:

Step . AIW
No. RegIiEe S Reference

Step1l | Required |[SetUp System Administrator Common
Applications

Step2 | Required [Define Accounting Key Flexfields Common
Applications

Step 3 | Required [Set Up Calendars, Currencies, and Set of Books Common
Applications

Step4 | Required |Define Human Resources Key Flexfields Common
Applications

Step5 | Required | Define Locations Common
Distribution

Step 6 | Required [ Define Organizations and Organization Relationships Common
Applications

Step 7 | Optional |Convertto a Multi—-Org Architecture Common
Applications

Step 8 | Required [ Define Inventory Key Flexfields Common
Applications

Step 9 | Required | Define Units of Measure Common
Applications

Step 10 | Optional | Define Freight Carriers Common
Applications

Step 11 | Required | Define Item Attributes, Codes, and Templates Common
Step with Applications

Defaults

Step 12 | Required | Define Categories Common
Applications

Step 13 | Optional | Define Catalog Groups Common
Applications

Step 14 | Required |Set Up Personnel Common
Applications

Step 15 | Required | Set Up Oracle Workflow Common
Applications

Setting Up
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Step 16 | Required | Decide How to Use the Account Generator Oracle
Purchasing
Step 17 | Required | Open Inventory and Purchasing Accounting Periods Common
Distribution
Step 18 | Optional | Define Subinventory Locations Common
Distribution
Step 19 | Optional | Define Cross—Reference Types Oracle
Purchasing
Step 20 | Optional | Define Tax Codes Common
Financial
Step 21 | Optional | Define Payment Terms Common
Financial
Step 22 | Required |Set Up Approval Information Oracle
Purchasing
Step 23 | Required | Define Lookups and Classes Oracle
Step with Purchasing
Defaults
Step 24 | Optional | Define Standard Attachments Oracle
Purchasing
Step 25 | Required | Define Purchasing Options Oracle
Purchasing
Step 26 | Required | Define Buyers Oracle
Purchasing
Step 27 | Optional | Define Items Oracle
Purchasing
Step 28 | Required | Define Line Types Oracle
Step with Purchasing
Defaults
Step 29 | Required | Start the Purchasing Database Administrator Oracle
Purchasing
Step 30 | Required | Define Financial Options Common
Financial
Step 31 | Optional | Define Transaction Reasons Oracle
Purchasing
Step 32 | Required | Define Receiving Options Oracle
Purchasing
Step 33 | Required | Set Up Transaction Managers and Resubmission Oracle
Intervals Purchasing
Step 34 | Required | Define Suppliers Common
Financial
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Step 35 | Required | Set Up Workflow Options Oracle
Step with Purchasing
Defaults
Step 36 | Required | Submit Workflow-related Processes Oracle
Purchasing
Step 37 | Optional | Define Descriptive Flexfields Common
Applications
Step 38 | Optional | Set Up Automatic Sourcing Oracle
Purchasing
Step 39 | Required | Perform Additional System Administrator Setup Common
Applications
Step 40 | Required | Define Manufacturing System and User Profiles Oracle
Purchasing
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Setup Steps

For those steps that are affected, a Context section indicates whether
you need to repeat the step for each set of books, set of tasks, inventory
organization, HR organization, or other operating unit under Multiple
Organizations.

Stepl  Set Up System Administrator

This step involves the following tasks:

o Create a super user to use as a logon name during setup and
assign the super user the required setup responsibilities.
Typically, the required responsibilities are as follows (Required):

— Purchasing
— System Administrator

e Set up printers. Although you do not have to set up all of your
printers now, it may be useful to set up one printer if you wish to
print anything during setup. See: Setting Up Your Printers,
Oracle Applications System Administrator’s Guide. (Optional)

See: Oracle Applications System Administrator’s Guide.

Step2  Define Accounting Key Flexfields (Required)

Define Accounting key flexfields and cross validation rules. You may
not need to perform this step if you have already installed and set up
Oracle Public Sector General Ledger or performed a
common-applications setup. See: Oracle Public Sector General Ledger
User’s Guide.

= Attention: If you are, or will be, fully installing other Oracle
applications, be sure to coordinate with those products’
flexfield setup before defining the key flexfields here, as it is
not recommended to change flexfields after you acquire any
flexfields data.

For instructions on how to set up key flexfields, see: Oracle Applications
Flexfields Guide.

Step3  Set Up Calendars, Currencies, and Set of Books (Required)

If you have defined your calendars, currencies, and set of books while
setting up a different Oracle Applications product, proceed to the next
step.
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Context: If you are performing a Multi-Org implementation of
Purchasing, you may optionally create more than one calendar,
currency, or set of books. See: Multiple Organizations in Oracle
Applications.

This step involves the following tasks:
e Set up calendars:

— Define period types. See: Defining Period Types, Oracle
Public Sector General Ledger User’s Guide.

— Define accounting calendar. See: Defining Calendars, Oracle
Public Sector General Ledger User’s Guide.

Note: You can define the following three optional items if you
install certain Oracle Manufacturing applications.

— Define transaction calendar. See: Defining Transaction
Calendars, Oracle Public Sector General Ledger User’s Guide.
(Optional)

— Define workday calendar. See: Overview of Workday
Calendar, Oracle Bills of Material User’s Guide. (Optional)

— Define exception templates. See: Creating a Workday
Exception Template, Oracle Bills of Material User’s Guide.
(Optional)

¢ Define currencies. See: Defining Currencies, Oracle Public Sector
General Ledger User’s Guide.

¢ Define conversion rate types. See: Defining Conversion Rate
Types, Oracle Public Sector General Ledger User’s Guide.

e Define your set of books. You must define at least one set of
books for your organization. See: Oracle Public Sector General
Ledger User’s Guide.

e Assign your set of books to the current responsibility. See: Oracle
Public Sector General Ledger User’s Guide.

¢ Define currency rates:

— Define daily rates. See: Entering Daily Rates, Oracle Public
Sector General Ledger User’s Guide.

— Define period rates. See: Entering Period Rates, Oracle
Public Sector General Ledger User’s Guide.

— Define historical rates. See: Entering Historical Rates, Oracle
Public Sector General Ledger User’s Guide.
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Step 4

Step 5

e Set up accounting code combinations. You do not need to
perform this task if you allow dynamic entry of code
combinations for the chart of accounts corresponding to your
Purchasing installation. See: Oracle Public Sector General Ledger
User’s Guide.

e Open and close accounting periods. See: Opening and Closing
Accounting Periods, Oracle Public Sector General Ledger User’s
Guide.

Define Human Resources Key Flexfields (Required)

You may not need to set up Human Resources key flexfields if you
have already installed and set up Oracle Human Resource
Management Systems or performed a common-applications setup. See
also: Oracle Human Resources User’s Guide.

= Attention: If you are, or will be, fully installing other Oracle
applications, be sure to coordinate with those products’
flexfield setup before defining the key flexfields here, as it is
not recommended to change flexfields after you acquire any
flexfield data.

For instructions on how to set up each of the key flexfields listed below,
see: Oracle Applications Flexfields Guide.

Define Human Resources and Payroll key flexfields:
¢ Job flexfield
o Position flexfield
o Grade flexfield
o Cost allocation flexfield
o People Group flexfield

o Personal Analysis flexfield

Define Locations (Required)

If you're also setting up other Oracle applications, you may already
have defined locations when you set up those applications.

You are required to set up at least one location for now. You can set up
the remaining locations after you define inventory organizations and
tax codes.

You may need to revisit this step after you set up organizations, if you
want to link a location to an inventory organization.
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Step 6

See: Defining Locations: page 1 —24.

Define Organizations and Organization Relationships (Required)

You may not need to perform this step if you have already installed
and set up Oracle Inventory or performed a common-applications

setup.

For the following tasks relating to setting up organizations, see: Oracle
Human Resources User’s Guide.

Define business groups, if you want to define new business
groups rather than using the default Setup Business Group. See:
Setting Up Security for Applications Using Some HRMS
Windows, Oracle Human Resources User’s Guide and Representing
Employers Using Business Groups, Oracle Human Resources
User’s Guide.

Assign business groups to responsibilities. Within your
responsibility, make sure that the profile option HR: Business
Group is set to the business group you want to use for that
responsibility. See: Oracle Human Resources User’s Guide.

Attention: Itis important that the HR: Business Group profile
option be set to the business group you want to use before you
define organizations as described below.

Define legal entities organizations.
Define operating—units and assign them to legal entities.

Set up inventory organizations. For the following tasks relating
to setting up inventory organizations, see: Oracle Inventory User’s
Guide.

Classify the organizations as inventory organizations.

Define accounting information for inventory organizations.

Define inventory organization parameters.

Define receiving options for the inventory organizations.
For this task, see: Defining Receiving Options: page 1 - 58.

Define human resources organizations.

Define organization hierarchies. See: Oracle Human Resources
User’s Guide. (Optional)
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Step 7

Step 8

Convert to a Multi-Org Architecture (Optional)

Although optional, this setup step is recommended even if your
business is composed of just one operating unit. Performing this step
now gives you the flexibility to add operating units later.

This step includes the following tasks:
o Set the profile options MO: Operating Unit and HR: User Type.

¢ Run the utility to convert to a Multi-Org architecture. It is
recommended to involve your system administrator with this
task.

See: Multiple Organizations in Oracle Applications.

Define Inventory Key Flexfields (Required)

You may not need to set up Inventory key flexfields if you have already
installed and set up Oracle Inventory or performed a
common-applications setup. See also: Oracle Inventory User’s Guide.

= Attention: If you are, or will be, fully installing other Oracle
applications, be sure to coordinate with those products’
flexfield setup before defining the key flexfields here, as it is
not recommended to change flexfields after you acquire any
flexfield data.

For instructions on how to set up each of the key flexfields listed below,
see: Oracle Applications Flexfields Guide.

Define Inventory key flexfields:

e System Items flexfield. After you compile the System Items
flexfields, the item flexfield view concurrent request is started.

e |tem Category flexfield

e PO Item Category flexfield. See: Item Category Flexfield
Structures, Oracle Inventory User’s Guide.

o Item Catalog flexfield

e Stock Locator flexfield

e Account aliases flexfields
o Sales orders flexfield

Note: Even if you do not use any of the above flexfields, you
must still enable at least one flexfield segment for each and
compile them because Oracle Inventory transactions (such as
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Step 9

Step 10

Step 11

the Define Items window), inquiries, and reports require a
frozen flexfield definition.

Define Units of Measure (Required)

You may not need to perform this step if you have already installed
and set up Oracle Inventory or performed a common-applications
setup. See: Oracle Inventory User’s Guide.

This step involves the following tasks:
e Define units—of-measure classes.
e Define units of measure.

¢ Define units—of-measure conversions. You can define three
different conversion types for your needs: Standard, Intra—class,
or Inter—class.

Define Freight Carriers (Optional)

If you’re also setting up Oracle Inventory, you may already have
performed this step when you set up Inventory. Define freight carriers
if you want to specify on a purchase order the freight carrier that a
supplier should use.

See: Defining Freight Carriers, Oracle Inventory User’s Guide.

Context: You must perform this step for each inventory organization.

Define Item Attributes, Codes, and Templates

See: Oracle Inventory User’s Guide.
This step involves the following tasks:
¢ Define item attribute controls. (Required with defaults)

Default: Most item attribute groups default to Item
Master—level control. The rest default to the Item/Organization
level.

¢ Define container type QuickCodes. These can be used to define
physical attributes for items. (Optional)

¢ Define status codes. (Required with defaults)

Default: Default status codes include basic statuses such as
Active, Inactive, Obsolete, and Prototype.

¢ Define item type QuickCodes. (Required with defaults)
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Step 12

Step 13

Default: Default QuickCodes include finished goods, option

class, kit, purchased item, and others.

¢ Define customer item commodity codes. These can be used to

group customer items. (Optional)

o Define item templates. You can define an item template if many

items share the same values for a number of attributes.
(Optional)

Define Categories

If you're also setting up Oracle Inventory, you may already have
performed this step when you set up Inventory.

This step involves the following tasks:

o Define category codes. See: Defining Categories, Oracle Inventory

User’s Guide. (Required)

Define category sets. See: Defining Category Sets, Oracle
Inventory User’s Guide. (Required with defaults)

Default: Examples of category sets are Inventory and
Purchasing.

Define default category sets. See: Defining Default Category
Sets, Oracle Inventory User’s Guide. (Required with defaults)

Default: Each functional area comes with a default category set.

Note: Purchasing requires you to enforce a list of valid categories.
Therefore, in the List of Valid Categories in the Category Sets
window, you must list all categories that are eligible for that
category set. In particular, make sure that the Default Category
in the Category Sets window also appears in the List of Valid
Categories.

Define Catalog Groups (Optional)

A catalog group consists of descriptive elements for items to which you
assign sets of values such as type, size, or color. If you’re also setting up
Oracle Inventory, you may already have performed this step when you

set up Inventory.

See: Defining Item Catalog Groups, Oracle Inventory User’s Guide.
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Step 14

Set Up Personnel

You may not need to perform this step if you have already installed
and set up Oracle Human Resource Management Systems or
performed a common-applications setup. See: Oracle Human Resource
Management Systems User’s Guide.

This step involves the following tasks:

Define employee QuickCodes. (Required with defaults)

Define jobs. See: Representing Jobs and Positions, Oracle Human
Resource Management Systems User’s Guide. (Required)

Define positions. You must define positions if you plan to use
position approval hierarchies. See: Representing Jobs and
Positions, Oracle Human Resource Management Systems User’s
Guide. (Optional)

Define position hierarchies. You can define one or more position
hierarchies to meet your needs. See: Position Hierarchy Window,
Oracle Human Resource Management Systems User’s Guide.
(Optional)

Default: If you skip this task, you cannot use position approval
hierarchies, but must use the employee/supervisor approval
method instead.

Define the following financial options in the Financial Options
window; see: Defining Financials Options, Oracle Public Sector
Payables User’s Guide (Required):

Employee numbering

Position approval hierarchies option (whether to use
position approval hierarchies)

Inventory organization

Business group (Make sure a business group is specified.)

Supplier numbering

Define employees. If you use Purchasing without Oracle Human
Resource Management Systems, use the setup window from
within Purchasing for defining employees. See: the online help
for the Enter Person window. If you use Purchasing with Oracle
Human Resource Management Systems, use the setup window
for defining employees from within the Human Resource
Management Systems application. See: Entering a New Person,
Managing People Using Oracle HRMS. (Required)
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Step 15

Step 16

Step 17

Step 18

Note: Purchasing users must have user names, which is a later
setup step. These Purchasing user names must be linked to an
employee name.

Set Up Oracle Workflow (Required)

Since Purchasing uses Oracle Workflow technology to perform
document approvals, automatic document creation, and account
generation via the Account Generator, you need to set up Oracle
Workflow, if you haven’t done so already. See: Setting Up Oracle
Workflow, Oracle Workflow Guide.

Decide How to Use the Account Generator (Required)

The Account Generator process in Purchasing builds a charge, budget,
accrual, and variance account for each purchase order, release, and
requisition distribution based on the distribution’s Expense, Inventory,
or Shop Floor destination type. You must review the default process
that Purchasing uses to see if it meets your accounting requirements.
You can optionally customize the Account Generator for each set of
books that you have defined. See: Using the Account Generator in
Oracle Public Sector Purchasing: page C - 9.

Context: This step needs to be performed for each operating unit.

Open Inventory and Purchasing Accounting Periods (Required)

This step involves the following tasks.

e Open Inventory accounting period. See: Maintaining
Accounting Periods, Oracle Inventory User’s Guide.

Context: This task needs to be performed for each inventory
organization.

e Open Purchasing accounting period. See: Purchasing Periods:
page 1 —-93.

Context: This task needs to be performed for each set of books.

Define Subinventory Locations (Optional)

You can define your own subinventory locations such as Inspection,
Cold Storage, or Reject-Disposition. You may not need to perform this
step if you have already installed and set up Oracle Inventory. See:
Defining Subinventories, Oracle Inventory User’s Guide.
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Step 20

Step 21

Step 22

Context: This step needs to be performed for each inventory
organization.

Define Cross—Reference Types (Optional)

An example of a cross—reference type is one used to cross-reference an
item number to the part number that the supplier uses. See: Defining
Cross—Reference Types, Oracle Inventory User’s Guide.

Define Tax Codes (Optional)

Define tax codes and assign them recovery rates or rules. You may not
need to perform this step if you have already installed and set up
Oracle Public Sector Payables or performed a common-applications
setup. See: Tax Codes, Oracle Public Sector Payables User’s Guide. See:
Partially Recoverable Tax, Oracle Public Sector Payables User’s Guide.

Default: If you skip this step, you will not be able to select a tax code
when entering a requisition or purchase order.

Context: This step needs to be performed for each operating unit.

Define Payment Terms (Optional)

If you're also setting up Oracle Public Sector Payables, you may already
have performed this step when you set up Payables. You can set up
payment terms such as 1/10 Net 30, which indicates that you get a 1%
discount if you pay within 10 days and the invoice is due in 30 days.

See: Payment Terms, Oracle Public Sector Payables User’s Guide.

Set Up Approval Information

All approvers must be employees and must have a logon user name as
described in Step 14 Set Up Personnel.

Note: Even offline approvers must have a user name. An
offline approver is someone who approves Purchasing
documents without logging on to Oracle Applications and
using the Notifications Summary window. To set up offline
approvers, see: Offline Approvers: page 2 —40. You can set up
offline approvers at any time, as long as user names have been
assigned to all approvers and Workflow has been set up.

Once all approvers have been set up as employees and set up with user
names, complete your approval setup as follows:

Context: This step needs to be performed for each operating unit.
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Define approval groups. See: Defining Approval Groups: page
1 -29. (Required)

Assign approval groups. See: Assigning Approval Groups: page
1 -33. (Required)

Fill employee hierarchy after defining position approval
hierarchies. See: Fill Employee Hierarchy Process: page 9 —41.
If you are using position approval hierarchies, you must run the
Fill Employee Hierarchy process. (Optional)

Define document types. See: Defining Document Types: page
1 —-87. (Required with defaults)

Default: Each Purchasing document (such as a Standard
Purchase Order, Blanket Purchase Agreement, Quotation, or
Requisition) comes with standard defaults. Update these
defaults to meet your security and approval needs.

Define Lookups and Classes

This step involves the following tasks:

o Define Purchasing lookups. See: Defining Lookup Codes: page

1 —74. (Required with defaults)

Default: An example of a default lookup code that Purchasing
provides is a Price Type of Fixed. See the section referenced
above for a list of the other defaults that Purchasing provides.

Define inspection codes. See: Defining Quality Inspection Codes:
page 1 —77. (Optional)

Default: If you skip this task, you will not be able to assign
inspection codes during receiving.

Define hazard classes. See: Defining Hazard Classes: page

1 -70. (Optional)

Default: If you skip this task, you will not be able to assign
hazard classes to items or purchase order lines.

Define United Nations (UN) numbers. See: Defining UN
Numbers: page 1 —71. (Optional)

Default: If you skip this task, you will not be able to assign UN
numbers to items or purchase order lines.
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Step 24

Step 25

Step 26

Step 27

Define Standard Attachments (Optional)

If you do not want to define standard attachments now, you can do so
at any time later. See: Annotating Purchasing Documents: page 1 — 36.
See: Attaching Notes to Purchasing Documents; page 1 —44.

Define Purchasing Options (Required)

See: Defining Purchasing Options: page 1 —45.

Context: This step needs to be performed for each operating unit.

Define Buyers (Required)

Employees who will use Purchasing as buyers or managers must all be
defined as buyers. See: Defining Buyers: page 1 - 27.

Define Items (Optional)

Although you can define items at any point from this step onward, it is
recommended that you set up at least one item to ensure that your
flexfields are working properly.

Default: If you skip this step, when you create a requisition or
purchase order, you will be able to enter only an item description, not
an item number.

Context: This step needs to be performed for each inventory
organization.

This step involves the following tasks.

¢ Define items at the master level. See: Master Level vs.
Organization Level, Oracle Inventory User’s Guide. See: Defining
Items, Oracle Inventory User’s Guide. Note that some Inventory
fields in the Master Item window, such as the Serial number
fields, are available only if Inventory is fully installed rather than
shared.

e Update the default categories assigned to the items.

e Assign items at the organization level. See: Updating
Organization Level Items, Oracle Inventory User’s Guide.

¢ Define item relationships. See: Defining Item Relationships,
Oracle Inventory User’s Guide.
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Step 28

Step 29

Step 30

Step 31

Step 32

Step 33

Define Line Types (Required with defaults)

See: Defining Line Types: page 1 —84.

Default: Default line types that Purchasing provides include Goods;
Services; and Outside Processing, if Work in Process is installed.

Start the Purchasing Database Administrator (Required)

See: Purchasing Database Administration: page 9 - 107.

Define Financial Options (Required)

See: Defining Financials Options, Oracle Public Sector Payables User’s
Guide.

Context: This step needs to be performed for each operating unit.

Define Transaction Reasons (Optional)

Transaction reason codes allow you to provide predefined explanations
for each receiving transaction. Examples of transaction reason codes
you can define include No Packlist, Shortage, Recall, or Supplier Error.
If you're also setting up Oracle Inventory, you may already have
performed this step when you set up Inventory.

See: Defining Transaction Reasons, Oracle Inventory User’s Guide.

Define Receiving Options (Required)

You may not need to perform this step if you’ve already defined
receiving options in Step 6 Define Organizations and Organization
Relationships. See: Defining Receiving Options: page 1 —58.

Context: This step needs to be performed for all inventory
organizations. Use the Change Organization function in the Purchasing
menu to perform this step for each inventory organization.

Set Up Transaction Managers and Resubmission Intervals

This step involves the following tasks:

o Start the following transaction managers. See: Administer
Concurrent Managers Window, Oracle Applications System
Administrator’s Guide. (Required)

— Receiving transaction manager

- Document approval manager
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Step 34

Step 35

Step 36

e Define resubmission intervals for concurrent processes. Contact
your system administrator if you need help with this task. See:
Defining Managers and Their Work Shifts, Oracle Applications
System Administrator’s Guide. (Optional)

Define Suppliers (Required)

You may not need to perform this step if you have already installed
and set up Oracle Public Sector Payables or performed a
common-applications setup. See: Entering Suppliers, Oracle Public
Sector Payables User’s Guide.

Set Up Workflow Options (Required with defaults)

Purchasing uses Oracle Workflow technology to handle requisition and
purchase order approvals, automatic creation of purchase orders and
releases, purchase order changes (specifically, any additional approvals
those changes require), and receipt confirmation. Workflow runs in the
background. It automates these procurement activities whenever you
submit a document for approval, create a requisition, or change a
purchase order.

Default: Purchasing provides default functionality in these
Workflow-automated processes. For example, one default
functionality is for the automatic document creation workflow to create
purchase orders automatically from approved requisition lines. If you
do not want this default functionality, you can easily change it in the
Oracle Workflow Builder.

For descriptions of the other defaults that Purchasing provides, see:
Choosing Workflow Options: page 1 — 95.

Submit Workflow-Related Processes

Start the following Workflow-related processes, if you haven't already
done so in the previous step:

¢ Send Notifications for Purchasing Documents process. See: Send
Notifications for Purchasing Documents: page 9 — 155.
(Required)

e Workflow Background Engine. Whether you need to submit this
process depends on the options you chose or the defaults you
accepted as described in the section Choosing Workflow
Options: page 1 - 95. For instructions on submitting the
Workflow Background Engine, see: To Schedule Background
Engines, Oracle Workflow Guide. (Required with defaults)
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Step 37

Step 38

Step 39

Step 40

Default: If you chose to accept the default Workflow options
that Purchasing provides, you must start the Workflow
Background Engine.

Define Descriptive Flexfields (Optional)

If you do not want to define descriptive flexfields now, you can define
them at any time. See: Oracle Applications Flexfields Guide.

Set Up Automatic Sourcing (Optional)

You can set up Purchasing to automatically default source document
information from a blanket purchase agreement or catalog quotation
onto a requisition or purchase order line for a particular item and
supplier. Or you can default just a supplier and optionally a supplier
site. See: Setting Up Automatic Sourcing: page 5 — 32.

You can set up automatic sourcing now or at any time on an ongoing
basis.

Perform Additional System Administrator Setup

This step involves the following tasks:
o Define custom menus. (Optional)

o Define new responsibilities based on your business and security
needs. See: Oracle Applications System Administrator’s Guide.
(Optional)

o Define user names. Purchasing users must have user names, and
the user names must be linked to an employee name. See: Users
Window, Oracle Applications System Administrator’s Guide.
(Required)

o Define printers if you haven’t already. See: Setting Up Your
Printers, Oracle Applications System Administrator’s Guide.
(Optional)

See: Oracle Applications System Administrator’s Guide.

Define Manufacturing System and User Profiles (Required)

See: Setting User Profile Options, Oracle Applications System
Administrator’s Guide. See: Common User Profile Options, Oracle
Applications System Administrator’s Guide. See: Profile Options in
Purchasing: page 1 - 103.
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Context: This step needs to be performed for each operating unit.
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Defining Locations

Use the Locations window to define ship-to, receiving, and other
location information for Purchasing documents.

» Toset up locations for Purchasing:
1. Navigate to the Locations window.

2. Forinformation on the Name, Description, Inactive Date, Global,
and Address Details fields, follow the instructions in Setting Up
Locations, Oracle Human Resources User’s Guide or see the online
help for the window.

Z= Location

PEGES M1 - Seattle
Seattle Mfg Plant 1

Inactive Date Ml Global

hipping Details

Contact

Ship-To Location |M1- Seattle

v Ship-To Site W Bill-To Site
W Receiving Site W |nternal Site
W Office Site

{Extra Inforrm...

3. Fillin information in the Shipping Details tabbed region.

Note: Selecting the check boxes means that you are making the
location Name a valid location in the list of values on a Purchasing
document. For example, selecting Ship-To Site makes the location
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Name a valid choice in the list of values for the Ship-To field on a
purchase order header. Note that if you define a default Ship—To or
Bill-To Location in the Supplier-Purchasing region of the Financials
Options window for your organization, that is the location that
defaults onto your purchase orders. But if you wanted to change
that default, the location Name that you define here and enable as a
Ship-To or Bill-To site is available in the list of values for you to
choose from in the Ship-To or Bill-To fields.

Contact: Optional contact name for the location Name.

Ship—To Location: Usually the same as the location Name. You could
select a separate, previously defined Ship-To Location—for
example, if you wanted to create a location Name, Office A, and
specify Receiving Dock A as its Ship—To Location. Note, however,
that once you specify a separate Ship—To Location, you can no
longer enable the location Name as a Ship-To Site. In this example,
Receiving Dock A is the ship-to site for Office A; therefore, Office
A itself cannot also be the ship-to site.

Ship-To Site: Select this option to make the location Name a valid
ship-to organization on a purchase order or requisition.

Receiving Site: Select this option to make the location a valid
receiving Location when creating a receipt or receiving transaction.

Office Site: Select this option to indicate that this location Name is
an office site, such as a field office.

Bill-To Site: Select this option to make the location Name a valid
bill-to site. The Bill-To Site, which is used by Payables, is specified
on a purchase order header.

Internal Site: Select this option to make the location a valid internal
ship-to location when creating an internal requisition.

Optionally fill in information in the Other Details tabbed region.

Inventory Organization: Select an inventory organization within
which this location will be available in the list of values on a
Purchasing document. By selecting no inventory organization, this
location becomes available on Purchasing documents in all
organizations.

Tax Name: Select a tax code to associate with the ship—to location. If
you check the Ship-To Location option in the Purchasing tax
default hierarchy, this is the tax code that defaults onto your
requisitions and purchase orders, depending on your hierarchy. See
Defining Tax Defaults Options: page 1 —55.
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EDI Location: If you use Electronic Data Interchange (EDI) to
receive Advance Shipment Notices (ASNs) or ASNs with billing
information (ASBNSs), enter a defined location. This location should
match the ship-to location specified on an ASN or ASBN. See:
Advance Shipment Notices (ASNs): page 7 - 16.

5. If you want to use the Extra Information button to enter additional
information required by your business, see: Entering Extra
Information, Oracle Human Resources User’s Guide or see the online
help for the window.
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Defining Buyers

Use the Buyers window to define and maintain your buyers. Buyers
can review all requisitions using the Requisitions window, and only

buyers can enter and autocreate purchasing documents. See the
Document Types window for rules governing access to documents.
See: Defining Document Types: page 1 —87.

Prerequisites

a

Q

Define employees before performing this step. See: the online help

for the Enter Person window.

Define locations before performing this step. See: Defining
Locations: page 1 —24.

p Todefine buyers:

1.

B Buyers

_ Buyer
JlAbbott, Ms. Rachel

Navigate to the Buyers window by selecting Buyers from the
menu.

Default Effective

Ship-To From
M1- Seattle

|i Adams, Mr. Brian

M1- Seattle

|| Anderson, Victoria

|| Anderson, Boh

|i Andretti, Mr. Evan

M1- Seattle

|i Armstrong, Mr. Billie Joe

M1. Seattle

|i Badger, Mr. David

|i Baker, Ms. Catherine

|| Black, Mr. Chris

]
]
]
]

| |Brock, Mr. Kim V1- New York Ci|05/MAR/1995 [ 5]

2.

Enter the Name of an employee who you want to define as a buyer.
If the name you want does not appear in the list of values, use the
Enter Person window to enter that person as an employee. See:

the online help for the Enter Person window.
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3. Enter the default purchasing Category of the goods the buyer
typically orders. Purchasing defaults this value in the Category
field when you are autocreating documents. See: Defining
Categories, Oracle Inventory User’s Guide.

4. Enter the name of the ship-to location for which the buyer typically
creates purchase orders. Purchasing defaults this value when you
are autocreating documents.

5. Enter the Start Date that you want to initiate the responsibilities for
a buyer. The default is the current date.

6. Enter the End Date after which the employee is no longer a buyer.

7. Save your work.
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Defining Approval Groups

Use the Approval Groups window to define and update approval
groups. Once you have defined an approval group here, you can then
use it to assign approval functions to jobs or positions in the Approval
Assignments window. You cannot delete an approval group that is
used in an active assignment. You can enable or disable the entire
approval group, or you can enter inactive dates for individual approval
rules.

Prerequisites

1 Define employees before performing this step. See: See: the online
help for the Enter Person window.

U Review how your choices in this window affect your approval
routing. See: Defining Approval Authorization Rules: page 2 - 16.
p To define approval groups:

1. Navigate to the Approval Groups window by selecting Approval
Groups from the menu.
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% Approval Groups (V1)

Approval Rules

. 0] L|| ect

2. Enter the Name of the approval group. You can change existing
approval group names, but names must be unique.

3. Select Enabled to permit the approval group to be assigned to a
position/job in the Approval Assignments window.

4. Choose one of the following Objects:

Account Range — (Required) For this option, you enter the
accounting flexfields for the Low and High Values. Include Type
rules identify accounts that you want to be included on the
document. Exclude Type rules identify accounts that you do not
want on the document. If you do not enter a rule for an account, the
default is to exclude the account. If you enter only an Exclude Type rule,
Purchasing does not automatically include everything else.

For example, entering only the following account includes account
01.000.0451 and excludes all else:

Account Range | Include 01.000.0451 | 01.000.0451

Entering only the following account excludes all accounts:
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Account Range | Exclude 01.000.0451 | 01.000.0451

Entering only the following two accounts includes all accounts
except 01.000.0451:

Account Range | Include 00.000.0000 | zz.zzz.zzzz

Exclude 01.000.0451 | 01.000.0451

The Inactive Date is optional, but you must enter an Amount Limit
for Include Type rules.

Document Total — (Required) The document total refers to the
monetary limit on an individual document. For this option, the
Type defaults to Include, and you can enter only the Amount Limit
(required) and the Inactive Date (optional).

Item Category Range — For this option, you enter the purchasing
category flexfields for the Low and High Values. Include Type
rules identify manufacturing categories that you want to be
included on the document. Exclude Type rules identify categories
that you do not want on the document. If you do not define a rule
for a category, the default is Include. The Inactive Date is optional,
but you must enter an Amount Limit for Include Type rules.

Item Range — For this option, you enter the item flexfields for the
Low and High Values. Include Type rules identify items that you
want to be included on the document. Exclude Type rules identify
items that you do not want on the document. If you do not define
a rule for an item, the default is Include. The Inactive Date is
optional, but you must enter an Amount Limit for Include Type
rules.

Location — The location refers to the deliver-to location on a
requisition as well as the ship-to location on purchase orders and
releases. Include Type rules identify locations that you want to be
included on the document. Exclude Type rules identify locations
that you do not want on the document. For this option, you enter
the location in the Low Value field. If you do not define a rule for a
location, the default is Include. The Inactive Date is optional, but
you must enter an Amount Limit for Include Type rules.

Select the rule Type: Include or Exclude indicates whether to allow
objects that fall within the selected range.

Enter the Amount Limit. This is the maximum amount that a
control group can authorize for a particular object range. This field
is required only for Include type rules.
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7. Enter the Low Value. This is the lowest flexfield (accounting,
purchasing category, or item) in the range pertinent to this rule.
When the object is Location, enter the location. You cannot enter
this field when the object is Document Total.

8. Enter the High Value. This is the highest flexfield (accounting,
purchasing category, or item) in the range pertinent to this rule.
You cannot enter this field when the object is Location or
Document Total.

9. Enter the Inactive Date on which Purchasing will no longer use this
rule in formulating the group.

10. Save your work.

See Also

Defining Approval Assignments: page 1 — 33
Approval Authorization Rules: page 2 —16
Defining Approval Authorization Rules: page 2 - 16
Using Approval Assignments: page 2 — 19
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Assigning Approval Groups

Use the Assign Approval Groups window to assign approval groups
and approval functions to positions or jobs. If you are using approval
hierarchies (the Use Approval Hierarchies option in the Financials
Options window is enabled), you must first use the Approval Groups
window to establish rules for your approval groups. Then you can
assign approval groups to positions in this window. When you are not
using approval hierarchies, you can use this window to assign approval
groups and approval functions to jobs within your organization.

Prerequisites

O Define approval groups before performing this step. See: Defining
Approval Groups: page 1 -29.

U Review how your choices in this window affect your approval
routing. See: Using Approval Assignments: page 2 — 19.

p Toassign approval groups:

1. Navigate to the Assign Approval Groups window by selecting
Assignments from the menu.
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%Assign Approval Groups (V1)

SLETT N7 10 ADMIN ASSISTANT Organization
S STAT00.Staff Administrator

Approval Assignments

Effective

_ Document Type Approval Graup From
| | Approve Standard Purchase (|Buyer Materials 15/JAN/2001

(0 (I (S (B (B (B (B (I

2. Enter the Position for which you want to assign approval groups
and approval functions. If the Use Approval Hierarchies option in
the Financial Options window is not enabled, this field is not
applicable.

3. Ifyou are not using approval hierarchies, enter the Job.
4. Select the approval function you want to assign to this position or
job.

5. Enter the approval group that you want to assign to the selected
position or job. The list of values includes only enabled approval
groups with at least one approval rule. See: Defining Approval
Groups: page 1 —29.

6. Enter the Start Date and End Date for the assignment.

Attention: The start and end dates that you assign here are the

ISy effectivity dates of the assignment. When the system date reaches
the end date of the assignment, the rule no longer applies. There is
no explicit warning that the rule is no longer in effect.

1 -34 Oracle Public Sector Purchasing User’s Guide



7. Save your work.

See Also

Defining Financials Options, Oracle Public Sector Payables User’s Guide

Representing Jobs and Positions, Oracle Human Resource Management
Systems User’s Guide

Defining Approval Groups: page 1 —29

Approval Authorization Rules: page 2 - 16
Defining Approval Authorization Rules: page 2 - 16
Using Approval Assignments: page 2 — 19
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Annotating Purchasing Documents

Major Features

Purchasing provides you with powerful features to create attachments
for your purchasing documents. You can provide unlimited text,
specify who can review the attachments, and print text attachments
onto your purchase orders. You can even modify existing attachments
to personalize your messages for different suppliers. You can easily
provide all the information you need when you create your purchasing
documents. You should be able to:

¢ Provide unlimited text attachments on your purchasing
documents

o Designate the appropriate people who can review the
attachments

e Print text attachments on your purchase orders and RFQs for the
supplier to review

o Reuse attachments on different documents
e Copy and modify existing attachments to speed up data entry

e Copy attachments from your requisitions to your RFQs and
purchase orders

e Provide standard attachments for an item that you can reference
whenever you create a purchasing document for that item

Copy

You can copy an existing long attachment so that you can customize it
without having to retype the entire attachment. This feature is
particularly useful if you have a lengthy document that you want to
modify for different suppliers.

Usage

You can indicate who has access to your long attachments. You
indicate whether the attachment is for an approver, receiver, buyer, or
supplier. Or you can indicate that you want the attachment for internal
use only. You can also enter attachments that will be displayed during
invoice matching in Accounts Payable. To understand how to enter
and review attachments for different usages, see: Managing
Attachments: page 1 —38.
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Using Brief Notes

Using Attachments

See Also

You can provide brief notes on most of your documents. Unlike
attachments, you cannot copy notes from one document to the next.
You should provide notes when the attachment contains no more than
240 characters, you do not want to reuse the note on other documents,
or you do not want to format the note. Otherwise, you should use
attachments to provide additional text for your documents.

You can provide as much text as you want for your documents. You
can provide attachments at the header and line level for the following
documents:

e Requisitions

e Standard and Planned Purchase Orders (also shipment level)
e Blanket Purchase Agreements

e Releases (header and shipment levels)

e Contract Purchase Agreements (header level only)

e RFQs

e Quotations

¢ Receipts (line level only)

e Receiving Transactions (line level only)

You can also provide attachments for your items. When you create an
attachment, you designate whether you want the attachment to be
available to the supplier, receiver, approver, or buyer. Or, you can
designate that you want the attachment to appear to anyone who has
access to that particular document on-line. To understand how to
create attachments for different usages, see: Managing Attachments:
page 1 —38.

Attaching Notes to Purchasing Documents: page 1 —44

Managing Attachments: page 1 —38
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Managing Attachments

Item Attachments

You can provide attachments for your items. When you reference an
item on a purchasing document, Purchasing makes the corresponding
item attachments available for you to review. Purchasing also prints
text attachments on your purchase orders and RFQs if you choose
Supplier as the usage when you create the item attachment.

Requisition and Standard Purchase Order Attachments

You can create attachments for your requisition headers and lines.
When you AutoCreate a requisition line onto a purchase order,
Purchasing copies the attachments from the requisition header and line
to the corresponding purchase order line. As a buyer, you can provide
additional attachments to a purchase order even after you AutoCreated
it from a requisition.

If the purchase order line references more than one requisition line,
Purchasing copies only the header and line attachments from the
requisition line that is the basis for the purchase order line. For
example, if you place multiple requisition lines onto a single purchase
order line, Purchasing copies only the requisition header and line
attachments from the line where you use the Copy option.

For each requisition line copied, the corresponding header level
attachment is copied. For example, you have a requisition with 3 lines
and they have 3 line level attachments and a header level attachment.
You then AutoCreate this requisition to a purchase order with 3 lines,
each of the 3 lines in the purchase order would have the specific line
attachment and the common header attachment.
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REQUISITION STANDARD PURCHASE
ORDER
autocreate
Create Create
— Header — Header
Copy
Create C
— Line Y Line
Create
View View
ITEM

Blanket Purchase Agreement and Release Notes

You can create long attachments for your blanket purchase agreements
at the header and line level. You can review the blanket purchase
agreement header attachment on the corresponding release header, and
you can enter new attachments on the release header. You can also
review the blanket agreement line attachment on the corresponding
release shipment, and you can enter new attachments for the
shipments. Purchasing does not copy requisition attachments to a
blanket agreement or release when you AutoCreate a release.
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1-40

BLANKET PURCHASE BLANKET RELEASE
ORDER
Creat i
reat Header R > Header
Create .
EE— Line
Y
View
ITEM View Shipment

Requisition, RFQ, and Quotation Notes

Similar to standard purchase orders, Purchasing copies requisition
header and line attachments to the corresponding RFQ line.
Purchasing copies all RFQ header and line attachments to the
corresponding quotation header and line when you copy a quotation
using the Entire RFQ or RFQ Header and Lines options in the Copy
Document window. Purchasing copies only the attachments from the
RFQ header to the quotation header when you copy a quotation using
RFQ Header Only. If you choose the Selective option when copying a
quotation, Purchasing copies the RFQ header attachments to the
quotation header and lets you decide which line attachments you want
to copy to the quotation line.
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Printing Attachments

Usages in Attachments

REQUISITION RFQ QUOTATION
autocreate autocreate
Copy
Create Create
- Header — Header Create Header
—_——
Copy User Specified Copy
Create o
— Line Tt Line Create Line
View View
ITEM

You can print text attachments on your purchase orders and RFQs. To
print an attachment on a purchase order or an RFQ, simply designate
Supplier as the usage for the attachment. Purchasing prints these
attachments on the corresponding purchase order or RFQ. Purchasing
prints as much as possible on each page and continues printing on the
next page where applicable.

Purchasing also prints item attachments and attachments with usage
Receiver on the Receipt Traveler.

You can enter unlimited attachments on any requisition, purchase
order, quotation, or request for quotation (RFQ). You decide which
standard attachments to print on your documents and reports. You can
easily combine the one-time attachments you enter for a specific
document with predefined standard attachments. You can even create
a new attachment directly from an existing attachment or use
attachments to enter long descriptions for the items you purchase.
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Understanding Usages

Purchasing provides you with a list of predefined usages you can use
depending on the type of document you create. The following list
shows the usages available for each document you can create.

Supplier You can use this usage on purchase orders, RFQs,
guotations, requisitions, and for items. Purchasing
prints all Supplier text attachments on your
documents.

Receiver You can use this usage on purchase orders,
quotations, RFQs, receipts, requisitions, and for
items. Purchasing displays these attachments to
the receiver in the receiving windows and prints
text attachments on the Receipt Traveler.

Approver You can use this usage on requisitions. Purchasing
displays these attachments to the approvers when
they approve your requisitions.

Buyer You can use this usage on requisitions. Purchasing
displays these attachments to the buyers when they
create purchase orders from your requisitions.

[Document] You can enter these attachments only on a specific

Internal [Document]. Reference this usage when you want
to enter information specific to a purchase order,
quotation, RFQ, receipt, requisition, or item.
Purchasing does not print or display these
attachments outside the window you use to enter
the document. RCV Internal attachments,
however, are printed on the Receipt Traveler.

Payables You can use this usage on purchase orders.
Purchasing displays these attachments during
invoice matching in Accounts Payable.

Defining a Standard Attachment

To define a standard attachment, you simply provide the usage for this
attachment, a meaningful and unique name, and the attachment itself.
You can also provide a start date and end date to control the
availability of this attachment. Purchasing defaults today’s date as the
start date for standard attachments. You can easily inactivate an
attachment by entering an end date for it. You cannot use a standard
attachment on a document after the end date has expired. You define
standard attachments in the Documents window. See: Defining
Product Specific Documents, Oracle Applications User’s Guide.
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Referencing a Standard Attachment

After you define your standard attachments, you can reference them on
your documents. You can reference as many standard attachments to

your documents as you want.

See Also
Attaching Notes to Purchasing Documents: page 1 — 44
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Attaching Notes to Purchasing Documents

You can attach files, such as notes, comments, spreadsheets, and
graphics to your application data.

For example, in Purchasing, you can attach files to purchasing
documents.

An attached file may include comments, for example if the buyer
would like to be notified when an item fails inspection.

» To attach notes to purchasing documents:

m  Choose the Attachments icon.

See Also

About Attachments, Oracle Applications User’s Guide
Working With Attachments, Oracle Applications User’s Guide
Annotating Documents: page 1 — 36

Managing Attachments: page 1 — 38
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Defining Purchasing Options

Use the Purchasing Options window to define default values and
controls for functions throughout Purchasing. You can often override
purchasing options when you are creating documents.

You can define specific categories of options when you select one of the

following:

Accrual Options

Control Options

Default Options

Internal
Requisition
Options

Numbering
Options

Tax Defaults
Options

Defining Default Options

Define accrual options, such as whether you accrue
expense items at period end or upon receipt. See:
Defining Accrual Options: page 1 -48.

Define control options, such as the receipt close
point. See: Defining Control Options: page 1 —49.

Define default options, such as the minimum
release amount. See: Defining Default Options:
page 1 —45.

Define the required order type and order source for
internal requisitions. You can navigate to this
window only when Purchasing, Order
Management, and Inventory are installed. See:
Defining Internal Requisition Options: page

1 -52.

Define the numbering method, numbering type,
and next number for each of your documents. See:
Defining Numbering Options: page 1 —53.

Define the sources from which purchasing
documents default tax information. See Defining
Tax Defaults Options: page 1 —55.

p To define default options:

1. Navigate to the Default tabbed region in the Purchasing Options

window.
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Accrual Control Default Internal Reguisition | Mumbering | Tax Defaults

Requisition Impart Group-By |Item Rate Type |Corporate

Minimurm Release Amount |1.I]I]

Price Break Type |Cumu|ati\re Price Type

Quote Warning Delay |7 " BF G Required

Receipt Close |10 % Invaice Close |1 %
Line Type |Goods Match Approval Level |3 Way

2. Select one of the following Reglmport Group By options for
requisitions imported through the requisition open interface: All
(not grouped), Buyer, Category, Item, Location, or Supplier. See:
Requisition Import Process: page 9 - 144,

3. Select the currency Rate Type that defaults on requisitions,
purchase orders, RFQs, and quotations. If the Rate Type is User,
you can override this default for each document line. If either your
functional currency (defined in your set of books) or your
transaction currency (the currency you enter in a purchasing
document window) is Euro (the European Monetary Unit
currency), and the other is another European currency, Purchasing
defaults in the appropriate conversion Rate Type, Rate, and Rate
Date. See: Defining Conversion Rate Types, Oracle Public Sector
General Ledger User’s Guide.

4. Enter the Minimum Release Amount that defaults on blanket,
contract, and planned purchase orders. This amount is in your
functional currency. See: Overview of Multi-Currency
Accounting, Oracle Public Sector General Ledger User’s Guide.

5. Select the Price Break Type that defaults on blanket purchase
orders:

Cumulative: Price breaks apply to the cumulative quantity on all
release shipments for the item.

Non—-cumulative: Price breaks apply to quantities on individual
release shipments for the item.
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10.

11.

12.

Select the Price Type that defaults on purchase orders. Use the
Lookup Codes window to define price types. See: Defining
Lookup Codes: page 1 - 74.

Enter the Quote Warning Delay. This is the number of days before
a quotation expires that you want to receive an expiration warning.
When a quotation is due to expire within the number of days you
provide here, you receive the following message in the
Notifications Summary window: Quotations active or approaching
expiration: [number]. See: Viewing and Responding to
Notifications: page 2 —31.

Select RFQ Required to require an RFQ for an item before you can
autocreate the corresponding requisition line onto a purchase order.
You can override this value for each item or requisition line.

Enter the Receipt Close tolerance percentage for your shipments.
Purchasing automatically closes a shipment for receiving if it is
within the receiving close tolerance at the receiving close point. Set
the receiving close point in the Control Options window. You can
override this option for specific items and orders. See: Defining
Control Options: page 1 —49.

Enter the Invoice Close tolerance percentage for shipments.
Purchasing automatically closes a shipment for invoicing if it is
within the invoicing close tolerance at billing, when Payables
matches invoices to purchase orders or receipts. You can override
this option for specific items and orders. See: Defining Control
Options: page 1 —49.

Select a default Line Type for requisition, RFQ, quotation, and
purchase order lines. When you create any of these documents, the
line type is part of your item information. You can override the
line type for each document line. See: Defining Line Types: page

1 -84,

Attention: This field is enterable only when the form is accessed
from the Purchasing menu.

Select one of the following options for Match Approval Level:

Two-Way: Purchase order and invoice quantities must match
within tolerance before the corresponding invoice can be paid.

Three-Way: Purchase order, receipt, and invoice quantities must
match within tolerance before the corresponding invoice can be
paid.
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Four-Way: Purchase order, receipt, inspection, and invoice
gquantities must match within tolerance before the corresponding
invoice can be paid.

See: Receiving Controls, Options, and Profiles: page 7 - 8.

Note: The Invoice Match Option in the purchase order Shipments
window and the Match Approval Level here are independent
options. The Invoice Match Option determines whether Payables
performs invoice matching to the purchase order or the receipt.
You can perform whichever Invoice Match Option you want on a
shipment regardless of the Match Approval Level you choose here.

13. Save your work.

Defining Accrual Options

» To define accrual options:

1. Navigate to the Accrual tabbed region in the Purchasing Options
window.

'%Purchasing Options (Vision Operations) |-/

Accrual Caontral Default Internal Reguisition | Mumbering | Tax Defaults

Accrue Expense ltems |At Receipt

Accrue Inventory ltems |At Receipt

Expense AP Accrual Account |I]1.l]l]l].222l].l]l]l]l].l]l]l]

Accrual Account Description |0peratiuns.EaIance Sheet.Accounts |

2. Choose one of the following Accrue Expense Items options:
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At Receipt: Accrue expense items upon receipt. You can override
this flag in the Shipment Details window when you are entering
purchase orders and releases.

Period End: Accrue expense items at period end.

= Attention: When using Cash Basis Accounting, you should set
this option to Period End, but you will not normally run the
Receipt Accrual — Period End process.

3. For Accrue Inventory Items, you currently have only one choice:
On Receipt.

4. Enter the default Expense AP Accrual Account.

5. Save your work.

Defining Control Options

p To define document control options:

1. Navigate to the Control tabbed region in the Purchasing Options
window.

'%Purchasing Options (Vision Operations)
Accrual Control Default Internal Reguisition | Mumbering | Tax Defaults

Price Tolerance |8 % I« Enfarce Price Tolerance

Enforce Full Lot Cluantity  |Advisory I Display Disposition Messages

Receipt Close Point |Received I Mgtify If Blanket PO Exists

Cancel Requisitions |Optionally I Allow Itern Description Update

[~ Enforce Buyer MName

I Enfarce Wendor Hald

2. Enter the Price Tolerance Percent. This is the percentage by which
the autocreated purchase order line price cannot exceed the
requisition line price. If you select Enforce Price Tolerance, you can
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create, but not approve, purchase orders for which this tolerance is
exceeded. There is no restriction on how much a price can
decrease.

Select Enforce Price Tolerance if you want Purchasing to enforce the
price tolerance percentage.

Select one of the following values for the Enforce Full Lot Quantity
option:

None: The requisition quantity is not rounded to the lot quantity.

Automatic: The requisition quantity is forced to the rounded
quantity.

Advisory: An advisory message suggesting rounding and a
suggested rounding quantity are displayed, but you can override.

Enforce Full Lot Quantity is used for rounding quantities on
Internal Requisitions, for example:

System Options Enforce Full Lot Quantities = Yes
Items Rounding Factor = 75%

Items Unit of Issue = DZ

Unit of Measure on Internal Requisition = Each

If the user enters 6 Each on the Internal Requisition, the quantity
will be rounding to 0. If the user enters 11 Each on the Internal
Requisition, the quantity will be rounded to 12 Each.

See: Overview of Requisitions: page 3 — 2.

Select Display Disposition Messages if you want to see any
disposition messages defined against inventory items when they
are placed on requisitions.

Select the Receipt Close Point, which is when the shipment is
closed for receiving: Accepted (passed inspection), Delivered, or
Received. Note that you need to set the receipt close tolerance
percentage in the Default Options window. See: Defining Default
Options: page 1 —45.

Select Notify If Blanket PO Exists if you want to be notified of
existing blanket purchase agreements when you create a
requisition, purchase order, or blanket purchase agreement line for
the item. If you sourced the item, you see the following message:
Blanket purchase order [number] already exists for this item. Your
requestors can directly create a release for the blanket purchase
agreements instead of creating a requisition or purchase order if
you allow your requestor to enter releases. See: Viewing and
Responding to Notifications: page 2 — 31.
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10.

11.

12.

13.

The Cancel Requisitions options apply only to requisitions from
which purchase orders were autocreated. Select one of the
following:

Always: When canceling the purchase order, Purchasing also
cancels the requisition.

Never: When canceling the purchase order, Purchasing does not
cancel the requisition, so it is again available for inclusion on a
purchase order.

Optional: When canceling the purchase order, you are given the
option to cancel the requisition. See: Controlling Documents: page
2 —55.

You can define for each item whether you allow updating of the
item description during the creation of requisition, RFQ, quotation,
or purchase order lines. This update affects only the line you are
creating. Select Allow Item Description Update if you want Yes to
be the initial default of the Allow Description Update attribute
when you are defining a new item.

Select a Security Hierarchy, which is a position hierarchy from the
Position Hierarchy window. When the Security Level is set to
Hierarchy for a document in the Document Controls window, this
position hierarchy governs access security for the document.

Attention: This field is enterable only when the form is accessed
from the Purchasing menu.

Select Enforce Buyer Name to enforce entry of only your name as
the buyer on purchase orders. Otherwise, you can enter the name
of any active buyer. See: Defining Buyers: page 1 —27.

Select Enforce Supplier Hold if you do not want to be able to
approve purchase orders created with suppliers that are on hold.
Use the Suppliers window to place suppliers on hold. See: About
Suppliers, Oracle Public Sector Payables User’s Guide.

Note: Even if you put a supplier on hold in the Suppliers window,
you can still approve a purchase order to that supplier if Enforce
Supplier Hold is not checked here.

Save your work.
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Defining Internal Requisition Options

» To define internal requisition options:

1. Navigate to the Internal Requisition tabbed region in the
Purchasing Options window.

% Purchasing Options (Vision Operations)

Accrual Caontral Default Internal Reguisition || Mumbering | Tax Defaults

Order Type |

Order Source |Interna|

= Attention: The following two fields are enterable only when the
form is accessed from the Purchasing menu.

2. Select the default Order Type for internal requisitions.

= Attention: The Order Type field is visible only if the application
Oracle Order Management is installed.

Order types are defined in Order Management. The order type you
choose here is the type that Purchasing uses to create sales orders
from internal requisitions.

3. Select the default Order Source for internal requisitions.

Purchasing defaults and only uses Internal. This is the source
Orderlmport uses to transfer internal requisitions from Purchasing
to Order Management.

4. Save your work.
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Defining Numbering Options

Purchasing numbers requisitions, purchase orders, quotations, and
RFQs within operating units in a Multi-Org setup. So, for example,
Purchasing allows the same requisition number to be used by different
operating units.

Purchasing also numbers receipts within inventory organizations rather
than across inventory organizations. So, for example, the same receipt
number could be used by different inventory organizations. To define
receipt numbering options, see: Defining Receiving Options: page

1 -58.

p To define numbering options for your documents:

1. Navigate to the Numbering tabbed region in the Purchasing
Options window.

% Purchasing Options (Vision Operations)

Accrual Caontral Default Internal Regquisition | Mumbering || Tax Defaults

RFQ Murber
Cluotation Number
PO Mumber

Requisition Mumber

Entry

Type

Mext Mumber

|Autumatic

v| |Alphanumeric

~| |100083

|ﬂutumatic

v| |Alphanumeric

~| |100109

|ﬂutumatic

v| |Alphanumeric

~| |1003607

|Autumatic

v| |Alphanumeric

~| |101287

2. Select the [Document] Number Entry method for RFQ, quotation,
purchase order, and requisition numbers:

Automatic: Purchasing automatically assigns a unique sequential
number to each document when you create the document.

Manual: You provide a document number manually when you
enter the document.
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Attention: You can change the method of entering document
numbers at any time. If you originally allow manual entry and
switch to automatic entry, make sure to enter a Next Number that
is higher than the highest number you assigned manually.

Select the [Document] Number Type you want Purchasing to use
for RFQ, quotation, purchase order, and requisition numbers;
Numeric or Alphanumeric.

Attention: If you choose Automatic document number entry, you
can generate only numeric document numbers, but you can still
import either numeric or alphanumeric values from another
purchasing system.

Attention: If you import purchasing documents from a foreign
system that references alphanumeric numbers, you must choose
Alphanumeric as your number type, regardless of your numbering
method.

If you choose Manual document number entry, you can choose
numeric or alphanumeric numbers. You can change the document
number type from Numeric to Alphanumeric whenever you want.
You can change the document number type from Alphanumeric to
Numeric only if all your current document numbers are humeric.

Attention: The ordering of numeric values in lists of values can
appear random when you use the Alphanumeric number type. If
you are using Alphanumeric numbering, consider entering all
numeric values with the same number of digits. For example, if
you can assume all numeric values contain six digits, you should
enter the first value as 000001.

Enter the Next Number. This is the starting value you want
Purchasing to use for generating unique sequential document
numbers if you choose Automatic document number entry.
Purchasing displays the next document number that will be used
for a new document when you create the new document. You
cannot enter this field if you choose Manual document number
entry.

If you use Master Scheduling/MRP, Inventory, Work in Process, or
any non-Oracle system to create requisitions automatically, you
must also let Purchasing number the corresponding requisitions
automatically.

Save your work.
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Defining Tax Defaults Options

The tax defaults you select in this window are used in the following
windows and processes in Purchasing:

Shipments window for standard and planned purchase orders
Requisition lines in the Requisitions window

Purchase order line shipments created by the AutoCreate
Documents window

Shipments tabbed region in the Releases window (for blanket
releases)

Release shipments created by the Create Releases process

RFQ Shipments window (for Bid or Standard RFQs) or RFQ
Price Breaks window (for Catalog RFQs)

Quotation shipments window (for Bid or Standard quotations)
or Quotation Price Breaks window (for Catalog quotations)

A Tax Code defined in the Purchase Order Preferences window
overrides any tax defaults you set here. See: Entering Purchase Order
Preferences: page 4 - 33.

Each source you choose below corresponds to a tax code. For more
information on defining tax codes, see: Defining Tax Codes, Oracle
Public Sector Payables User’s Guide. See also: Defining Locations: page
1 -24.

1. Navigate to the Tax Defaults tabbed region in the Purchasing
Options window.
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Hierarchy

W Supplier Site

v Supplier

T =TE]

v Financial Options

2. Check one or more of the tax defaults sources from which your
purchasing documents default tax codes.

Ship-To Location — The tax code defaults from the Tax Code you
entered in the Location window.

Item — The tax code defaults from the Tax Code value you entered
in the Purchasing region of the Master Item or Organization Item
windows. The tax code defaults first from the item and the ship-to
organization, if available; if not, it defaults from the item and
inventory organization.

Supplier Site — The tax code defaults from the Invoice Tax Code in
the Invoice Tax region of the Supplier Sites window (accessible
from within the Suppliers window).

Supplier — The tax code defaults from the Invoice Tax Code value in
the Invoice Tax region of the Suppliers window.

Financial Options — The tax code defaults from the Tax Code in the
Financials Options window.

3. Inthe Hierarchy column, enter a ranking number (starting with 1)
for each of the tax defaults sources you checked (even if you
checked only one).

For example, you may check Item, Supplier Site, and Supplier and
rank them 3, 2, and 1 respectively. This means that when your
purchasing documents default tax information, they look first for
tax information from the supplier; if that tax information is not
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found, they look next for tax information from the supplier site; if
that’s not found, they look for tax information corresponding to the
item.

4. Save your work.

See Also

Tax Control Methods, Oracle Public Sector Payables User’s Guide
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Defining Receiving Options
Use the Receiving Options window to define options that govern
receipts in your system. Most of the options that you set here can be
overridden for specific suppliers, items, and purchase orders. See:
Receiving Controls, Options, and Profiles: page 7 — 8.
» To define receiving options:

1. Navigate to the Receiving Options window from the menu.

B Receiving Options (M1)

Receipt Date Miscellaneous

Action

Owver Receipt Control

Tolerance _ % EELETNERTGIN Standard Receipt

N arming -

Receipt Number Options
Action Type Next Receipt Number

Numeric _________ <JJl10000416

(e 11 8801.000.1410.0000.000
qildg Operations.Balance Sheet.lnventory Raw Material Va.No Sub A

2. Enter the maximum acceptable number of Days Early and Days
Late for receipts.

3. Enter the Action for Receipt Date Control. This field determines
how Purchasing handles receipts that are earlier or later than the
allowed number of days selected above. Choose one of the
following options:

None — Receipts may exceed the allowed days early or late.
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Reject — Purchasing does not permit receipts outside the selected
number of days early or late.

Warning — Purchasing displays a warning message but permits
receipts outside the selected number of days early or late.

Enter the maximum acceptable over-receipt Tolerance percentage.

Enter the Action for Overreceipt Quantity Control. This field
determines how Purchasing handles receipts that exceed the
guantity received tolerance. Choose one of the following options:

None — Receipts may exceed the selected tolerance.

Reject — Purchasing does not permit receipts that exceed the
selected tolerance.

Warning — Purchasing displays a warning message but permits
receipts that exceed the selected tolerance.

Choose an action for ASN Control. This field determines how
Purchasing handles receiving against purchase order shipments for
which an Advance Shipment Notice (ASN) exists. Choose one of
the following options.

None — Purchasing does not prevent or warn you when you try to
receive against a purchase order shipment for which an ASN exists.

Reject — Purchasing gives you a message and prevents you from
receiving against a purchase order shipment for which an ASN
exists.

Warning — Purchasing gives you a message informing you that an
ASN exists for the purchase order shipment and lets you decide
whether to receive against the purchase order shipment or its ASN.

Check Allow Substitute Receipts if you want to receive substitute
items in place of ordered items. You must define substitute items
in the Item Relationships window before you can receive them.
You can override this option for specific suppliers, items, and
orders. See: Defining Item Relationships, Oracle Inventory User’s
Guide.

Check Allow Unordered Receipts if you want to receive unordered
items. You can later match the unordered receipts to a purchase
order. If you enable this option, you can override it for specific
suppliers and items.

Check Allow Express Transactions to enable express deliveries and
receipts. See: Express Receipts and Receiving Transactions: page
7 - 26.
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10.

11.

12.

13.

14.

15.

Check Allow Cascade Transactions to enable cascading for receipts
and receiving transactions. See: Cascading Receipts and Receiving
Transactions: page 7 — 25.

Select Allow Blind Receiving if you want blind receiving at your
site. Blind receiving helps you ensure that receivers record the
exact amount they receive. With blind receiving, you cannot see
the quantity due or the quantity ordered for shipments when you
receive items. Purchasing ignores all quantity receipt tolerances to
help ensure that you can receive the exact amount the supplier
shipped.

Enter the default Receipt Routing that you assign goods: Direct
Delivery, Standard Receipt, or Inspection Required. You can
override this option at receipt time by changing the destination
type for specific suppliers, items, and orders if the RCV: Allow
Routing Override user profile is set to Yes. See: Profile Options in
Purchasing: page 1 - 103.

Enter the Enforce Ship To location option to determine whether the
receiving location must be the same as the ship-to location.
Choose one of the following options:

None — The receiving location may differ from the ship-to location.

Reject — Purchasing does not permit receipts when the receiving
location differs from the ship-to location.

Warning — Purchasing displays a warning message but permits
receipts when the receiving location differs from the ship-to
location.

Choose the Entry method for receipt numbers.

Automatic: Purchasing automatically assigns a unique sequential
number to each receipt when you create the receipt.

Manual: You provide a receipt number manually when you enter
the receipt.

Purchasing numbers receipts within inventory organizations rather
than across inventory organizations. So, for example, the same
receipt number could be used by different inventory organizations.

Attention: You can change the method of entering receipt
numbers at any time. If you originally allow manual entry and
switch to automatic entry, make sure to enter a Next Number that
is higher than the highest number you assigned manually.

Choose the receipt number Type you want Purchasing to use for
receipt numbers: Numeric or Alphanumeric.
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Attention: If you choose Automatic receipt number entry, you can

ISy generate only numeric receipt numbers, but you can still import
either numeric or alphanumeric values from another purchasing
system.

= Attention: If you have any alphanumeric documents in your
system, you must choose Alphanumeric as your number type,
regardless of your numbering method.

If you choose Manual receipt number entry, you can choose
numeric or alphanumeric numbers. You can change the receipt
number type from Numeric to Alphanumeric whenever you want.
You can change the receipt number type from Alphanumeric to
Numeric only if all your current receipt numbers are numeric.

Attention: The ordering of numeric values in lists of values can

ISy appear random when you use the Alphanumeric number type. If
you are using Alphanumeric numbering, consider entering all
numeric values with the same number of digits. For example, if
you can assume all numeric values contain six digits, you should
enter the first value as 000001.

16. Enter the Next Receipt Number. This is the starting value you
want Purchasing to use for generating unique sequential receipt
numbers if you choose Automatic receipt number entry.
Purchasing displays the next receipt number that will be used for a
new receipt when you create the new receipt. You cannot enter this
field if you choose Manual receipt number entry.

17. Enter the accounting flexfield for the default Receiving Accrual
Account.

See Also

Defining Purchasing Options: page 1 —45
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Defining Requisition Templates

1-62

Use the Requisition Templates window to define requisition templates.
These templates automate requisitioning of commonly ordered items
like office supplies. To create a requisition for office supplies,
requestors in your organization simply use your template and enter the
quantity of each item they want to order.

To create a template, you can specify the items individually or you can
reference an existing requisition or purchase order. If you reference an
existing document, Purchasing adds all lines on the document to the
template. You can reference multiple documents to add all their lines
to the same template.

After you define a template, you can reference the template in the
Supplier Item Catalog. When you do so, Purchasing displays all
template lines that are valid for the destination organization, and you
can use any of these lines on your requisition. You can create
requisitions with this template as long as the requisition creation date is
before the template inactive date.

To define requisition templates:

1. Navigate to the Requisition Templates window by selecting
Requisition Templates from the menu.
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%R&quisﬁiun Template (Vision Operations)

T

Type

Category D
MISC.MISC|| Capi

=TI Capital =S DANBURY

Contact

Supplier ltem

Crganization

Subirventory

=M@ Black, Mr. Chris

Enter the requisition Template name.
Enter a Description of the template.

Enter the Inactive Date after which you do not want any requestor
to create a requisition from this template.

Enter the requisition Type: Internal or Purchase. In either case,
you can enter individual requisition lines of either type.

p Tocopy lines to a template:

1.
2.
3.

Select the Copy button to open the Base Document window.
Enter the Base Document Type: Purchase Order or Requisition.

Enter the base document Number from which you want to copy
lines to the template.
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Choose the OK button to copy all lines of the base document onto
the template. You can choose the Cancel button to return to the
Requisition Templates window without copying.

You can place lines from multiple documents onto the same
requisition template.

» To manually add lines to a template:

1.

Use the Lines region to manually add new lines to the template.
You can also remove lines that you have copied from a base
document, and you can change certain information in these lines.

Enter a Number in this field to identify the sequence of the line on
your requisition. Purchasing provides default sequence numbers in
increments of one.

Enter the line Type. You can enter or change information in this
field only for new lines. The default is from the Purchasing
Options window. See: Defining Default Options: page 1 —45.

Enter the Item number. You can enter or change information in this
field only for new lines.

For new lines only, you can enter the item Revision number.

If you entered an item, Purchasing displays the purchasing
Category, and you cannot change it. Otherwise, you must enter a
purchasing category.

Purchasing displays the item Description from the document you
selected in the Base Document Number field. If you are entering a
new line, the description is from the item master. You can change
the description only if this attribute is active for the item.

The Source type determines the source of the requisitioned items.
The choice you have in this field is dependent on your user profile
options and the system profile options. At either level, you may be
restricted to one of the following options: Inventory or Supplier.

Note that if you have both options, you can source requisition lines
independently of the requisition type. You can even mix inventory
and supplier sourced requisition lines in the same requisition.
Purchasing creates one internal sales order for each inventory
source type requisition line on this requisition. The supplier source
type requisition lines go onto purchase orders, either automatically
with AutoCreate Documents or manually with the Purchase Orders
window.

Enter the default unit of measure.
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10. For supplier sourced lines, you can enter the unit price, and this

11.

price is used in the Requisitions window. For inventory sourced
lines, the cursor does not enter this field, and the price in the
Requisitions window is the actual cost from inventory.

Save your work.

To enter sourcing information:

You can enter sourcing information for the current line in the lower
part of the screen.

For supplier source type lines, you can enter the name of the Buyer
to whom you want to assign the requisition line. The buyers can
query requisition lines that you assign to them when they
AutoCreate purchase orders.

For supplier source type lines, you can select RFQ Required to
indicate that you want to require an RFQ before the buyer can
create a purchase order for the requisition. Purchasing displays a
warning message if you try to create a purchase order without a
required RFQ.

For supplier source type lines, you can enter a suggested Supplier
for your requisition items. You can choose a supplier from the list
of available suppliers. Alternatively, you can suggest a new
supplier by entering the name of the supplier directly.

For supplier source type lines, you can enter the supplier Site. You
can enter this field only if you provide a suggested supplier name.
You can choose a supplier site from the list of values. Alternatively,
you can enter a new site directly.

For supplier source type lines, you can enter the name of your
Contact at the supplier site.

For supplier source type lines, you can enter the Supplier Item
number.

For inventory source type lines, you can specify the source
Organization.

For inventory source type lines, you can optionally specify the
Subinventory source. If you do so, Oracle Order Management
reserves the goods and uses only the specified subinventory for
allocation. If the goods do not exist at the specified subinventory;,
Order Management backorders them, even if they do exist in
another subinventory.
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See Also

Overview of the Supplier Item Catalog: page 5 -8

1 -66 Oracle Public Sector Purchasing User’s Guide



Purchasing Hazardous Materials

Purchasing provides you with flexible features to handle all your
hazardous materials purchasing and receiving requirements. You can
clearly identify and classify hazardous materials and print information
on your RFQs and purchase orders to ensure that your suppliers pack,
label, and ship hazardous materials according to the regulations. You
can also review hazardous materials information when receiving items
and take the required safety precautions.

Use the Hazard Classes window (See: Defining Hazard Classes: page
1 -70.) to define the hazard classes you need. Use the UN Numbers
window (See: Defining UN Numbers: page 1 —71.) to define the
identification numbers you use and to assign them to hazard classes.
Use the Item window to associate hazard classes and UN numbers
with your items. See: Defining Items, Oracle Inventory User’s Guide

Regulation Background

Section 19 of the ISRS (International Safety Rating System) requires that
you clearly identify and record all orders for hazardous materials. The
US Department of Transportation provides similar regulations. These
regulations provide an extensive classification system for hazardous
materials. The purpose of this classification is to provide detailed
requirements for shipping papers, package marking, labelling, and
transport vehicle placarding applicable to the shipment and
transportation of hazardous materials. For each hazardous material,
the classification provides:

Shipping Name  Describes the item ordered or shipped. Shipping
names are regulated in some cases.

Examples:

Calcium hydrogen sulfite solution
Epichlorohydrin

Fuel oil

Mercuric oleate, solid

Petroleum Distillate

Small arms ammunition
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Hazard Class

Identification
Number

Oracle Public Sector Purchasing User’s Guide

Categorizes the hazardous material. Most
hazardous materials belong to only one hazard
class. Some materials belong to more than one
hazard class and some materials do not belong to
any. If amaterial belongs to more than one hazard
class, you should list these classes in a specific
order.

Examples:
Corrosive Material
Flammable liquid
Forbidden
Combustible liquid
Poison A

ORM-A

Class A explosive

Identifies the hazardous material. Each
identification number has a description. There are
two types of identification numbers. Identification
numbers preceded by "UN” (United Nations) have
descriptions appropriate for international and US
domestic shipments. Identification numbers
preceded by "NA” (North American) apply only to
US domestic shipments and shipments between the
US and Canada. ldentification numbers are not
unique. For instance, the same UN Number may
correspond to two closely related but different
types of materials.

Examples:

UNO0001 Alarm Devices, Explosives
UNO0027 Black powder

UNO0180 Rockets

NA1133 Cement

NA2016 Grenade

UN2016 Ammunition

UN2769 Benzoic derivative pesticide, liquid



Labels Required

Packaging
Requirements

Shipping
Requirements

UN2769 Benzoic derivative pesticide, solid

Some hazardous materials do not have a
corresponding identification number.

Examples:
Fuse, lighter

Propellant, explosive, liquid

In some cases, hazardous materials that you
identify by the same identification number can
belong to two different hazard classes.

Example:

Fuel, aviation, turbine engine has the ID Number
UN1863, but it can be in either the Flammable
Liquid or the Combustible Liquid hazard class.

Specifies the labels required for each package of the
hazardous material. The regulations provide
detailed instruction concerning the format, size,
colors, and printing of labels.

Examples:
Flammable liquid
Explosive C

Poison B

Specify the packaging and placarding requirements
and exceptions for the hazardous material.
Packaging requirements depend mainly on the
hazard class for the hazardous material, but there
are many exceptions to this rule.

Specify the maximum amount of hazardous
material you can carry per package depending on
the mode of transportation you use. Also provide
additional shipping, handling, storing, or other
information about the hazardous material.

Examples:
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Keep dry
Keep cool

Store away from acids

Defining Hazard Classes

Use this window to define codes for different classes of hazardous
materials. You provide the class name, description, and the date after
which the class is no longer active. You can assign a hazard class to
multiple UN numbers to identify hazardous items.

Purchasing automatically copies hazardous material information onto
your documents and prints this information on your purchase orders,
RFQs, and Receipt Travelers. Purchasing automatically displays
hazardous material information for your receivers.

If you use Multilingual Support (MLS), translations can be entered for
the hazard classes from within each of your installed languages. To
enter the translations for the hazard classes, select Translations from
the View menu. For more information, see the Oracle Applications User’s
Guide.

p To define hazard classes:

1. Navigate to the Hazard Classes window.
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g Hazard Classes

Description Inactive Date
Liguid goods that explode if ignited

Substance that corrodes other items it contacts

FLAMMABLE

Liquid goods that burn if ignited

Solid goods that burn if ignited

2. Enter a unique name for each hazard class you want to define. For
example, you might provide any of the following classes:
Explosive, Poisonous, Toxic.

3. Enter a description for your hazard class. You can use this
description to provide a more detailed explanation of the hazard
class.

4. Enter the date your hazard class becomes inactive. You cannot use
the hazard class after this date.

5. Save your work.

See Also

Purchasing Hazardous Materials: page 1 - 67
Defining UN Numbers: page 1 - 71
Defining Items, Oracle Inventory User’s Guide

Defining UN Numbers

Use this window to define United Nations identification numbers for
hazardous materials. You can associate a hazard class with multiple
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identification numbers. You can also assign an identification number
and a hazard class to each item you define.

Purchasing automatically copies hazardous material information onto
your documents. Purchasing prints hazardous material information on
your purchase orders, RFQs, and Receipt Travelers and displays this
information for your receivers and inspectors.

If you use Multilingual Support (MLS), translations can be entered for
the UN numbers from within each of your installed languages. To enter
the translations for the UN numbers, select Translations from the View
menu. For more information, see the Oracle Applications User’s Guide.

Prerequisites

U Define Hazard Classes before performing this step. See: Defining
Hazard Classes: page 1 —70.

p To define UN numbers:

1. Navigate to the UN Numbers window.

== UN Numbers

Mumber

Description Hazard ( Inactive Date

FLAMMABLE FL1

2. Enter the UN identification number. You can define multiple
instances of the same UN number as long as the descriptions are
different.

3. Enter a Description for your identification number.
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4. Enter the Hazard Class you want to associate with the
identification number. This is optional.

5. Optionally enter the Inactive Date for the identification number.

6. Save your work.

See Also

Purchasing Hazardous Materials: page 1 - 67
Defining Hazard Classes: page 1 - 70

Defining Items, Oracle Inventory User’s Guide
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Defining Lookup Codes

1-74

Use the Oracle Public Sector Purchasing Lookups window to define
lookup codes in Purchasing.

Purchasing uses lookup codes to define lists of values throughout the
system. A lookup category is called a lookup type, and the allowable
values for the lookup type are called lookup codes. You can add your
own codes to those initially provided for some of the lookup types,
depending on your Access Level.

For example, Purchasing supplies the following Supplier Type codes:
Employee and Supplier. You might want to define an additional code
called Consultant to use for the purchase of consulting services.

= Attention: You cannot change or delete codes once you have
added and saved them, but you can change the code
descriptions.

For detailed information on defining and updating lookups, see:
Lookups, Oracle Applications Developer’s Guide, or see online help.

If you use Multilingual Support (MLS), translations can be entered for
the lookups from within each of your installed languages. To enter the
translations for the lookups, select Translations from the View menu.
For more information, see the Oracle Applications User’s Guide.

To define lookup codes:

1. Navigate to the Oracle Public Sector Purchasing Lookups window
from the menu.
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% Oracle Purchasing Lookups

Access Level
IS ACCEPTANCE TYPE

Purchase order acceptance type

i Oracle Purchasing
i Purchase order acceptance type

Effective Dates Enabled

Code Meaning Jescription ag From 0 [1]

[

31/AU0G/2000

[

[

[

(0 B B

2. Enter one of the following predefined lookup Types: 1099 Supplier
Exception, Acceptance Type, FOB (free on board), Freight Terms,
Minority Group, Pay Group, PO/Requisition Reason, Price Type,
Quotation Approval Reason, Reply/Receive Via, and Supplier
Type.

3. Enter up to 25 characters as a unique code you want to add to the
lookup codes already provided. Purchasing provides the following
codes for the listed lookup types:

1099 Supplier Exception: Purchasing provides no 1099 Supplier
Exception codes, but you can define your own. These codes are
used only in the Payables reports: 1099 Invoice Exceptions Report
and 1099 Supplier Exceptions Report.

Acceptance Type: Purchasing provides Accepted Terms, On
Schedule, and Unacceptable Changes.

FOB: Purchasing provides no FOB codes, but you can define your
own. This code is printed on your purchase orders.
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Freight Terms: Purchasing provides no Freight Terms codes, but you
can define your own. This code is printed on your purchase
orders.

Minority Group: Purchasing provides no Minority Group codes, but
you can define your own. Minority Group codes are used to
classify suppliers for reporting purposes.

Pay Group: Pay Groups can be assigned to Payables invoices. Then
Payables payment batches can be limited to invoices assigned to a
specified Pay Group. The system provides no Pay Group lookups,
but you can define your own in this window.

Price Type: Purchasing provides Cost Plus Fee, Cost Plus
Percentage, Fixed, Indexed, and Variable.

Quotation Approval Reason: Purchasing provides Best Delivery, Best
Design, Lowest Price, Only Source, Quality, and Service.

Reply/Receive Via: Purchasing provides no Reply/Receive Via
codes, but you can define your own.

PO/Requisition Reason: Purchasing provides no transaction
reason/transaction nature codes for purchase orders, requisitions,
RFQs, and quotations, but you can define your own.

Vendor (Supplier) Type: Purchasing provides Employee, Supplier,
and Public Sector Agencies. These codes are used to classify
suppliers for reporting purposes. You enter this value in the Type
field of the Classification region of the Suppliers window. See:
Classification Region of the Suppliers window, Oracle Public Sector
Payables User’s Guide. It is also used to define tax recovery rules.
See: Tax Recovery Rules, Oracle Public Sector Payables User’s Guide.
The Tax Authority supplier type indicates suppliers to whom you
remit withholding taxes. See: Setting Up Withholding Taxes, Oracle
Public Sector Payables User’s Guide.

Enter an Inactive Date on which the code is no longer active.

Save your work.
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Defining Quality Inspection Codes

Use the Quality Inspection Codes window to define and update your
inspection codes. You can define as many codes for inspection as you
want. Each code must have a corresponding numerical ranking, which
provides an inspection scale. You use these inspection codes when you
receive and inspect the items you ordered.

p To define quality inspection codes:

1. Navigate to the Quality Inspection Codes window by selecting
Quiality Inspection Codes on the menu.

% Quality Inspection Codes

~ Ranking

10

Guality Code

Excellent

Description
Substantially exceeds quality stand

Inactive Date

Above Average

Exceeds gquality standards

Meets quality standards

Below Average

Below quality standards, but accep

Unacceptable

Below quality standards, not accep

Reject & Notify

Serious quality prohlem, contact su

2. Enter a Ranking number that corresponds to a specific quality
code. This value must be between 0 and 100, where 0 represents
the lowest quality. For example, 10 might represent a quality
ranking of Poor, while 90 might represent a quality ranking of
Excellent. Purchasing lists these rankings when you inspect your
receipts.

3. Enter a Quality Code to indicate a particular quality standard. For
example, you might want to define Excellent Condition or
Damaged as quality codes.
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4. Enter a description for your quality code. You can use this
description to provide a more detailed explanation of the quality
code.

5. Enter the Inactive Date after which the quality code is no longer
active.

6. Save your work.
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Purchasing Services

Purchasing provides the line type feature so that you can clearly
differentiate orders for goods from those for amount—based services or
outside processing.

Background

Requestors and buyers generally order both goods and services by
quantity. You order the number of items you need in a specific unit of
measure and at a given price. For instance, a buyer could order 10
computer terminals at a price of $1500 each. Later, the receiving agent
records the receipt of one crate of 5 terminals. The accounts payable
department receives a bill for 5 terminals, and matches the invoice
against the original purchase order. Sometimes, you also need to order
services in the same way. For example, you purchase 40 hours of
product training at a rate of $40 per hour. You simply record the hours
of training ordered and the price per hour. Once you receive the
training, you record the hours received.

However, you sometimes order services by amount rather than by
guantity. For example, a project manager orders $10,000 of consulting
services to install a local area network. In this case, the buyer only
needs to record the total amount of the service.

When half of the work is complete, the project manager records a
receipt of $5000. The consulting firm may send an invoice for the
complete amount of the service, or it may send partial invoices. In
either case, the accounts payable department must match the invoice to
the original purchase order or receipt by amount.

Purchasing provides you with the features you need to order both
goods and services. You should be able to:

e Create your own purchasing document line types. For each line
type, you should be able to specify the value basis: amount or
quantity. For both amount and quantity based line types, you
can specify default values for category, unit of measure, and
whether you require receipt. For quantity based line types, you
can specify the unit price, but for amount based line types the
unit price defaults to 1. For quantity based lines, you can specify
whether the line type is used for outside processing.

e Create a purchasing document with any combination of line
types you need.
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Major Features

o AutoCreate purchase order lines from your requisition lines,
grouping requisition lines for the same line type and item onto
the same purchase order lines.

e Create amount-based purchase order lines by selecting an
amount-based line type, category, item description, and total
amount for the line.

Line Type

The line type governs the type of requisition, purchase order, RFQ, and
quotation lines you create. Quantity—based line types let you order and
receive and/or invoice based on the quantity of goods or services
provided. Amount-based line types let you order and receive and/or
invoice based on the value of the service provided.

Quantity-Based Purchasing

Use quantity—based line types when you want to specify the quantity,
unit of measure, and unit price for the items you are ordering.
Purchasing provides Goods as an initial quantity-based line type. You
can modify this line type or create new quantity—based line types to
satisfy your needs.

Amount-Based Purchasing

Use amount-based line types when you want to order services and
other items by amount. You create an order for a service by selecting
an amount-based line type, category, item description, and total
amount of the service. You can also receive and match services by
amount.

Outside Processing Line Types

You can use outside processing line types to enter purchasing
documents to pay suppliers for outside processing operations.
Purchasing provides Outside Processing as an initial outside processing
line type, and you can create additional outside processing line types.
You cannot use outside processing line types, unless Purchasing, Work
in Process, and Bills of Material are installed. See: Overview of
Outside Processing, Oracle Work in Process User’s Guide.

1 -80 Oracle Public Sector Purchasing User’s Guide



Line Types Step by Step

Defining Line Types

Purchasing provides one initial line type: Goods. If Work in Process is
installed, Purchasing also provides the line type Outside Processing.
You can modify these line types or create new line types in the Line
Types window. To define a new line type, you simply provide a name
and description for lines types with a value basis of quantity or
amount. You can then optionally specify a default category, whether
receipt is required, and unit of measure. The unit price defaults to 1 for
amount-based line types but is otherwise optional. You cannot specify
a line as outside processing unless the value basis is quantity. You must
provide a default unit of measure for amount-based line types. You
use the unit of measure for amount-based lines as reference
information only. Purchasing does not perform any unit conversion for
amount based lines. You can create a unit of measure such as
AMOUNT for amount based line types to help you determine if you
ordered by amount. See: Defining Line Types: page 1 —84. See:
Defining Units of Measure, Oracle Inventory User’s Guide.

Creating Purchasing Document Lines

Purchasing lets you specify whether you are creating a document line
for quantity, amount, or outside processing. You simply choose the line
type when you create your document line. You enter the item, item
description, quantity, unit of measure, and unit price for quantity based
document lines. For amount based document lines, you enter only the
category, item description, and the amount (in the Quantity field). The
Unit Price defaults to 1 and you cannot change it.

Setting Up a Default Line Type

Since you typically use one line type more than the others, Purchasing
lets you define a system default line type in the Purchasing Options
window. All new purchasing document lines default to this line type.
You can override this value when you need to create document lines of
another type. You do not have to set up a system default if you use
many different line types. See: Defining Default Options: page 1 —45.

AutoCreating Purchase Orders

You can use the AutoCreate Documents window to convert approved
requisition lines for items and services into purchase orders and
releases. You can gather requisition lines for the same line type and
place them onto a single purchase order. You can also place
requisitions for different line types onto the same purchase order.
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Purchasing combines requisition lines for the same item, line type, unit
of measure, and item revision onto a single purchase order line. See:
Autocreate Documents Overview: page 6 — 2

Enhanced Document Printing

Purchasing prints your document lines according to their line types.
For quantity based line types, Purchasing prints the quantity, unit price
and total amount for purchase orders and RFQs. Purchasing prints
only the amount for amount based document lines.

Enhanced Reporting

The line type feature includes enhanced reporting to differentiate
between quantity and amount based orders. Purchasing prints the line
type so you can easily determine whether the information is quantity or
amount based. For amount based orders, Purchasing prints only the
total amount of the order.

Purchasing Services Step by Step

1-82

Creating Requisitions for Services

Purchasing lets you create requisition lines for services and other
amount based orders. When you choose an amount based line type,
Purchasing automatically sets the unit price to 1 for your line and
enters the default unit of measure for the line type. You cannot change
the unit price or unit of measure for amount-based requisition lines.
You enter the amount of the service in the Quantity field. Your total
line amount is the same as the value displayed in the quantity field.
You can use the quantity field in your distributions to allocate the order
amount to multiple accounting flexfields.

Creating Purchase Orders for Services

You can use AutoCreate Purchase Orders to create purchase order lines
and releases from approved requisitions. You can gather all requisition
lines for services and review these lines before placing specific ones on
purchase orders. You can also split a requisition line for a service into
several requisition lines for goods and services. Purchasing creates a
purchase order for all of the requisition lines you choose.

You can also enter purchase orders for services manually by entering a
service line type, the amount (Quantity) of the service, the category,
and the item description. Purchasing automatically enters the unit
price and unit of measure.
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Sourcing Services

When you request a quotation from a supplier for a particular service,
you can provide a complete description of the service you are
requesting. You must choose a quotation type of Catalog if you want to
use it for sourcing.

If you provide a requested service amount on your RFQ, Purchasing
prints ”Amount Requested:” followed by the total amount you entered.
For example, you request quotations for the installation of a local area
network and you know that you would like to pay $10000. You simply
create an amount-based RFQ line and one shipment for this line.
Purchasing automatically sets the unit price to 1 and fills in your unit of
measure. On the RFQ shipment, you enter the amount, 10000, in the
quantity field. Purchasing automatically sets the shipment break price
and unit of measure.

When you choose sourcing information for amount-based requisition
and purchase order lines, Purchasing copies the total amount from
your chosen quotation shipment into the Quantity field of your
purchasing document. Since you are creating an amount-based line
and the unit price is set to 1, the Quantity field displays the total
amount for the line.

Receiving Services

You receive services the same way you receive goods. When you
receive a service, your quantity fields reflect the amounts of your order.
Simply specify the amount you receive, correct, or return in the
Quantity fields. Purchasing displays your line type so you can
determine whether you are receiving by amount or quantity. You must
receive services and other amount-based purchases in the unit of
measure specified on the purchase order.

Matching Service Purchase Orders

When matching Payables invoices to service purchase order or receipt
lines, you enter the amount invoiced in the Quantity field. Payables
defaults the unit price to 1 when matching to service purchase orders
or receipts. You should not change the unit price. Payables warns you
if the unit price is not 1 for service orders.
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Defining Line Types

Use the Line Types window to define and update line types.

When you enter a line on a purchasing document and choose a line
type, Purchasing automatically displays the default information that
you define here for the line type.

Line types let you distinguish between quantity and amount based line
items. You use quantity based line items when you know the quantity
and price of the line you are ordering. For example, you might buy a
dozen pens for $10. You use amount based line items when you are
ordering a service. For example, you might order $5,000 of consulting
services over the next year.

When you are entering amount based document lines in purchasing
windows such as the Purchase Orders window, Purchasing skips the
Item and Revision fields, and sets the price to 1. You simply provide
the total amount of 5,000 as the quantity. Then, when you record your
receipts, you can enter the amount you have received as a quantity. For
example, if you have incurred $300 of a $500 charge, you record a
quantity of 300.

You can create line types to reflect different characteristics for the items
you purchase. For example, you may want to define one line type for
items you order by quantity and unit price, another line type for
services you order by hour, and yet another that indicates an outside
processing operation used in Oracle Work In Process (WIP). You can
create purchasing document lines and specify whether they are for
goods, services, outside processing, or any other line type you define.

Outside processing line types are necessary when you are using WIP
and want to enter purchasing documents for outside processing
operations in WIP. When you choose an outside processing line type
on a purchasing document line, you can enter only outside processing
items and the destination type can be only Shop Floor.

Purchasing automatically provides you with a line type of Goods that is
quantity based. If Work in Process is installed, Purchasing also
provides you with an Outside Processing line type. You can set up
your purchasing options to copy a default line type for lines you add to
every requisition, purchase order, RFQ, or quotation document. You
can override the default line type for each document line you create.

If you use Multilingual Support (MLS), translations can be entered for
the line types from within each of your installed languages. To enter the
translations for the line types, select Translations from the View menu.
For more information, see the Oracle Applications User’s Guide.
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Prerequisites

a

a

Define categories. See: Defining Categories, Oracle Inventory User’s
Guide.

Define units of measure. See: Defining Units of Measure, Oracle
Inventory User’s Guide.

p Todefine line types:

1.

Navigate to the Line Types window from the menu.

Default

Category

[ ]

[

[

[ |

[ ]

(X

[

L

2.
3.

Enter the Name and Description of the line type.

Enter the Value Basis for the line type. You cannot update this field
after you save your work.

Amount: Receive items by amount. You cannot change the unit of
measure and unit price on purchasing document lines.

Quantity: Receive items by quantity. Outside Processing line types
must have this value basis.

Enter the default purchasing Category for items with this line type.
You can override this purchasing category on purchasing document
lines.
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See Also

9.

Select Receipt Required if you want this as the default on your
purchasing document shipments with this line type. You can
overrule the default when you enter the shipment.

Enter the default Unit of measure for items with this line type. You
must enter a default unit when you use the Amount value basis for
your line type. You can override this unit of measure on your
purchasing document lines only when you use non-Outside
Processing line types with Quantity value basis.

If you use the Amount value basis, you may want to choose your
functional currency as the unit of measure. For example, if your
functional currency is US dollars, you may want to define a unit of
measure USD that you can use for your line types with the Amount
value basis.

Enter the default Unit Price for items with this line type.
Purchasing automatically enters a unit price of 1 when you use the
Amount value basis and prevents you from updating this price
when you create your line type. You can override this unit price on
your purchasing document lines only when you use line types with
Quantity value basis.

Select Outside Processing to restrict this line type to purchasing
outside processing. Also, when you use an outside processing line
type on a purchasing document, your choices for the item are
limited to outside processing items. You can select this check box
only if the value basis is Quantity and if you are using Work in
Process.

Enter the Inactive Date on which the line type is no longer usable.

10. Save your work.

Purchasing Services: page 1 —79

Overview of Outside Processing, Oracle Work in Process User’s Guide
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Defining Document Types

Use the Document Types window to define access, security, and control
specifications for all Purchasing documents. You cannot enter new
document types; you can enter new document subtypes only for RFQs
and quotations.

If you use Multilingual Support (MLS), translations can be entered for
the document types from within each of your installed languages. To
enter the translations for the document types, select Translations from
the View menu. For more information, see the Oracle Applications User’s
Guide.

Prerequisites

O Before you use this window to set up your document types, you
should perform the following steps:

¢ If you want to be able to choose the document approval
hierarchy in this form, you must enable Use Approval
Hierarchies in the Financials Options window. See: Defining
Financials Options, Oracle Public Sector Payables User’s Guide.

e You must use the Position Hierarchy window to create and
update the position hierarchies, since Purchasing uses these
hierarchies as document approval routings. See: Representing
Jobs and Positions, Oracle Human Resource Management Systems
User’s Guide.

p To define document types:

1. Navigate to the Document Types window from the menu. The
Find Document Types window appears.

Select one of the following Document Types: Purchase Agreement,
Purchase Order, Quotation, Release, Request for Quotation, and
Requisition.
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FEZDocument Types (Vision Operations)

Document

Subtype Quotation C
| Purchase Order Standard Standard Purchase Ord

Attributes

FOwner Can Approve y Public

Ml Approver Can Modify Access Level (RO
Change Forward-To TGRS EGTG Direct

nge Forward-From Print

ange Approval Hierarchy lefs i i Materials

PO Approval

2. You can enter user—-defined Document Subtypes only for document
types Quotation and Request for Quotation. You can delete
Quotation and Request for Quotation document types you have
created, but only if no actual document exists for the type.
Purchasing provides the following document subtypes:

Purchase Agreement — Blanket and Contract (For more information
on these document types, see: Purchase Order Types: page 4 - 4.)

Purchase Order — Planned and Standard (For more information on
these document types, see: Purchase Order Types: page 4 — 4.)

Quotation — Bid, Catalog, and Standard (For more information on
these document types, see: Types of Quotations and RFQs: page
5-6.)

Release — Blanket and Scheduled (For more information on these
document types, see: Purchase Order Types: page 4 —4.)
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Request for Quotation — Bid, Catalog, and Standard (For more
information on these document types, see: Types of Quotations and
RFQs: page 5-6.)

Requisition — Internal and Purchase (For more information on these
document types, see: Requisition Types: page 3 - 6.)

Enter your Document Name for the document. The description
must be unique for the given document type. The name that you
enter here appears as a list of values choice in the Type field in the
appropriate document entry window. For example, the Name Bid
Quotation appears, along with the Quotation Class Bid, as a list of
values choice in the Quotation Type field in the Quotations
window.

The Quotation Class is applicable only for document types
Quotation and Request for Quotation. Choose one of the following
options:

Bid — The quotation or RFQ is for a specific fixed quantity, location,
and date.

Catalog — The quotation or RFQ includes price breaks at different
quantity levels.

For more information about Bid and Catalog, see: Types of
Quotations and RFQs: page 5 — 6. (Although there are three types
of quotations—Bid, Standard, and Catalog—there are only two
quotation classes—Bid and Catalog. Standard belongs to the Catalog
class.)

Check Owner Can Approve to indicate that document preparers
can approve their own documents. This field is not applicable
when the Document Type is Quotation or RFQ.

Attention: If you are using budgetary control and enable this
option, you should also enable the Reserve at Requisition
Completion option in the Financials Options window. Likewise, if
you disable this option, you should also disable the Reserve at
Requisition Completion option.

Check Approver Can Modify to indicate that document approvers
can modify documents. This field is not applicable when the
Document Type is Quotation or RFQ.

Check Can Change Forward-To to indicate that users can change
the person the document is forwarded to. This field is not
applicable when the Document Type is Quotation or RFQ.

For more information on how this and the next two fields affect
your approval routing, see: Approval Routing: page 2 —13.
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10.

11.

12.

13.

Check Can Change Forward-From to indicate that users can
change the name of the document creator. This field is applicable
only when the Document Type is Requisition.

Check Can Change Approval Hierarchy to indicate that approvers
can change the approval hierarchy in the Approve Documents
window. This field is not applicable when the Document Type is
Quotation or RFQ.

Check Disable to disable a document type. This field is applicable
only for user—defined quotations and RFQs.

For user—defined quotations and RFQs, Purchasing displays as a
default the Security Level of the Standard Quotation or RFQ, and
you cannot enter the field. Otherwise, choose one of the following
options:

Hierarchy — Only the document owner and users above the owner
in the defined purchasing security hierarchy may access these
documents.

Private — Only the document owner may access these documents.
Public — Any user may access these documents.

Purchasing — Only the document owner and users listed as buyers
in the Define Buyers window may access these documents.

For an overview of Security Level and Access Level, see: Document
Security and Access: page 2 - 10.

For user—defined quotations and RFQs, the Access Level is that of
the Standard Quotation or Standard RFQ, and you cannot enter the
field. Otherwise, choose one of the following Access Level options:

Full — Users can view, modify, cancel, and final close documents.
Modify — Users can only view and modify documents.
View Only — Users can only view documents.

The Forward Method field is not applicable when the Document
Type is Quotation or RFQ. The following options apply regardless
of whether you are using position hierarchies or the
employee/supervisor relationship to determine your approval
paths. Choose one of the following options:

Direct — The default approver is the first person in the preparer’s
approval path that has sufficient approval authority.

Hierarchy — The default approver is the next person in the
preparer’s approval path regardless of authority. (Each person in
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14.

15.

the approval path must take approval action until the person with
sufficient approval authority is reached.)

The Archive When field is applicable only when the Document
Type is Purchase Agreement, Purchase Order, or Release. Choose
one of the following options:

Approve — The document is archived upon approval. This option is
the default. The Change Order workflow begins only if this option
is chosen. See: Workflow Processes for Approving Change Orders:
page C — 168..

Print — The document is archived upon printing.

The Default Hierarchy field is not applicable when the Document
Type is Quotation or RFQ. Otherwise, when Use Approval
Hierarchies is enabled in the Financial Options window, you can
enter a position hierarchy from the Position Hierarchy window.
This hierarchy then becomes the default in the Approve Documents
window.

To associate certain workflows with specific document types:

In Purchasing, all approvals are handled in the background by Oracle
Workflow technology. The default approval workflow processes in
Purchasing use the approval controls and hierarchies you define
according to the setup steps in Setting Up Document Approval and
Security: page 2 — 2. If you created a workflow process of your own
and wanted to associate it with a specific document type, you would
choose that workflow process here.

1.

Select the Approval Workflow you want to use for this particular
document type, or use the default that is already provided.

The PO Approval workflow is used for approving purchase orders.
The PO Requisition Approval workflow is used for approving
requisitions. If you’ve created a workflow of your own, you can
select that for this document. See: Approval Workflows: page
C-111.

Select the Workflow Startup Process you want to use for this
particular document type, or use the default that is already
provided.

Usually the Workflow Startup Process is the highest-level process
in a workflow. The default startup process for the PO Approval
workflow is the PO Approval Top Process. The default startup
process for the PO Requisition Approval workflow is the Main
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Requisition Approval Process. If you’ve created a startup process
of your own, you can select that for this document.

3. For requisitions only, select the Autocreate Workflow you want to
use for automatically creating purchase orders or releases from
approved requisition lines, or use the default that is provided.

The default workflow that comes with Purchasing is the PO Create
Documents workflow. If you’ve created a workflow of your own,
you can select that for this document. See: Workflow for Creating
Purchase Orders or Releases: page C — 204.

4. For requisitions only, select the Autocreate Workflow Startup
Process you want to use, or use the default that is already
provided.

The highest-level process for the PO Create Documents workflow
is the Overall Document Creation / Launch Approval Process. If
you’ve created a startup process of your own, you can select that
for this document.

Defining Financials Options, Oracle Public Sector Payables User’s Guide

Representing Jobs and Positions, Oracle Human Resource Management
Systems User’s Guide

The online help for the Enter Person window

Budgetary Control and Online Funds Checking, Oracle Public Sector
General Ledger User’s Guide

Submitting a Document for Approval: page 2 — 35
Entering Requisition Headers: page 3 - 57
Entering Purchase Order Headers: page 4 -39
Entering RFQ Headers: page 5 —57

Entering Quotation Headers: page 5 — 74
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Controlling Purchasing Periods

Use the Control Purchasing Periods window to control the purchasing
periods defined in the Accounting Calendar window. You use
purchasing periods to create journal entries in your general ledger
system. Purchasing lets you create journal entries only for transactions
you enter in an open purchasing period. You create general ledger
journal entries when encumbering requisitions, purchase orders or
accruing receipts.

If you use encumbrance or budgetary control, Purchasing verifies that
the GL Dates you provide on purchase order distributions and
requisition distributions are within an open purchasing period. See:
Budgetary Control and Online Funds Checking, Oracle Public Sector
General Ledger User’s Guide.

Prerequisites

U Before using this window you should define your purchasing
periods in the Accounting Calendar window. See: Defining
Calendars, Oracle Public Sector General Ledger User’s Guide.

p To control purchasing periods:

1. Navigate to the Control Purchasing Periods window from the
menu.

Purchasing displays the Period Status, Period Number, Fiscal Year,
Period Name, Begin Date, and End Date for each existing period.
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pen =1 2002 Jan{2 01:JAN/2002 31/JAN2002

Open 12 2001 Dec01 01/DEC/2001 31/DEC/2001

Open 11 2001 Hov01 01/HOV/20M1 30/HOV/2001

Open 10 2001 Oct1 01/0CT/2001 31/0CT/2001

Open 9 2001 SepM 01/SEP/2001 30/SEP/2001

Open 8 2001 Aug01 01/AUG/2001 31/AUG/2001

Open i 2001 Jul01 01:JUL/2001 31:JUL/2001

Open 6 2001 Jun01 01/ JUN/2001 30/JUN/2001

Open H] 2001 May-01 01/MAY2001 31/MAY2001

Open 4 2001 Aprd1 01/APRA2001 30/APR2001
In the Period Status field, you have the following options:
Closed — Use this option to close this purchasing period. When you
close a purchasing period, Purchasing does not allow further
accruals during this period. Purchasing reverses the status of
accrued purchase order lines so that you can accrue them in the
next period if you want.
Future — Use this option if you want to open this purchase period in
the future. This option is available only when the current status is
Never Opened.
Never Opened — Purchasing displays this default status if you have
not opened this period in the past.
Open — Use this option to open this purchasing period.
Permanently Closed — Use this option if you do not want to open this
period in the future. This option is irreversible.

See Also

Defining Purchasing Options:; page 1 —45

Controlling the Status of AP Accounting Periods, Oracle Public Sector

Payables User’s Guide
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Choosing Workflow Options

Purchasing provides default functionality in its Workflow—-automated
processes. This default functionality is described in the sections below.
If you do not want this default functionality, you can change it in the
Oracle Workflow Builder.

Before you can use or modify any of the workflows in Purchasing, you
need to set up Oracle Workflow if you haven’t done so already. See:
Setting Up Oracle Workflow, Oracle Workflow Guide.

Although Workflow is installed with Purchasing automatically, you
need to complete additional setup steps described in the Oracle
Workflow Guide, if you did not already do this as part of your
installation or upgrade. Additionally install the Workflow Builder only
if you want to modify the default workflows that Purchasing provides
or if you just want to see and understand the workflow processes as
they are graphically displayed in the Builder.

Choosing Document Creation Options

Prerequisite

1 Before you can use or modify any of the workflows in Purchasing,
you need to set up Oracle Workflow if you haven’t done so already.
See: Setting Up Oracle Workflow, Oracle Workflow Guide.

Purchasing integrates with Oracle Workflow technology to create
standard purchase orders or blanket releases automatically from
approved requisition lines. The workflow for creating purchasing
documents automatically is called PO Create Documents. PO Create
Documents includes three attributes, the values of which you can
change in the Oracle Workflow Builder:

¢ Is Automatic Creation Allowed? — The default value of this
attribute is set to ’Y,” meaning that automatic document creation
is allowed for approved requisition lines. You can prevent
automatic document creation by setting the default value of this
attribute in the Workflow Builder to N’ for No.

¢ Should Workflow Create the Release? — The default value of this
attribute is set to 'Y,” meaning that the workflow tries to create
the release; if it cannot, or if the value of this attribute is set to
"N’ for No, then the workflow will not create the release; you
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See Also

must use the AutoCreate Documents window to create the
release.

¢ |s Automatic Approval Allowed? — The default value of this
attribute is set to "N’ for No, meaning that documents are not
automatically approved after they are created. If you setitto’Y’
for Yes, then the PO Approval workflow is launched to route the
documents for approval.

For each of these attributes you can change their values to 'Y’ for Yes or
N’ for No. You make these changes in the Oracle Workflow Builder.

To modify automatic document creation defaults:

1. Start the Workflow Builder and open the PO Create Documents
workflow.

See: Opening and Saving Item Types, Oracle Workflow Guide.
2. Expand the Attributes branch.

3. Select any of the three item attributes described above and, in the
attributes’ Properties windows, change the Default Value to suit
your public sector needs.

See the Oracle Workflow Guide.

Workflow for Creating Purchase Orders and Releases: page C — 204

Choosing a Process Mode for Automatic Document Creation

The item attribute Send PO Autocreation to Background is used by the
Main Requisition Approval Process in the PO Requisition Approval
workflow. Send PO Autocreation to Background determines whether
the approval workflow should launch automatic document creation in
Background mode. By default, this item attribute is set to Y for Yes. But
you can change it to N for No if you’d rather process automatic
document creation in Online mode.

Background and online modes affect your system performance in
different ways. For more information on what Background and Online
mean, see PO: Workflow Processing Mode in the section Profile Options
in Purchasing: page 1 —103.
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Note: The profile option PO: Workflow Processing Mode sets the
processing mode for the entire approval workflow in
Purchasing, whereas the item attribute Send PO Autocreation
to Background enables you to change the processing mode
specifically for automatic document creation after requisition
approval, regardless of how the profile option PO: Workflow
Processing Mode is set.

p If you want to keep the default mode of Background:

®m  Use the Submit Requests window in the System Administrator
responsibility to start the Workflow Background Process, which
must be running for Background mode.

Attention: Since the item attribute Send PO Autocreation to

IS5 Background contains a default value of Y—which means
automatic document creation occurs in Background mode—you
must start the Workflow Background Process if you are going
to keep the default.

You can submit the process for all workflows or just for a particular
workflow, in this case the PO Requisition Approval workflow. See:
To Schedule Background Engines, Oracle Workflow Guide.

p If you want to change the default mode to Online:

1. Start the Oracle Workflow Builder and open the PO Requisition
Approval workflow.

See: Opening and Saving Item Types, Oracle Workflow Guide.

2. Select the item attribute Send PO Autocreation to Background and
open its Properties window.

3. Change its Default value from Y to N.

Automatic document creation, when launched from the requisition
approval workflow process, will now perform in Online mode.

Deciding If You Want to Use the Timeout Feature

Prerequisite

1 Before you can use or modify any of the workflows in Purchasing,
you need to set up Oracle Workflow if you haven’t done so already.
See: Setting Up Oracle Workflow, Oracle Workflow Guide.
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The Timeout feature in the approval workflow enables you to specify a
period of time after which, if no response has yet come from an
approver, a reminder is sent. You can send up to two reminders to an
approver using the Timeout feature. You can also specify that after a
certain period of time, the document is forwarded automatically to the
next approver in the hierarchy. You can optionally set up this feature
through the Oracle Workflow Builder.

If you don’t set up the Timeout feature, the approval workflow will not
time out; it will simply wait to receive a response from each approver.

» Tosetup approval reminders using the Timeout feature:

1. Start the Workflow Builder and open the PO Approval workflow
for purchase orders or the PO Requisition Approval workflow for
requisitions.

See: Opening and Saving Item Types, Oracle Workflow Guide.

2. Open any of the following activities’ Properties windows and enter
a Timeout period (for instructions, see the Oracle Workflow Guide):

¢ To enable the Timeout feature in the PO Approval workflow,
modify the following activities in the Notify Approver
subprocess by entering a Timeout period in their Properties
windows: Approve PO Notification, PO Approval Reminder 1,
and PO Approval Reminder 2.

e To enable the Timeout feature in the PO Requisition Approval
workflow, modify the following activities in the Notify Approver
subprocess by entering a Timeout period in their Properties
windows: Approve Requisition Notification, Requisition
Approval Reminderl, and Requisition Approval Reminder2.

For example, you enter the following Timeout days in all three
purchase order approval notifications as follows:

e Approve PO Notification — 3 days
e PO Approval Reminder 1 -2 days
e PO Approval Reminder 2 — 1 day

In this example, the first notification, Approve PO Notification,
times out after 3 days if the approver does not take an action on the
notification, and PO Approval Reminder 1 sends the reminder
notification. PO Approval Reminder 1 times out after 2 days, and
PO Approval Reminder 2 times out after 1 day. Then the workflow
looks for the next approver.

3. Save your changes.
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The Workflow Background Process must be running for the
Timeout feature to take effect.

See: Using the Workflow Background Engine: page 1 - 100.

Modifying Change Order Workflow Options

Prerequisite

U Before you can use or modify any of the workflows in Purchasing,
you need to set up Oracle Workflow if you haven’t done so already.
See: Setting Up Oracle Workflow, Oracle Workflow Guide.

Purchasing integrates with Oracle Workflow technology to let you
define what changes to purchase orders or releases—for example, to
amounts, suppliers, or dates—require full reapproval. All of the
workflow processes and functions relating to change orders can be
found within the PO Approval workflow. The change order workflow
process uses the same reapproval rules already defined in Purchasing
to determine whether a document, depending on its document type,
requires reapproval. If you want to change the reapproval rules that
the change order workflow uses, you can change those reapproval rules
that determine what percentage change to a unit price, quantity, or
document total requires reapproval. You can optionally change these
rules by modifying their attributes in the Oracle Workflow Builder. See
the section Customizing the Change Order Workflow in: Workflow
Processes for Approving Change Orders: page C — 168.

The change order workflow requires that Archive on Approve be
chosen in the Document Types window. The Archive on Approve
option copies the purchase order information into the archive tables in
Purchasing every time you approve or reapprove a purchase order.
The change order workflow needs to use this archive information to
compare a document before and after you make a change.

Starting the ”Send Notifications for Purchasing Documents” Process

The workflow process, Send Notifications for Purchasing Documents,
looks for documents that are incomplete, rejected, or in need of
reapproval and sends notifications to the appropriate people of the
document’s status. For these notifications to be sent, you need to start
the concurrent program process Send Notifications for Purchasing
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Documents if you haven’t done so already as part of your standard
setup. See: Send Notifications for Purchasing Documents: page
9 - 155.

Using the Workflow Background Engine

Prerequisite

L Before you can use or modify any of the workflows in Purchasing,
you need to set up Oracle Workflow if you haven’t done so already.
See: Setting Up Oracle Workflow, Oracle Workflow Guide.

The Workflow Background Engine must be running if you are using the
following options:

e The Background mode for Purchasing approvals. By default the
profile option PO: Workflow Processing Mode is set to
Background. You must start the Workflow Background Engine in
order for the Background mode to work. See: Profile Options in
Purchasing: page 1 - 103.

e The Timeout feature in any workflow. The Timeout feature
sends reminder notifications.

e The Background mode for the item attribute Send PO
Autocreation to Background in the PO Requisition Approval
workflow. See: Choosing a Process Mode for Automatic
Document Creation: page 1 — 96.

e The Confirm Receipts Workflow Select Orders process. Thisisa
process you submit through the Submit Request window. If you
submit it, the Workflow Background Engine must also be
running. See: Confirm Receipts Workflow Select Orders Process:
page 9 -28.

If you are using the Workflow Background Engine for the Timeout
feature, it is reasonable to schedule the process to run once or twice a
day. If you are using it for Background mode, you should schedule it to
run much more frequently; a workflow activity that is set to Background
mode doesn’t begin until the Workflow Background Engine picks it up
for processing.

If you want to use the Workflow Background Engine for both
requisitions and purchase orders, you need to submit it twice, once for
PO Approval and once for PO Requisition Approval. Or, by not
specifying an item type, you can submit it for all item types.
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Report Submission

In the Submit Requests window, in the System Administrator
responsibility, select Workflow Background Process in the Name field.

See: To Schedule Background Engines, Oracle Workflow Guide.
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Self-Service Purchasing Setup Windows

The following windows are part of the Self-Service Purchasing setup.
Located in the Setup menu in Purchasing, they are used only by
Self-Service Purchasing. Self-Service Purchasing is used to create
requisitions on the Web. These requisitions are turned into purchase
orders in Purchasing. Use these windows only if you are setting up
Self-Service Purchasing:

Define Information Template — enables you to create
additional-information templates.

Note: Information templates are not the same as requisition
templates in Purchasing. Requisition templates in Purchasing
are a pre—filled listing of frequently ordered items. Information
templates are additional information templates that a requester
in Self-Service Purchasing completes for certain items.

Item Source — used to define internal or external catalog sources
for items.

Define Catalog Server Loader Values — enables you to define which
catalog data to load into the system.

Define Catalog Server for External Suppliers — enables
communication with external suppliers outside the firewall.

Realms — used to create user access privileges to internal or
external catalogs.

For instructions on these windows, see the Oracle Self-Service
Purchasing Implementation Manual.
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Profile Options and Security Functions

Profile Options

Profile Option Settings

During implementation, the system administrator sets up profile
options and security functions.

During implementation, you set a value for each user profile option to
specify how Purchasing controls access to and processes data.

Generally, the system administrator sets and updates profile values.
See: Setting User Profile Options, Oracle Applications System
Administrator’s Guide.

The table below indicates whether you (the ”User”) can view or update
the profile option and at which System Administrator levels the profile
options can be updated: at the user, responsibility, application, or site
levels.

A ”Required” profile option requires you to provide a value. An
”Optional” profile option already provides a default value, so you only
need to change it if you don’t want to accept the default.

User System Administrator Requirements
Profile Option Default
i ired?
User | User Resp App Site | Required? value
MRP: Default Sourcing I - - - » | Required if | No Default
Assignment Set using
sourcing
rules
MRP: Sourcing Rule I - - - I Required if | No Default
Category Set using
sourcing
rules
PO: Allow Buyer Override I I I I I Optional Yes
in AutoCreate Find

Key

V- You can update the profile option.
- You can view the profile option value but you cannot change it.

0 You cannot view or change the profile option value.

Table1-1 (Page 1 of3)
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User System Administrator Requirements
Profile Option Default
i ired?
User | User Resp App Site | Required? value
PO: Allow Category v v I I »~ | Optional Yes
Override in AutoCreate
Find
PO: Allow Rate Override - I I I I Optional No
for User Rate Type
PO: Archive Catalog on - - I I » | Optional No
Approval
PO: AutoCreate GL Date I I I I = | Optional AutoCreate
Option Date
PO: Automatic Document - 0 0 I I Optional No
Sourcing
PO: Change Supplier Site - 0 I V- I Optional No Default
PO: Default Supplier Item V- - I I » | Optional Negotiated
Catalog Option Sources
PO: Display AutoCreated I I I I y»~ | Optional Yes
Quotation
PO: Display the v v I I y~ | Optional Yes
Autocreated Document
PO: Enable Sql Trace for v v v v v Optional No
Receiving Processor
PO: ERS Aging Period - 0 I I = | Optional 0
PO: ERS Invoice Number — 0 I I »~ | Optional ERS-
Prefix
PO: Item Cross Reference - 0 I I I Optional Disposition
Warning
PO: Legal Requisition Type - 0 V- v V- Optional Both
PO: Override Approved No longer used
Supplier List Status
PO: Price Tolerance (%) for I I I I = | Optional No Default
Catalog Updates
PO: Release During V- V- I I »~ | Optional No
Reglmport
PO: Set Debug Concurrent See description below No
ON
PO: Set Debug Workflow See description below No
ON
» | You can update the profile option.
Key - You can view the profile option value but you cannot change it.
0 You cannot view or change the profile option value.

Table1-1 (Page 2 of 3)
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User System Administrator Requirements
Profile Option Default
i ired?
User | User Resp App Site | Required? value
PO: Supplier Pricing No longer used
Method
PO: Use P-Cards in - v I V- I Optional No
Purchasing
PO: Warn if RFQ Required I I I I »~ | Optional No
before AutoCreate
PO: Workflow Processing I I I I I Optional Background
Mode
PO: Write Server Output to I I I I I Optional No Default
File
RCV: Allow routing V- V- - - - Optional No
override
RCV: Fail All ASN Lines if — 0 I I I Optional No
One Line Fails
RCV: Print Receipt Traveler I I I I » | Optional No
RCV: Processing Mode I I I I I Optional Online
v You can update the profile option.
Key - You can view the profile option value but you cannot change it.
0 You cannot view or change the profile option value.

Table1-1 (Page 3 of 3)

Profile Options Descriptions

MRP: Default Sourcing Assignment Set

This profile option indicates which sourcing rules assignment set will be
used in Purchasing and Supplier Scheduling. Planning allows you to
use multiple Assignment Sets, but Purchasing looks at only a single
Assignment Set—the one that is specified in this profile option.
Therefore, the Assignment Set name you choose for this profile option is
the Assignment Set name you should specify when you assign sourcing
rules in the Sourcing Rule/Bill of Distribution Assignments window.
This profile option must be set if you are using sourcing rules in
Purchasing.

MRP: Sourcing Rule Category Set

If you are using sourcing rules in Purchasing, this profile needs to be set
to the name of the default category set used by Purchasing as indicated
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in the Default Category Sets window. Otherwise, you will not be able to
display Category and Category-Organization assignments in the
Sourcing Rule / Bill of Distribution Assignments window.

PO: Allow Buyer Override in AutoCreate Find

Yes or No indicates whether the suggested buyer (from the Enter Person
window) defaulted into the Find Requisition Lines window can be
cleared or overridden. The default is Yes.

PO: Allow Category Override in AutoCreate Find

Yes or No indicates whether the category (from the Buyers window)
defaulted into the Find Requisition Lines window can be cleared or
overridden.

PO: Allow Rate Override for User Rate Type

Yes or No indicates whether the Rate in the Currency tabbed region of
the Receipts window can be changed. Even if the Rate Type is User, you
cannot change the Rate if this profile option is set to No. This profile
option affects the Rate on the receipt only, not in the Currency window
of a purchase order, RFQ, or quotation. (In the Currency window, you
can modify the Rate if the Rate Type is User.)

PO: Archive Catalog on Approval

Yes or No indicates whether Purchasing archives blanket purchase
agreements in a price/sales catalog submission upon approval. You
need to consider this profile option only if you receive price/sales
catalog submissions from your suppliers through the Purchasing
Documents Open Interface. This profile option comes into effect only if
Archive on Approval is chosen in the Document Types window in
Purchasing and you import the documents with a status of Approved,; if
you then choose No for this profile option, Purchasing does not archive
the price/sales catalog agreements.

Note: If a document update is pending review in the Exceeded
Price Tolerances window, the revision of that document is not
updated until you accept all line updates.

For more information, see the Oracle Manufacturing, Distribution, Sales
and Service Open Interfaces Manual.

PO: AutoCreate GL Date Option

Indicates the date used on purchase orders generated by AutoCreate:
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AutoCreate Date The autocreate date is used as the purchase order

date.
Requisition GL The GL date on the requisition distribution is used
Date as the purchase order date.

PO: Automatic Document Sourcing

Yes means that Purchasing automatically defaults source document and
pricing information for an item from the most recently created blanket
purchase agreement or quotation. No means that this source document
information comes from the Approved Supplier List window, where
you must specify which source documents to use. Note that if an item
on a requisition is associated with both a blanket purchase agreement
and a quotation, Purchasing uses the blanket purchase agreement even
if the quotation was created more recently. See: Setting Up Automatic
Sourcing: page 5 - 32.

PO: Change Supplier Site

Yes or No indicates whether users can change the supplier site on
approved purchase orders.

PO: Default Supplier Item Catalog Option

Indicates the default source tabbed region in the supplier item catalog:
Negotiated Sources, Prior Purchases, Sourcing Rules, or Requisition
Templates.

PO: Display AutoCreated Quotation

Controls the viewing of an autocreated quotation.

PO: Display the Autocreated Document

Yes or No indicates whether Purchasing opens the appropriate
transaction window (Purchase Orders window or RFQs window) and
displays the created line(s) when you autocreate a document.

PO: Enable Sql Trace for Receiving Processor

Yes means that when you run the Receiving Transaction Processor, the
View Log screen displays the receiving transaction pre—processor’s
actions, including errors, as it processed the receipt data from start to
finish. Yes also generates a trace file in the database; if you need help
with an error that occurs while the Receiving Transaction Processor
runs, Oracle Support Services may ask you for this trace file. This profile
option should be set to Yes only while debugging the Receiving Open
Interface. The Receiving Open Interface validates receipt transactions
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from other systems and uses the Receiving Transaction Processor to
import the validated data into Purchasing. See the Oracle Manufacturing,
Distribution, Sales and Service Open Interfaces Manual, Release 11i.

PO: ERS Aging Period

The value in this profile option indicates the number of days between
the receipt date and the Payment on Receipt automatic invoice creation
date. For example, a value of 2 means that Payment on Receipt creates
invoices only for receipts that are 2 or more days old. Any corrections or
returns you make against a receipt during that 2-day period are
included on the Payment on Receipt invoice.

PO: ERS Invoice Number Prefix

'ERS-" is the prefix that appears before all invoices that you create
automatically using Payment on Receipt. This profile option allows you
to change this prefix. For example, shortening this prefix allows extra
spaces for longer packing slip or receipt numbers.

PO: Item Cross Reference Warning

Indicates the Item Cross Reference Type that you want to use as a
disposition warning message for requisitions.

PO: Legal Requisition Type

Indicates whether users can enter internal requisitions sourced from
stock by means of an internal sales order, purchase requisitions sourced
from a purchase order, or both types. Available values are Both,
Internal, and Purchase.

PO: Override Approved Supplier List Status

If you have upgraded from a previous release, you will see this profile
option in the application, but the profile option is ho longer used.

PO: Price Tolerance (%) for Catalog Updates

A value in this profile option specifies the maximum percentage increase
allowed to an item’s price when your supplier sends updated
price/sales catalog information through the Purchasing Documents
Open Interface. This profile option affects only those documents
imported through the Purchasing Documents Open Interface. If the
tolerance is exceeded, the buyer receives a notification and can accept or
reject the price increase in the Exceeded Price Tolerances window.

1 -108 Oracle Public Sector Purchasing User’s Guide



This profile option is used only if price tolerances are not already
defined at lower levels, in the purchase agreement Terms and
Conditions window or the Supplier-Item Attributes window.

See: Receiving Price/Sales Catalog Information Electronically: page
5-22.

PO: Release During Reqlmport

Yes or No indicates whether Purchasing can automatically create
releases during the Requisition Import process.

PO: Set Debug Concurrent ON

This profile option is used, usually by technical support staff only, for
finding problems with Requisition Import. The default value is No. The
user can view and update this profile option. It can also be updated at
the user, responsibility, application, and site levels.

Caution: For performance reasons, it is very important that
this profile option always be set to No, unless you are instructed
otherwise by Oracle Corporation for debugging purposes.

PO: Set Debug Workflow ON

This profile option is used, usually by technical support staff only, for
finding problems with Purchasing workflow processes. The default
value is No. The user can view and update this profile option. It can
also be updated at the user, responsibility, application, and site levels.

Caution: For performance reasons, it is very important that
this profile option always be set to No, unless you are instructed
otherwise by Oracle Corporation for debugging purposes.

PO: Supplier Pricing Method

If you have upgraded from a previous release, you will see this profile
option in the application, but the profile option is no longer used.

PO: Use P-Cards in Purchasing

Set this profile option to Yes if you use procurement card—also known
as P-Card or corporate credit card—numbers on requisitions in
Self-Service Purchasing. Set this profile option to Yes to display the
procurement card number in the Purchase Orders, Releases, and
Purchase Order Headers summary windows.

Set this profile option to No if you do not have Self-Service Purchasing
installed or do not want to display the procurement card field to buyers.
Purchasing windows can physically display the procurement card field
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even if Self-Service Purchasing is not installed and procurement cards
aren’t used. Therefore, set this profile option to No if you are not using
procurement cards.

PO: Warn if RFQ Required before AutoCreate

Yes or No indicates whether you are given a warning message and an
opportunity to cancel autocreate if one or more of the requisition lines
selected for inclusion requires an RFQ and has not been placed on an
RFQ.

If you use the PO Create Documents workflow to create purchase orders
automatically from approved requisition lines, note that setting this
profile option to Yes can affect the workflow. If itis set to Yes and the
requisition line is not on an RFQ (but RFQ Required is checked for the
requisition line), the workflow stops automatic document creation
because it is unable to issue the warning. (The requisition line will still
be available in the AutoCreate Documents window.) Even if an RFQ is
required for the requisition line, as long as this profile option is set to
No, the workflow will continue creating the document.

PO: Workflow Processing Mode

Affects the performance of the Purchasing approval workflow

processes:

Online Completes an entire approval workflow process
before letting you proceed to the next activity, but
provides you with an updated Status (for purchase
orders) as soon as it finishes.

Background Enables you to proceed to the next activity while

the approval process completes in the background.

Whichever option you choose, you can always view the current status of
a requisition or purchase order through the Requisitions Summary or
Purchase Orders Summary windows.

The default value is Background.

Note: When this profile option is set to Background, you must
start the Workflow Background Engine, which you access
through the System Administrator responsibility. It is
recommended that you set this process to run frequently, if you
are using it for Background mode approvals. See: To Schedule
Background Engines, Oracle Workflow Guide.
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PO: Write Server Output to File

Yes or No indicates whether log details are written to a flat file rather
than to the standard concurrent manager details log viewable through
the View Log button in the Submit Request window when running the
Purchasing Documents Open Interface program.

Yes means log details are written to a flat file. No means log details are
written to the concurrent manager log screen, which can cause overflow
problems for large catalogs. Leaving this profile option blank means log
details are not written at all, which improves performance.

You need to consider a value for this profile option only when
debugging a price/sales catalog submission from your supplier through
the Purchasing Documents Open Interface.

See the Oracle Manufacturing, Distribution, Sales and Service Open
Interfaces Manual, Release 11i.

RCV: Allow routing override

Yes or No indicates whether the destination type assigned during
requisition or purchase order entry can be overridden at receipt time.

RCV: Fail All ASN Lines if One Line Fails

If you choose Yes, you can reject an entire Advance Shipment Notice
(ASN) if any ASN line fails validation or processing. If you choose No,
then you can accept an ASN if at least one ASN line is successful.

RCV: Print Receipt Traveler

Yes or No indicates whether Purchasing automatically prints the receipt
traveler when you perform a receipt or a receiving transaction, and
when you match unordered receipts. You can always print receipt
travelers from the Submit Requests window.

RCV: Processing Mode

Indicates the processing mode used after you save your work for
receiving transactions:

Batch The transaction goes to the interface table, where it
will be picked up the next time the Receiving
Transaction Processor runs.

Immediate The transaction goes to the interface table, and the
Receiving Transaction Processor is called for the
group of transactions that you entered since you
last saved your work.
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On-line The Receiving Transaction Processor is called
directly.

See Also

Overview of User Profiles, Oracle Applications User’s Guide

Setting User Profile Options, Oracle Applications System Administrator’s
Guide

Setting Your Personal User Profile, Oracle Applications User’s Guide
Common User Profile Options, Oracle Applications User’s Guide

Profile Options in Oracle Application Object Library, Oracle Applications
User’s Guide

Function Security for Purchasing

Function Security defines the specific access to individual forms and the
business functions of each form. A form can have several business
functions associated with it, however some forms and functions may not
be appropriate for each user. Purchasing provides the following basic
responsibilities: Requestor, Receiver, Buyer, and PO Superuser. You can
create new responsibilities or modify the existing ones. A responsibility
defines an application user’s current privileges while working with
Oracle Applications.

You can use Function Security to control access to forms (windows) and
functions within windows, thereby tailoring each responsibility to the
needs of an individual user. However, if you grant a user access to a
window, all the functions within that window are automatically
included in the user’s access. If you want the user to have access to the
window but not to all the window’s functions, you must exclude access
to each function individually.

For example, if you want a user to be able to view the Purchase Orders
Summary window but not have access to the functions associated with
the New Release, New PO, and Open buttons within that window, you
would grant access to the Purchase Orders Summary window but
disable access to the New Release, New PO, and Open functions.
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Window Function Requestor Receiver Buyer PO
Superuser
Requisition View X X X
Summary Tools Lines
Menu Distributions
Purchase Orders
Sales Orders
Action History
Preferences
Control
Requisition New X X X
Summary
window
Purchase Order New Release X X
Summary New PO
window Open
Buttons
Purchase Order View X X X X
Summary Tools Lines
Menu Shipments
Distributions
Action History
Invoices
Receipts
Acceptances X X
Control
Preferences
Supplier Open View Only X
Summary
window
New X
Exceeded Price Accept/Reject View Only | View Only View Only View Only
Tolerances
window

Table1-2 (Page1of1l)

See Also

Overview of Function Security, Oracle Applications System Administrator’s
Guide

Forms and Subfunctions, Oracle Applications System Administrator’s Guide
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Overview of Oracle Application Security, Oracle Applications System
Administrator’s Guide
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Approval, Security, and
Control

CHAPTER

T his chapter tells you what you need to know about Approval,
Security, and Control, including:

e Setting Up Document Approval and Security: page 2 — 2
e Position Hierarchies: page 2 - 8

e Document Security and Access: page 2 - 10

e Approval Routing: page 2 - 13

e Approval Authorization Control: page 2 - 16

e Assigning Employees: page 2 — 23

e The Document Approval Process: page 2 — 24

e Offline Approvers: page 2 — 40

e Document Control Overview: page 2 — 44

¢ MassCancel: page 2 - 60
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Setting Up Document Approval and Security

2-2

Human Resources with Purchasing

Human Resources and Purchasing share job and position information if
they are installed together. You should consider your requirements
from both perspectives before deciding on an approval/security
structure.

Human Resources uses jobs to classify categories of personnel in your
organization, and associates information like the exempt/non-exempt
code and EEO code with individual jobs. Examples of a typical job
include Vice President, Buyer, and Manager. Positions represent
specific functions within these job categories. Examples of typical
positions associated with the Vice President job include Vice President
of Manufacturing, Vice President of Engineering, and Vice President of
Sales.

Human Resources uses position hierarchies to define management line
reporting and control access to employee information.

Review your Personnel department’s system requirements before you
decide how you want to use positions, jobs, and position hierarchies in
Purchasing.

Using Approval Hierarchies

Approval hierarchies let you automatically route documents for
approval. There are two kinds of approval hierarchies: position
hierarchy and employee/supervisor relationships.

If you choose to use employee/supervisor relationships, you define
your approval routing structures as you enter employees using the
Enter Person window. In this case, Purchasing does not require that
you set up positions.

If you choose to use position hierarchies, you must set up both jobs and
positions. While positions and position hierarchies require more initial
effort to set up, they are easy to maintain and allow you to define
approval routing structures that remain stable regardless of how
frequently individual employees leave your organization or relocate
within it.

Using Security Hierarchies

Security hierarchies let you control who has access to certain
documents. For example, you can create a security hierarchy in which
only you and other buyers in that hierarchy can view each other’s
purchase orders.
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Security hierarchies are not an alternative to approval hierarchies, but
something different altogether. Changes you make to a security
hierarchy do not affect the approval hierarchy and vice versa.

If you want to specify a Security Level of Hierarchy for any of your
document types, you must first define all positions which should have
access to the documents you want to restrict in this manner. (Even if
you are using jobs to route documents for approval, you must define
positions before you can enable this Security Level). You then define a
security position hierarchy, and specify it in the Purchasing Options
window.

Approval Workflow

Purchasing uses Oracle Workflow technology to handle approvals.
Workflow works in the background, using the approval controls and
hierarchies you define in the setup steps below to route documents for
approval. Because Workflow handles your approval process in the
background, you can use Oracle Workflow Builder’s easy interface to
modify your approval process. See: Purchase Order Approval
Workflow: page C — 111. See: Requisition Approval Workflow: page
C-54.

Approval and Security Setup Steps

1. Use the Financials Options window to indicate whether you want
to route documents for approval using position hierarchies or
employee/supervisor relationships. This decision applies only to
the Business Group you choose for your Purchasing installation in
the Financials Options window. See: About Financials Options,
Oracle Public Sector Payables User’s Guide.

If you choose to use position hierarchies, you must define positions
in addition to jobs. You later build your hierarchies by referencing
these positions.

2. Use the Job window to create each of the job titles in your
organization (for example: Buyer, Supply Base Engineer). If you
are not using positions, you assigh one or more employees to each
job. If you are using positions, you assign one or more positions to
each job, and later assign one or more employees to each position.

= Attention: You assign authorization rules to jobs or positions

based on your decision in Step 1. It is important to ensure that
your job/position infrastructure supports the different approval
levels in your organization.

For example, if your purchasing staff includes a Junior Buyer, a
Senior Buyer, a Supply Base Manager, and a Purchasing Manager,
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all of whom have different authorization levels for different
document types, you should define a different job or position for
each role. If your purchasing department is comprised of five
employees with common authorization limits, then a single
approval group (see steps 7 and 8) could be given to those five jobs
or positions. See: Representing Jobs and Positions, Oracle Human
Resource Management Systems User’s Guide.

Use the Position window to create each of the positions in your
organization. This step is required if you plan to use either security
or position approval hierarchies. See: Representing Jobs and
Positions, Oracle Human Resource Management Systems User’s Guide.

Use the Position Hierarchy window to build and administer your
position hierarchies. There are two distinct uses for position
hierarchies in Purchasing: 1) document approval routing and 2)
document security control. You can use a single position hierarchy
for both purposes. See: Representing Jobs and Positions, Oracle
Human Resource Management Systems User’s Guide. See also:
Position Hierarchies: page 2 - 8.

Use the Purchasing Options window to choose a single security
hierarchy for your installation if you want to use the document
Security Level of Hierarchy for any or all of your document types.
See: Defining Control Options: page 1 — 49. For additional
overview information, see Document Security and Access: page

2 —10 and Approval Routing: page 2 - 13.

Attention: Note that a security hierarchy controls which positions
(and therefore which employees) have access to a particular
document type. It does not control whether an employee has the
authority to approve a document or perform other actions.

An Off-line approver is a valid employee with approval authority,
but without access to the relevant form. An On-line approver is an
active employee with approval authorization, and with access to
the relevant form.

Use the Document Types window to specify distinct security and
approval controls for each document type/subtype. See: Defining
Document Types: page 1 — 87.

Use the Approval Groups window to define approval
authorization rules. See: Defining Approval Groups: page 1 — 29.

Use the Assign Approval Groups window to associate approval
rules with a specific job or position and a document type. See:
Assigning Approval Groups: page 1 - 33.
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9. Use the Enter Person window to assign employees to jobs or
positions. If you are not using position approval hierarchies for
document routing, you must provide the employee’s supervisor.
See: the online help for the Enter Person window.

10. Run the Fill Employee Hierarchy process. This process creates an
employee—populated representation of your approvals hierarchy
and should be run whenever you make a structural or personnel
change to your hierarchies or assignments. You can set up this
process to run automatically at predefined intervals. See: Fill
Employee Hierarchy Process: page 9 — 41.

Changing the Approval Hierarchy

When you make a change to an approval hierarchy—for example, by
adding or removing an approver—existing documents still use the
previous hierarchy before you changed it. Future documents use your
changed hierarchy. Remember that every time you change a hierarchy;,
you must run the Fill Employee Hierarchy process.

If you are using position hierarchy approvals, and you move an
employee out of a position that’s in the approval hierarchy, assign
another employee to the vacant position. You can remove a position
altogether if it has no positions below it; you can also end-date the
position or create a new version of the hierarchy. You can build a new
version of a hierarchy by creating a new version of it or by copying an
existing hierarchy.

If you are using employee/supervisor approvals, and you remove an
employee or supervisor from an employee/supervisor chain, you must
rebuild the employee/supervisor chain.

See: Changing a Position Hierarchy, Oracle Human Resource Management
Systems User’s Guide.
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See Also

Approval and Security Setup Matrix

Security
Hierarchy?
Approval
Hierarchy?

Security Y
Hierarchy?
Approval
Hierarchy?

Security
Hierarchy?

Approval
Hierarchy?

]

Security Y
Hierarchy?
Approval Y
Hierarchy?

o

Define Positions

Use Approval Hierarchy: Y ;vfri]:zr\;’iab Options
‘ Define Jobs ‘ \Job window

‘ \Position window

&

o

‘ Build Position Hierarchies

\ Position Hierarchy
window

Specify Security
Hierarchy

#

97

Specify Security

\ Purchasing Options

Hierarchy g

Define Document Types

\ Document Types
window

&

&

Define Approval Groups

‘ \ Approval Groups

window
é_ é é \ Assign Approval
‘ Assign Approval Groups Grzj;inwiﬁzxa
é é \Enter P
‘ Assign Employees ‘ wmr:;;l e

- 6006

&

o ¢

®

\ Run Fill Emplo

~<

ee Hierarchy

\ Submit Requests
‘ window

v

-

v

/Complet: D ‘//Complete\\\/ (//Complet; D (//Complete\\>

Define a Position, Oracle Human Resource Management Systems User’s

Guide

Create a Position Hierarchy, Oracle Human Resource Management Systems

User’s Guide
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Copy an Existing Hierarchy, Oracle Human Resource Management Systems
User’s Guide

Delete a Position Hierarchy, Oracle Human Resource Management Systems
User’s Guide

Run the Position Hierarchy Report, Oracle Human Resource Management
Systems User’s Guide
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Position Hierarchies
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Use the Positions window to create each of the positions in your
organization. This step is required if you plan to use either security or
position approval hierarchies. See: Representing Jobs and Positions,
Oracle Human Resource Management Systems User’s Guide.

All the positions you want to include in your hierarchies must be
included in the Business Group you selected in the Financials Options
window.

A position can be added to multiple hierarchies.

Use the Position Hierarchy window to build and administer your
position hierarchies. There are two distinct uses for position hierarchies
in Purchasing: 1) document approval routing and 2) document security
control. You can use a single position hierarchy for both purposes. See:
Representing Jobs and Positions, Oracle Human Resource Management
Systems User’s Guide.

When you build your hierarchies, always begin with the most senior
position and work down. Use your organization charts and predefined
special approval paths to facilitate this process.

While you can include a position in many hierarchies, it can appear
only once within a single hierarchy.

If you want to use the document Security Level of Hierarchy for any or
all of your document types, the hierarchy you specify in the Purchasing
Options window must include all the positions in your organization
that should have access to these documents. See: Defining Control
Options: page 1 —49.

If you build multiple hierarchies for use in the approval process, it is
useful to give them meaningful names. This helps employees quickly
choose the appropriate approval path when moving documents from
one approval hierarchy to another.

For example, you can define a special approval hierarchy including a
Facilities Manager and Chief Financial Officer for all plant and property
purchases. Name this hierarchy "Facilities.” Your default approval
hierarchy for standard purchase orders (called ”Purchasing”) includes
only your procurement staff and a Vice President of Operations, none
of whom have the authority to approve plant and property items.
When a buyer attempts to approve a standard purchase order for these
items, Purchasing will require a forward-to employee. Assuming your
setup allows changes to the default approval hierarchy for standard
purchase orders, instruct buyers to route these documents to the
“Facilities” approval hierarchy.
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Before you can reference your position hierarchies in Purchasing, you
must assign employees to the referenced positions with the Enter
Person window and then use the Submit Requests window to run the
Fill Employee Hierarchy process. See: Fill Employee Hierarchy
Process: page 9 — 41.

See Also

Setting Up Document Approval and Security: page 2 — 2
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Document Security and Access
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Purchasing lets you control which groups of employees have access to
each document type, and what modification/control actions these
individuals can take once they gain access. Use the Document Types
window to specify your security options. See: Defining Document
Types: page 1 - 87.

You can restrict document access based on the following Security Level
options for each document type:

Public All system users can access the document

Private Only the document owner and subsequent
approvers can access the document

Purchasing Only the document owner, subsequent approvers,
and individuals defined as buyers can access the
document

Hierarchy Only the document owner, subsequent approvers,

and individuals included in the security hierarchy
can access the document

Within the installation security hierarchy, you can
access only those documents that you or your
reporting employees own

= Attention: You must define one position hierarchy including
all positions that require access to the document types you
want to control with a Security Level of Hierarchy. You need to
specify this hierarchy in the Purchasing Options window before
you can choose a Security Level of Hierarchy for a given
document type. See: Defining Control Options: page 1 — 49.

In addition to the Security Level, you specify an Access Level to control
what modification/control actions you can take on a particular
document type once you gain access. Document owners always have
Full access to their documents. The Access Level options include:

View Only Accessing employees can only view this document

Modify Accessing employees can view, modify, and freeze
this document

Full Accessing employees can view, modify, freeze,
close, cancel, and final-close this document

Both the Security Level and Access Level apply to existing documents.
Anyone with menu access to the document entry windows can create a
document. These individuals then become the document owners.
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The Security Level and Access Level work together. For example, if
you assign a Security Level of Public and an Access Level of Full to
standard purchase orders, then all users can access all standard
purchase orders from document entry, view, and control windows.

= Attention: While any document is in the approval process
(regardless of Access or Security Level), no one can access it
using an entry window.

If you change the Access Level to View Only for a document type, then
all users (except for the document owner whose Access Level is always
Full, and approvers who can optionally modify the document when it
is in their approval queue based on the document control Approver
Can Modify) can access these documents in the view windows, but not
in the document entry or control windows. If you change the Security
Level for a document type to Private, then only the document owner
and subsequent approvers can access these documents.

Finally, the Security Level and Access Level work with the Approver
Can Modify option that you choose in the Document Types window. [f
this control is set to Yes for a particular document type (even if the
Access Level is View Only), then all approvers can modify documents
in their pending approval queue. Once you approve a document, you
cannot make further modifications.

The following matrix describes the effects of all possible Security Level
and Access Level combinations in which groups of employees can
access documents using the view, entry, or control windows.
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The Security Level / Access Level Matrix

Document | Access View Entry Windows Control Windows
Type Level Windows
Doc NOT | Doc in Freeze/ Cancel/
in Approval | Close Final Close
Approval
View Only | All Owner None Owner Owner
Public Modify All All None All Owner
Full All All None All All
- Owner
View Only Approver Owner None Owner Owner
. . Owner
Private Modify Approver Owner None Owner Owner
Full Owner Owner None Owner Owner
Approver
Owner
View Only | Approver | Owner None Owner Owner
Buyers
Owner Owner
. . Owner Owner
Purchasing | Modify Approver | Approver | None Buyers Buyers
Buyers Buyers
Owner Owner
Full Approver | Approver [ None g::vre]'e,; g::vre]'e,;
Buyers Buyers 4 4
Owner
View Only | Approver | Owner None Owner Owner
Hierarchy
Owner Owner Owner
Hierarchy | Modify Approver | Approver | None Hi Owner
: ' ierarchy
Hierarchy | Hierarchy
Owner Owner
Owner Owner
Full Approver | Approver [ None . .
Hierarchy | Hierarchy Hierarchy | Hierarchy

Table2-1 (Pagelofl)

2-12 Oracle Public Sector Purchasing User’s Guide



Approval Routing

Purchasing lets you route documents for approval based on either
position hierarchies or employee/supervisor relationships. In both
cases, you control whether documents are routed to the first employee
with enough authority to approve the document (Direct method), or if
they must pass through each level of the associated hierarchy or
reporting infrastructure regardless of authority (Hierarchy method).
You can also control whether document owners are able to approve the
documents they create.

Use the Document Types window to specify routing controls by
document type. See: Defining Document Types: page 1 — 87.

Owner Can
Approve

Can Change to
Forward-To

Can Change
Forward-From

Prevent or allow document owners to approve the
documents they create.

Prevent or allow changes to the default forward-to
employee.

If you are using position approval hierarchies and
there is more than one employee associated with a
particular position, Purchasing defaults a
Forward-To employee in the Approvals window
based on alphabetic order.

If you are using position approval hierarchies and
allow changes to the Forward-To employee, the list
of values in the Approvals window includes all
employees in the selected hierarchy:.

If you are routing documents using
employee/supervisor relationships and you allow
changes to the Forward-To employee, the list of
values in the Approvals window includes all
employees defined in the Business Group you
specify in the Financials Options window.

Prevent or allow changes to the default
forward-from employee. This control applies only
to requisitions.

If you allow changes to the forward-from
employee, Purchasing restricts the Forward-From
list of values in the Approvals window to
requestors associated with the requisition you are
trying to approve.

Approval, Security, and Control 2-13



2-14

Can Change
Approval
Hierarchy

This flexibility allows you to build an approval
history including the original requestor rather than
the preparer.

This control applies only if you are using position
approval hierarchies. Prevent or allow changes to
the default approval hierarchy.

If you allow changes to the default approval
hierarchy, the list of values in the Approvals
window includes all hierarchies defined in the
Business Group you specify in the Financials
Options window.

> Attention: When you submit a document for approval,
Purchasing verifies that you are included in the default position

hierarchy for your document. If you are not included in this
hierarchy, and Allow Change to Approval Hierarchy is set to
No, you cannot approve the document or route it to another
employee. If you have enough authority to approve the
document, you can complete this action regardless of whether
you are included in the default hierarchy.

Forward Method

Default
Hierarchy

Select Direct to route documents to the first
employee with enough authority to approve them.
Select Hierarchy to route documents to the next
person in the approval hierarchy or reporting
infrastructure regardless of authority.

Approval authority is determined by the approval
rules you define in the Define Approval Groups
and Assign Approval Groups windows. For
example, a hierarchy of three approvers consists of
one with a $1,000 approval limit, one with a $5,000
approval limit, and one with a $10,000 approval
limit. In a Direct forward method, a document
totalling $7,000 is routed directly to the approver
with the $10,000 approval limit. In a Hierarchy
forward method, the document routes to all three
approvers, stopping at the $10,000 approver.

This control applies only if you are using position
approval hierarchies. You must specify a default
approval hierarchy for each document type.

Combine these controls to build an approval routing policy that is as
strict or as flexible as your needs warrant. For example, if you set
Allow Change to Approval Hierarchy and Allow Change to
Forward-To to No, Purchasing forces employees to route all documents
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according to the approval hierarchy or employee /supervisor
relationships that you define. If you set these controls to Yes,
Employees can route documents for approval with a high degree of
autonomy and flexibility within the structures you define.

See Also

About Financials Options, Oracle Public Sector Payables User’s Guide

Submitting a Document for Approval: page 2 — 35
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Approval Authorization Control

See Also

You can define flexible groups of authorization rules (Approval
Groups) which you assign to specific document types and jobs or
positions (based on your implementation). These authorization rules
are comprised of include/exclude and amount limit criteria that you
specify for Document Total, Account Range, Item Range, Item Category
Range, and Location. You can associate multiple approval groups
(collections of authorization rules) with a single document/job or
position combination to create unique approval structures in support of
your organization’s signature policies. Finally, you link employees to
authorization limits when you assign them to jobs or positions.

When you attempt to approve a document, Purchasing evaluates the
authorization rules associated with your job or position and the
document type to determine whether you have adequate authority. If
you do not have enough authority to approve the document,
Purchasing provides default routing information based on your
approval setup. Depending on the level of routing flexibility you
specify, approvers may or may not be able to change these defaults.

Defining Approval Groups: page 1 - 29

Assigning Approval Groups: page 1 — 33

Defining Approval Authorization Rules: page 2 — 16
Using Approval Assignments: page 2 - 19

Defining Approval Authorization Rules

An approval group is a set of authorization rules comprised of
include/exclude and amount limit criteria for the following Object
Types: Document Total, Account Range, Item Range, Item Category
Range, and Location. For each position or job, you ultimately associate
these approval groups with document types to implement your
authorization rules.

To build an approval group, first assign a descriptive name that will
make it easy to reference in the Assign Approval Groups window. You
can then add multiple rules for the same Object Type to your approval
group. When you associate two or more rules for the same Object Type
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with a single job/position and document type combination, Purchasing
uses the most restrictive criteria during the authorization check.

An Account Range rule defines the distribution accounting flexfield
ranges and their amount limits that the approval group can approve,
and an Include rule is required for at least one approval group
associated with each document type in the Assign Approval Groups
window. To include an account range, choose this Object Type with an
Approval Type of Include, enter an Amount Limit, and specify the
Value Low and Value High for your range.

= Attention: The Amount Limit that you specify for an Account
Range Include rule applies to the sum of all accounts included in
the range. It does not apply to each individual account within the
range.

To exclude an account range, choose this Object Type with an Approval
Type of Exclude and specify the Value Low and Value High for your
range. The approval group will be unable to approve documents
including these accounting distributions, even if your enabling Include
rule contains these accounts within its upper and lower bounds.

A Document Total rule defines the maximum document amount that
the approval group can approve. This is not required to enable the
approval group. If you want to specify a Document Total, choose this
Object Type with an Approval Type of Include and enter an Amount
Limit.

An Item Range rule defines the items and their amount limits that the
approval group can approve. An Item Range rule is not required;
approval groups can approve documents for all items by default.

To include an item range, choose this Object Type with an Approval
Type of Include, enter an amount limit, and specify the Value Low and
Value High for your range. An Item Range Include rule allows you to
specify approval amount limits for individual items or item ranges, and
the Amount Limit you enter applies to the sum of all items within the
range. Also, an Item Range Include rule does not implicitly exclude
items that are not referenced in the rule.

To exclude an Item Range, choose this Object Type with an Approval
Type of Exclude and specify the Value Low and Value High for your
range. The approval group will be unable to approve documents
including these items.

An Item Category Range rule defines the item categories and their
amount limits that the approval group can approve. An Item Category
Range rule is not required; approval groups can approve documents
for all item categories by default.
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To include an Item Category Range, choose this Object Type with an
Approval Type of Include, enter an Amount Limit, and specify the
Value Low and Value High for your range. An Item Category Range
include rule allows you to specify approval amount limits for
individual item categories or item category ranges, and the Amount
Limit you enter applies to the sum of all item categories within the
range. Also, an Item Category Range include rule does not implicitly
exclude item categories that are not referenced in the rule.

To exclude an Item Category Range, choose this Object Type with an
Approval Type of Exclude and specify the Value Low and Value High
for your range. The approval group will be unable to approve
documents including these item categories.

A Location rule defines the ship—to and deliver—to locations and their
amount limits that this approval group can approve. Purchasing
verifies the ship to location for purchase orders and releases, and the
deliver to location for requisitions. A Location rule is not required,;
approval groups can approve documents for all ship to and deliver to
locations by default.

To include a Location rule, choose this Object Type with an Approval
Type of Include, enter an Amount Limit, and specify the Location you
want to control using the Value Low field. A Location Include rule
allows you to specify approval amount limits for individual ship to and
deliver to locations. It does not implicitly exclude locations not
referenced in the rule.

To exclude a ship to or deliver to location, choose this Object Type with
an Approval Type of Exclude and specify the location using the Value
Low field. The approval group will be unable to approve purchase
orders and releases that include this location as a ship to, or
requisitions that include this location as a deliver to.

To illustrate approval group implementation, assume a Purchasing
department is comprised of three kinds of purchasing professionals
with a corresponding position defined for each in Purchasing: Senior
Buyers (who purchase all manufacturing and MRO items/services with
a $50,000 document limit), MRO Buyers (who purchase all
non-manufacturing items and services with a $10,000 document limit),
and Junior Buyers (who purchase all but one manufacturing item
category with a $25,000 document limit).

This organization uses four two-segment item categories:
MRO-SERVICE, MRO-SUPPLIES, MFG-GENERAL, and
MFG-SPECIAL.

Oracle Public Sector Purchasing User’s Guide



First, define one approval group called ”Buyer Master” containing a
single Account Range Include rule for all accounting distribution
ranges with a $50,000 Amount Limit.

You can then define a supplementary approval group called ”"MRO
Buyer” containing two rules: 1) a Document Total rule with an
Amount Limit of $10,000 and 2) an Item Category Range rule excluding
all item categories with MFG as the first segment.

Finally, you can define another supplementary approval group called
”Junior Buyer” containing three rules: 1) a Document Total rule with
an Amount Limit of $25,000, 2) an Item Category Range rule excluding
all item categories with MRO as the first segment, and 3) another Item
Category Range rule excluding the MFG-SPECIAL category.

See Also

Defining Approval Groups: page 1 — 29
Defining Approval Assignments: page 1 — 33
Approval Authorization Rules: page 2 — 16
Using Approval Assignments: page 2 — 19

Using Approval Assignments

Use the Assign Approval Groups window to associate approval groups
with a specific job or position and a document type including:
Purchase Requisition, Internal Requisition, Standard Purchase Order,
Planned Purchase Order, Blanket Purchase Agreement, Contract
Purchase Agreement, Scheduled Release, and Blanket Release. You can
associate multiple approval groups with a single document type/job or
position combination. Whenever you associate two or more approval
groups with a single document type/job or position combination,
Purchasing uses the most restrictive rule to evaluate authorization
limits.

Attention: While individual approval groups do not require an
ISy enabling Account Range Include rule, every document type for
each job/position must be associated with at least one approval
group with this characteristic. Otherwise, employees in the
associated job or position will be unable to approve this document

type.
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If no approval groups are associated with a particular document type
for a given job or position, then employees assigned to this job or
position will be unable to approve documents of this type.

If you want to specify the approval assignments for the Purchasing
department described in the Defining Approval Authorization Rules
document (See: Defining Approval Authorization Rules: page 2 — 16),
you can begin with the Senior Buyer position. Assuming Senior Buyers
should be able to approve all document types, you can set up the
control assignments as follows:

Control Function Approval Group Start Date

Blanket Purchase Agreement Buyer Master dd-MON-yy
Blanket Release Buyer Master dd-MON-yy
Contract Purchase Agreement Buyer Master dd-MON-yy
Internal Requisition Buyer Master dd-MON-yy
Planned Purchase Order Buyer Master dd-MON-yy
Purchase Requisition Buyer Master dd-MON-yy
Scheduled Release Buyer Master dd-MON-yy
Standard Purchase Order Buyer Master dd-MON-yy

Table2-2 (Page 1o0f1)

This plan allows Senior Buyers to approve all document types for all
account ranges with a maximum amount limit of $50,000. The Senior
Buyer position can approve all locations, items, and item categories by
default.

If Junior Buyers can approve releases (and no other document types)
based on the authorization criteria you specified in the Defining
Approval Authorization Rules document, set up the Control
Assignments as follows for this position:

Control Function Control Group Start Date
Blanket Release Buyer Master dd-MON-yy
Blanket Release Junior Buyer dd-MON-yy

Table 2-3 (Page 10f2)
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Control Function Control Group Start Date

Scheduled Release Buyer Master dd-MON-yy

Scheduled Release Junior Buyer dd-MON-yy

Table2-3 (Page 2 of 2)

In this case, Junior Buyers can approve up to $25,000 for each Blanket
and Scheduled Release including all but one category of manufacturing
items. These employees cannot approve Standard Purchase Orders,
Planned Purchase Orders, Purchase Requisitions, Internal Requisitions,
Blanket Purchase Agreements, or Contract Purchase Agreements
regardless of document total or content. Finally, Junior Buyers are
unable to approve any document type that includes MRO item
categories.

Attention: Note that we assigned two approval groups to each

IS5 document type in this example. The Buyer Master approval group
lets Junior Buyers approve releases by providing an enabling
Account Range Include rule. The Junior Buyer approval group
introduces the specific authorization restrictions for this position.
Remember, the most restrictive rules prevail at approval time, so
even though the Buyer Master Account Range Include rule allows
for a $50,000 Amount Limit, the Junior Buyer Document Total rule
with a $25,000 Amount Limit controls the approval ceiling.

MRO Buyers should be able to approve any document type for up to
$10,000 of MRO item categories. Set up the approval assignments as

follows:

Control Function Approval Group Start Date

Blanket Purchase Agreement Buyer Master dd-MON-yy
Blanket Purchase Agreement MRO Buyer dd-MON-yy
Blanket Release Buyer Master dd-MON-yy
Blanket Release MRO Buyer dd-MON-yy
Contract Purchase Agreement Buyer Master dd-MON-yy
Contract Purchase Agreement MRO Buyer dd-MON-yy
Internal Requisition Buyer Master dd-MON-yy
Internal Requisition MRO Buyer dd-MON-yy

Table 2-4 (Page 10f2)
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See Also
Defining Approval Groups: page 1 — 29
Defining Approval Assignments: page 1 — 33
Approval Authorization Rules: page 2 — 16
Defining Approval Authorization Rules: page 2 - 16
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Control Function Approval Group Start Date

Planned Purchase Order Buyer Master dd-MON-yy
Planned Purchase Order MRO Buyer dd-MON-yy
Purchase Requisition Buyer Master dd-MON-yy
Purchase Requisition MRO Buyer dd-MON-yy
Scheduled Release Buyer Master dd-MON-yy
Scheduled Release MRO Buyer dd-MON-yy
Standard Purchase Order Buyer Master dd-MON-yy
Standard Purchase Order MRO Buyer dd-MON-yy

Table 2 -4 (Page 2 of 2)




Assigning Employees

p To assign employee to jobs or positions:

1. Use the Enter Person window to assign employees to jobs or
positions. If you are not using position approval hierarchies for
document routing, you must provide the employee’s supervisor.
See: the online help for the Enter Person window.

You can assign an employee to only one job or position.

Attention: If Human Resources is installed, you must maintain

ISy employee information using the People window for Human
Resources. See: Entering a New Person, Managing People Using
Oracle HRMS.

2. Before you can reference your position hierarchies in Purchasing,
you must run the Fill Employee Hierarchy process. This process
creates an employee—populated representation of your approvals
hierarchy and should be run whenever you make a structural or
personnel change to your hierarchies or assignments. You can set
up this process to run automatically at predefined intervals. See:
Fill Employee Hierarchy Process: page 9 — 41.

The process creates an error log which lists all positions to which
no employee is assigned, but having such positions is a benign
error that does not hamper system operation.
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The Document Approval Process

2-24

Approve Document Window

Purchasing lets you approve requisitions, standard and planned
purchase orders, blanket and contract purchase agreements, and
releases using a common process. When you complete your
documents and are ready to initiate the approval process, select the
Approve button in the document entry window to open the Approve
Document window.

In the Approve Document window, choosing Submit for Approval (and
then choosing OK) approves the document if Owner Can Approve is
enabled for the specific document type in the Document Types window
and you have the authority to approve the document. See: Defining
Document Types: page 1 —87. If the document requires someone else’s
approval, choosing Submit for Approval (and then choosing OK)
automatically submits the document to that person (or routes it to
multiple approvers) for approval, based on your approval hierarchy
setup. See: Setting Up Document Approval and Security: page 2 - 2.

Purchasing offers the following document approval actions in the
Approve Document window: Reserve or Unreserve (if using
encumbrance / budgetary control), Submit for Approval, and Forward.
You can also change the approval hierarchy from within the Approve
Document window if Allow Change to Approval Hierarchy is selected
for the document type in the Document Types window. You can also
specify a Forward To person if you want the document to be approved
by someone outside the approval hierarchy. You can also select the
Print option, and the document will automatically print once it is
approved.

When you select the Approve button in a document entry window,
Purchasing performs submission checks to verify that the document is
complete and in an appropriate state for the action you chose. Status
checks are performed when you take an approval action. See:
Document Submission Checks: page 2 — 27. See: Document Status
Checks: page 2 - 26.

Notifications Web Page

You can also approve documents through the Notification Details Web
page, accessible through the Notifications Summary menu in
Purchasing. The Notifications Summary page lists all the documents
awaiting your approval, so that you can manage your pending
approval queue and take approval actions. After opening a
notification, you can drill down to the document itself, and review it
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Approval Workflow

See Also

and its action history. You can also modify the document if Approver
Can Modify is enabled for the document type. See: Defining
Document Types: page 1 - 87. (After you modify a document, you
need to return to the notification to take an approval action.)

You can also view and respond to notifications through e-mail. Oracle
Applications uses Oracle Workflow technology to route notifications
through e-mail. This way, an approver who has easier access to e-mail
than to the Purchasing application can view notifications and take
approval actions.

See: To View Notifications from the Worklist, Oracle Workflow Guide.

See: Reviewing Notifications via Electronic Mail, Oracle Workflow
Guide.

Purchasing uses Oracle Workflow technology to handle the entire
approval process. When you take an approval action in the Approve
Document window or the notification, or through the Web or e-mail,
you are “submitting” the approval action to Workflow. Workflow
works in the background, using the approval controls and hierarchies
you’ve defined to route documents for approval. Because Workflow
handles your approval process in the background, you can use Oracle
Workflow Builder’s easy interface to modify your approval process.
For more information about the approval workflows in Purchasing, see:
Purchase Order Approval Workflow: page C — 111 and Requisition
Approval Workflow: page C — 54.

Submitting a Document for Approval: page 2 — 35
Viewing and Responding to Notifications: page 2 — 31

Approved Documents and Supply

A Pre-Approved document does not show up as supply. A
Pre—Approved document is one that meets the following conditions:

e A person with the final authority to approve the document
approves it, but then forwards it to someone else for additional
approval, thus changing its status to Pre-Approved.
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e Your organization uses encumbrance (reserves funds for
documents), and the document is authorized for approval but
funds have not yet been reserved for it. Even if someone with
sufficient approval authority approves the document, its status
may still be Pre—-Approved if funds were not able to be reserved
at the time of approval. Once funds are reserved for the
approved document, the document changes its status to
Approved.

A Pre-Approved document does not show up as supply until its status
changes to Approved.

When you make a change to an approved document that changes its
status to Requires Reapproval, that change (for example, to quantity)
does not show up as supply until the document has been approved
again.

Document Status Checks

2-26

Purchasing performs a status check on all documents whenever you
perform or attempt an approval action. This check verifies that the
document is in a valid state to perform the selected approval action. If
your document fails the status check, Purchasing provides an error
message in the window in which you are working.

The following matrix describes the valid actions for each document
state. Generally, lists of values in the document entry and approval
windows restrict the list of available approval actions based on
document status, so you should rarely encounter status check failures.

Document Approval Status Rules

Valid Actions

Current Approve | Reserve | Forward | Reject
Document

Status
Incomplete
In Process X X X X
Approved
Pre—-Approved X X X

Table2-5 (Pagelof2)

Oracle Public Sector Purchasing User’s Guide



Current Approve | Reserve | Forward | Reject
Document

Status
Rejected
Returned
Requires X X
Reapproval
Not on Hold X X X X
Not Frozen X X X X
Not Cancelled X X X X
Not Reserved X X X X
Open X X X X
Closed X X X X

Document Submission

Table2-5 (Page 2 of 2)

Checks

Purchasing performs a submission check on all documents that
successfully complete a status check whenever you perform or attempt
an approval action.

The submission check verifies that all mandatory fields have been
entered and that various quantities, amounts, and dates are within
prescribed ranges or limits. If your document fails any of the
submission check rules, Purchasing automatically brings you to the
Approval Errors window where you can review the cause(s) of failure.
You can then return to the document entry window to make required
corrections.

The following matrix describes the submission checks that are
performed for each document type.
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Submission Check Rules

HEADER Standard Planned Blanket Contract Release Requisition
Document must have a X X X X
supplier
Document must have a X X X X
supplier site
Supplier must not be X X X X
on hold
Supplier must be X X X

included in current
Approved Supplier
List entries for items
requiring an approved

supplier

Document must have a X X X X
currency

Foreign currency must X X X X
have a rate

Foreign currency must X X X X

have a rate type

Foreign currency must X X X X
have a rate date if rate
type is not User

Document must have a X X X X
ship-to location

Document must have a X X X X
bill-to location

Amount limit must be X

greater than or equal to

Amount Agreed

Amount limit must be X X

greater than or equal to
Minimum Release
Amount

Amount limit must be X X
greater than or equal to
the total amount
already released

Table2-6 (Page1of4)
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HEADER

Standard Planned Blanket Contract

Release Requisition

Amount limit must be
greater than or equal to
the standard purchase
order line total
referencing this
contract

X

Related document
cannot be on hold

Release date must fall
within related
document effectivity
dates

Related purchase
agreement cannot be
on hold

Related document
supplier cannot be on
hold

Current release total
must be greater than or
equal to header
minimum release
amount specified on
related agreement

Current Release total
plus all approved
release totals must be
greater than or equal to
the related document
amount limit

LINE

Standard

Planned

Blanket

Contract

Release Requisition

Each document must
have at least one line

X

X

X

Line quantity must
equal the sum of its
shipment quantities

If a line references a
contract, the contract
must be approved

Table2-6 (Page2of4)
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LINE

Standard Planned Blanket Contract

Release Requisition

If a line references a
contract, the supplier
on the contract must be
the supplier on the PO
header

X

X

PO line total related to
a contract plus existing
approved lines relating
to the same contract
cannot exceed contract
amount limit

Requisition line
guantity must equal
the sum of its
distribution quantities

SHIPMENT

Standard

Planned

Blanket

Contract

Release Requisition

Each PO line must
have at least one
shipment

X

X

Shipment quantity
must equal the sum of
its distribution
guantities

Each release must have
at least one shipment

Current shipment total
must be greater than or
equal to line minimum
release amount
specified on related
document

Price must be within
specified price
tolerance if Enforce
Price Tolerance is Yes
and the release was
AutoCreated from a
requisition

Table2-6 (Page 3 of4)
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DISTRIBUTION Standard Planned Blanket Contract Release Requisition

Each shipment must X X X
have at least one
distribution

Each requisition line X
must have at least one
distribution

Foreign currency X X X X
distributions must
have a rate

Foreign currency X X X X
distributions must
have a rate type

Foreign currency X X X X
distributions must
have a rate date if rate
type is not User

Table2-6 (Page 4 of 4)

Viewing and Responding to Notifications

Use the Notification Details Web page, accessible through the
Notifications Summary menu in Purchasing, to manage your pending
approval queue and take approval actions. After opening a
notification, you can also submit a document for approval from the
notification if you didn’t yet do it through the Approve Document
window.

Purchasing offers the following document approval actions in the
notification: Approve, Approve and Forward, Forward, and Reject.
You can also reassign a notification to somebody else.

The approval amount noted in the notification includes nonrecoverable
tax if you use tax and recovery rates. See: Tax Defaults in Purchasing:
page 4 — 138.

The Notifications Web page requires Oracle Workflow to be set up. See:
Setting Up Oracle Workflow, Oracle Workflow Guide.
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Purchasing Notifications

2-32

Reassign and Forward

A Reassign action is not recorded in the Action History window, but a
Forward action is. See: Viewing Action History: page 8 — 2. To reassign
a notification but still record you as the approver, choose Reassign, and
then choose Delegate. To forward the notification so that the new
approver is recorded in the action history instead of you, open the
notification and select the Forward action. (Do not use the
Reassign/Transfer option.)

Ignore

Some reminder notifications include a response of Ignore. Ignore
means that you are ignoring the notification for now. Purchasing will
not display that notification again until the concurrent program process
Send Notifications for Purchasing Documents runs. (See: Send
Notifications for Purchasing Documents: page 9 — 155.)

Close Button

When you click Close, Purchasing considers the notification closed. If
you want to see the notification again, choose Search and select a status
of All or Closed.

Opening a Document

From a notification that you have opened, you can also drill down to
the document and modify it if Approver Can Modify is enabled for the
document type. See: Defining Document Types: page 1 - 87.
Depending on the function security assigned to your responsibility, you
have varying levels of access to information. A responsibility defines
an application user’s current privileges while working with Oracle
Applications.

> Attention: After you modify a document opened through the
notification, you must return to the notification and choose
Approve there, not in the document itself, so that Purchasing
can record your approval action and continue with or complete
the approval process.

In the Notifications Summary list, notifications for the following
Purchasing documents appear. The Send Notifications for Purchasing
Documents process must be running for some of these notifications to
be sent:

e Purchase orders and requisitions that require approval action.
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e Requisitions or purchase orders that are incomplete.

e Purchase orders and releases that require acceptance. (You
indicate on your standard purchase orders, purchase
agreements, and releases whether you require your suppliers to
accept your orders by a specific date by selecting Acceptance
Required in the Terms and Conditions window.) For purchase
orders and releases that have not been entered as accepted in the
Acceptances window, Purchasing notifies you that acceptance is
required. If the Acceptance Require By date indicates that the
acceptance is overdue, Purchasing sends a notification that
acceptance is past due.

e RFQs and quotations with a Status of In Process. Purchasing
sends a notification that the document requires completion.

e RFQs for which the Status is Active and the current date is
between the Due Date and the Close Date on the RFQ.
Purchasing sends a notification that the RFQ is approaching
expiration.

¢ Quotations for which the Status is Active and the current date is
between the Effectivity end date on the Quotation and the Quote
Warning Delay end date in the Default region of the Purchasing
Options window. Purchasing sends a notification that the
quotation is approaching expiration.

e Blanket purchase agreements or catalog quotations sent by your
supplier through the Purchasing Documents Open Interface
when price increases on those documents exceed a price update
tolerance that you define. You receive a notification for each
affected document. See: Receiving Price/Sales Catalog
Information Electronically: page 5 - 22.

¢ Reschedule notifications from Master Scheduling/MRP. Master
Scheduling/MRP can automatically reschedule standard
purchase orders and blanket and planned releases by changing
the Need By date on the document if you respond to the
reschedule notification with your approval. See: Summary of
Exception Process 2, Oracle Master Scheduling/MRP and Oracle
Supply Chain Planning User’s Guide.

For notifications about purchase order acceptances, RFQ expiration,
and quotation expiration, you can choose a response of Close. The
closed notification won’t reappear unless you change the expiration
date on the document.

If you receive a notification titled Document Manager Failed:
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Additional Information

Open the notification and read the detailed message. You or your
system administrator may need to reactivate the PO Document
Approval Manager. Once the PO Document Approval Manager is
reactivated, respond to the notification by choosing Retry.

= Attention: After the PO Document Approval Manager is
reactivated, you must respond to the notification with Retry to
restart the approval process where it left off.

If you receive a notification titled Unable to Reserve Document:
You have several options:

o Reserve the document again if, for example, more funds have
been allocated.

Attention: To reserve funds for the document, first open the

IS5 document from the notification. Choose the Approve button in the
document, and then check Reserve and OK. Then respond with
Retry in the natification.

¢ Send the document back to its preparer for modification; the
preparer can then, for example, reduce the quantity on the
document and submit it again for approval.

e Forward the document to somebody else with authority to
reserve the funds.

If you see Resubmit Requisition, Update Requisition, and
Requisition Detail icons in a notification:

These icons enable you to resubmit, update, or view requisitions only if
Self-Service Purchasing is installed.

For more detailed instructions on how to use the Notifications
Summary Web page, including the Worklist and Find Notifications
pages accessible in the Workflow menu in Purchasing, see: To View
Notifications from the Worklist, Oracle Workflow Guide, To View the
Details of a Notification, Oracle Workflow Guide, and To Find
Notifications, Oracle Workflow Guide.

You can also view and respond to notifications through e-mail. Oracle
Applications uses Oracle Workflow technology to route notifications
through e—-mail. This way, an approver who has easier access to e-mail
than to the Purchasing application can view notifications and take
approval actions. See: Reviewing Notifications via Electronic Mail,
Oracle Workflow Guide.
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See Also
Overview of Function Security, Oracle Applications System
Administrator’s Guide
Function Security for Purchasing: page 1 — 112

Send Notifications for Purchasing Documents: page 9 — 155

Submitting a Document for Approval

Use the Approve Document window to take approval actions on
documents that you create or modify. (You can also use this window to
make changes to encumbered documents. See: Changing Encumbered
Documents: page 4 — 135.)

p To take approval actions:

Navigate to the Approve Document window by selecting the Approve
button in a document entry window.
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1. Ifyou are using encumbrance/budgetary control, Reserve and
Unreserve options are available.

Reserve — You can reserve funds for the document only if you are
using encumbrance/budgetary control. Requisition preparers can
choose this option only if Reserve at Completion in the Financials
Options window is enabled and the document is currently
unreserved. See: Defining Financials Options, Oracle Public Sector
Payables User’s Guide. When you select Reserve (and then OK),
Purchasing reserves the funds now. Purchasing also automatically
approves the document if the document has been preapproved,
you’re the appropriate approver, and no more approvals are
required. If you get a message that you cannot reserve the funds,
forward the document to an approver who has the authority to
reserve them. If you don’t select Reserve, but just select Submit for
Approval (and then OK), Purchasing reserves funds later, when the
approver with the authority to reserve the funds approves the
document.
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Unreserve — You can unreserve funds for the document only if you
are using encumbrance/budgetary control and funds are currently
reserved for that document.

Unreserve Date — If you selected Unreserve, enter an Unreserve Date
that falls within an open reserve period.

2. Select Submit for Approval.

3. Select Forward only if you want to forward the document to
someone other than the next approver in the default Approval
Path.

If you select Forward, you must enter a Forward To person. If you
don’t select Forward, Purchasing will automatically route the
document to the appropriate person in the Approval Path, if you're
not the appropriate approver.

If the Forward To person is higher up in the default (or selected)
Approval Path, but still does not have enough approval authority,
Purchasing will continue the approval process with the next person
in that Approval Path. If the Forward To person is not in the
default (or selected) Approval Path, and also does not have enough
approval authority, you will receive an Approver Not Found
notification.

4. If Allow Change to Approval Hierarchy is selected for the
document type, you can select a new Approval Path. See: Defining
Document Types: page 1 — 87.

5. Choose OK.

The document is submitted to the approval process, which routes
the document to the appropriate approvers based on the approval
hierarchies and controls you’ve defined. If Owner Can Approve is
enabled for the specific document type in the Document Types
window and you have the authority to approve the document, then
choosing OK approves the document.

p To cancel your approval action:
m  Choose the Cancel button to cancel your approval action and
return to your document entry window.

» To change the Forward From person:

m  For requisitions only, if you have selected Forward as the action
and if Allow change to Forward-From is enabled for the document
type in the Document Types window, you can change the Forward
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From person to the original preparer or to any requestor on a line
of the requisition. See: Defining Document Types: page 1 — 87.

» Tochange the Forward To person:

m  |f you have selected Forward as the action and if Allow change to
Forward-To is enabled for the document type in the Document
Types window, you can change the Forward To person. See:
Defining Document Types: page 1 — 87.

The Forward To value is a default from the employee/supervisor
relationship or from the approval hierarchy, depending on whether
you are using approval hierarchies.

p To enter notes:

m  Enter notes in the Note field to record information about your
approval action or provide instructions for the next approver if
your document requires additional authorization. See also:
Attaching Notes to Purchasing Documents: page 1 — 44.

p To print the document:
m  Select Print.
The document will automatically print once it is approved.

A purchase order will not print if the supplier site on the purchase
order is already set up to receive purchase orders through
Electronic Data Interchange (EDI).

p Tosend afacsimile of the purchase order:

m  Select Fax and enter a Fax Number. CommercePath, or any
facsimile software that is compatible with the CommercePath Fax
Command Language (FCL), must be installed to use this
functionality.

If a Fax Number is defined in the Supplier Sites window, that
number defaults, but you can change it.

Selecting Fax and entering a Fax Number automatically sends a
facsimile of the document once it is approved.

Selecting Fax without entering a Fax Number sends the document
to your facsimile server once it is approved. Depending on your
CommercePath setup, you can choose where or when to send the
documents that are stored on your facsimile server.
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If the supplier is already set up to receive purchase orders through
Electronic Data Interchange (EDI), a facsimile of the purchase order
will not be sent.

See Also

Defining Document Types: page 1 — 87

The Document Approval Process: page 2 — 24

Viewing and Responding to Notifications: page 2 — 31
Setting Up Document Approval and Security: page 2 — 2
Purchase Order Approval Workflow: page C — 111
Requisition Approval Workflow: page C — 54
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Offline Approvers

An offline approver is someone who does not log on to Oracle
Applications, but uses someone else to approve on his or her behalf.

All approvers, including offline approvers, need to have a logon user
name. Even if the approver is set up as an employee in the approval
hierarchy, Purchasing cannot continue with approval without that
employee’s also having a logon user name.

If in the Approve Document window you forward to an approver who
does not have a logon user name, Purchasing alerts you right away. If
an approver without a logon user name is already included in the
approval hierarchy, the approval workflow will fail at that approver.
(The document will remain In Process.)

To include the offline approver in document approvals, you need to:
e Assign the offline approver a logon user name.

e Use the notification handling feature to forward the offline
approver’s documents to a proxy approver—someone who can
log on to Oracle Applications and approve the document on the
offline approver’s behalf.

You need to do both of these steps. The approval process needs to
know the offline approver’s logon user name before it can route that
person’s documents to the proxy approver. Both of these steps are
described below.

When you designate a proxy approver to approve on the offline
approver’s behalf, the offline approver, not the proxy approver, shows
up as having approved the document in the Action History window.

To designate a proxy approver:

1. Assign the offline approver a logon user name if the approver does
not already have one.

For instructions, see: Users Window, Oracle Applications System
Administrator’s Guide.

2. Inthe Purchasing or System Administrator responsibility, in the
Workflow menu, navigate to Notification Rules, which opens a Web

page.
In the System Administrator responsibility, the Workflow

Administrator > Notification Rules menu enables you to reassign
anyone’s notifications. In the Purchasing responsibility, the
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Workflow User > Notification Rules menu enables you to reassign
only your notifications.

Designate a proxy approver for the offline approver by following
the instructions in Defining Rules for Automatic Notification
Handling, Oracle Workflow Guide.

The instructions for defining these rules refer to a role. For
Purchasing, role means the user for whom you are designating a
proxy approver.

When you reach the Find Notification Routing Rules Web page,
enter the user name of the offline approver.

If you want to designate the proxy approver for both requisitions
and purchase orders, when you reach the step about selecting the
workflow (item type) for which you need to create the proxy
approver, select the PO Requisition Approval workflow. Then
repeat the steps for the PO Approval workflow, for purchase
orders. (Recall that different document types are tied to their
corresponding workflows—usually to either the PO Requisition
Approval workflow or the PO Approval workflow—in the
Document Types window during Purchasing setup. For example,
the PO Approval workflow handles all purchase order types,
unless you’ve set up the Document Types window to do
differently.)

Once you have selected the workflow, you will be presented with a
list of the notifications within the workflow. For offline approvers,
you may want to select All notifications.

When you reach the step that asks you to enter a comment, it is
advisable to enter a comment—for example, ”This document
requires your approval on Joan’s behalf.” This helps the proxy
approver know whether it is just another document in his or her
queue, or a document that needs to be approved for someone else.
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Mass Forwarding Documents

Use the Forward Documents window to forward all or selected
documents awaiting approval from one approver to a new approver.
This lets you keep your documents moving when the original approver
of a document is unavailable.

p» To mass forward documents:

1. Select Forward Documents from the menu. Purchasing displays
the Enter Approver modal window, where you must provide the
name of the original Approver and select OK to display the
Forward Documents window.

%Furward Documents (Vision Operations) - Black, Mr. Chris

W= Abbott, Ms. Rachel
Mote

Forward Date Murnber
04/JUL/2000 Standard Purcl 1000872 50.00 |\ PRE-APPROVED
05/ JUL22000 Standard Purc 1000912 500.00 jIH PROCESS

e

[

|
|

_
_
_

L

Change Approver ...

For each document available for forwarding, Purchasing displays
the Forward Date, document Type, document Number, Currency,
Amount, Status, From person, Note, document Description,
document Owner, and Creation Date.
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2. Select the documents you want to forward.

3. Enter the New Approver to whom you want to forward the
selected documents.

4. Save your work.

p To change the original approver:

m  Select the Change Approver button to display the Enter Approver
modal window, where you can change the original approver for
whom the Forward Documents window displays documents
available to be forwarded.

» Toview action history:

m  Select View Action History on the Tools menu. See: Viewing
Action History: page 8 - 2.
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Document Control Overview

Purchasing allows you to control the status of your requisitions,
planned and standard purchase orders, blanket and contract purchase
agreements, and releases during the document life cycle.

Purchasing provides you with the features you need to satisfy the
following basic needs. You should be able to:

Delete unapproved documents or unapproved lines, shipments,
and distributions that you add to previously approved
documents

Terminate existing commitments to buy from suppliers by fully
or partially cancelling your documents

Indicate that no further internal activity is expected or allowed
on completed orders by final closing them

Freeze or unfreeze documents to control whether modifications
are allowed

Place documents on hold to prevent printing, receiving,
invoicing, and approval until the hold is removed

Firm purchase orders to prevent Oracle Master Scheduling/MRP
and Supply Chain Planning from suggesting reschedules in,
cancellations, or new planned purchase orders within the time
fence created by your firm date

Control how Purchasing automatically closes documents for
receiving and invoicing activity

Document Security determines the documents on which you can
perform control actions. See: Document Security and Access: page

2-10.

See Also

Controlling Documents: page 2 — 55

Document Control Options

Delete

Before documents are approved, you can delete them or their
components from the document entry window.
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Example

= Attention: If you are using automatic humbering, you cannot
reuse document numbers that you delete with this option.

You can also use the appropriate entry window to delete unapproved
lines, shipments, and distributions that you added to previously
approved documents.

If you use online requisitions, Purchasing returns all requisitions
associated with your delete action to the requisition pool. You can
reassign these unfilled requisitions to other purchase orders or releases
using the AutoCreate Documents window. See: Finding Requisition
Lines for AutoCreate: page 6 — 12.

Cancel

Purchasing lets you terminate an existing commitment to buy from a
supplier by cancelling document headers, lines, shipments, or releases.

When you cancel a purchase order entity, you are unable to receive or
pay for cancelled items and services, however, you can pay for all
previously received orders. You also cannot modify a cancelled entity
or its components. For example, if you cancel a line you cannot modify
the associated shipments and distributions. If you cancel a document
header, you cannot access the document in the corresponding entry
form. You can approve documents that include cancelled entities (lines
and shipments), but you cannot approve documents that are cancelled
at the header level. You can also print cancelled documents.
Purchasing marks these documents with a cancellation notice to
highlight this action to the supplier. Finally, you can Purge documents
that were cancelled at the header level before the Last Activity Date
that you specify when you submit Purge. See: Printed Purchase Order
Overview: page 4 - 112. See: About Purging Records, Oracle Public
Sector Payables User’s Guide.

If you are using encumbrance and budgetary control, Purchasing
automatically creates negative debit encumbrance journal entries in
your general ledger system to reverse the encumbrance that
corresponds to the document header, lines, or shipments you are
cancelling.

If you are using online requisitions, Purchasing returns unfilled
requisitions associated with cancelled purchase order entities to the
requisition pool based on the Cancel Requisitions control you specify in
the Purchasing Options window. See: Defining Control Options: page
1-49.

You order 100 items from a supplier, and after receiving 30 of these
items, you realize that you no longer have a need for the outstanding
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balance. Cancel the remaining 70 items, print the purchase order, and
send it to the supplier to indicate contractually that you do not want to
take delivery of these items.

You should cancel documents or their components only if you are
absolutely certain that all desired activities have been completed; you
cannot undo a cancel action.

You can cancel an entire requisition or particular requisition lines.
However, you cannot cancel a requisition line a buyer placed on a
purchase order, modified during AutoCreate, or placed on a sales
order.

If a buyer places a requisition line on a purchase order, you cannot
cancel the requisition line or the corresponding requisition header until
you cancel or final close all purchase order lines associated with the
requisition.

Similarly, you cannot cancel a requisition if any of its lines are on an
active internal sales order. However, if the related internal sales order
is cancelled, you should cancel the originating requisition line.

When you cancel a requisition related to a cancelled sales order, the
quantity cancelled on the requisition line is the same as the quantity
cancelled on the sales order line, not the remainder of the requisition.

You cannot cancel a purchase order if there are batch receiving
transactions in the receiving interface awaiting processing against the
purchase order.

If you partially received a shipment corresponding to multiple
distributions, Purchasing cannot always cancel the shipment. To make
sure Purchasing can cancel a shipment, enter the delivery transactions
for the receipts you entered against that shipment. You can use express
delivery to facilitate this process.

Use the Control Document window to cancel a single document or its
entities. Use the Define MassCancel and Run MassCancel windows to
cancel many documents by accounting distribution and date range.
See: Controlling Documents: page 2 —55. See: Defining MassCancel:
page 2 — 60. See: Running MassCancel: page 2 — 65.

Final Close

Prevent modifications to or actions against completed documents,

lines, and shipments by final closing them. Final-closed documents are
not accessible in the corresponding entry forms, and you cannot
perform the following actions against final-closed entities: receive,
transfer, inspect, deliver, correct receipt quantities, invoice, return to
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supplier, or return to receiving. You can approve documents that
include final-closed entities, but you cannot approve documents that
are final closed at the header level. You can print final-closed
documents; this is an internal control action that has no bearing on
your contractual relationship with the supplier. Finally, you can Purge
documents that were final closed at the header level before the Last
Activity Date that you specify when you submit Purge. See: About
Purging Records, Oracle Public Sector Payables User’s Guide.

You should final close documents or their components only if you are
absolutely certain that all desired activities have been completed; you
cannot undo a final-close action.

If you are using encumbrance and budgetary control, final close
automatically creates credit encumbrance journal entries in your
general ledger system to reverse the encumbrance that corresponds to
the document header, lines, or shipments you are final closing.

If you are using online requisitions, Purchasing does not return unfilled
requisitions associated with final-closed purchase order entities to the
requisition pool. You must cancel or final close these requisitions using
the Control Document window. See: Controlling Documents: page
255,

Payables can also final close documents during Payables Approval for
purchase order matched invoices only, if you select Allow Final
Matching in the Payables Options window. See: Payables Options,
Oracle Public Sector Payables User’s Guide.

You can final close an entire requisition or particular requisition lines.
However, you cannot final close a requisition line a buyer placed on a
purchase order, modified during AutoCreate, or placed on a sales
order.

If a buyer places a requisition line on a purchase order, you cannot final
close the requisition line or the corresponding requisition header until
you cancel or final close all purchase order lines associated with the
requisition.

Similarly, you cannot final close a requisition if any of its lines are on an
active internal sales order. If the related internal sales order is closed,
you can final close the originating requisition line.

You cannot final close a purchase order if there are batch receiving
transactions in the receiving interface awaiting processing against the
purchase order.
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Example

Example

Freeze

Freeze your purchase orders and releases to prevent changes or
additions while maintaining the ability to receive and match invoices
against received shipments. You cannot access frozen documents in the
entry forms.

Use the Control Document window to freeze or unfreeze a document.
See: Controlling Documents: page 2 — 55.

Hold

Place documents on hold to unapprove them while preventing
printing, receiving, invoicing, and future approval until you remove the
hold.

After sending a purchase order to a supplier and receiving some items,
you discover a severe quality problem with one of the incoming lots.
While you wait for corrective action from the supplier, place the
document on hold until the problem is resolved.

Use the Control Document window to place a document on hold, or
remove a hold. See: Controlling Documents: page 2 — 55.

Firm

When you firm an order, Master Scheduling/MRP uses the firm date to
create a time fence within which it will not suggest new planned
purchase orders, cancellations, or reschedule-in actions. It continues to
suggest reschedule-out actions for orders within the time fence. If
several shipments with different promised or need-by dates reference
the same item, Master Scheduling/MRP sets the time fence at the latest
of all scheduled dates.

You can firm orders at the document header or shipment level. If you
firm at the header level, Purchasing applies this control to every
shipment on the document.

When you negotiate delivery dates for an allocated commodity, the
supplier warns that you will be unable to expedite or cancel this order.
Firm the order to prevent Master Scheduling/MRP from assuming you
have this flexibility in its planning logic.

Use the relevant document entry window to firm a given order. See:
Entering Purchase Order Details Information: page 4 — 61. See:
Entering Release Headers: page 4 — 90.

You can also create firm time fences for specific items using the Item
window. See: Defining Items, Oracle Inventory User’s Guide.
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Close, Close for Receiving, Close for Invoicing

Purchasing automatically closes shipments for receiving and invoicing
based on controls that you specify in the Purchasing Options window.
Once all shipments for a given line are closed, Purchasing
automatically closes the line. When all lines for a given header are
closed, Purchasing automatically closes the document.

You can specify closing controls including: Receipt Close Tolerance,
Receipt Close Point, and Invoice Close Tolerance. See: Defining
Purchasing Options: page 1 —45.

e The Receipt Close Tolerance lets you specify a quantity
percentage within which Purchasing closes a partially received
shipment. For example, if your Receipt Close Tolerance is 5%
and you receive 96% of an expected shipment, Purchasing
automatically closes this shipment for receiving.

¢ The Receipt Close Point lets you choose which receiving action
(Received, Accepted, or Delivered) you want to use as the point
when Purchasing closes a shipment for receiving based on the
Receipt Close Tolerance. For example, if you set a Receipt Close
Tolerance of 5% and choose Delivered as your Receipt Close
Point, Purchasing closes shipments for receiving when you have
delivered 95% or more of the ordered quantity.

e The Invoice Close Tolerance lets you specify a similar quantity
percentage within which Purchasing automatically closes
partially invoiced shipments for invoicing.

Purchasing does not include closed shipments in the Open Purchase
Order reports, and you can purge documents that were closed at the
header level before the Last Activity Date that you specify in the
Submit Purge window. See: About Purging Records, Oracle Public
Sector Payables User’s Guide.

You can close and reopen documents and their components for
invoicing and receiving using the Control Document window. You can
reopen a document at any time by modifying it or taking another action
against it. See: Controlling Documents: page 2 — 55.

Note: The Close for Invoicing status does not prevent you from
matching an invoice to a purchase order or to a receipt.
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Purchase Order Control Matrices

The following matrices describes each of the purchase order control
functions including information on where the control is specified, what
purchase order activities can occur when a document is in a given state,
the related MRP/ATP effects, related encumbrance effects, and finally,
related requisition effects.

Control Details Actions
Close Close for Invoicing Close for Receiving
Document available to Yes, if header final closed No No
purge? before Last Activity Date
Modify controlled entity? Yes Yes Yes
Action causes revision No No No
change?
Print document? Yes Yes Yes
Receive against controlled Yes Yes Yes
entity?
RTV against controlled Yes Yes Yes
entity?
Invoice against controlled Yes Yes Yes
entity?
Does document maintain its Yes Yes Yes
approval status?
AutoCreate or Release Yes Yes Yes
against document?
MRP/ATP Effect Closed quantity no No effect Closed quantity no
longer available as longer available as
supply; supply is supply; supply is
recreated when reopened recreated when reopened
Encumbrance Effect No effect No effect No effect
Associated Requisitions No effect No effect No effect

Table2-7 (Pagelofl)
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Actions

Control Details Cancel Finally Close Freeze Hold Firm
Yes, if header Yes, if header
aD\?EfilIJameentto cancelled final closed No No No
urge? before Last before Last
purge: Activity Date Activity Date
. Cannot modify
pee]iyy (e:r?t?tr;oérn?)%?c% entity or below No Yes Yes
ity? inal—
controlled entity? cancelled entity final c_Iosed
entity
Action causes
revision change? LS e A E MU -
Print document? Yes Yes Yes No Yes
Receive against No No Yes No Yes
controlled entity?
RTV against
controlled entity? e e L = LG
Invoice against Yes, against
controlled entity? received qty. e L MY LG
. Yes if header,
Yes,lilrf]eh%arder, line, or
shipmyent is Sl
Does document cancelled; but if f|n;l C(I)?JS%?];I)M Yes, but the No; documents
maintain its you cancel the c)llose the Frozen check on hold require Yes
approval status? header, the header. th box is selected reapproval
Cancelled eagier, he
check box is Closure Status
selected is updated
correspondingly
AutoCreateor | SEREEL | GO losed | release against
S(e)lceuarieeﬁ?’? — doc; cannot doc; cannot frozen Noeffect No effect
' create release create release purchase order
. No effect. MRP will not
Cancelled Finally Closed -
. . MRP can reschedule in
quantity no guantity no
MRPZATP Effect longer available | longer available resstéﬂggile Noeffect Oorri]aer:,ce(lsgle
as supply as supply actions the)

Table2-8 (Page 1 o0f2)
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Control Details Cancel Finally Close Freeze Hold Firm
Outstanding .
Outstanding
E?fcelétm e ?23‘;2:(;2202 encumbrance No effect No effect No effect
. reversed as CR
negative DR
Determined by Not returned to
. Purchasing req pool; must
stoc_lgt_ed Options: Never, manually final No effect No effect No effect
equisitions
Always, close or cancel
Optional associated req

Table2-8 (Page 2 of 2)

Note: Within the time fence created by a Firm order, MRP will not
suggest new planned orders, cancellations, or reschedule—in actions;
but it will suggest reschedule-out actions.

Document Control Applicability Matrix

The Document Control Applicability matrix describes which control
actions are valid for each document type and entity.

Valid Actions
Current Document Type Cancel | Finally | Close | Close for | Close for | Freeze | Hold Firm
Close Invoice Receipt

Planned PO Header X X X X X X X X
Planned PO Line X X X X X
Planned PO Shipment X X X X X X
Standard PO Header X X X X X X X X
Standard PO Line X X X X X
Standard PO Shipment X X X X X X
Blanket Agreement Header X X X X X X
Blanket Agreement Line X X X
Contract Agreement Header X X X X X
Release Header X X X X X X

Table2-9 (Pagelof2)
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Current Document Type Cancel | Finally | Close | Close for | Close for | Freeze | Hold Firm
Close Invoice Receipt
Release Shipment X X X X X X
Requisition Header X X
Requisition Line X X

Table2-9 (Page 2 of 2)

Document Control Status Check Matrix

Purchasing performs a status check on all documents when you choose
a control action. This check verifies that the document is in a valid
state to perform the selected control action. If your document fails the
status check, Purchasing provides an error message in the window in
which you are working.

The following matrix describes the valid actions for each possible
document state. Generally, Purchasing restricts the list of available
actions based on document status, so you should rarely encounter
problems in the status check.

Valid Actions
Current Document Cancel Finally Close Open Close Close Freeze Hold
Status Close for for
Invoice | Receipt
Incomplete X
In Process X
Approved X X X X X X X
Pre-Approved X X
Rejected X X
Requires Reapproval X
On Hold
Frozen X
Cancelled

Table2-10 (Page1of2)
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Current Document Cancel Finally Close Open Close Close Freeze Hold
Status Close for for
Invoice | Receipt

Finally Closed

Reserved X X X X X X X
Open X X X X X X X
Closed X X X X
Closed for Invoicing X X X X X X X
Closed for Receiving X X X X X X X

Table2-10 (Page2o0f2)

Document Control Submission Check Matrix

2-54

Purchasing performs a submission check on each document for which
you choose a Cancel or Finally Close control action. The submission
check verifies that the document satisfies specific conditions for these
control actions. For example, if you try to cancel a blanket purchase
agreement, the submission check verifies that all releases associated

with this agreement have been cancelled or final closed. If your

document fails any of the submission check rules, Purchasing opens the
View Online Report window where you can review the cause(s) of

failure.

The following matrix describes the submission checks that Purchasing

performs for each document type.

CANCEL Standard Planned Blanket Contract Release Requisition

Shipment quantity received X
must be less than or equal
to quantity ordered

X

Shipment quantity billed X X
must be less than or equal
to quantity ordered

Table2-11 (Page 1of2)
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CANCEL Standard Planned Blanket Contract Release Requisition

Distribution quantity X X
delivered must be less than
or equal to quantity ordered

Distribution quantity billed X X
must be less than or equal
to quantity ordered

Delivery quantity must X X

equal receipt quantity for all

receipts

Cancel date must be within X X X X

accounting distribution
effectivity dates

All associated releases must X X
be cancelled or final closed

All accounting flexfields X X X X
must be valid

FINALLY CLOSE Standard Planned Blanket Contract Release Requisition

Delivery quantity must X X

equal receipt quantity for all

receipts

Cancel date must be within X X X X

accounting distribution
effectivity dates

All associated releases must X X
be cancelled or final closed

All accounting flexfields X X X X
must be valid

Table2-11 (Page 2 of 2)

Controlling Documents

Use the Control Documents window to control requisitions and
requisition lines as well as purchase orders, purchase order lines,
releases, and shipments. For requisitions, the only available actions are
Cancel and Finally Close. Only control options appropriate for the
selected requisition or purchase order are displayed in the Actions
field. The following control actions are available in this window:
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Cancel — If you use on-line requisitions, and you cancel a purchase
order you did not receive or pay at all, Purchasing cancels the
requisition lines associated with the purchase order if the Cancel
Requisitions check box is selected. If the Cancel Requisitions check box
is not selected, the requisition lines are not cancelled and are returned
to the pool of available requisitions. You can then assign these
requisition lines to new purchase orders to fulfill your requestors’
needs. See: Defining Control Options: page 1 — 49.

If you use on-line requisitions, and you cancel a partially received
purchase order line, Purchasing recreates requisition lines for the
remainder of the maximum of the billed or received quantity you have
not received. You can assign these requisition lines to a new purchase
order line to fulfill the requestor’s needs. See: Autocreate Document
Options: page 6 — 4.

If you are using encumbrance or budgetary control, Purchasing
automatically creates negative debit entries in your general ledger
system to cancel the encumbrance that corresponds to the purchase
order header, lines, or shipments you are cancelling, using the action
date you specify in Action Date. Purchasing recreates requisition
encumbrances for the requisition lines you used to create the purchase
order if the Cancel Requisitions check box is not selected. Purchasing
uses the distributions from your cancelled purchase order to recreate
the encumbrance for your requisition. See: Budgetary Control and
Online Funds Checking, Oracle Public Sector General Ledger User’s Guide.

After you partially or completely cancel a purchase order, you need to
inform your supplier of the cancellation. You can reprint purchase
orders or releases you partially or completely cancelled. Purchasing
automatically prints a cancellation message on the purchase order,
purchase order line, purchase order shipment, or release you cancelled.

You can source a requisition line from a line in the Prior Purchases
region of the Supplier Item Catalog window. (A line in the Prior
Purchases region corresponds to a purchase order line.) However,
Purchasing does not automatically update the corresponding sourcing
information if you cancel a blanket agreement or agreement line with
which you source requisition lines. If you cancel a blanket agreement
or agreement line, be sure to update the corresponding information in
the Requisition Templates or the Sourcing Rules window. See:
Defining Requisition Templates: page 1 — 62. See: Automatic Sourcing:
page 5 - 30.

Close — You can close at the header, release, line, and shipment levels.

Close for Invoicing — You can close for invoicing at the header, release,
line, and shipment levels. Note that if you close for invoicing a
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purchase order header that is currently open, Purchasing sets the status
of all purchase order shipments to Closed for Invoicing, but the
purchase order lines and header remain open. This status will not
prevent you from matching an invoice to the purchase order or to the
receipt.

Close for Receiving — You can close for receiving at the header, release,
line, and shipment levels. Note that if you close for receiving a
purchase order header that is currently open, Purchasing sets the status
of all purchase order shipments to Closed for Receiving, but the
purchase order lines and header remain open.

Finally Close — You can final close at the header, release, line, and
shipment levels. Purchasing automatically closes fully billed and
received purchase orders. However, to prevent further actions on the
purchase order, you should use this window to final close purchase
orders. Finally Close prevents modifications to the purchase order.
Also, if you are using encumbrance or budgetary control, Finally Close
automatically creates credit encumbrance journal entries in your
general ledger system to reverse the encumbrance that corresponds to
the purchase order header, lines, or shipments you are closing, using
the action date you specify in Action Date. See: Budgetary Control
and Online Funds Checking, Oracle Public Sector General Ledger User’s
Guide.

Freeze — You can freeze only at the header and release level. You freeze
a purchase order when you want to prevent any future modifications to
the purchase order. When you freeze a purchase order, you can still
receive and pay for goods you already ordered. If you want to prevent
future receipt or matching invoices against this purchase order, cancel
or final close the purchase order instead.

If you use a Requisition template or source requisition lines from a
purchase order line, Purchasing does not automatically update the
corresponding sourcing information when you freeze a purchase order
with which you source requisition lines. If you freeze a purchase order,
be sure to update the corresponding information in the Requisition
Templates or the Sourcing Rules window. See: Defining Requisition
Templates: page 1 — 62. See: Automatic Sourcing: page 5 — 30.

On Hold - You can place a purchase order on hold only at the header
level. This unapproves the purchase order while preventing printing,
receiving, invoicing, and future approval until you remove the hold.

Open - You can open at the header, line, and shipment levels.

Open for Invoicing — You can reopen for invoicing at the header, line,
and shipment level.
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Open for Receiving — You can reopen for receiving at the header, line,
and shipment level.

Release Hold — You can release a hold only at the header level.

Unfreeze — You can unfreeze only at the header and release levels.

p To control documents:

1. Navigate to the Control Document window by selecting Control
from the Tools menu in the Requisition Headers Summary and
Requisition Lines Summary windows. For purchase orders, you
can navigate to the Control Document window from the summary
windows titled Purchase Order Headers, Purchase Order Lines,
and Purchase Order Shipments.

£E Control Document (VISION OPERATIONS) - 1003624

Cancel PO

Close

Close For Invoice
Close For Receiving
Finally Close
Freeze

Actions

Action Date

Reason

M| Frint docurment

2. Select the control Action.
3. If you selected the Cancel action, you can update the Action Date.

Note: If you are using encumbrance or budgetary control, make
sure the action date you specify lies in an open period.

4. Optionally enter a Reason for the action.

5. If you are cancelling a purchase order, you can enter a Note to
Supplier.
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6. The Cancel Requisitions check box appears only when you have
selected the Cancel action for a purchase order. The operation of
the check box is governed by the Cancel Requisitions flag in the
Purchasing Options window. If this flag is set to Never, the check
box does not appear. If this flag is set to Always, the check box
appears checked when you select the Cancel action, but you cannot
update the check box. If this flag is set to Optional, the check box
appears unchecked when you select the Cancel action, and you can
update it. If the check box is checked, requisition lines associated
with the cancelled purchase order header, line, shipment, or release
are cancelled. If the check box is unchecked, requisition lines
associated with the cancelled purchase order header, line,
shipment, or release are not cancelled and are returned to the
requisition pool. See: Defining Control Options: page 1 —49.

p To cancel control actions:

m  Select the Cancel button to cancel your actions and return to the
previous window.

See Also

Document Control Options: page 2 — 44
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MassCancel

Defining MassCancel

Use the Define Mass Cancel window to specify criteria for cancelling
groups of requisitions or purchase orders that you no longer want to
honor.

You can specify a range of Accounting Flexfields for which to cancel
requisitions or purchase orders. You can use this zone to specify a
range of accounts, programs, projects, or funds, or one account,
program, project, or fund for which to cancel purchase orders or
requisitions. Purchasing selects for cancellation all purchase orders or
requisitions that meet your other selection criteria and have
distributions falling completely or partially within these ranges.

You can define multiple ranges of Accounting Flexfields, each including
both a low and high value for each key segment. Purchasing excludes
all values outside the specified ranges.

When you enter the Include Low field, Purchasing displays a pop-up
window that contains a prompt for each segment you have defined for
your Accounting Flexfield. You enter both the low and high ends of
each range in this pop—up window. After you finish entering each
range, Purchasing displays your low segment values in concatenated
form in the Low field and displays your high segment values, similarly,
in the High field.

Note that Purchasing does not perform checking for incompatible
ranges, so you must take care to insure that your High value is actually
higher than your Low value. Otherwise, no documents will be selected
for MassCancel.

After you specify your cancellation criteria, Purchasing selects all
purchase orders or requisitions meeting your cancellation criteria and
automatically prints the Define MassCancel Listing. This report lists
requisitions and purchase orders that are not cancellable, that fall
partially within your cancellation criteria, and that fully meet your
cancellation criteria. You can cancel purchase orders or requisitions in
the latter two categories using the Run MassCancel window.

To define cancellation criteria:

1. Navigate to the Define MassCancel window from the menu.
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%Deﬁne MassCancel (Vision Operations)
Batch Mame
Document Type Requisition Type [N
®Cancel Backing Reguisition Lines
Creatian Date
Supplier

Include Rules

Lo High
| 100.000.0000.305.000 £ FAFF 305.000

2. Enter the MassCancel Batch Name. Purchasing displays this name
in the Run MassCancel window, where you can choose the batch
for cancellation.

3. Choose one of the following Options:
Requisition — Use this option to submit MassCancel for Requisitions.

Purchase Order — Use this option to submit MassCancel for planned
and standard purchase orders, and blanket purchase agreements.

4. Select Cancel Backing Requisition Lines to indicate that you want
to cancel the backing requisition lines when you cancel a purchase
order. The cursor enters this field only when you choose the
Purchase Order option in this window and then only when the
Cancel Requisitions option in the Purchasing Options window is
set to Optional. In this case, the default is to disable the check box,
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but you can change it. You cannot disable this option when the
Cancel Requisitions option is Always or enable this option when
the Cancel Requisitions option is Never. See: Defining Control
Options: page 1 —49.

If you set the Cancel Backing Requisition Lines option to Never,
when you complete your MassCancel for purchase orders
Purchasing recreates the requisition (and requisition encumbrance
if you use requisition encumbrance or requisition budgetary
control) from which you created your purchase order. Therefore,
you should define and run MassCancel for all your purchase orders before
you define and run MassCancel for your requisitions.

Enter the Start Date and End Date you want Purchasing to use to
choose requisitions or purchase orders for cancellation. The
creation date is the date you created your requisitions or purchase
orders. Purchasing selects requisitions or purchase orders for
cancellation that have creation dates between the start date and
end date you specify here.

For requisitions only, enter the Document Type: Internal or
Purchase.

Enter the Supplier Name for which you want Purchasing to choose
purchase orders for MassCancel. If you specify a supplier name,
Purchasing selects for cancellation all purchase orders for this
supplier that also fit your other cancellation criteria. If you do not
specify a supplier name, Purchasing selects all purchase orders that
meet your other selection criteria. You cannot specify a supplier
name if you are cancelling requisitions.

Enter the Low and High values of your MassCancel rule range.
Neither value has to be a valid Accounting Flexfield value nor does
it have to be made up of valid key segment values.

The lowest and highest possible values in a range are operating
system dependent. The lowest possible value is either the number
0 or the character A. If the lowest value on your computer is the
number 0, then the highest possible value is the character Z. If the
lowest value on your computer is the character A, then the highest
possible value is the number 0. You must determine which
combination is correct for your computer. If you enter the incorrect
combination of lowest to highest, Purchasing displays an error
message so you know your computer accepts the other lowest to
highest range combination. Note that ZZ is a higher value than Z.
If you want to specify a single value to include, enter the same
value in both the Low and High fields.
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Example  You want to cancel all purchase orders you charge to project 305.

You define your Accounting Flexfield as Fund — Account —
Organization — Project. Your computer uses 0 as the lowest value.
You specify the Include Low value as 00-0000-000-305 and Include
High as zz-zz7z77-777-305. Note that if none of the Accounting
Flexfield segments are required, you can have a range of all null
(empty) segments, which in effect means that all accounts are
included in the range.

Overview of Encumbrance Accounting, Oracle Public Sector General
Ledger User’s Guide

Define MassCancel Listing: page 2 — 63
Running MassCancel: page 2 — 65

Define MassCancel Listing

Use the Define MassCancel Listing to review purchase orders and
requisitions you have selected for cancellation using the Define
MassCancel form. Purchasing prints this report automatically after you
define your purchase order or requisition cancellation criteria in the
Define MassCancel window and save your work. The report is in four
sections: Unable to Cancel Requisitions, Unable to Cancel Purchase
Orders, Partially in Range Documents, and Fully in Range Documents.

The Unable to Cancel Requisitions and Unable to Cancel Purchase
Orders sections print documents which fit your selection criteria, but
which are not cancellable by MassCancel for a reason that the report
provides.

Purchasing displays one of the following reasons why you cannot
cancel a requisition:

Included in PO You have matched at least one line of your
requisition to a purchase order. Therefore, you
cannot cancel the entire requisition.

One or more POs  You have one or more purchase orders that have
are created based been created based on this requisition. Therefore,

on this REQ you cannot cancel the requisition.

REQ is either The requisition is either incomplete, cancelled, or
incomplete, final closed. Therefore you cannot cancel the
cancelled, or final

closed
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requisition.

Purchasing displays one of the following reasons why you cannot
cancel a purchase order;

Line Overbilled

Line
Overdelivered

Invalid
Accounting
Flexfield

Shipment Fully
Received

Shipment Fully
Billed

Shipment
Received But Not
Delivered

Oracle Public Sector Purchasing User’s Guide

You have been billed for more goods or services
than you ordered on at least one distribution of
your purchase order.

If you required receipt, you have been billed for
more goods or services than you have recorded
deliveries for at least one distribution of your
purchase order. Therefore, you cannot cancel the
purchase order in its entirety.

You have recorded deliveries in excess of goods or
services ordered for at least one distribution of this
purchase order. Therefore, you cannot cancel the
purchase order in its entirety.

One of the Accounting Flexfields you use for a
purchase order distribution has expired.
Therefore, you cannot create a journal entry using
this Accounting Flexfield. You need to reactivate
the Accounting Flexfield if you wish to cancel this
line.

Purchasing prints this Cannot Cancel Reason only
if you are using encumbrance or budgetary control
for purchase orders.

You have received all the goods or services you
ordered for at least one shipment of your purchase
order. Therefore, you cannot cancel this purchase
order in its entirety.

You have been billed for all the goods or services
for at least one of your shipments for this purchase
order. Therefore, you cannot cancel this purchase
order in its entirety.

If you have been billed for goods or services in
excess of the quantity ordered, Purchasing prints
Line Overbilled as the Cannot Cancel Reason.

You have recorded receipts for some goods or
services on at least one shipment for this purchase
order. You have not recorded delivery of at least
one of these items. Since you have received goods



Report Submission

See Also

Running MassCancel

for this purchase order, you cannot cancel it in its

entirety.
Included in You have been billed for at least one item of your
Invoice purchase order. Therefore, you cannot cancel the

entire purchase order. Purchasing prints this
Cannot Cancel Reason only if you are using
encumbrance or budgetary control for purchase
orders.

The Partially in Range Documents section prints purchase orders or
requisitions having distributions which fall partially in the range of
Accounting Flexfields you selected for cancellation. Column headings
provide you with descriptions of the contents of each column.

The Fully in Range section prints purchase orders or requisitions which
meet all your selection criteria, and whose distributions fall completely
within the range of Accounting Flexfields you selected for cancellation.
Column headings provide you with descriptions of the contents of each
column.

After you review the Define MassCancel Listing, you can complete the
MassCancel process using the Run MassCancel window. You can
cancel only purchase orders or requisitions which are Fully in Range or
Partially in Range.

Since this report is automatically submitted, it is not available in the
Submit Requests window.

Defining MassCancel: page 2 — 60
Running MassCancel: page 2 — 65

Use the Run MassCancel window to cancel a group of purchase orders
or requisitions you have selected for cancellation, usually as part of
your year—end processing. When you cancel purchase orders or
requisitions using this window, Purchasing reverses encumbrances
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associated with your requisitions or purchase orders. If you cancel a
purchase order you created from a requisition, and you are using
requisition encumbrance or requisition budgetary control, Purchasing
allows you to recreate the requisition encumbrance using the
distributions from your purchase order. Therefore, if you are cancelling
both requisitions and purchase orders as part of your year—end processing, you
need to cancel purchase orders before you cancel requisitions.

When you define your MassCancel criteria, you may select some
purchase orders or requisitions for cancellation that Purchasing is
unable to cancel for some reason. Purchasing does not display these
purchase orders or requisitions in this window. However, you can
review the Define MassCancel Listing for purchase orders or
requisitions that are not cancellable, together with the reason why they
are not cancellable. When the concurrent manager runs the
MassCancel process, it checks all the purchase orders or requisitions for
cancellability, using the same checks performed by the Define
MassCancel window. The purchase orders or requisitions that cannot
be cancelled are listed separately in the Run MassCancel Listing.

When you enter a batch name in this window, Purchasing displays the
purchase orders or requisitions that can be cancelled. Cancel Backing
Requisition Lines is checked if this option was selected for the batch in
the Define MassCancel window. For each document, Purchasing
displays the document Type (Requisition, Standard Purchase Order,
Planned Purchase Order, or Blanket Purchase Agreement), document
Number, Creation Date, and Supplier Name. Fully in Range is checked
if all the distributions of this entry fall within all the Accounting
Flexfield ranges you specify in the Define MassCancel window.

When you run MassCancel, Purchasing cancels all purchase orders or
requisitions that are selected. If you are using encumbrance or
budgetary control, Purchasing creates reversal entries for your
commitments and obligations (pre—encumbrances and encumbrances)
when you cancel requisitions and purchase orders, respectively.

Prerequisites

U Defining MassCancel: page 2 - 60
U Define MassCancel Listing: page 2 - 63

To run MassCancel:

1. Navigate to the Run MassCancel window from the menu.
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See Also

Enter the Batch Name of the MassCancel batch you want
Purchasing to use for cancellation. See: Defining MassCancel:
page 2 - 60.

If you are using budgetary control, enter the Cancel Date that you
want Purchasing to use to create reversing encumbrance entries in
your general ledger. Purchasing uses this date to reapply funds to
a specific period. The date you enter must be in an open
purchasing period.

Deselect each entry you do not want to cancel. If you save your
work without running MassCancel, your selections are saved and

are redisplayed the next time you query the batch.

5. Select the Run MassCancel button.

To delete the MassCancel batch:

m  Select the Delete MassCancel Batch button to delete the selected
MassCancel batch.

Defining MassCancel: page 2 — 60
Define MassCancel Listing: page 2 — 63
Run MassCancel Listing: page 2 — 67

Overview of Encumbrance Accounting, Oracle Public Sector General
Ledger User’s Guide

Run MassCancel Listing

Use the Run MassCancel Listing to review purchase orders and
requisitions you have cancelled or were unable to cancel using
MassCancel. Purchasing prints this report automatically after you

complete your Run MassCancel process. The listing is in three sections:
Unable to Cancel Requisitions, Unable to Cancel Purchase Orders, and
Cancelled Documents. The Unable to Cancel Requisitions and Unable

to Cancel Purchase Orders sections print documents which fit your
selection criteria but which are not cancellable by MassCancel for
another reason, which the report provides.

Purchasing prints one of the following reasons you cannot cancel a
requisition:
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Included in
Purchase Order

One or more POs
are created based
on this REQ

REQ is either
incomplete,
cancelled, or final
closed

You have matched at least one line of your
requisition to a purchase order. Therefore, you
cannot cancel the entire requisition.

You have one or more purchase orders that have
been created based on this requisition. Therefore,
you cannot cancel the requisition.

The requisition is either incomplete, cancelled, or
final closed. Therefore you cannot cancel the
requisition.

Purchasing prints one of the following reasons you cannot cancel a

purchase order:

Line Overbilled

Line
Overdelivered

Invalid
Accounting
Flexfield

Shipment Fully
Received

Shipment Fully
Billed
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You have been billed for more goods or services
than you ordered on at least one distribution of
your purchase order.

If you required receipt, you have been billed for
more goods or services than you have recorded
deliveries for at least one distribution of your
purchase order. Therefore, you cannot cancel the
purchase order in its entirety.

You have recorded deliveries in excess of goods or
services ordered for at least one distribution of this
purchase order. Therefore, you cannot cancel the
purchase order in its entirety.

One of the Accounting Flexfields you use for a
purchase order distribution has expired.
Therefore, you cannot create a journal entry using
this Accounting Flexfield. You need to reactivate
the Accounting Flexfield if you wish to cancel this
line.

Purchasing prints this Cannot Cancel Reason only
if you are using encumbrance or budgetary control.

You have received all the goods or services you
ordered for at least one shipment of your purchase
order. Therefore, you cannot cancel this purchase
order in its entirety.

You have been billed for all the goods or services
for at least one of your shipments for this purchase



Report Submission

See Also

order. Therefore, you cannot cancel this purchase
order in its entirety.

If you have been billed for goods or services in
excess of the quantity ordered, Purchasing prints
Line Overbilled as the Cannot Cancel Reason.

Shipment You have recorded receipts for some goods or
Received But Not services on at least one shipment for this purchase
Delivered order. You have not recorded delivery of at least

one of these items. Since you have received goods
for this purchase order, you cannot cancel it in its

entirety.
Included in You have been billed for at least one item of your
Invoice purchase order. Therefore, you cannot cancel the

entire purchase order. Purchasing prints this
Cannot Cancel Reason only if you are using
encumbrance for purchase orders.

When you cancel purchase orders or requisitions and you are using
encumbrance or budgetary control, Purchasing creates relieving
encumbrance entries for your purchase orders or requisitions. See:
Overview of Encumbrance Accounting, Oracle Public Sector General
Ledger User’s Guide.

Since this report is automatically submitted, it is not available in the
Submit Requests window.

Defining MassCancel: page 2 — 60
Running MassCancel: page 2 — 65
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Requisitions

CHAPTER

T his chapter tells you everything you need to know about
Requisitions, including:

e Overview of Requisitions: page 3 -2

e Overview of Internal Requisitions: page 3 — 15
e Finding Requisitions: page 3 — 42

e Entering Requisition Preferences: page 3 — 52

e Entering Requisition Headers: page 3 — 57

¢ Entering Requisition Lines: page 3 - 60

e Entering Requisition Distributions:; page 3 — 67

e Using Requisition Templates: page 3 — 72
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Overview of Requisitions

3-2

With on-line requisitions, you can centralize your purchasing
department, source your requisitions with the best suppliers, and
ensure that you obtain the appropriate management approval before
creating purchase orders from requisitions. You can use Master
Scheduling/MRP to generate on-line requisitions automatically based
on the planning requirements of your manufacturing organization. See:
Overview of Implementing Planning Recommendations, Oracle Master
Scheduling/MRP and Supply Chain Planning User’s Guide. You can use
Inventory to generate on-line requisitions based on replenishment
requirements. See: Overview of Inventory Planning and
Replenishment, Oracle Inventory User’s Guide. You can use Work in
Process to generate on-line requisitions for outside processing
requirements. See: Overview of Outside Processing, Oracle Work in
Process User’s Guide. Finally, you can use Purchasing to create internal
requisitions, which are handled as internal sales orders and are sourced
from your inventory rather than from outside suppliers like purchase
requisitions. See: Overview of Internal Requisitions: page 3 — 15.

Purchasing provides you with the features you need to satisfy the
following basic requisition needs. You should be able to:

o Create, edit, and review requisition information on-line. You
should also be able to enter suggested supplier information,
delivery instructions, multiple accounting distributions, and
notes to buyers, approvers, and receivers.

e Review the current status and action history of your requisitions.
You should always know who approves requisitions and
whether they are in the approval, purchasing, receiving, or
delivery stage.

e Route requisitions according to your approval structure. You
should also be able to set authorization limits by amount, charge
account, item category, and location.

e Review and approve requisitions that need your approval. You
should also be able to see the full requisition detail and review
the action history before you approve a requisition.

e Print requisitions (with status Approved, Cancelled, Rejected, In
Process, Pre-Approved, and Returned) for off-line review and
approval. You should always be able to track the status of
requisitions through the approval process.

o Import requisitions from other systems such as material or
distributions requirement planning applications
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Major Features

e Perform on-line funds checking before creating requisitions. You
should always know how your planned expenses compare to
your budget.

e Automatically source requisitions from outstanding blanket
purchase agreements or quotations you have received from
suppliers

e Create requisitions quickly and easily for commonly purchased
items

e Provide attachments as notes on requisition headers and lines

e Assign requisition lines to buyers and review buyer assignments
for requisition lines

e Forward all requisitions awaiting approval from one approver to
an alternate approver. Within your security and approval
constraints, you should be able to reroute requisitions from one
approver to another whenever you want.

e Record suggested foreign currency information for each
requisition line

Eliminate Paper

With Purchasing, your requestors submit requisitions on-line. You
therefore eliminate the need for paper requisitions that you can
misplace or lose during the approval process.

Quick Online Entry

With Purchasing, you can easily create requisitions on-line. Complete
a requisition for any item by simply entering the requestor name, item
description, delivery location, price, delivery quantity, and accounting
distribution. Purchasing uses the Account Generator to enter the
distribution automatically whenever possible.

Approval Status

Purchasing automatically displays the approval status of your
requisition and informs you whether it is Approved, Cancelled, In
Process, Incomplete, Pre—-Approved, Rejected, or Returned. You know
where your requisition is at all times.
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Action History

Purchasing lets you review the action history of requisitions as they
move through the approval process. Purchasing uses your security and
approval structure to help you forward requisitions. On-line
notifications keep your requisitions moving. If someone rejects a
requisition, you always know who and why.

Easy Resubmission

Purchasing lets you resubmit a rejected requisition for reconsideration.
Depending on how you define system setup options, resubmitted
requisitions return either to the original approver for reconsideration or
to an alternate approver that you choose.

Easy Cancellation / Final Close

Purchasing lets you cancel or final close a requisition or requisition line
before your manager approves it or before a buyer places it on a
purchase order.

If you are using encumbrance or budgetary control, Purchasing
automatically creates negative debit encumbrance entries for the
cancelled requisitions. When you final close a purchase order,
Purchasing creates credit entries which reverse the encumbrances.

Easy Assignment

Purchasing lets you assign requisitions to specific buyers and review
which requisitions are Assigned and Unassigned.

Accurate Accounting

Purchasing uses the Account Generator to automatically supply
accounting information as part of a requisition. You can allocate line
item quantities to cost centers, organizations, projects, or departments.
You can also create multiple distributions for a single item. For
instance, you can allocate a computer system purchase across more
than one department or organization

Maximum Flexibility

Purchasing provides maximum flexibility by letting requestors create
requisitions quickly and add details later. In the requisition header and
on each line item, Purchasing provides space for descriptions and notes
to approvers, buyers, and receivers.
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Quick Customization

Purchasing lets you use Descriptive Flexfields to tailor the format of the
requisition header and line blocks to your unique needs without
additional programming.

Online Funds Availability Checking

Purchasing lets you verify whether you have enough funds available in
your budget before you complete a requisition. You can check and
reserve funds for a requisition at any level of a requisition.

Online Approvals

Purchasing lets you approve or reject requisitions on-line. You can
access full requisition detail and prior action history to review the full
detail before making an approval decision. Depending on your
approval controls, you may be able to update a requisition before you
approve it.

Requisition Templates

This feature, accessible through the Supplier Item Catalog, lets you
quickly create requisitions for commonly purchased items. Buyers
create templates that group commonly ordered items like office
supplies into one place.

Quantity Rounding

If Quantity Rounding for inventory sourced lines is enabled in the
Purchasing Options window, Purchasing either displays the rounded
quantity you should have entered in a warning message or it updates
the quantity to the appropriate rounded quantity. The rounding is
based on the Unit of Issue (or primary unit of measure if the Unit of
Issue is not defined) and the Rounding Factor defined for the item in
Inventory. Rounding is up or down to the nearest whole Unit of
Issue/primary unit of measure using the rounding factor.

Requisition Printing

Purchasing provides a requisition printing capability to provide hard
copy requisitions. You can print requisitions after completing them, or
have somebody print and distribute all requisitions. Use the Printed
Requisitions Report to print the requisitions which have the following
status: Approved, Cancelled, Rejected, In Process, Pre-Approved, and
Returned. The report does not include requisitions with status
Incomplete.
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Quick Access to Particular Requisitions

You can place requisitions that you reference frequently in the Oracle
Applications Navigator. Placing documents in the Navigator is useful
when you need to query large documents with multiple lines,
shipments, or distributions. When the requisition is open, choose Place
on Navigator from the Action menu. When you choose the Documents
tabbed region in the Navigator, you can then access that document
directly from within the Navigator. You can also do this with purchase
orders. See: Using the Navigator’s Documents Region, Oracle
Applications User’s Guide.

Note: Once you place a document in the Navigator, it is the first thing
you see in the Navigator the next time you log into Purchasing. Choose
Functions to return to the Purchasing menu.

Requisition Import

Using Requisition Import, you can import requisitions from other
Oracle Applications or from non-Oracle systems. Requisition Import
lets you integrate Purchasing with new or existing applications such as
Material or Distribution Requirement Planning systems. You can
import requisitions as often as you want. Then, you can review or
place these requisitions on purchase orders. See: Requisition Import
Process: page 9 — 144

Master Scheduling/MRP, Work In Process, Order Management, and
Inventory all provide requisition information to the requisition
interface table from which Requisition Import creates requisitions.
While requisitions can be imported with any approval status, they are
most commonly approved since they correspond to specific production
schedules, outside processing, or stock resupply. However, if you are
using requisition encumbrance, Requisition Import changes the
Approved status to Pre-Approved so that you can reserve funds for
the requisition.

Requisition Types

Benefits of On-line Requisitions

You can save time, money, and paper by processing requisitions
on-line. With a paper system, you must provide forms to the
requestor, the requestor must send the form to someone else to be
approved, and the buyer must manually consolidate requisitions to
place on a purchase order. Throughout all of these transactions, you
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may generate a number of errors, waste time, and lose money. Some of
the many problems you may incur with paper requisitions include:

e The requestor may not fill in the requisition completely or
accurately.

e The requestor’s handwriting may be illegible.

e Someone without proper authority can potentially approve a
requisition.

e The requestor might have to mail the requisition to an approver
at a different location and wait a number of days to get it back.

e The approver or buyer may lose or damage the requisition.

e The buyer may translate the information from the requisition to
the purchase order incorrectly.

¢ You may lose significant quantity discounts if the buyer cannot
locate all the requisitions that reference a particular item.

Implementing On-line Requisitions

Many organizations want to provide on-line requisitions to everyone in
the agency. Others want to limit the number of users who have access
to the system. Purchasing is flexible enough to meet the needs of your
organization. To give everyone access to the system, simply create a
user name for each employee in the organization and assign the
employee the appropriate responsibilities. You can easily designate a
smaller group of individuals as requisition preparers if you want to
limit the number of requestors on the system. These people can create
requisitions for anyone in the organization by identifying the
appropriate requestor directly on the requisition line. You might also
want to limit some preparers to internal requisitions and others to
purchase requisitions. You can also print requisitions to obtain
signature approvals if some of the approvers do not have access to the
system. You can then assign an individual to update the authorization
status for these requisitions.

Purchase Requisitions

Use the Requisitions window to create requisitions. You must choose
the requisition type (internal or purchase). You can also provide a
description, unlimited notes, and defaults for requisition lines. For
each requisition line, you choose the item you want to order along with
the quantity and delivery location. You can get sourced pricing from
catalog quotations or open blanket purchase agreements. You can also
choose a price from a list of historical purchase order prices. In the
Distributions window, you can charge the item to the appropriate
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accounts, or you can let the Account Generator create the accounts for
you. Once you complete the requisition, you send it through the
approval process. See: Entering Requisition Lines: page 3 — 60. See:
Using the Account Generator in Oracle Public Sector Purchasing: page
c-9.

Internal Requisitions

Unlike purchase requisitions, which are supplied from purchase orders,
internal requisitions are supplied from internal sales orders. Internal
requisitions are not picked up when you AutoCreate RFQs or purchase
orders, nor can they be assigned to a buyer in the Assign Requisitions
window. See: Internal Requisitions Overview: page 3 — 15.

Requisition Templates

Use the Requisition Templates window to define requisition templates
for items you purchase frequently. For example, if you frequently buy
certain office supplies, you can set up an office supplies template for
your requestors. This template consists of a list of all items, prices, and
sourcing information you want available to the requestor. When you
want to order items from this template, use the Supplier Item Catalog,
choose the office supplies template, and indicate the quantity you want
to order. Purchasing supplies default sourcing and delivery
information. See: Defining Requisition Templates: page 1 — 62.

Imported Requisitions

Purchasing lets you import or reschedule requisitions from other
Oracle or non-Oracle systems. See: Requisition Import Process: page
9 —144. For example, Work in Process uses Requisition Import to
create requisitions for outside processing. See: Overview of Outside
Processing, Oracle Work in Process User’s Guide. Similarly, Master
Scheduling/MRP automatically creates requisitions using Requisition
Import when you mass load purchase requisitions. Master
Scheduling/MRP also automatically reschedules existing requisitions
by updating the need-by date during this process. See: Overview of
Implementing Planning Recommendations, Oracle Master
Scheduling/MRP and Supply Chain Planning User’s Guide. If you are
using Inventory, you can send a requisition requirement to Purchasing
and then run Requisition Import in Purchasing to create the requisition.
See: Overview of Inventory Planning and Replenishment, Oracle
Inventory User’s Guide.
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Paper Requisitions

You do not need to create a requisition on-line to purchase an item.
Instead, you can reference a paper requisition number directly on the
purchase order Distribution Details. See: Entering Purchase Order
Distributions: page 4 — 77. Later, you can use the Purchase Orders
window to review the status of the purchase orders referencing the
paper requisitions.

Reserving Funds for Requisitions

See Also

Purchasing lets you reserve or encumber funds for requisitions. If you
are using budgetary control, you can also check to see whether funds
are available before you encumber the requisition. If you have
problems reserving funds for a requisition, the Approval Errors
window lets you review the reasons.

Purchasing automatically transfers the encumbrance from the
requisition to the purchase order when you successfully approve the
purchase order on which you placed the requisition. Purchasing also
automatically transfers the encumbrance back to the requisition when
you cancel the purchase order. See: Overview of Encumbrance
Accounting, Oracle Public Sector General Ledger User’s Guide.

Note: Even if someone with sufficient approval authority approves a
requisition, its status may still be Pre—Approved if funds were not able
to be reserved at the time of approval. A Pre—Approved requisition
does not show up as supply until its status changes to Approved. Once
funds are reserved for the Pre—Approved requisition, the requisition’s
status changes to Approved and shows up as supply.

Changing Encumbered Documents: page 4 — 135.
The Document Approval Process: page 2 — 24

Requisition Import Process: page 9 — 144

Reviewing Requisitions

After you create a requisition, you can query the requisition at any time
to review the status, action history, or problems with encumbering
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funds. Use the Requisition Summary windows to review requisitions.
If a buyer has already placed the requisition line onto a purchase order,
you can review the purchase order number. You can also review the
changes that the buyer made to the requisition and the quantity
receivers have delivered. See: Finding Requisitions: page 3 —42.

Use the View Action History window to review the action history of
requisitions. You can navigate to this window from the Tools menu in
many entry windows. You can see who has approved or rejected the
requisition and the corresponding notes the approvers provided. For
Inventory sourced lines, you can review the status of the internal sales
order. See: Viewing Action History: page 8 - 2.

Use the Approval Errors window to review reasons you could not
completely reserve funds for requisitions.

Managing Requisitions

3-10

Purchasing lets you manage requisitions to help buyers save money
and time when creating requisitions.

Sourcing Requisitions

You can suggest buyer and supplier information when creating a
requisition. Simply provide the appropriate information in the Source
Details tabbed region of the Requisitions window. A buyer can then
query all requisition lines based on this information to help consolidate
purchase orders. Alternatively, you can automatically source
requisition line items by using the Sourcing Rule and Approved
Supplier List windows. You use the Approved Supplier List window
to list the primary blanket purchase agreement or catalog quotation for
each item you want to order. When you create a requisition line for any
item that you list in the Sourcing Rule and Approved Supplier List
windows, Purchasing automatically provides suggested supplier,
buyer, and source document information for you. (See: Automatic
Sourcing: page 5 - 30. See: Approved Supplier List: page 5 -42.)
Purchasing also automatically provides the sourcing information if you
use Requisition Import to import requisitions from an outside system.
See: Requisition Import Process: page 9 — 144.

Assigning Requisitions to a Buyer

Purchasing lets you manage the buyers’ workload by reviewing how
many requisition lines are assigned to a particular buyer and
reassigning them to distribute the workload better. You can also
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review how many unassigned requisitions are urgent or are needed
within a certain time limit so that you can assign them to the
appropriate buyers for immediate ordering. See: Finding Requisition
Lines for Review or Assignment: page 5 — 100.

Returning Requisitions

A buyer can return a requisition line to the original preparer instead of
placing it onto a purchase order. Upon returning the requisition line,
the buyer indicates the reason for the return. For example, the
purchase price may exceed the requisition price, or the buyer may
know that the requested item is no longer being purchased. When a
buyer returns an individual requisition line, Purchasing automatically
returns all other lines on the same requisition that are not currently on
a purchase order. Purchasing returns the other lines to let the preparer
decide whether it is still appropriate to order the rest of the requisition
asis. See: Autocreate Purchase Order Options: page 6 — 4.

Referencing Requisition Reports

You can use the Buyer’s Requisition Action Required Report to review
all current requisition lines that are not currently on a purchase order.
You can choose from a number of report setup options to narrow the
search to a particular list of approved requisition lines. You can also
print reports to review requisition status, requisition distribution detail,
and requisition import status. See: Buyer’s Requisition Action
Required Report: page 9 — 23.

Managing Foreign Currency Information

For new requisitions, the initial default is the functional currency
specified in the Financials Options window. You can specify a different
suggested foreign currency for each requisition line.

If you source to a foreign currency blanket agreement or catalog
guotation, Purchasing retrieves the foreign currency information for the
document. Your user—defined preferences for currency are overridden
by the currency information on the source document. This is also true
even if the source document currency is blank (the same as the base
currency).

Purchasing automatically updates the functional unit price if you enter
the foreign currency unit price using the specified rate. Purchasing also
updates the foreign currency price if you update the functional unit
price.

When you AutoCreate new purchase orders, Purchasing converts the
requisition price into a purchase order price based on specified
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currency and rate information. (See: Entering Currency Information:
page 4 — 58.) You cannot specify currency information in AutoCreate if
you are adding requisition lines to an existing document. See:
Entering Document Information and Completing AutoCreate: page

6 — 20.

Purchasing performs price tolerance verification for all currencies and
uses the requisition total in functional currency to verify authorization
limits.

Cancelling Requisitions

With Purchasing, you can submit a requisition for approval and then
cancel the requisition or a requisition line if you no longer want to
order the item. Use the Control Documents window to cancel the
entire requisition or specific requisition lines. Once a buyer places a
purchase requisition line onto a purchase order, you can no longer
cancel the requisition line or the corresponding requisition header.
Similarly, you cannot cancel a requisition line that has been modified
with the AutoCreate Documents window, or a line that is currently on
asales order. See: Controlling Documents: page 2 — 55.

If you cancel an internal sales order or back order that was generated
by an internal requisition, you get a warning message that the order
line is related to a requisition line that is now awaiting cancellation. At
this point, you can navigate to the Control Documents window and
explicitly cancel the requisition line. Alternatively, you can continue
processing sales orders and later use the MassCancel function to cancel
any or all requisition lines awaiting cancellation. See: Defining
MassCancel: page 2 - 60.

When you cancel an internal requisition related to a cancelled sales
order, the quantity cancelled on the requisition is the same as the
quantity cancelled on the sales order, not the remainder of the
requisition. This is because a quantity of goods may have been shipped
but not yet delivered against the requisition. See: Controlling
Documents: page 2 — 55.

If you are using encumbrance or budgetary control, Purchasing
automatically creates negative debit encumbrance journal entries in
your general ledger system to cancel the encumbrance that corresponds
to the requisition header or lines you are cancelling. See: Budgetary
Control and Online Funds Checking, Oracle Public Sector General Ledger
User’s Guide.
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Final Closing Requisitions

Use the Control Documents window to final close requisitions and
requisition lines when you no longer need the items. You cannot final
close a requisition line a buyer placed on a purchase order, a line that
has been modified with the AutoCreate Documents window, or a line
that is currently on a sales order. Purchasing automatically creates
credit encumbrance journal entries to reverse the encumbrance that
corresponds to the requisition header or lines you are final closing.

Updating Requisitions

Updating Incomplete Requisitions

As a requisition preparer, you can change the information on a
requisition before you send it through the approval process. To update
a requisition you created using the Requisitions window, simply
navigate to the Find Requisitions window and query up the requisition.
Once you send a requisition through the approval process, your access
to it is determined by the security and approval structure.

Recreating Requisitions

When you cancel a purchase order line in the Control Documents
window, you have the option to either have the referencing requisition
lines cancelled or return them to the requisition pool for placement on
another purchase order. If you have already partially received the item,
Purchasing recreates the requisition line for the unreceived quantity.
See: Controlling Documents: page 2 — 55.

Using Modify to Update Requisitions

A buyer may want to alter a requisition line before placing it onto a
purchase order. The buyer can either return the requisition line to the
preparer for changes or simply choose Modify from the Tools menu
while in the AutoCreate Documents window to update the requisition
line. You can split the requisition into multiple lines so that you can
source the requisition across different suppliers. Or, you can change
the requisition line if the preparer did not request the item correctly.
For example, the preparer might order a computer, though you know
you buy computers by ordering the peripherals and keyboards
separately. The preparer can later review the requisition to see the
original requisition line and the changes the buyer made. See:
Additional Autocreate Features: page 6 — 8. You cannot modify
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requisition lines if you are using requisition encumbrance or budgetary
control. See: Autocreate Purchase Order Options: page 6 — 4.

Updating Requisitions During Approval

Instead of approving a requisition, the approver can reject the
requisition and send a note to the preparer to make specific changes.
Alternatively, the approver can make changes directly to the requisition
without rejecting it. From the Notifications Summary window or any
of the requisitions summary windows, the approver can navigate to the
Requisitions window and make the appropriate changes, if Approver
Can Modify is enabled for the document type in the Document Types
window. See: Viewing and Responding to Notifications: page 2 — 31.
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Overview of Internal Requisitions

Major Features

Internal requisitions provide the mechanism for requesting and
transferring material from inventory to other inventory or expense
locations. When Purchasing, Order Management, Shipping Execution,
and Inventory are installed, they combine to give you a flexible solution
for your inter—organization and intra—organization requests. You
should be able to:

e Set up your supply chain and automatically source your
requirements from inventory or suppliers

¢ Define your inter—organization shipping network, and optionally
require that you use internal orders for your inter—organization
transfers

e Use intransit inventory when you want to track items as they
move between organizations

¢ Reduce warehousing, shipping, and handling costs by requesting
items in fixed lot sizes

e Use the same windows for data entry and inquiry that you use
for purchase requisitions and sales orders

e Take advantage of standard requisition and sales order
functionality to suit your individual business requirements

o Automatically generate inventory replenishment requisitions
and fulfill them via internal or external suppliers

e Automatically source MRP generated requisitions to internal or
external suppliers

¢ View the status of requests on-line

e Use internal requisitions to move inventory items from one
inventory organization to another, even if that organization
belongs to a different operating unit, legal entity, or set of books

Complete Item Sourcing Definition

Purchasing and Inventory combine to provide the flexibility you need
to define your item sourcing information. You can use the default
sourcing options to automatically determine the correct source type
and source for your requests. You can specify either Inventory or
Supplier as the default source type, as well as the source organization
and subinventory for internal requests.
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Inter—-Organization Shipping Network

Inventory provides the features you need to define your
inter—organization shipping network. For transfers between two
organizations, you can specify whether to use intransit or direct
shipments. You can also require internal orders for transfers between
specific organizations.

Flexible Processing

You can tailor internal requisition processing to fit your requirements.
You can limit on-line interaction by setting up background processes to
automatically perform specific actions such as creating inventory
replenishment requests and creating internal sales orders in Order
Management. Or, you can take advantage of other features such as
on-line requisition approvals, internal sales order cycles, and on-line
receipt and delivery of internally requested items.

Creating Online Requisitions

You can create on-line internal requisitions for both expense and
inventory destinations using the same windows you use to create
purchase requisitions. You can combine inventory and supplier
sourced requisition lines on the same requisition. Also, Purchasing
uses your item sourcing information to default the correct source type
and supplier for the item and destination. You can define requisition
templates for commonly requested internally sourced items.

Full Unit of Issue Enforcement

Purchasing offers the option of full unit of issue enforcement in which
quantities entered on internal requisitions are automatically rounded to
a full unit of issue defined for the item. You can also set this option to
recommend a rounded quantity on requisitions, but leave the
opportunity to change the recommended quantity. The quantity
rounding is based on the specified unit of issue, if available, otherwise
on the primary unit of measure.

Inventory Replenishment Requisitions

Inventory generates replenishment requisitions through min-max
planning, reorder point planning, subinventory replenishment for
replenishment counts, and Kanban replenishment. Purchasing uses
your item sourcing information to create inter—organization or
subinventory transfer requests. See: Overview of Inventory Planning
and Replenishment, Oracle Inventory User’s Guide. See: Demand for
Internal Requisitions: page 3 — 18.
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MRP Generated Requisitions

MRP generated requisitions are sourced using the same item sourcing
information that you define for inventory replenishment and on-line
requisitions. For ”buy” items, the Requisition Import process uses the
item sourcing information to create either a purchase requisition or an
inter—organization internal requisition for planned orders.

Approvals and Controls

You can control internal requisition approvals and document security
just as you control purchase requisitions. Purchasing gives you the
flexibility you need to set up approvals and limits for internal requests.
You can use the same authorization rules, or you can relax or tighten
controls for internal requisitions.

Creation of Internal Sales Orders

When you approve an internal requisition for a stocked item,
Purchasing translates the requisition into an internal sales order,
providing a link between the end user’s requirement and the physical
demand against Inventory.

Order Management

Once you create an internal sales order from a requisition, you can
manage internal requisitions just as you manage regular sales orders.
You can use Order Management to define order cycles, approvals and
holds to effectively process requisition orders. You can selectively pick
release and otherwise process internal sales orders as easily as you do
regular sales orders.

Complete Requisitions Status Visibility

You get complete visibility on the status of requests through inquiries
and reports. You get on-line visibility to the internal sales order
number, as well as the shipment and delivery status for requisitions.
You can report on backordered items, internal requisition status, and
delivery discrepancies.

Exception Processing

Internal requisitions help you manage exceptions to your normal
business flow. Order Management automatically backorders your
request when you have insufficient supply to fill the internal order by
creating another shipment line for the unavailable quantity. You can
reschedule orders when the shipment date changes, and the expected
arrival date on the intransit shipment is updated automatically.
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Cancellation of Requisitions

You can easily cancel a request if you have a change in requirements or
if you cannot fulfill the entire order. Using Order Management, you
can partially or fully cancel the line quantities on the internal sales
order. You complete the cancellation process by cancelling the original
requisition line in Purchasing.

Using Internal Requisitions

Internal requisitions provide a flexible solution to your inventory
requisitioning needs. You can eliminate user intervention when you do
not need it, such as when you are loading internal requisitions into
Order Management or placing demand. The following sections
describe the entire business and information flow for internal
requisitions, and identifies opportunities for you to simplify
processing.

Demand for Internal Requisitions

Online Requests

Demand for inventory requests can come from several sources. The
primary sources are:

e Online user’s request for stock items out of inventory
¢ Inventory Replenishment Requests

¢ Oracle Master Scheduling/MRP and Supply Chain Planning
generated requisitions

o External system’s requests

On-line requisitions give you the choice of supplier or inventory
sourced requisitions. Default sourcing information is determined by
the requisition type, the item, and the destination of the request. When
you enter a requisition, Purchasing automatically selects the correct
source type and source information for the item and destination.

To restrict certain users to internal requisitions only, set their profile
PO: Legal Requisition Type to Internal. Purchasing then requires that
they source all internally orderable items from inventory. See:
Entering Requisition Headers: page 3 - 57.
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For frequently requested items, you can define requisition templates to
create internal requisitions quickly. Requestors can pull up the
template they need, fill in the need-by date and destination of the
request, and specify the quantity for each desired item.

Internal requisitions also use the Account Generator, which
automatically builds account distributions. You can specify only one
accounting distribution per inventory sourced line. See: Using the
Account Generator in Oracle Public Sector Purchasing: page C - 9.

Inventory Replenishment Requests

Inventory automatically generates requisitions to maintain an item’s
stock level. The requisitions may request stock from an internal
predefined source organization or from an outside supplier. See:
Overview of Inventory Planning and Replenishment, Oracle Inventory
User’s Guide.

Inventory generates replenishment requests automatically using the
following methods:

e Min-Max Planning

e Reorder Point Planning

¢ Subinventory Replenishments for Replenishment Counts
e Kanban Replenishments

All inventory replenishment methods create requisitions via the
Requisitions Open Interface.

= Attention: If the destination subinventory uses locator
control, you must specify a primary locator for direct
inter—organization and subinventory transfers.

S~ Suggestion: You can interface with third—party systems to
@ enter count information and load it into Inventory using the

Replenishment Interface. Inventory automatically creates
replenishment requisitions using the source and planning
method you define.

Kanban Replenishments

In a pull-based system, inventory items for a particular part or
assembly area are replenished as soon as they are needed. When the
items are needed, kanban cards in Oracle Inventory change their
Supply Status to Empty, and Inventory generates the kanban
replenishment request automatically. Then Requisition Import in
Purchasing validates and imports replenishment requests as
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requisitions. If the Source Type of the request is Supplier, Purchasing
creates a blanket release (if a blanket agreement exists) or a standard
purchase order (if a valid quotation exists) for the item. If the Source
Type is Inter-Org, Requisition Import generates an internal requisition
for the item. See: Overview of Kanban Replenishment, Oracle Inventory
User’s Guide. See: Requisition Import Process: page 9 — 144,

Once Purchasing approves the standard purchase order, blanket
release, or internal requisition, Inventory automatically receives a
status for the kanban card of In Process.

In Purchasing, Kanban replenishment requests look like any other
purchasing document, and you receive them like you do any other
shipment. As soon as you receive the item for delivery through the
Receipts or Receiving Transactions windows in Purchasing, Inventory
automatically receives a status for the kanban request of Full,
indicating that the inventory supply has been replenished.

MRP Generated Requisitions

External Systems

Master Scheduling/MRP creates requisitions for ”buy” items when you
release them using the Planner Workbench. MRP generated
requisitions are sourced using the same rules as on-line and inventory
replenishment requisitions. However, since MRP is planning for the
entire organization, inventory sourced requisitions for MRP planned
orders must be inter-organization transfer requests. You cannot
request subinventory transfers using internal requisitions for MRP
planned orders, unless you specify a nhon-nettable source subinventory
on the internal requisition. See: Viewing On-hand Quantities, Oracle
Master Scheduling / MRP User’s Guide.

You can automatically import internal requisitions from other Oracle
Applications or existing non-Oracle systems using the Requisitions
Open Interface. This interface lets you integrate the Purchasing
application quickly with new or existing applications. Purchasing
automatically validates your data and imports your requisitions. You
can import requisitions as often as you want. Then, you can review
these requisitions, approve or reserve funds for them if necessary, and
place them on internal sales orders. See: Requisition Import Process:
page 9 — 144,
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Internal Requisition Approvals

After you create an internal requisition, you can optionally require
approval. For on-line requests, you can set up approval rules that are
specific for internal requisitions, or you can share the same rules you
use for purchase requisitions. If you do not require additional approval
steps, you can set up rules so that you can always complete and
approve the document in the Requisitions window. See: Entering
Requisition Headers: page 3 — 57.

Min-max planning, Reorder Point planning, and MRP generated
requisitions are loaded as approved requisitions through the
Requisitions Open Interface. If you set the Inventory Profile INV: RC
Requisition Approval to Unapproved, you can optionally load
Subinventory Replenishment requisitions as unapproved and use the
document approval functionality in Purchasing. This profile option
affects only Subinventory Replenishment requisitions. See: Submitting
a Document for Approval: page 2 — 35. See: Oracle Inventory Profile
Options, Oracle Inventory User’s Guide. An internal requisition
corresponding to a kanban card in Oracle Inventory enters Purchasing
through Requisition Import with a status of Approved. (If
encumbrance/budgetary control is on, Purchasing sets the status to
Pre—Approved.) As soon as the internal requisition is approved,
Inventory automatically receives a status for the kanban card of In
Process. See: Demand for Internal Requisitions: page 3 — 18. See:
Requisition Import Process: page 9 — 144.

Requisition supply is created for the destination organization as soon
as the requisition is approved. If you create approved requisitions
through Requisition Import, supply is created at the time the
requisition is created. Master Scheduling/MRP and Inventory
planning get complete visibility to the incoming internal requisition
supply so the planning processes do not create additional reorders for
items that you have already requested.

Creation of Internal Sales Orders

Once you approve inventory sourced requisition lines, Purchasing
translates the requisition into an internal sales order, providing the link
between the requestor’s requirement and the physical demand against
inventory. You run two separate batch processes to create the internal
sales order from the approved requisition:

e Create Internal Sales Orders. See: Create Internal Sales Orders
Process: page 9 — 35.
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e Orderlmport. See: Orderlmport, Oracle Order Management User’s
Guide.

Purchasing uses location associations to create internal sales orders
from internal requisitions for a given deliver-to location. When you
associate a customer and customer site with a location and then enter
an internal requisition with that location as the deliver—to point,
Purchasing uses the associated customer and customer site on the
internal sales order that it creates. The associated customer site
becomes the ship—to site for Order Management’s ship confirmation.
See: Defining Locations: page 1 —24. See: Assigning a Business
Purpose to a Customer Address, Oracle Public Sector Receivables User’s
Guide.

Internal orders are automatically scheduled by setting the Schedule
Ship Date on the sales order to the Need-by Date from the requisition.
If you specify a subinventory on the internal requisition line, Order
Management reserves the goods and uses only the specified
subinventory for allocation. If the goods do not exist at the specified
subinventory, Order Management backorders them, even if they do
exist in another subinventory.

The Create Internal Sales Orders process loads the Order Management
open interface, Orderlmport, using the order type you define in the
Purchasing Options window. See: Defining Internal Requisition
Options: page 1 —52. Orderlmport creates internal sales orders from
the records in the interface table, and determines the order cycle and
defaults values based on the order type.

Note: You should not drop-ship internal sales orders. See: Drop
Shipments: page 4 — 136.

Multi-Org: Creation of Internal Sales Orders Across Operating Units

A Multi-Org implementation of Purchasing enables separate operating
units within an organization to operate independently of each other.
However, you may still need to obtain goods from another operating
unit, and Purchasing supports this. You can create an internal sales
order for an item in another operating unit. When creating this internal
sales order, you must create it in the destination organization’s
operating unit, and all Order Management activity must take place
within that destination operating unit. For example, you have two
operating units; Operating Unit 1 (with Inventory Organization A) and
Operating Unit 2 (with Inventory Organization B). You want to move
an item from Inventory Organization B to Inventory Organization A.
You must use your Order Management responsibility tied to Operating
Unit 1 to create an internal sales order for the item in Inventory
Organization B (in Operating Unit 2). Then you must continue to use
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that responsibility tied to Operating Unit 1 to perform other Order
Management functions for that internal sales order.

Management of Internal Sales Orders

You manage internal sales orders using some of the same windows as
customer sales orders. Once you import an internal requisition using
Orderlmport, you can use the Sales Orders window to change the
reserved quantity, schedule date, ship-to contact, and shipment
priority. The destination organization has complete visibility to any
changes in incoming supply based on schedule date changes or partial
shipments.

Pricing of internal requisitions is based on item costs as they are passed
through Orderlmport; price lists are irrelevant.

Once an internal sales order is scheduled, it is visible as demand. You
can reserve inventory for internal requisitions either to the
organization, or the organization and subinventory levels.

Order Management does not process internal sales order lines for the
Receivables Interface, even if the Receivables Interface is an action in
the order cycle for the internal sales order.

Note: You should not drop-ship internal sales orders. See: Drop
Shipments: page 4 — 136.

Pick Release for Internal Sales Orders

You can directly pick release from the Shipping Transactions window.
Or you can selectively release one internal sales order at a time by
entering the internal sales order number as a pick release criterion. Or,
you can release a group of internal sales orders by specifying the
internal sales order, order type, and a range of dates, or by using the
shipment planning delivery, trip, and trip stop information. You can
also release internal sales orders with customer orders by entering a
range of dates.

When you enter an internal requisition, you must specify the source
organization, and you can optionally specify the subinventory source.
If you do not enter source subinventory information on an internal
requisition, picking proceeds using the standard inventory picking
rules.
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Oracle Shipping Execution releases only order lines which meet the
prerequisites of the order cycle specific to the internal sales order type.

See: Oracle Shipping Execution User’s Guide.

Ship Confirmation for Internal Sales Orders

Use the Shipping Transactions window to ship confirm entire or partial
shipments. You can also backorder the internal sales order when you
do not have enough on-hand quantity to fulfill the request.

Partial shipments are handled by splitting internal order lines into
multiple shipment schedules with different delivery dates. You cannot
change the warehouse or the subinventories on the delivery details.

When you ship confirm, Shipping Execution updates the Inventory
Interface and generates a delivery ship notice outbound (DSNO)
transaction. Inventory automatically updates on-hand quantities to
reflect the internally ordered items that you shipped. If you are
shipping using intransit inventory, the destination organization gets
complete visibility of the incoming intransit supply. Internal
requisition supply is reduced by the quantity of the shipment.

You can also enter the expected arrival date at ship confirmation to
provide a more accurate supply picture to MRP and inventory
planning.

See: Oracle Shipping Execution User’s Guide.

Management of Internal Requisitions

Update Intransit Information

For inter—organization transfers that use intransit, you can use the
Manage Shipments window to update the expected arrival date.
Master Scheduling/MRP and inventory planning get complete
visibility to the change in expected arrival date. See: Managing
Shipments: page 7 — 93.

Receive, Inspect, and Deliver Items

Use the Receipts and Receiving Transactions windows to process
receipts of inter—organization requests that use intransit. Receiving
personnel can simply enter the requisition number on the shipping
documentation and process the entire shipment using express receiving
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transactions. For receipt of partial shipments, you can record the
quantities for the individual items included in the shipment. You can
receive items into receiving, or you can receive the goods directly to the
final destination, either an inventory or expense location.

If you receive items into receiving/inspection, you process inspections,
transfers, and deliveries for internal requisitions just as you would
process supplier receipts or inventory transfers. See: Overview of
Receiving: page 7 - 2.

View Internal Requisition Status

In Purchasing, you can view the internal sales order and any changes to
it, by selecting View Sales Orders on the Tools menu in the Requisition
Lines Summary window. Or, you can access the Sales Orders window
directly in Order Management and query on the specific internal sales
order number, or any other relevant criteria. The Sales Orders window
provides information about the status of the internal sales order,
quantities shipped, quantities cancelled, and dates of transactions.

You can also report on requisition status. See: Backordered Internal
Requisitions Report: page 9 — 18, Internal Requisitions Status Report:
page 9 — 43, Internal Requisitions/Deliveries Discrepancy Report: page
9 - 45, and Requisitions on Cancelled Sales Order Report: page 9 — 149.

Cancelling Internal Requisitions

If you cancel an internal sales order that was generated by an internal
requisition, you get a warning message that the order line is related to a
requisition line that is now awaiting cancellation. You can then use the
Control Document window to cancel the requisition line. See:
Controlling Documents: page 2 — 55.

Purchasing lets you cancel or final close an inventory sourced
requisition line only after you cancel the internal sales order in Order
Management. See: Cancelling Orders, Oracle Order Management User’s
Guide.

Internal Requisitions Processing Summary

Below is a summary of key transactions and processes you use for
Internal requisitions. If you are using inventory replenishment or MRP
generated internal requisitions, Pick Release and Ship Confirmation are
the only required on-line transactions. If you are creating on-line
requests, you also use the Requisitions window. See: Online
Processing Automation for Internal Requisitions: page 3 — 34 for
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suggestions on how to implement automated processing and reduce
on-line interaction.

Step Action Required Window/Process
1 Create Internal Requisition | On-line or | Requisitions window and
Automatic | Requisition Import process:
Inventory replenishment, MRP
Planned Orders, External Sources
2 Approve Requisition Optional Approve Documents window
3 Create Internal Sales Orders | Automatic | Create Internal Sales Orders
process, Orderlmport process
4 Modify Order Schedule Optional Sales Orders window
5 Pick Release Orders On-line Release Sales Orders for Picking
window or Shipping Transactions
window
6 Confirm Pick-Wave Move Optional Transact Move Order window (if
Order not auto—pick confirming from
Pick Release window)
7 Ship Confirmation On-line Shipping Transactions window,
Order Management Interface,
Inventory Interface
8 Receive Items Optional Receipts window, Receiving
Transaction Processor
9 Inspect Receipts Optional Receiving Transactions window,
Receiving Transaction Processor
10 Deliver Receipts Optional Receiving Transactions window,
Receiving Transaction Processor,
Inventory Transaction Processor
1 View Requisition Status Optional Requisition Headers Summary
window, Requisition Lines
Summary window
12 Cancelling Internal Orders Optional Sales Orders window, Control
Document window, Define
MassCancel window, Run
MassCancel window

Table3-1 (Page1of1l)
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Internal Requisitions Setup Overview

Internal requisitions provide a solution to a variety of inventory
requisitioning needs. When you implement this feature, you need to
carefully review the options and configure the applications to support
your business processes.

For example, if you are using internal requisitions to generate
inventory replenishment requisitions and fulfill them via subinventory
transfers within a plant, you may want to limit your on-line interaction
to pick release and ship confirmation. You do not have to record
separate ship, receive, and deliver transactions when the same
employee actually picks the items out of the source subinventory and
places them at the destination in one step.

Product Internal Requisition Setup Function

Order Management Update profile options, Define transaction types, Define
order number sources, Update/define default value rules,
Define price lists, Define Concurrent Program
Resubmission interval for the Orderlmport process

Shipping Execution Define release sequence rules, Define pick slip grouping
rules, Define shipping parameters

Inventory Define internally requested items, Define
inter—organization shipping network, Define item
sourcing, Define Concurrent Program Resubmission
intervals in Inventory planning and replenishment
windows

Purchasing Define Internal Requisition Deliver-To Sites, Set Legal
Requisition Type profile, Define Purchasing Options,
Define Concurrent Program Resubmission intervals for
the Requisition Import and Create Internal Sales Orders
processes

Table3-2 (Page 1o0f1)

Minimum Order Management Setup for Internal Requisitions

You use standard sales order functionality to define transaction types
for internal sales orders. You also need to use the Purchasing Options
window to specify the order type you use for internal requisitions. See:
Defining Internal Requisition Options: page 1 — 52.
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You must perform the following setups in Order Management to use
the internal requisition features. You may choose to take advantage of
other Order Management features which require additional setups.
See: Oracle Order Management Recommended Setup, Oracle Order
Management User’s Guide.

Define Order Management Profile Options

Set the profile option OM: Item Flexfield. This profile option defines
which structure of the item flexfield to use. See: Order Management
Profile Options, Oracle Order Management User’s Guide.

Note that Order Management uses the same set of books as defined in
the System Options window in Oracle Public Sector Receivables. See:
Accounting System Options, Oracle Public Sector Receivables User’s
Guide.

Use the Parameters window in Order Management to define the Item
Master organization for this installation.

3~ Suggestion: Setthe Item Validation Organization to the same
@ Item Master organization as your purchasing reference

organization (set in the Financials Options window). See:
About Financials Options, Oracle Public Sector Payables User’s
Guide.

Define Transaction Types

Use the Transaction Types window to define order and line types.
Order Management provides default order cycle workflows that you
must associate with each order and line type. See: Defining Transaction
Types, Oracle Order Management User’s Guide.

Define an Order Management Number Source For Internal
Requisitions

Define order number sources to automatically number internal sales
orders as you import them. You can use a single order number source
to assign unique numbers to all your orders, or you can use a different
order number source within each order type. See: Defining Order
Number Sources, Oracle Order Management User’s Guide.

Define a Price List For Internal Requisition

Although internal requisitions use the item’s cost as the price, Order
Management requires price lists to process all sales orders. Define a
price list for use with the internal requisition order type. You do not
need to add any lines to the price list. See: Defining a Price List, Oracle
Order Management User’s Guide.

Oracle Public Sector Purchasing User’s Guide



Decide which Default Value Rules to Use

Default value rules define the defaulting that occurs as orders are
entered or imported. Order Management provides default value rules
that you can use for internal sales orders. Confirm that the default
value rules that Order Management provides suit your public sector
needs. If not, use the Defaulting Rules window to modify them.

See: Defining Default Value Rules, Oracle Order Management User’s
Guide.

Define Inventory Accounting (Account Generator)

Order Management can dynamically create the Cost of Goods Sold
(COGS) Account for each shipped or returned item based on rules you
define. Order Management provides a default Account Generator
process to be used in determining the COGS Account during the
Inventory Interface process.

You can either accept the default COGS Account Generator process or
customize it to suit your public sector needs. For more information on
how to accept or customize this feature, see: Using the Account
Generator in Oracle Order Management, Oracle Order Management
User’s Guide.

Internal Sales Orders Processing Constraints (Optional)

Order Management processing constraints apply to all your sales
orders, including internal sales orders imported from Purchasing.
Processing constraints prevent users from adding, updating, deleting
and cancelling order information beyond certain points in the order
cycles. You can use the System rules Order Management provides,
which prevent data integrity violations, or define your own, stricter,
rules. See: Defining Processing Constraints, Oracle Order Management
User’s Guide.

Minimum Shipping Execution Setup for Internal Requisitions
Perform the following steps:
o Define release sequence rules
e Define pick slip grouping rules
¢ Define shipping parameters

See: Oracle Shipping Execution User’s Guide.
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Minimum Purchasing Setup for Internal Requisitions

Define Internal Requisition Deliver-To Sites

Purchasing uses locations to identify the final delivery location for both
inventory and supplier sourced requisitions. As a requestor, you want
to specify the same destination for both purchase and internal
requisitions. As a shipping clerk, you are concerned with the final
delivery location of the item, regardless whether it is for an internal or
external customer. Purchasing and Order Management use location
associations to minimize the decisions you need to make when you
create internal requests.

Use the Location window to define a location for each site that receives
either inventory or supplier sourced material. See: Defining Locations:
page 1 —24. For internal requisition deliver—to locations, you also need
to associate the locations with a customer. Use the Customers window
to define a Customer and Ship-To site for each deliver—to location. Use
the Business Purposes region in the Customers window to associate
your internal locations to your customers. See: Assigning a Business
Purpose to a Customer Address, Oracle Public Sector Receivables User’s
Guide.

s~ Suggestion: Create an internal customer for each destination
@ organization, and customer ship-to site for each deliver-to
location within the destination organization.

3~ Suggestion: Define the same address for the customer ship-to
@ site as the deliver-to location. Order Management prints the
ship-to address on the shipping documentation.

3~ Suggestion: Order Management requires both a ship-to and

@ an invoice-to for each order, even though internal order lines
are not invoiced. When you define a customer, either make the
ship-to address both a ship-to and bill-to business purpose
and set the Primary flag to Yes on the business purpose, or
assign the ship-to to a bill-to location.

Set Up Internal Requisition Approvals and Security

You set up approval and security rules for internal requisitions just as
you do for purchase requisitions. Use the Document Types, Positions,
Position Hierarchies, Approval Groups, and Assign Approval Groups
windows to set up approval and security options for internal
requisitions. See: Setting Up Document Approval and Security: page
2-2.
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Define Purchasing Options for Internal Requisitions

You need to set up these additional purchasing options to use internal
requisitions:

e Order Type

Pick the Order Type you defined in Order Management for
internal sales orders. Purchasing uses this type to create sales
orders from internal requisitions. See: Defining Internal
Requisition Options: page 1 — 52.

¢ Enforce Quantity Rounding
In the Purchasing Options window, specify whether you enforce
lot quantity rounding or display advisory messages when you

create on-line requisitions using the Requisitions window. See:
Defining Control Options: page 1 — 49

Minimum Inventory Setup for Internal Requisitions

Define Internally Orderable Items

When you define internally orderable items, there are a few attributes
that require extra consideration. See: Defining Items, Oracle Inventory
User’s Guide.

¢ Inventory and Order Management regions

Items you use on internal requisitions must be Inventory
enabled, internally orderable and stockable, shippable, and
Order Management transactable for the source organizations.
Under Inventory, you need to select the Inventory Item,
Transactable, and Stockable options. Under Order Management,
you need to select the Internal Ordered, Internal Orders Enabled,
OE Transactable, and Shippable options.

e Source Type — General Planning region
Specify a default source type of Inventory or Supplier.

You cannot create intraorganization internal requisitions for MRP
planned items. When you specify sourcing information for MRP
planned items, you need to ensure that you do not define an
intraorganization sourcing rule for these items.

e List Price — Purchasing region
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Inventory sourced requisitions use item costs for pricing. You
may still want to specify a list price for items that are sourced
both from suppliers or inventory.

e Unit of Issue — Purchasing region

You use units of issue to round order quantities, minimizing
shipping, warehousing, and handling costs.

Enter the unit of measure you typically use to issue the item
from inventory. Purchasing uses this unit of measure as the
default for internal requisition lines sourced from inventory
when you create them in the Requisitions window.

¢ Rounding Factor — Purchasing region

Enter a number between 0 and 1. This factor determines how to
round the quantity on an internal requisition that results from
conversions between the requisition line unit of measure and the
item’s Unit of Issue. This factor ensures that the unit of issue
resolves to an integer, rather than a fractional amount.

Purchasing either performs rounding automatically or advises
you of the suggested quantity, depending how you set up your
purchasing options.

Set Up Item Sourcing

Internal requisitions use the sourcing information you specify in
Inventory. All items, subinventories, and organizations may have item
sourcing information specified for them. At each level (item,
subinventory, or organization), you can choose whether items are
replenished from inventory or purchased from a supplier.

e Source Type

Specify Inventory as the default source type if you want to
source requests from an internal stock location.

e Source Organization and Subinventory

If you specify an item to be replenished from inventory, you
must specify a source organization; a source subinventory is
optional. When you place an order for this item, Inventory
creates an internal requisition for the item from the source
location.

In case of a conflict between the item, subinventory, and organization
levels, internal requisitions use the following order of precedence to
determine the default source type and source for the item and
destination:
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— Sourcing information specified in the item-subinventory
relationship

— Sourcing information specified in the subinventory
definition
— Sourcing information specified in the item definition

— Sourcing information specified in the organization setup
options

Define the Inter-Organization Shipping Network

Use the Shipping Networks window to define your inter—organization
network. You must enable the network between each source (shipping)
and destination (receiving) organization.

¢ Internal Order Required

Select Internal Order Required if you want all transfers between
these two organizations to use internal orders.

e Transfer Type

Specify whether you ship material directly, or use intransit
inventory for shipments between these two organizations.

= Attention: If you use Lot, Serial, or Item Revision Control in
both the source and destination organization, you must use
intransit if you ship from an organization with less control (i.e.
Lot Control), to an organization with more control (i.e. Lot and
Serial Control).

¢ Receipt Routing

For intransit transfers, you can choose from the following
primary receipt routings: Standard receipt, Inspection required,
or Direct delivery.

e FOB Point

Specify whether the destination organization takes ownership of
transferred items when they are issued to intransit (Shipment),
or when they are received out of intransit (Receipt).

e Transfer Charge Type

Specify how you want to apply transfer costs to the destination
organization. Choose either a predefined or requested
percentage of the transaction value or a fixed amount that
represents an added value.
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Set Up a Customer Association

To define your organization as the destination for an internal
requisition, Order Management has to recognize you as a customer.
See: Defining Locations: page 1 —24. See: Assigning a Business
Purpose to a Customer Address, Oracle Public Sector Receivables User’s
Guide.

Online Processing Automation for Internal Requisitions

Internal requisitions provide a number of options to automate
processing. You can set up the following processes to run
automatically as often as you like to limit on-line interaction and
streamline processing. See: Submitting a Request, Oracle Applications
System Administrator’s Guide.

o Reorder Point Planning Report
e Min-Max Planning Report

e Requisition Import

¢ Create Internal Sales Orders

e Orderlmport

back-to-back over specific time intervals when you are using

@ Suggestion: Create a report group to run all requests
internal requisitions for automatic subinventory transfers.

L]
Internal Requisitions Example

Purchasing provides flexible internal requisitions that you can tailor to
meet your needs. Review the example in this section to better
understand how you can use internal requisitions.

You are not required to manage internal requisition activities exactly as
described in the following example. Rather, the objective of these
examples is to highlight the flexibility of internal requisitions across a
variety of situations.

Use the Control Documents window to final close requisitions and
requisition lines when you no longer need the items. You cannot final
close a requisition line a buyer placed on a purchase order, a line that
has been modified with the AutoCreate Documents window, or a line
that is currently on a sales order. Purchasing automatically creates
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Example Overview

credit encumbrance journal entries to reverse the encumbrance that
corresponds to the requisition header or lines you are final closing.

Oracle Manufacturing recommends that you experiment and review the
results of different approaches to determine the best implementation of
the internal requisition functionality for your unique needs. You should
use this example as a starting point to better understand how you
might use internal requisitions.

Global Computers, Incorporated is a computer manufacturer with
organizations in Austin, TX and Sacramento, CA.

The Austin organization repetitively manufactures plastic components
and uses the components, along with purchased items, to assemble
base and cover assemblies in the Sacramento organization. Ownership
of inter—organization transfers between Austin and Sacramento
changes hands at the time of receipt (FOB Point: Receiving).

The Sacramento organization uses the Austin base and cover
assemblies to assemble configurations of Sentinel computers.
Sacramento also has a local sales offices for customer visits and
demonstrations. Your agents distribute sales brochures during
customer visits.

Employees can request Sentinel Computers for their own use, as well
as mouse pads and wrist pads for their offices.

Define the following items at Global Computers:

Item Item Description

Ab4888 Sentinel Base Assembly Assembled in Austin, Sub Assembly of
Sentinel Computer, Internally Orderable
in Austin, Default Source Type of Inven-
tory, Default Source Organization of Aus-
tin, Default Source Subinventory of Re-
petitive Assembly

586662 Sentinel Cover Assembly Sub Assembly of Sentinel Computer,
Assembled in Austin, Internally Order-
able from Austin, Default Source Type of
Inventory, Default Source Organization of
Austin, Default Source Subinventory of
Repetitive Assembly

Table 3-3 (Page 1 of 2)
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Item Item Description

S56302 Sentinel Computer Assembled in Sacramento, Internally
Orderable by Employees

C13139 Hard Drive Used in Sentinel Base Assembly

S85773 Sales Brochure Purchased from external suppliers,
Stocked at Sacramento for internal use,
Limited quantities on hand at the sales
office

M1002 Mouse Pad Purchased from external suppliers,
Stocked at Sacramento for internal use

M1002 Wrist Pad Purchased from external suppliers,
Stocked at Sacramento for internal use

Table 3-3 (Page 2 of 2)
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Define the following subinventories at Global Computers:

Organization Subinventory

Austin AUS-Finished Goods: Contains completed Sentinel
Base Assemblies, Contains completed Sentinel Cover
Assemblies, Tracked — asset subinventory

Austin Repetitive Assembly: Contains Hard Drives for final
assembly in WIP, Uses Min/Max replenishment to signal
replenishment, Request from AUS-Stores subinventory

Austin AUS-Stores: Contains additional supply of Hard Drives,
Tracked — asset subinventory

Sacramento SAC-Finished Goods: Contains completed Sentinel
Computers, Tracked — asset subinventory

Sacramento SAC-Stores: Contains completed Sentinel Base
Assemblies shipped from Austin, Contains completed
Sentinel Cover Assemblies shipped from Austin,
Tracked — asset subinventory

Sacramento Office Supplies: Contains supply of Wrist Pads and
Mouse Pads for internal use, Not tracked — expense
subinventory

Sacramento Storage: Central storage for excess Sales Brochures,
Tracked — asset subinventory

Sacramento Visit Center: Contains local supply of Sales Brochures
for customer visits, Space for only 100 Sales Brochures,
Not tracked - expense subinventory

Table3-4 (Page 10f1)

Inventory Replenishment Request (Manufacturing)

You use one Hard Drive during the assembly of each Sentinel Base
Assembly, and keep a limited supply of the Hard Drives in your
Repetitive Assembly subinventory. As you consume Hard Drives from
the Repetitive Assembly, you want to automatically send inventory
replenishment requests to transfer additional Hard Drives from your
Stores subinventory. The material handler needs to receive the
inventory request and transfer the material before you run into a
shortage situation. You create a report group that submits the
Min-Max Planning, Requisition Import, Create Internal Sales Orders,
and OrderImport processes every two hours.
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As soon as the Hard Drive supply in the Repetitive Assembly
subinventory drops below the minimum quantity, the next run of the
Min-Max Planning process automatically creates a replenishment order
for the reorder quantity. The reorder uses the item sourcing
information to automatically create an intraorganization request in the
Austin plant to move Hard Drives from Stores to the Repetitive
Assembly subinventory. The request is automatically loaded as an
internal requisition and an internal sales order, providing visibility of
the request to the material handlers in the Austin plant.

The material handler also runs Pick Release every two hours to identify
the pull requests from the shop floor subinventory. The next run of
Pick Release creates a move order line for the subinventory transfer of
Hard Drives. The material handler picks the Hard Drives out of the
Stores subinventory, completes a ship confirmation and replenishes the
Repetitive Assembly subinventory before a shortage occurs. At ship
confirmation, the on-hand balances of the two subinventories are
automatically updated.

MRP Generated Inter-Organization Request (Manufacturing)

3-38

You use Oracle Master Scheduling/MRP and Supply Chain Planning in
Sacramento to schedule production of the final assembly of the
Sentinel Computer. The Sentinel Base Assembly and Sentinel Cover
Assembly are provided by the Austin organization, so you define
these items as ”buy” items in Sacramento. You also specify the
following sourcing information for the item:

e Source Type - Inventory
e Source Organization — Austin
e Source Subinventory - AUS-Finished Goods

Master Scheduling/MRP recommends that you produce 400 Sentinel
Computers to fulfill demand over the next four weeks (100 each week),
and you only have 100 Sentinel Cover Assemblies and 100 Sentinel
Base Assemblies on hand in Sacramento. You need five days to ship
material from Austin to Sacramento, so the planner implements
planned orders for 100 Sentinel Cover Assemblies and 100 Sentinel
Base Assemblies for the next three weeks using the Planner
Workbench.

When the planner releases the planned orders for Sacramento, Master
Scheduling/MRP automatically loads the Requisitions Open Interface
and submits Requisition Import. Requisition Import uses the sourcing
information that you set up to create a requisition line for each week
sourced from the Austin AUS-Finished Goods subinventory. In the
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background, the Create Internal Sales Orders and Orderlmport
processes automatically load the internal sales order against the Austin
organization.

What if you have a three day production delay in Austin and you need
to delay the third shipment of Sentinel Base Assemblies for a few
days? Sacramento needs visibility to the delay to adjust the production
schedules of the final assembly of the Sentinel Computers. In Austin,
you can use the Sales Orders window to update the scheduled
shipment date by three days, or choose a different freight carrier for
faster delivery if you need to expedite the shipment to prevent a
shortage in Sacramento. When you ship the third shipment from
Austin, you can update the expected arrival date, giving the planner
and MRP in Sacramento full visibility of supply changes.

Each ship confirmation of the Sentinel Base Assemblies creates an
intransit shipment from Austin to Sacramento. You do not require
inspection of your own inter—organization transfers, so the receiving
clerk in Sacramento receives directly into the Final Assembly
subinventory when the shipment arrives. The intransit inventory
balance is automatically updated and the inter—organization accounting
entries are created along with the receipt transaction.

Inventory Replenishment Request (Office Stock Locations)

In the Sacramento sales office, you use internal requisitions to replenish
your stock of sales brochures in the Visit Center.

Agents use your brochures well, and most customers take brochures
with them after the visit. You want easy access to brochures in the
Visit Center, but only have room for 100 Sales Brochures. You
typically use about 75 a week, but the number fluctuates with sales
activity. Agents take what they need; you do a stock count on Monday
and Wednesday of each week and replenish whenever the stock count
falls below 25.

You need to define min—-max information for the Sales Brochures that
you stock in the Visit Center subinventory. Use the Item
Subinventories window to specify a planning method of Min-max
planning, a minimum quantity of 25, and a maximum quantity of 100.

An assistant counts the Sales Brochures in the Visit Center on
Monday, enters the results (20 remaining) into the Enter Replenishment
Counts form, chooses On—-Hand Quantity as the replenishment
method, and runs the replenishment processor. Inventory
automatically creates one replenishment request in the Requisitions
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Open Interface for 80 Sales Brochures to Visit Center from the Storage
subinventory.

Requisition Import creates an approved internal requisition for
subinventory transfers, and the sales order is automatically loaded.

The material handler reviews the picking slip, pulls the 80 Sales
Brochures from Storage Subinventory and delivers them to the Visit
Center. After delivering the material the handler records the shipment
using the Confirm Shipments window. The shipment, receipt, and
delivery information is recorded at once, and the on—-hand balance of
the Storage subinventory is updated automatically. Inventory
automatically creates the necessary accounting entries to reduce the
overall value of Sales Brochures in the Storage subinventory and
charges the accounts associated with the Visit Center subinventory.

Online Request for Goods out of Inventory

3-40

In Sacramento, you stock low-cost office supplies on site to provide
quick delivery to your employees. Employees can request items that
are sourced from suppliers or inventory, but they do not know the
source type at the time of the request. You also require internal
requisitions to process requests for goods out of the stock locations.
You have an organization policy to always request items from Office
Supplies whenever possible. You do not require any additional
approvals, and a material handler picks the items out of inventory and
delivers them directly to your office. A one day turnaround time is
required for all internal requests.

As a requestor, you want to order the following items to improve your
comfort and productivity:

e Sentinel Computer

¢ Mouse Pad

e Wrist Pad

e Glare Screen (not stocked on site)

Use the Requisitions window to create your request. Since
organization policy dictates that you request items from inventory
whenever possible, the default requisition type is Internal Requisition
and the default source type is Inventory. When you create the four
requisition lines for your items, Purchasing automatically uses the item
sourcing information to source the Mouse Pad and Wrist Pad from the
Office Supplies subinventory, and the Sentinel Computer from the
SAC-Finished Goods subinventory. Since the Glare Screen can only
be purchased from suppliers, Purchasing sets the source type to
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Supplier and uses your sourcing rules and Approved Supplier List
entries to determine the suggested supplier and document information.
See: Automatic Sourcing: page 5 - 30. See: Approved Supplier List:
page 5 —42.

Material handlers need immediate visibility of your requests to be able
to deliver in 24 hours. The system administrator sets the Create
Internal Sales Orders and Orderlmport processes to run every hour for
internal sales orders.

The material handler in charge of the Office Supplies subinventory
runs Pick Release twice a day to generate pick slips. The material
handler reviews the picking slip, pulls the Mouse Pad and Wrist Pad
from Storage and delivers them to your office. After getting your
signature, the handler records the shipment using the Confirm
Shipments window. The shipment, receipt, and delivery information is
recorded at once, and the quantity delivered on the internal request is
updated.

Office Supplies is an expense subinventory, and the correct accounts
are charged when you receive the supplies into this subinventory.
Since you are sourcing from an expense subinventory, ship
confirmation does not generate any accounting entries for the issue of
the items from the Office Supplies subinventory to your office
location.

A separate material handler receives the Sentinel Computer request,
and picks and ships it from the SAC-Finished Goods subinventory.
When you complete the ship confirmation, Inventory automatically
issues the Sentinel Computer out of the SAC-Finished Goods asset
subinventory to the expense location listed on the requisition.
Inventory and Purchasing also record the accounting transactions to
credit the SAC-Finished Goods asset account and debits the
appropriate charge account listed on the requisition.
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Finding Requisitions
Use the Find Requisitions window to:

e Access the Requisitions window.

e Perform requisition inquiries at header, line, and distribution
levels

Depending on the function security assigned to your responsibility, you
have varying levels of access to information. A responsibility defines
an application user’s current privileges while working with Oracle
Applications. See: Function Security for Purchasing: page 1 - 112.

p» To enter search criteria:

1. Navigate to the Find Requisitions window by selecting Requisition
Summary from the menu. Then enter as many as desired of the
search criteria described in the following steps.

%Find Requisitions (Vision Operations)

Requisition Mumber

Freparer .
Buyer é Madifiad
L
L

Reference Mum Irmport Source

Line

Line Type [

Results

ltern, Rey

Category ®Lin

Description ® [istributions

Supplier ltem

2. Enter the requisition number. If you enter a requisition number,
you can also enter a Line number.
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12.

Select the requisition Type (Purchase or Internal).

Enter the Preparer.

Enter the Requestor.

Enter the Buyer.

Select Yes or No to restrict the search to Modified requisitions.
Enter the Reference Number.

Enter the Import Source.

. Enter the Line Type.
11.

Use the tabbed regions to further restrict the search:

¢ Inthe Item region, you can enter the following search criteria:
Item number, Revision number, Category, item Description, and
Supplier Item number.

¢ In the Status region, you can limit the search by Approval status
(Approved, Incomplete, In Process, Pre—Approved, Rejected, or
Returned), Control status (Open, Cancelled, or Finally Closed),
or Reserved status (Yes or No).

¢ In the Date Ranges region, you can enter date ranges for the
following dates: Creation, Need By, and Closed.

¢ In the Sourcing region, you can limit the search by Source
(Supplier or Inventory). For Supplier sourced requisitions, you
can further limit the search by Supplier, Site, and Currency. For
Inventory sourced requisitions, you can further limit the search
by Organization and Subinventory.

¢ In the Deliver To region, you can limit the search by Destination
Type (Expense, Inventory, or Shop Floor), Organization,
Location, and (for Inventory destinations only) Subinventory.

¢ In the Related Documents region, you can limit the search by
Document Type, Document number and Line Number, Purchase
Order number, and drop shipment Sales Order number.

¢ In the Accounting region, you can limit the search by Period, GL
Date, Charge Account, Budget Account, and whether there are
Active Encumbrances (Yes or No).

Select the Results group (Headers, Lines, or Distributions) to
determine which summary window to open. Depending on the
search criteria you have specified, all summary windows may not
be available. For example, if you specify criteria in the Accounting
region, only the Distributions summary window is available.
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13. Select the Find button to initiate the search and open the
appropriate Summary window.

» Toclear existing search criteria:

m  Select the Clear button to clear any existing search criteria.

» Toenter a new requisition:

m  Select the New button to open the Requisitions window. See:
Entering Requisition Headers: page 3 - 57.

See Also

Using the Requisition Headers Summary Window: page 3 — 44
Using the Requisition Lines Summary Window: page 3 — 47
Using the Requisition Distributions Summary Window: page 3 — 49

Overview of Function Security, Oracle Applications System
Administrator’s Guide

Using the Requisition Headers Summary Window

Use the Requisition Headers Summary folder window to:
o View requisition header information.
o Drill down to view requisition line and distribution information.
e Access the Requisitions window for entry of new documents.

o Access the Requisitions, Requisition Preferences, and Control
Document windows for maintenance of existing information.

¢ View information in the Action History window.

» To navigate to the Requisition Headers Summary window:

1. Inthe Find Requisitions window, select Headers in the Results
region and select the Find button to open the Requisition Headers
Summary folder window.
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%R&quisitiun Headers Summary (vision Operations)

Description

Approval Status Creation Date

13/JAN/2001 11:44:32 JUSD

15/JAN/2001 11:33:32 USD

13/JAN/2001 11:32:01 |USD

15/JAN/2001 11:22:48 JUSD

15/JAN/2001 11:19:51 JUSD

13/JAN/2001 10:52:08 |USD

The following information is displayed: requisition Number,
Preparer, Status, Description, Total amount, Currency, Creation
Date, Type, Cancelled status, Finally Closed status, and Reserved
status.

To drill down to view requisition line information:

m  Select the Lines button to drill down to the Requisition Lines
Summary folder window. You can also select View Lines on the
Tools menu to open this window. See: Using the Requisition Lines
Summary Window: page 3 — 47.

To enter a new requisition:
m  Select the New button to open the Requisitions window. See:
Entering Requisition Headers: page 3 — 57.

To open the Requisitions window for the current line:

m  Select the Open button to open the Requisitions window and query
the requisition on the current line. Your options in this window
depend on the status of the requisition and your approval and
security options. For example, if a requisition has a status of In

Requisitions 3-45



See Also

Process, you cannot open it from this window. See: Entering
Requisition Headers: page 3 - 57.

To view requisition distributions information:

m  Select View Distributions on the Tools menu to open the
Requisition Distributions Summary folder window. See: Using the
Requisition Distributions Summary Window: page 3 — 49.

To view action history:
m  Select View Action History on the Tools menu to open the Action
History window. See: Viewing Action History: page 8 - 2.

To view purchase orders:

m  Choose the Lines button to open the Requisition Lines Summary
window. Then select View Purchase Orders on the Tools menu to
open the purchase order.

To view sales orders:

®m  Choose the Lines button to open the Requisition Lines Summary
window. Then select View Sales Orders on the Tools menu to open
the Sales Orders window.

To enter requisition control information:

o Select Control on the Tools menu to open the Control Document
window for the document on the current line. See: Controlling
Documents: page 2 — 55.

To enter requisition preferences:

m  Select Preferences on the Tools menu to open the Requisition
Preferences window. See: Entering Requisition Preferences: page
3-52.

Customizing the Presentation of Data in a Folder, Oracle Applications
User’s Guide

Finding Purchase Orders: page 4 — 19
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Using the Requisition Lines Summary Window

Use the Requisition Lines Summary folder window to:
e View requisition line information.
o Drill down to view requisition distribution information.
o Access the Requisitions window for entry of new documents.

o Access the Requisitions, Requisition Preferences, and Control
Document windows for maintenance of existing information.

e View information in the Action History window.

* View purchase order and sales order information, if the
requisition has been placed on a purchase or sales order.

p To navigate to the Requisition Lines Summary window:

1. Inthe Find Requisitions window, select Lines in the Results region
and select the Find button to open the Requisition Lines Summary
folder window. You can also nhavigate to this window from the
Requisition Headers Summary window by selecting the Lines
button or View Lines on the Tools menu.

%R&quisiﬁun Lines Summary (\ision Operations)

Plastic Stock - White
Plastic Stock - White
Sentinel multimedia
Plastic Stock - White
Plastic Stock - White
SRI'S A ITEM TOP
Hard Drive - 850 MB

L

Distributions
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See Also

The following information is displayed: requisition Number, Line,
Item, item Revision, Category, item Description, quantity Ordered,
quantity Delivered, Type, UOM, Price, Need By date, Requestor,
Total amount, Currency, Modified status, Currency Price, Supplier,
supplier Site, Supplier Item number, Source Document Type, PO
Number, PO Line number, Reference Number, Source Type, Source
Organization, Source Subinventory, Destination Type, Destination
Organization, Deliver To, Destination Subinventory, Finally Closed
status, Cancelled status, and Reserved status.

To drill down to view requisition distribution information:

m  Select the Distributions button to drill down to the Requisition
Distributions Summary folder window. You can also select View
Distributions on the Tools menu to open this window. See: Using
the Requisition Distributions Summary Window: page 3 — 49.

To enter a new requisition:
m  Select the New button to open the Requisitions window. See:
Entering Requisition Headers: page 3 - 57.

To open the Requisitions window for the current line:

m  Select the Open button to open the Requisitions window and query
the requisition on the current line. Your options in this window
depend on the status of the requisition and your approval and
security options. For example, if a requisition has a status of In
Process, you cannot open its line from this window. See: Entering
Requisition Headers: page 3 - 57.

To view purchase orders:
m  Select View Purchase Orders on the Tools menu to open the
purchase order.

To view sales orders:

m  Select View Sales Orders on the Tools menu to open the Sales
Orders window.

Customizing the Presentation of Data in a Folder, Oracle Applications
User’s Guide
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Viewing Action History: page 8 — 2
Finding Purchase Orders: page 4 — 19
Controlling Documents: page 2 — 55

Entering Requisition Preferences: page 3 — 52

Using the Requisition Distributions Summary Window

Use the Requisition Distributions Summary folder window to:
e View requisition distribution information.
e Access the Requisitions window for entry of new documents.

¢ Access the Requisitions, Requisition Preferences, and Control
Document windows for maintenance of existing information.

¢ View information in the Action History window.

p To navigate to the Requisition Distributions Summary window:

1. Inthe Find Requisitions window, select Distributions in the Results
region and select the Find button to open the Requisition
Distributions Summary folder window. You can also navigate to
this window by selecting View Distributions on the Tools menu in
the Requisition Headers Summary and Requisition Lines Summary
windows.
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%R&quisﬂiun Distributions Summary (Vision Operations)

Description

Plastic Stock - White

Plastic Stock - White

Plastic Stock - White

Plastic Stock - White

Sentinel multimedia

Plastic Stock - White

SRI'S A ITEM TOP

Hard Drive - 850 MB

SRI'S A ITEM TOP

See Also

The following information is displayed: requisition Number, Line
number, Distribution number, Item, item Description, UOM, Price,
Quantity, Amount, and Charge Account.

To enter a new requisition:

m  Select the New button to open the Requisitions window. See:
Entering Requisition Headers: page 3 - 57.

To open the Requisitions window for the current line:

m  Select the Open button to open the Requisitions window and query
the requisition on the current line. Your options in this window
depend on the status of the requisition and your approval and
security options. See: Entering Requisition Headers: page 3 — 57.

Customizing the Presentation of Data in a Folder, Oracle Applications
User’s Guide

Viewing Action History: page 8 - 2
Finding Purchase Orders: page 4 — 19
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Entering Requisition Preferences: page 3 — 52
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Entering Requisition Preferences

Use the Requisition Preferences window to enter requisition line
defaults (including currency, destination, project, and sourcing default
information). These defaults are applicable during this user session to
all new requisition lines you create after you set the defaults until you
exit Purchasing. You can override these defaults for specific lines.

p Toenter main preferences:

1. Navigate to the Requisitions Preferences window by selecting
Preferences on the Tools menu in the Requisitions window or in the
Requisitions Headers, Lines, and Distributions Summary windows.
In the Main tabbed region, you can enter the defaults described in
the following steps.

%R&quisitiun Preferences (Vision Operations)

Meed-By .
GL Date Rate Type
Charge Account Rate Date

Currency

Justificatian Rate

Mote Ta Receiver

Reference Mumber Source -
Transaction Nature Buyer
[ Urgent Mote To Buyer

Destination Type - [" RFQ Required

Reguestor Supplier
Organization Site
Locatian Contact
Subinventory Phone

2. Enter the Need By date.

3. Enter the GL Date to be used when funds are reserved. You can
enter a GL Date only if you set up your financials system options to
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10.

11.

use encumbrance or budgetary control for requisitions. See: About
Financials Options, Oracle Public Sector Payables User’s Guide. See:
Budgetary Control and Online Funds Checking, Oracle Public Sector
General Ledger User’s Guide.

Enter the Charge Account for the cost of the items on the
requisition line. The account you enter here is used only for
expense destinations, and it overrides any account built by the
Account Generator.

Enter a Justification for your requisition line. Buyers and
approvers can review this justification.

For Internal requisitions only, enter a Note To Receiver. For
example, you could note that the receiver should unpack your
requested items or that only you can accept delivery. For both
internal and purchase requisitions, you can provide additional
notes to the receiver by using attachments. See: Attaching Notes
to Purchasing Documents: page 1 —44.

Enter the default Reference Number for all requisition lines. You
use the reference number to match your requisition line with a
specific work, project, etc.

Enter the Transaction Nature. See: Defining Lookup Codes: page
1-74.

Check Urgent to indicate that your requisition should be expedited.
Buyers have the option to process urgent requisitions faster when
they AutoCreate purchase orders from requisitions.

Enter a default suggested Currency for the requisition lines. This
must be an enabled code from the Currency window. See:
Defining Currencies, Oracle Public Sector General Ledger User’s Guide.

Enter the default Rate Type. You can also set this default in the
Purchasing Options window. Defining Default Options: page
1-45. Purchasing supplies you with one of two predefined
currency rate types: User or EMU Fixed. A rate type of User
means that you can enter a conversion rate between the foreign
currency (or transaction currency in a document entry window)
and the base currency (or functional currency, defined in your set
of books). A rate type of EMU Fixed means that if either your
transaction currency or your functional currency is Euro (the
European Monetary Unit currency) and the other is another
European currency, Purchasing automatically enters a conversion
Rate Date and Rate for you that you cannot change.
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You can define additional currency rate types in the Daily
Conversion Rate Types window. See: Defining Conversion Rate
Types, Oracle Public Sector General Ledger User’s Guide.

12. Enter the default currency Rate Date.

13. Enter the default currency conversion Rate. Purchasing overrides
this default when you are entering requisition lines if the rate type
is not User and if you have established a rate for the rate type and
date. See: Entering Daily Rates, Oracle Public Sector General Ledger
User’s Guide.

14. Enter the Destination Type to indicate the final destination of the
purchased items:

Expense — The goods are delivered to the requestor at an expense
location.

Inventory — The goods are received into inventory upon delivery.
This option is appropriate only if the item is stock enabled in the
deliver—to organization.

Shop Floor — The goods are delivered to an outside processing
operation defined by Work in Process. This option is appropriate
only for outside processing items.

15. Enter the Requestor. This is the employee who requests the
quantities on the requisition lines. Purchasing copies this name as
the requestor for every requisition line.

16. Enter the Organization. The default is the requestor’s organization.
The List of Values displays all valid receiving organizations.

17. Enter the delivery Location for all requisition lines. The default is
the requestor’s location. You can pick any location that does not
have an organization or any location whose organization matches
the deliver-to organization. See: the online help for the Enter
Person window. See: Defining Locations: page 1 — 24.

If the Destination Type is Inventory, you can also enter the
Subinventory. See: Defining Subinventories, Oracle Inventory User’s
Guide.

18. Enter the Source type: Inventory or Supplier. If you have both
options, you can source requisition lines independently of the
document type. You can also mix inventory and supplier sourced
requisition lines in the same requisition. Purchasing creates one
internal sales order for all Inventory source type requisition lines
on this requisition. You can use the Autocreate Documents
window to place Supplier source type requisition lines onto
purchase orders.
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For Inventory source type lines, you can enter a default
Organization and Subinventory. If you specify a subinventory for
an internal requisition line, Order Management reserves the goods
and uses only the specified subinventory for allocation. If the
goods do not exist at the specified subinventory, Order
Management backorders them, even if they do exist in another
subinventory.

For Supplier source type lines, you can enter the following defaults:
Buyer, Note to Buyer, Supplier, Site, Contact, and Phone. You can
also check RFQ Required to indicate that you want to require an
RFQ before the buyer creates a purchase order for the requisition.

If RFQs are required and you AutoCreate a purchase order before
creating an RFQ for the requisition line, Purchasing displays a
warning message. You can also set this default in the Purchasing
Options window. See: Defining Default Options: page 1 — 45.

To enter project information preferences:

You see a Project Information tabbed region if one of the following is
true:

e Oracle Projects is installed, or

¢ Oracle Project Manufacturing is installed and Project Reference
Enabled is selected in the Project Manufacturing Organization
Parameters window

The project information you enter is used by Oracle Projects for Deliver
To destination types of Expense, or by Oracle Project Manufacturing for
Deliver To destination types of Inventory or Shop Floor. See: Oracle
Projects User’s Guide. See: Oracle Project Manufacturing Implementation
Manual.

1. Choose the Project Information tabbed region.
2. Select a Project Number.

For a Deliver To destination type of Inventory or Shop Floor, you
can optionally enter a Project Number if the Project Control Level is
set to Project in the Project Information tabbed region of the
Organization Parameters window.

For a Deliver To destination type of Expense, you can always
optionally enter a Project Number.

3. If you entered a Project number, select a Task number.

You must enter a Task number for a Deliver To destination type of
Inventory or Shop Floor, if the Project Control Level is set to Task in
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the Organization Parameters window and if you have entered a
Project number.

4. Enter Expenditure information;

Expenditure information is required only if your Destination Type
is Expense.

o Select the Expenditure Type.

¢ If you chose an Expenditure Type, enter an Expenditure
Organization.

o If you chose an Expenditure Organization, select the Expenditure
Item Date.

» To apply your defaults:

m  Select the Apply button to apply your defaults. The preferences
entered here will affect new lines entered after you select Apply
until you exit the application.

See Also

Using the Account Generator in Oracle Public Sector Purchasing: page
C-9
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Entering Requisition Headers

Use the Requisitions window to:

e Enter internal and purchase requisitions. Your approval and
security setup options determine which types of requisitions you
can enter.

o Take approval actions on individual requisitions online.

o Edit requisitions. Your approval and security setup options
determine which requisitions you can edit. See: Controlling
Documents: page 2 — 55.

» Toenter requisition header information:

1. Navigate to the Requisitions window from the menu, by selecting
the New button in the Find Requisitions and requisitions summary
windows, or by selecting the Requisitions button in the Order Pad
of the Supplier Item Catalog.

v T oW

%R&quisﬁiuns (Vision Operations) - [New]

Mumber _ ¥pe SRS Stock, Ms. Pat
Jascription Status Tatal  [1ky0] 0.00
[l

Rey  Category Description

]

Subinventaory one
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The upper part of the Requisitions window has the following
display-only fields:

Preparer — Your employee name from the Application User window.
Status — The requisition status:

Incomplete — The requisition is incomplete, or the preparer has not
yet submitted the requisition to an approver.

Rejected — The approver rejected the requisition.

Returned — A buyer rejected the requisition. Purchasing returns to
the preparer all requisition lines within the same requisition that
are not on a purchase order.

Total — The currency code and the base currency total amount of all
lines in this requisition.

2. Enter a unique Requisition number. If automatic requisition
number generation is active, the cursor does not enter this field and
the number is generated when you save your work. See: Defining
Numbering Options: page 1 — 53.

3. Choose the Requisition Type:

Purchase Requisition — The requisition lines are usually satisfied
from an outside supplier by means of a purchase order.

Internal Requisition — The requisition lines are usually satisfied from
inventory by means of an internal sales order.

When you enter requisition lines you can source them

independently of the document type. You can mix inventory and
supplier sourced requisition lines in the same requisition of either
document type. See: Profile Options in Purchasing: page 1 — 103.

p To open the Supplier Item Catalog:

m  With the cursor in a requisition line row, select the Catalog button
to open the Supplier Item Catalog. See: Overview of the Supplier
Item Catalog: page 5 - 8.

p To take approval actions:

m  After completing a requisition, select the Approval button to open
the Approve Documents window. See: Submitting a Document for
Approval: page 2 - 35
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p» Tocheck funds:

m  Select Check Funds on the Tools menu.

p To enter requisition preferences:

m  Select Preferences on the Tools menu to open the Requisition
Preferences window. See: Entering Requisition Preferences: page
3-52.

p To reaccess a requisition quickly:

m  Choose Place on Navigator from the Action menu. Choose the
Documents tabbed region in the Navigator to later access the
requisition more quickly. See also: Using the Navigator’s
Documents Region, Oracle Applications User’s Guide.

Note: Once you place a document in the Navigator, it is the first
thing you see in the Navigator the next time you log into
Purchasing. Choose Functions to return to the Purchasing menu.

See Also

Overview of Requisitions: page 3 -2
Entering Requisition Lines: page 3 - 60
Changing Encumbered Documents: page 4 — 135
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Entering Requisition Lines

Use the Items tabbed region in the Requisitions window to enter
requisition line information.

You can choose a predefined item (See: Defining Items, Oracle Inventory
User’s Guide.) or you can an enter an item without an item number.

p To enter requisition line information:

1. Navigate to the Items tabbed region in the Requisitions window.

%R&quisitiuns (Vision Operations) - 101256

[tem

Purchase Req

Rey

=elllE Incomplete

Category

LA

& Peters, Mr. Samuel
usp 285.00

Description

RWA15027

PRODUCTHN.BUL

Plastic Stock - White

Inventory

Peters, Mr. Samuel

Vision Operations

G W - Hew York City

Subinventory

Supplier

Consolidated Supplies

Dallas

Contact

Phone

2. Enter aline Type for the requisition line. Line types help you
define how you want to categorize your items. The default for this
field is the Line Type from the Purchasing Options window. (See:
Defining Default Options: page 1 — 45.) If you change this line
type, defaults from the Line Types window appear in the Category,
UOM and Price fields, and the cursor moves to the Category field.
See: Defining Line Types: page 1 — 84.
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For purposes of requisition line entry, line types are handled in
three classes: amount-based, quantity-based, and outside
processing. The defaults that appear when you enter a line type are
cleared if you change the line type to a different class. Once you
have committed a line, you can change the line type only to another
line type of the same class.

For quantity—based line types and outside processing line types,
enter the Item you want to request. Purchasing displays defaults
for purchasing category, item description, unit of measure, and unit
price for this item. See: Defining Items, Oracle Inventory User’s
Guide.

Enter the Revision (if any) that corresponds to the item you want to
order.

Enter the purchasing Category. You cannot change the category if
you provide an item number in the Item field.

Enter the item Description to explain the item in further detail.
When you enter an item number, Purchasing displays the item
description from the Items window. You can change this
description only if the Allow Description Update attribute for the
item is enabled. See: Defining Items, Oracle Inventory User’s Guide.

Enter the Quantity you want to request for the item. You can enter
decimal quantities, but you must enter a value greater than 0.

You can use the Catalog button to get price breaks for different
quantities from catalog quotations or blanket purchase agreements.

If Quantity Rounding is enabled, Purchasing either displays the
rounded quantity you should have entered in a warning message
or it updates the quantity to the appropriate rounded quantity. The
rounding is based on the Unit of Issue (or primary unit of measure
if the Unit of Issue is not defined) and the Rounding Factor defined
for the item in Inventory. Rounding is up or down to the nearest
whole Unit of Issue/primary unit of measure using the rounding
factor. See: Overview of Requisitions: page 3 - 2.

Enter the unit of measure you want to use for your requisition line.
If you enter an item number, Purchasing defaults the unit of
measure for this item. If you change this value, the quantity is
rounded again if appropriate, and the price is recalculated. If you
enter a line type that is amount based, Purchasing uses the unit of
measure that you assigned to that line type in the Line Types
window. You cannot change the unit of measure of amount based
items.
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10.

11.

12.

Enter the unit Price for the item. You can enter the price in decimal
format. You must enter a value greater than or equal to 0. If you
enter an item number, Purchasing defaults the list price for this
item, but you can change this value. If you create a requisition line
for an amount based line type, Purchasing sets the price to 1, and
you cannot change it. Unit prices are in the functional currency.

Enter the Need By date for the requested items. This is required
only for planned items. You must enter a date greater than or
equal to the requisition creation date.

The Charge Account is rolled up from a single distribution after the
distribution is created. If more that one distribution is created for
the line, Multiple is displayed.

The lower part of the screen below the Lines tabbed region consists
of optional fields for which the default can be set in the Requisition
Preferences window. See: Entering Requisition Preferences: page
3-52.

Enter or use the default Tax Code for taxable items.

The tax code defaults from the Tax Defaults region in the
Purchasing Options window. See:; Defining Tax Defaults Options;
page 1 - 55.

Accept the default tax code or select another. You cannot override
the tax code if the profile option Tax: Allow Override of Tax Code is
set to No, or the shipment has been received.

If on the requisition you change a tax source, such as Supplier or
Site, then Purchasing does not redefault a new Tax Code on the
current line, but does default it on new lines. The same is true even
after you override the Tax Code: Purchasing does not redefault it
on current lines when you change a tax source.

Note: If you change the Tax Code after already creating
distributions for the line, the associated Recovery Rate on those
distributions is not redefaulted for the new Tax Code.

For an overview of tax in Purchasing, see: Tax Defaults in
Purchasing: page 4 — 138.

Enter the Destination Type:

Expense — The goods are delivered to the requestor at an expense
location. The destination subinventory is not applicable.

Inventory — The goods are received into inventory upon delivery.
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13.

14.
15.

16.

17.

Shop Floor — The goods are delivered to an outside processing
operation defined by Work in Process. Purchasing uses this option
for outside processing items.

Enter the name of the employee who is requesting the item. You
must provide a Requestor before you can approve the requisition.
The default is the requisition preparer.

Enter the Organization.

Enter the delivery Location for the requested items. Purchasing
defaults the deliver—to location that you assign to the employee in
the Enter Person window. You must provide a deliver—to location
before you can approve the requisition. Before the source of the
line can be Inventory, the deliver—to location must be linked to a
customer address in the Customer Addresses window. See:
Assigning a Business Purpose to a Customer Address, Oracle Public
Sector Receivables User’s Guide.

Enter the Subinventory. This field applies only when the
Destination Type is Inventory.

Enter the Source type. The source type determines the source of
the requisitioned items. The choice you have in this field is
dependent on the PO: Legal Requisition Type profile option. You
may be able to use either the Inventory or the Supplier source type,
or both types. See: Profile Options in Purchasing: page 1 — 103.

Note that if you have both options, you can source requisition lines
independently of the document type. You can even mix inventory
and supplier sourced requisition lines in the same requisition.
Purchasing creates one internal sales order for all inventory source
type requisition lines on this requisition. The supplier source type
requisition lines are placed onto purchase orders with the
AutoCreate Documents window.

Even if you are restricted to one type, Purchasing restricts the
source type as appropriate for the item. If you are restricted to
Inventory but you are requesting a Supplier item (Purchased Item
attribute — Yes, Internal Ordered Item attribute — No), the source
type can be only Supplier. Conversely, if you are restricted to
Supplier requisitions and you ask for an Inventory item (Purchased
Item attribute — No, Internal Ordered Item attribute — Yes), the
source type can be only Inventory. This is allowed because a
requestor may not know the item source type.

For Inventory source type lines, you can enter a default
Organization and Subinventory. If you specify a subinventory for
an internal requisition line, Order Management reserves the goods
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and uses only the specified subinventory for allocation. If the
goods do not exist at the specified subinventory, Order
Management backorders them, even if they do exist in another
subinventory.

18. For the Supplier source type, enter the suggested Supplier, Supplier
Site, Contact, and Phone. For the Inventory source type, enter the
Organization and Subinventory.

19. Save your work. If you save a requisition line without entering a
distribution, Purchasing tries to generate a distribution line for you,
using the Account Generator based on the information you have
entered. If you want your distribution account numbers to be
generated based on project information, you must enter project
information in the Requisition Preferences or Requisition
Distributions windows before committing the distribution line. See
To enter project information preferences in: Entering Requisition
Preferences: page 3 — 52. See To enter project information in:
Entering Requisition Distributions: page 3 — 67.

p To enter line source details for the Supplier source type:

m  Navigate to the Source Details tabbed region. When the source
type is Supplier, you can enter the Note to Buyer, Buyer, RFQ
Required, Supplier Item number, source Document Type (Blanket
or Quotation), source Document, and document Line Number.

p» Toenter line details:

m  Navigate to the Details tabbed region. You can enter a Justification,
Note to Receiver, Transaction Nature, Reference Number, UN
Number, and Hazard class. See: Defining Lookup Codes: page
1-74

» Toenter line currency information
1. Navigate to the Currency tabbed region.

2. Enter a suggested currency for the requisition line. This must be an
enabled code from the Currency window. The cursor enters the
remaining currency fields only if you have entered a currency here.
See: Defining Currencies, Oracle Public Sector General Ledger User’s
Guide.

3. Purchasing supplies you with one of two predefined currency rate
types: User or EMU Fixed. A rate type of User means that you can
enter a conversion rate between the foreign currency (or

Oracle Public Sector Purchasing User’s Guide



transaction currency in a document entry window) and the base
currency (or functional currency, defined in your set of books). A
rate type of EMU Fixed means that if either your transaction
currency or your functional currency is Euro (the European
Monetary Unit currency) and the other is another European
currency, Purchasing automatically enters a conversion Rate Date
and Rate for you that you cannot change.

You can define additional currency rate types in the Define Daily
Conversion Rate Types form, and you can enter User or one of
your additional types. See: Defining Conversion Rate Types,
Oracle Public Sector General Ledger User’s Guide.

4. Enter the currency rate date.

5. Enter the currency conversion rate. Purchasing overrides this
default when you are entering requisition lines if the rate type is
not User and if you have established a rate for the rate type and
date. See: Entering Daily Rates, Oracle Public Sector General Ledger
User’s Guide

To enter outside processing information:

m  Select the Outside Processing button to open the Outside
Processing window for outside processing line types. See:
Entering Outside Processing Information: page 4 — 83.

To open the Supplier Item Catalog:

m  With the cursor in a requisition line row, select the Catalog button
to open the Supplier Item Catalog. See: Overview of the Supplier
Item Catalog: page 5 - 8.

To enter requisition distributions:

m  Select the Distributions button to open the Distributions window.
See: Entering Requisition Distributions: page 3 - 67.

To view tax information:

m  After you have entered and saved all tax information, do either or
both of the following:

e Choose Tax Code Summary from the Tools menu to see the total
recoverable and nonrecoverable tax for each tax code in your
document. See: Viewing Tax Code Summary Information: page
4-141.
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e Choose Tax Details from the Tools menu to see recoverable and
nonrecoverable tax details for each line and distribution. See:
Viewing Tax Details: page 4 — 143.

» To approve requisitions:

m  Select the Approval button to open the Approve Documents
window. See: Submitting a Document for Approval: page 2 — 35

p» To check funds:

m  Select Check Funds on the Tools menu.

» Toenter requisition preferences:

m  Select Preferences on the Tools menu to open the Requisition
Preferences window. See: Entering Requisition Preferences: page
3-52.

» To reaccess a requisition quickly:

m  Choose Place on Navigator from the Action menu. Choose the
Documents tabbed region in the Navigator to later access the
requisition more quickly. See also: Using the Navigator’s
Documents Region, Oracle Applications User’s Guide.

Note: Once you place a document in the Navigator, it is the first
thing you see in the Navigator the next time you log into
Purchasing. Choose Functions to return to the Purchasing menu.

See Also

Overview of Requisitions: page 3 — 2

Using the Account Generator in Oracle Public Sector Purchasing, Oracle
Applications User’s Guide

Entering Requisition Headers: page 3 - 57
Changing Encumbered Documents: page 4 — 135
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Entering Requisition Distributions

Use the Distributions window to enter requisition distributions or to
view distributions that Purchasing has automatically created for you.
You can charge the cost of this requisition line to multiple Accounting
Flexfields or update the default values you provided in the Requisition
Preferences window. Note that if the line source type is Inventory, you
cannot approve the requisition if you enter more than one distribution
line.

p To enter requisition distributions:

1. Navigate to the Distributions window by selecting the
Distributions button in the Requisitions window. You begin in the
Accounts tabbed region.

%Distrihuliuns (Mision Operations) - 101256

Accounts

Recovery
Mum  CQuantity Charge Account Rate GL Date Budget Account

I 500 01.000.1410.0000.000

Account Description
o Elie[-8 Operations.Balance Sheet.Inventory Budget
S Operations.Balance Sheet.Accounts | VEENE- Operations.Vision Operations In.Invo

2. Enter the Quantity you want to distribute. The quantity must be in
decimal format. Purchasing displays the quantity you have not yet
assigned to an Accounting Flexfield. Multiple distribution
guantities must total to the requisition line quantity.

Using decimal quantities in this field, you can easily distribute
costs across distributions using percentages. For instance, you can
have a simple quantity of one (1) on your requisition line. If you
want to charge one Accounting Flexfield for 30% of the cost of the
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item and another Accounting Flexfield for 70% of the cost of the
item, simply enter .3 and .7 as the respective quantities for the
requisition distribution lines.

If you have a quantity different from one (1), you can use the
Calculator to perform the arithmetic, as illustrated by the following
example:

e Your requisition line quantity is 5000
e You want to charge 35% of the cost to a first Accounting Flexfield

e You want to charge 65% of the cost to a second Accounting
Flexfield

Simply enter (5000x35)/100 = 1750 as the quantity for the first
requisition distribution and (5000x65)/100 = 3250 as the quantity
for the second requisition distribution.

When you enter a Charge Account, Purchasing uses the Account
Generator to automatically create the following accounts for each
distribution:

e Accrual: the AP accrual account
e Variance: the invoice price variance account

If you are using encumbrance control, Purchasing also creates the
following account for each distribution:

e Budget: the encumbrance budget account

The Account Generator creates these accounts based on predefined
rules. See: Using the Account Generator in Oracle Public Sector
Purchasing: page C - 9.

With one exception, you cannot create or update these accounts
manually. If the requisition line destination type is Expense,
however, you can change the default charge account supplied by
the Account Generator.

Change or accept the default Recovery Rate for taxable items.

The recovery rate is the percentage of tax that your business can

reclaim for credit. The recovery rate defaults in based on the Tax

Code on the line in the Requisitions window and the setup in the
Financials Options window.

You can change the recovery rate if the profile option Tax: Allow
Override of Recovery Rate is set to Yes, and the shipment has not
been received. Depending on the setup in the Financials Options
window and the type of tax, only certain recovery rates may be
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allowed. See: Recoverable Tax, Oracle Public Sector Payables User’s
Guide.

If on the requisition you change a tax source, such as Supplier, Site,
or Tax Code, then Purchasing does not redefault a new Recovery
Rate on the current distribution, but does default it on new
distributions you create.

You can choose to use a different recovery rate for different
distributions, even if they use the same tax code.

For an overview of tax in Purchasing, see: Tax Defaults in
Purchasing: page 4 — 138.

Enter the GL Date that you want to use when you reserve funds.
You can enter a GL Date only if you set up your financials options
to use encumbrance for requisitions. The Reserved check box
indicates whether funds have been reserved. The default is the
current date. See: About Financials Options, Oracle Public Sector
Payables User’s Guide.

If you enter a date that belongs to two separate accounting periods,
Purchasing creates a journal entry in the first accounting period
that contains this date. See: Controlling Purchasing Periods: page
1-93.

Save your work.

p Toview tax information:

After you have entered and saved all tax information, do either or
both of the following:

e Choose Tax Code Summary from the Tools menu to see the total
recoverable and nonrecoverable tax for each tax code in your
document. See: Viewing Tax Code Summary Information: page
4-141.

e Choose Tax Details from the Tools menu to see recoverable and
nonrecoverable tax details for each line and distribution. See:
Viewing Tax Details: page 4 — 143.

p To enter project information:

You see a Project tabbed region if one of the following is true:

e Oracle Projects is installed, or
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e Oracle Project Manufacturing is installed and Project Reference
Enabled is selected in the Project Manufacturing Organization
Parameters window

The project information you enter is used by Oracle Projects for
destination types of Expense, or by Oracle Project Manufacturing for
destination types of Inventory or Shop Floor. See: Oracle Projects
User’s Guide. See: Oracle Project Manufacturing Implementation Manual.

1. Choose the Project tabbed region.
2. Select a Project Number.

For a requisition line Destination Type of Inventory or Shop Floor,
you can optionally enter a Project Number if the Project Control
Level is set to Project in the Project Information tabbed region of
the Organization Parameters window.

For a requisition line Destination Type of Expense, you can always
optionally enter a Project Number.

3. If you entered a Project number, select a Task number.

You must enter a Task number for a requisition line Destination
Type of Inventory or Shop Floor, if the Project Control Level is set
to Task in the Organization Parameters window and if you have
entered a Project number.

4. Enter Expenditure information.

Expenditure information is required only if your Destination Type
is Expense.

o Select the Expenditure Type.

¢ If you chose an Expenditure Type, enter an Expenditure
Organization.

¢ If you chose an Expenditure Organization, select the Expenditure
Date.

5. Note that the distribution Quantity that will be charged to the
project should already be entered for you.

If you change the Quantity here, then the distribution Quantity on
the requisition line changes as well.

6. Note that a Unit Number field is visible if Project Manufacturing is
installed.

If the item is under model/unit effectivity control, you must select
an end-item model Unit Number. This field is disabled if the item
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is not under model/unit effectivity control. See: Model/Unit
Effectivity, Oracle Project Manufacturing Implementation Manual.

Note: You can also view the Unit Number as a hidden field in the
Requisition Distributions Summary window.

7. Save your work.

The Charge, Budget, Accrual, and Variance accounts in the
Account Description region are generated automatically. See:
Using the Account Generator in Oracle Public Sector Purchasing:
page C-9.

See Also

Budgetary Control and Online Funds Checking, Oracle Public Sector
General Ledger User’s Guide

Entering Requisition Lines: page 3 - 60
Changing Encumbered Documents: page 4 — 135
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Using Requisition Templates

From the Requisitions window, use the Supplier Item Catalog window
and Requisition Templates to create requisitions more easily.

» To use requisition templates to enter requisitions:

1

See Also

3-72

Navigate to the Requisitions window by selecting Requisitions
from the menu.

Enter requisition header information. See: Entering Requisition
Headers: page 3 - 57.

Navigate to the Items tabbed region. See: Entering Requisition
Lines: page 3-60

Select Catalog to open the Search Supplier Item Catalog window.
See: Finding Supplier Items: page 5 - 11.

Select the desired Requisition Template from the list of values. See:
Defining Requisition Templates: page 1 — 62.

Choose the Find button to open the Supplier Item Catalog window
and display the template lines.

Copy the desired lines to the Order Pad. See: Using the Supplier
Item Catalog Tabbed Regions: page 5 - 15.

Choose the Select button to close the Supplier Item Catalog
window and transfer the order pad lines to the requisition.

Save your work.

Overview of the Supplier Item Catalog: page 5-8
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Purchase Orders

CHAPTER

T his chapter tells you everything you need to know about Purchase
Orders, including:

e Overview of Purchase Orders: page 4 - 3

e Purchase Order Defaulting Rules: page 4 — 12

e Finding Purchase Orders: page 4 — 19

e Entering Purchase Order Preferences: page 4 — 33
e Entering Purchase Order Headers: page 4 — 39

¢ Entering Purchase Order Lines: page 4 — 45

e Entering Purchase Order Price Reference
Information: page 4 — 49

e Entering Purchase Order Reference Document
Information: page 4 - 51

e Entering Purchase Order Miscellaneous Information: page 4 — 53
e Entering Purchase Agreement Information: page 4 — 55

e Entering Currency Information: page 4 — 58

e Entering Purchase Order Details Information: page 4 — 61

e Entering Purchase Order Shipments: page 4 — 65

¢ Entering Purchase Order Receiving Controls: page 4 — 71
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e Entering Purchase Agreement Price Break
Information: page 4 — 75

e Entering Purchase Order Distributions: page 4 — 77

e Entering Outside Processing Information: page 4 — 83

e Entering Purchase Order Notification Controls: page 4 — 85
e Entering and Viewing Purchase Order Acceptances: page 4 — 87
e Entering Releases: page 4 — 90

e Automatic Release Generation: page 4 — 106

e Copying Purchase Orders: page 4 — 109

e Printed Purchase Order Overview: page 4 — 112

e Document Revision Numbering: page 4 — 126

e Changing Encumbered Documents: page 4 — 135

e Drop Shipments: page 4 — 136

e Tax Defaults in Purchasing: page 4 — 138

e Procurement Card Purchase Orders and Releases: page 4 — 146
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Overview of Purchase Orders

Purchasing provides the Purchase Orders window that you can use to
enter Standard and Planned purchase orders as well as Blanket and
Contract purchase agreements. You must be defined as a buyer to use
this window. See: Entering Purchase Order Headers: page 4 — 39. See:
Defining Buyers: page 1 - 27.

To create purchasing documents more quickly, use the AutoCreate
Documents window. See: Autocreate Documents Overview: page

6-2.

Purchasing provides you the features you need to satisfy the following
purchasing needs. You should be able to:

Review all of your purchases with your suppliers to negotiate
better discounts

Create purchase orders simply by entering a supplier and item
details

Create standard purchase orders and blanket releases from both
on-line and paper requisitions

Create accurate and detailed accounting information so that you
charge purchases to the appropriate departments

Check your funds availability while creating purchase orders

Review the status and history of your purchase orders at any
time for all the information you need

Print purchase orders flexibly by using a number of print options
Inform your suppliers of your shipment schedule requirements

Record supplier acceptances of your purchase orders. You
always know whether your suppliers have received and
accepted your purchase order terms and conditions

Create your purchase orders by providing a quantity and price
for each item you are ordering. Alternatively, you should also be
able to create your purchase order simply by providing an
amount if you are ordering a service that you cannot break down
by price and quantity

Copy purchase orders. See: Copying Purchase Orders: page
4 -1009.
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Purchase Order Types

Purchasing provides the following purchase order types: Standard
Purchase Order, Planned Purchase Order, Blanket Purchase Agreement,
and Contract Purchase Agreement. You can use the Document Name
field in the Document Types window to change the names of these
documents. For example, if you enter Regular Purchase Order in the
Document Name field for the Standard Purchase Order type, your
choices in the Type field in the Purchase Orders window will be
Regular Purchase Order, Planned Purchase Order, Blanket Purchase
Agreement, and Contract Purchase Agreement.

Standard Purchase Orders

You generally create standard purchase orders for one-time purchase
of various items. You create standard purchase orders when you know
the details of the goods or services you require, estimated costs,
quantities, delivery schedules, and accounting distributions. If you use
encumbrance accounting, the purchase order may be encumbered since
the required information is known.

Blanket Purchase Agreements

Blanket Releases

You create blanket purchase agreements when you know the detail of
the goods or services you plan to buy from a specific supplier in a
period, but you do not yet know the detail of your delivery schedules.
You can use blanket purchase agreements to specify negotiated prices
for your items before actually purchasing them.

You can issue a blanket release against a blanket purchase agreement to
place the actual order (as long as the release is within the blanket
agreement effectivity dates). If you use encumbrance accounting, you
can encumber each release.

Contract Purchase Agreements

You create contract purchase agreements with your suppliers to agree
on specific terms and conditions without indicating the goods and
services that you will be purchasing. You can later issue standard
purchase orders referencing your contracts, and you can encumber
these purchase orders if you use encumbrance accounting.

4-4 Oracle Public Sector Purchasing User’s Guide



Planned Purchase Orders

A planned purchase order is a long-term agreement committing to buy
items or services from a single source. You must specify tentative
delivery schedules and all details for goods or services that you want
to buy, including charge account, quantities, and estimated cost.

Scheduled Releases

You can issue scheduled releases against a planned purchase order to
place the actual orders. If you use encumbrance accounting, you can
use the planned purchase order to reserve funds for long term
agreements. You can also change the accounting distributions on each
release and the system will reverse the encumbrance for the planned
purchase order and create a new encumbrance for the release.

Purchase Order Types Summary

Standard Planned Blanket Contract
Purchase Purchase Purchase Purchase
Order Order Agreement Agreement
Terms and Conditions Known | Yes Yes Yes Yes
Goods or Services Known Yes Yes Yes No
Pricing Known Yes Yes Maybe No
Quantity Known Yes Yes No No
Account Distributions Known | Yes Yes No No
Delivery Schedule Known Yes Maybe No No
Can Be Encumbered Yes Yes No No
Can Encumber Releases N/ZA Yes Yes N/A

Table4-1 (Pagelof1l)
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Purchase Order Features

AutoCreate

AutoCreate lets you compose a purchase order or a release from
on-line requisitions in a few keystrokes. See: Autocreate Documents
Overview: page 6 - 2.

Workflow for Automatic Purchase Order and Release Creation

Accurate Accounting

Purchasing uses Oracle Workflow technology to create purchase orders
and releases automatically from approved requisition lines. Purchase
orders and releases are created automatically only if the approved
requisition lines are valid (for example, they contain valid source
document information) and if the ”’Is Automatic Creation Allowed?”
attribute in the Oracle Workflow Builder is set to 'Y’ for Yes. (Itis set to
'Y’ by default.) See: Workflow for Creating Purchase Orders or
Releases: page C — 204. See: Choosing Workflow Options: page 1 — 95.
See also: Automatic Release Generation: page 4 — 106.

You supply accounting information as part of your purchase order.
You can allocate order line quantities and costs to organizations,
projects, or departments.

On-line Funds Availability Checking

You can determine whether you have enough funds available in your
budget before you complete a purchase order. You can check funds at
the purchase order header, lines, shipments, distributions, and release
levels. You can also check whether funds are available before you
approve your purchase order. You can even set up your system setup
options to prevent a buyer from approving a purchase order until
sufficient funds are available.

To use on-line funds checking, you need to implement budgetary
controls. You can check funds at the detail or summary level. You can
also choose to check your funds for each period, quarter, or year. See:
Budgetary Control and Online Funds Checking, Oracle Public Sector
General Ledger User’s Guide
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Revising Purchase Orders

Shipment Schedules

Acceptances

Line Types

To change a standard or planned purchase order, simply query this
purchase order and enter your changes. You can provide additional
paper requisition information to a standard purchase order. You can
also revise blanket or contract purchase agreements. When you make
changes to a purchase order or release, Purchasing’s change order
workflow processes determine whether or not the changes require
reapproval and, if so, route the document for the necessary
reapprovals. See: Workflow Processes for Approving Change Orders:
page C — 168.

To add on-line requisition lines to an existing standard purchase order
or release, use AutoCreate. You can add requisition lines as a new
purchase order line or add to an existing purchase order line. See:
Autocreate Document Options: page 6 — 4.

When you change a purchase order, Purchasing automatically
increments the revision number. See: Document Revision Rules: page
4-128.

You can create purchase order lines that have an unlimited number of
ship-to locations and delivery dates. Each shipment line has a Ship-To
Organization and Location, Promise-By Date, Need-By Date, and Last
Accept Date. You receive goods and services against each shipment
line.

You can enter purchase order acceptances to verify that your suppliers
have agreed to and accepted the details on the purchase orders you
send to them. See: Entering Purchase Order Acceptances: page 4 — 87.

Purchasing uses Line Types to distinguish between items you order by
quantity and price, and services that you order by amount. Line Types
also serve to identify outside processing services for which Work in
Process creates requisitions. See: Defining Line Types: page 1 — 84.
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Approving Purchase Orders

Purchasing checks purchase orders for accuracy and completeness
before printing. You can submit purchase orders to the approval
process from the Purchase Orders window before you print them.
Also, you can use the Notifications Summary window to submit
purchase orders for approval. See: Submitting a Document for
Approval: page 2 — 35. See: Viewing and Responding to Notifications:
page 2 - 31.

You can also assign an authorization limit to each buyer and decide
whether you want to enforce this limit whenever any buyer approves a
purchase order. See: Overview of Purchasing Options: page 1 — 45.
See: Defining Buyers: page 1 — 27.

Printing Purchase Orders

4-8

You can print purchase orders at the time you approve them. (See:
Submitting a Document for Approval: page 2 — 35.) You can reprint
purchase orders as often as you want using the Submit Requests
window (See: Submitting a Request, Oracle Applications System
Administrator’s Guide). You can choose from the following options:

e Print all new and changed purchase orders

e Print all changed purchase orders

e Print all new purchase orders

e Print a particular purchase order or range of purchase orders
e Print a test purchase order

e Landscape or portrait format

You can also print purchase orders, change orders, and RFQs in other
languages, if you use Multilingual Support (MLS). See: Printed
Purchase Order Overview: page 4 — 112.

You can send facsimiles of printed purchase orders and change orders
if CommercePath is installed. You can send the facsimiles at the time
you approve the purchase orders, or when you submit the printed
purchase order or change order reports. See: Submitting a Document
for Approval: page 2 — 35. See: Printed Purchase Order Overview:
page 4 — 112.
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Copying Purchase Orders

You can copy one purchase order to another. For example, if you want
to renew a blanket purchase agreement with hundreds of lines, you can
copy the previous agreement to a new document and change the
effectivity dates. You can copy the following purchase order types:

e Standard purchase orders
¢ Blanket purchase agreements
¢ Planned purchase orders

See: Copying Purchase Orders: page 4 — 109.

Cancelling Purchase Orders

Purchasing lets you cancel a purchase order or purchase order line after
you have approved it. When you cancel a purchase order or purchase
order line, you pay only for those goods you received before
cancellation, and you can optionally reassign any unfilled requisitions
to another purchase order. See: Controlling Documents: page 2 — 55.

If you are using encumbrance or budgetary control and if you choose to
cancel referencing requisitions, Purchasing creates negative debit
entries in your general ledger system to cancel the encumbrance
associated with the purchase order. Purchasing recreates requisition
encumbrances for the requisition lines you used to create the purchase
order, using the distributions from your cancelled purchase order. See:
Budgetary Control and Online Funds Checking, Oracle Public Sector
General Ledger User’s Guide.

Closing and Final Closing Purchase Orders

Purchasing lets you automatically close a purchase order once you have
received and paid for all items you ordered. This feature lets you
concentrate on those purchase orders that are overdue or partially
received. You can also manually close purchase orders at any time. Of
course, you always have the option to review or reopen a purchase
order by adding new lines or creating additional receipt transactions
until the purchase order is final closed. See: Controlling Documents:
page 2 — 55.

If you designate an invoice as the final match to a purchase order,
Payables final closes the purchase order shipment during Approval.
You cannot update the status of a final-closed purchase order. See:
Approval, Oracle Public Sector Payables User’s Guide.
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If you are using encumbrance or budgetary control and if you choose to
cancel referencing requisitions, Purchasing automatically creates credit
entries in your general ledger system to reverse the encumbrance that
corresponds to the purchase order are final closing. See: Budgetary
Control and Online Funds Checking, Oracle Public Sector General Ledger
User’s Guide.

Close for Receiving and Close for Invoicing

Purchasing automatically closes shipments for receiving and invoicing
based on controls that you specify in the Purchasing Options window.
Once all shipments for a given line are closed, Purchasing
automatically closes the line. When all lines for a given header are
closed, Purchasing automatically closes the document.

You can specify closing controls including: Receipt Close Tolerance,
Receipt Close Point, and Invoice Close Tolerance. See: Defining
Purchasing Options: page 1 —45.

Note: The Close for Invoicing status does not prevent you from
matching an invoice to a purchase order or a receipt.

Holding and Freezing Purchase Orders

Purchasing lets you freeze a purchase order so that you can prevent
changes or additions to it, but still receive and pay for goods already
ordered. You can easily control your purchase order changes because
you can freeze or unfreeze a purchase order when appropriate.
Likewise, you can place a purchase order on hold to prevent all actions
until you remove the order from hold. See: Controlling Documents:
page 2 - 55.

Notification Controls (Using Oracle Alert)
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For planned purchase orders, blanket purchase agreements, and
contracts, you can establish expiration and release control notification
conditions and specify the number of days before the condition is met
that you want to be notified. In the Notification Controls window,
accessible through the Purchase Orders window, you can specify the
following notification conditions:

e Amount released by date
e Amount not released by date

e Amount not released
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e Amount released
e Expiration date

When the notification conditions are met, Purchasing sends you an
Alert (or email) so that you can take appropriate action. See: Entering
Purchase Order Notification Controls: page 4 — 85. See: Using Oracle
Alert in Oracle Public Sector Purchasing: page B — 2.

Quick Access to Particular Purchase Orders

You can place purchase orders that you reference frequently in the
Oracle Applications Navigator. Placing documents in the Navigator is
useful when you need to query large documents with multiple lines,
shipments, or distributions. When the purchase order is open, choose
Place on Navigator from the Action menu. When you choose the
Documents tabbed region in the Navigator, you can then access that
document directly from within the Navigator. You can also do this
with requisitions. See: Using the Navigator’s Documents Region,
Oracle Applications User’s Guide.

Note: Once you place a document in the Navigator, it is the first thing
you see in the Navigator the next time you log into Purchasing. Choose
Functions to return to the Purchasing menu.

Viewing Changes to Purchase Orders

You can view at a glance all past revisions made to archived purchase
orders through the PO Change History menu item in the Oracle Public
Sector Purchasing Navigator. See: Viewing Purchase Order Changes:
page 8 — 4.
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Purchase Order Defaulting Rules

Purchasing uses a comprehensive defaulting mechanism to provide most
required purchase order information and minimize document creation
time. For example, when you are entering a standard purchase order
and you want only one shipment and distribution for each purchase
order line, you do not need to navigate beyond the Lines tabbed region
unless you want to change the default information in the shipments
and distributions that Purchasing automatically creates. If you are
creating an outside processing line, you must go to the Distributions
window to enter outside processing information. Finally, note that the
Account Generator may be unable to build accounts for a number of
reasons, for example, if you have entered a one-time item. In this case,
you must enter distributions in the Distributions window.

Purchase Order Default Matrix Conventions

4-12

The Purchase Order Default Matrix uses the following conventions:

o “Default” in this context means that Purchasing provides this
information for you. It does not mean that you can always
change the defaulted information.

e When options are listed as 1-2-3, Purchasing looks first for the
option specified as 3. If new information is provided, or if
information is not available in this source, Purchasing uses the
next source. For example, when defaulting the currency to a
standard purchase order header, Purchasing first provides the
currency specified in the Financials Options window. When you
specify a supplier, Purchasing updates the currency based on the
supplier’s default currency. Finally, when you specify a supplier
site, Purchasing updates the currency accordingly.

For Releases, ”Source Agreement” refers to Blanket Purchase
Agreements or Planned Purchase Orders, as appropriate.

The Last Acceptance Date is calculated using the Promised Date
if available. Otherwise, Purchasing uses the Need-By date.

Purchasing provides a GL Date only if you are using
encumbrance.

The following abbreviations are used in the matrix:
- OSP Outside Processing
- PO Opt Purchasing Options
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Purchase Order Defaulting Rules

Header Standard Planned Blanket Contract Release
Purchase Value = Value = ”Blanket”
Order Type ”Standard”

Buver User name (must | User name (must | User name (must | User name (must | User name (must

Yy be buyer) be buyer) be buyer) be buyer) be buyer)

1 Set of Books Set of Books Set of Books Set of Books Source Agreement
(not changeable)
Currency 2 Supplier Supplier Supplier Supplier
3 Supplier Site Supplier Site Supplier Site Supplier Site
supplier Source Agreement
pPp (not changeable)
From supplier if From supplier if From supplier if From supplier if | Source Agreement
supplier Site only 1 only 1 only 1 only 1 (not changeable)
PP “Purchasing” site | “Purchasing” site | “Purchasing” site | “Purchasing” site
exists exists exists exists
Supplier Fromsiteifonly 1 | Fromsite ifonly 1 | From site ifonly 1 | From site if only 1
Contact contact exists contact exists contact exists contact exists

Confirm Order

Value = “No”

Value = “No”

Value = “No”

Value = “No”

Financials Options

Financials Options

Financials Options

Financials Options

Source Agreement

1
Ship To (not changeable)
Location Supplier Supplier Supplier Supplier
3 Supplier Site Supplier Site Supplier Site Supplier Site
1 Financials Options | Financials Options | Financials Options | Financials Options | Source Agreement
. (not changeable)
Bill To
Location 2 Supplier Supplier Supplier Supplier
Supplier Site Supplier Site Supplier Site Supplier Site
1 Financials Options | Financials Options | Financials Options | Financials Options | Source Agreement
P (not changeable)
ayment
Terms Supplier Supplier Supplier Supplier
Supplier Site Supplier Site Supplier Site Supplier Site
1 Financials Options | Financials Options | Financials Options | Financials Options | Source Agreement
. (not changeable)
Freight
Terms Supplier Supplier Supplier Supplier
3 Supplier Site Supplier Site Supplier Site Supplier Site
1 Financials Options | Financials Options | Financials Options | Financials Options | Source Agreement
(not changeable)
Ship Via - - - -
2 Supplier Supplier Supplier Supplier
3 Supplier Site Supplier Site Supplier Site Supplier Site

Table4-2 (Pagelof2)
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Header Standard Planned Blanket Contract Release
1 Financials Options | Financials Options | Financials Options | Financials Options | Source Agreement
(not changeable)
FOB - - - -
2 Supplier Supplier Supplier Supplier
3 Supplier Site Supplier Site Supplier Site Supplier Site
Rate Type Purchasing Purchasing Purchasing Purchasing Source Agreement
yp Options Options Options Options (not changeable)
. Source Agreement
Effective Date (not changeable)
Expiration Source Agreement
Date (not changeable)
Minimum Purchasing Purchasing
Release Options Options
Amount
Notification Terms and Terms and Terms and
Control conditions conditions conditions
Expiration expiration date expiration date expiration date
Date
Acceptance Value = “No” Value = “No” Value = “No” Value = “No” Source Agreement
Required (not changeable)
Release Existing number +
Number 1
Release Date Today'’s date
Table 4-2 (Page2of2)
Line Standard Planned Blanket Contract Release
. Purchasing Purchasing Purchasing
Line Type Options Options Options
1 Line Type Line Type Line Type
Category
2 Item Item Item
1 Line Type Line Type Line Type
UOM yp yp yp
2 Item Item Item
1 Line Type Line Type Line Type
2 List Price List Price List Price
Unit Price Source document | Source document | Source document
specified in specified in specified in
3| Supplier-ltem Supplier-Item Supplier-Item
Attributes Attributes Attributes
window window window
UN Number Item Item Item
Hazard Class Item Item Item

Table 4-3 (Page 1o0f?2)
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Line Standard Planned Blanket Contract Release
OSP UOM Type Item Item Item
List Price Item Item Item
Market Price Item Item Item
Price Type PO Preferences PO Preferences PO Preferences
Allow Price Value = “No” Value = “No”
Override
PO Preferences PO Preferences PO Preferences Source
Promised Date Agreement (not
changeable)
PO Preferences PO Preferences PO Preferences Source
Need-By Date Agreement (not
changeable)
Transaction Nature | PO Preferences PO Preferences PO Preferences
Price Break Type PO Preferences
Table 4-3 (Page 2 of 2)
Shipment Standard Planned Blanket Contract Release
Financial System
1 Options (blanket
releases only)
Financial System Financial System Agreement Source Agreement
Ship-To 2 Options Options Header’s Ship-To (not changeable)
Or panization locations (blanket releases
9 organization only)
3| PO Preferences - PO Preferences — Agreement PO Preferences —
Validated against Validated against Header’s Ship-To Validated against
item item locations item (blanket
organization releases only)
PO Preferences — PO Preferences— | Agreement Header Source Agreement
. - Validated against Validated against (not changeable)
Ship-To Location validated validated
organization organization
. 1 Lines Lines Lines Lines
Promised Date
2 PO Preferences PO Preferences PO Preferences PO Preferences
1 Lines Lines Lines Lines
Need-By Date
2 PO Preferences PO Preferences PO Preferences PO Preferences
. 1 Purchasing Purchasing Purchasing
Receipt Close Options Options Options
Tolerance - - -
2 Line Type Line Type Line Type
3 Item Item Item

Table 4-4 (Page 1 of3)

Purchase Orders

4-15




Shipment Standard Planned Blanket Contract Release
) 1 Purchasing Purchasing Purchasing
Invoice Close Options Options Options
Tolerance
2 Item Item Item
. . Purchasing Purchasing Purchasing
Invoice Matching | 1 - - -
2, 3, 4 Way) Options Options Options
2 Line Type Line Type Line Type
Item Item Item
1 Else = Receipt Else = Receipt Else = Receipt
Required Value Required Value Required Value
No, if PO Opt No, if PO Opt No, if PO Opt
2 | expense accrual is | expense accrual is expense accrual is
“Period End” “Period End” “Period End”
Accrue on — - — - — -
Receipt Yes, if item is Yes, if item is Yes, if item is
3 stockable in stockable in stockable in
ship-to ship-to ship-to
organization organization organization
4 Yes, if line type is Yes, if line type is Yes, if line type is
OsP OsP OSP
Taxable is selected | Taxable is selected Taxable is selected
Taxable if there is a Tax if there is a Tax if there is a Tax
Code Code Code
Tax Defaults in Tax Defaults in Tax Defaults in
1 Purchasing Purchasing Purchasing
Options window Options window Options window
2 Tax Code from
Tax Code planned purchase
order shipment
3 Purchasing Order Purchase Order Purchase Order
Preferences Preferences Preferences
1| Receiving Options | Receiving Options Receiving Options
Enforce Ship-To I Supplier Supplier Supplier
Location PP PP Pp
3 Item Item Item
1 | Receiving Options | Receiving Options Receiving Options
Allow Substitute 2 Supplier Supplier Supplier
Receipts PP PP Pp
3 Item Item Item
1 | Receiving Options | Receiving Options Receiving Options
Receipt Routing |2 Supplier Supplier Supplier
3 Item Item Item
Quantity 1| Receiving Options | Receiving Options Receiving Options
Received 2 Supplier Supplier Supplier
Tolerance 3 Item Item Item
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Shipment Standard Planned Blanket Contract Release
Quantity 1| Receiving Options | Receiving Options Receiving Options
Received 2 Supplier Supplier Supplier
Exception 3 Item Item Item

1| Receiving Options | Receiving Options Receiving Options
Days Early - - -
Receipt Allowed 2 Supplier Supplier Supplier
3 Item Item Item
1| Receiving Options | Receiving Options Receiving Options
Days Late 2 s li s li s li
Receipt Allowed upphier upphier upphier
3 Item Item Item
Promised Date or Promised Date or Promised Date or
Need By Date + Need By Date + Need By Date +
Last Accept Date Late Receipt Late Receipt Late Receipt
Tolerance Tolerance Tolerance
1| Receiving Options | Receiving Options Receiving Options
Receipt Date 2 Supplier Supplier Supplier
Exception Pp PP PP
3 Item Item Item
. . Source Agreement
Shipment Price (not changeable)
1 Supplier Site Supplier Site Supplier Site
Country of 2 | Approved Supplier | Approved Supplier Approved Supplier
Origin List List List (blanket
releases only)
Table 4-4 (Page 3 of 3)
Distribution Standard Planned Blanket Contract Release
1 If line type is OSP If line type is OSP If line type is OSP
= “Shop Floor” =*“Shop Floor” =*“Shop Floor”
If item stockable in | If item stockable in If item stockable in
2 ship-to org. = ship-to org. = ship-to org. =
“Inventory” “Inventory” “Inventory”

o If item stockable in | If item stockable in If item stockable in
Destination Type ship-to org, and ship-to org, and ship-to org, and

3| purchasable and purchasable and purchasable and

Accrue on Receipt
is No =“Expense”

Accrue on Receipt
is No =“Expense”

Accrue on Receipt
is No =“Expense”

If item is NOT
stockable =
“Expense”

If item is NOT
stockable =
“Expense”

If item is NOT
stockable =
“Expense”

Requestor

PO Preferences

PO Preferences

Table4-5 (Page 1 of?2)
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Distribution Standard Planned Blanket Contract Release
PO Preferences if PO Preferences if Requestor’s
) 1| wvalid for ship-to valid for ship-to location
Deliver-To org and item org and item
Location
2 Requestor’s Requestor’s Requestor’s
location location location
Project Details PO Preferences PO Preferences PO Preferences
Rate Date PO Header PO Header Source Agreement
(not changeable)
PO Preferences PO Preferences Today’s date if in
GL Date valid period; else
null
Accounts Account Generator | Account Generator Account Generator
Recovery Rate Tax Code Tax Code Tax Code
L. 1 PO Preferences PO Preferences
Requisition 0 0 T
Information 2 Source Requisition | Source Requisition Source Requisition

(Online)

(Online)

(Online)

4-18

Table 4-5 (Page 2 of 2)

See Also

Defining Financials Options, Oracle Public Sector Payables User’s Guide

About Suppliers, Oracle Public Sector Payables User’s Guide

Site Locations, Oracle Human Resource Management Systems User’s Guide

Using the Account Generator in Oracle Public Sector Purchasing: page

Cc-9

Defining Purchasing Options: page 1 - 45

Defining Receiving Options: page 1 — 58

Profile Options in Purchasing: page 1 — 103

Entering Purchase Order Shipments: page 4 — 65

Entering Purchase Order Distributions: page 4 — 77
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Finding Purchase Orders

Use the Find Purchase Orders window to:
e Access the Purchase Orders window.
e Access the Releases window.

e Perform purchase order inquiries at header, line, shipment, and
distribution levels

Depending on the function security assigned to your responsibility, you
have varying levels of access to information. A responsibility defines
an application user’s current privileges while working with Oracle
Applications.

See Also

Overview of Function Security, Oracle Applications System
Administrator’s Guide

Function Security for Purchasing: page 1 - 112

p To enter search criteria:

1. Navigate to the Find Purchase Orders window by selecting
Purchase Order Summary from the menu. Enter desired search
criteria as described in the following steps.
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%Find Purchase Orders (Vision Operations)

Pury

Supplier

Ship-Ta Crg

Ship-To

Bill-Ta

Line

Shipment

Buyer

Line Type

ltem, Few

Category

Description

Supplier temn

Clear

tibutinns

Enter the purchase order number. If you enter a purchase order
number, you can also enter a Release, Line, and/or Shipment
number for the purchase order.

Select the View Releases check box to include all associated releases
for blanket purchase agreements and planned purchase orders.
Purchasing automatically selects this check box if you specify
selection criteria for which it would be required (for example, if
you select Scheduled Releases as the purchase order Type). This
check box is not available when inappropriate (for example, if you
select Standard PO as the purchase order Type).

Select the purchase order Type (Standard purchase order, Blanket
purchase agreement, Planned purchase order, Contract purchase
agreement, Blanket Release, or Scheduled Release.

Enter the Currency.

Enter the Supplier. If you enter a supplier, you can also enter a
supplier Site.
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10.
11.
12.

13.

Enter the Ship To Organization.

Enter the Ship To location.

Enter the Bill To location.

Enter the Buyer.

Enter the Line Type.

Use the tabbed regions to further restrict the search:

¢ In the Item region, you can enter the following search criteria:
Item number, Revision number, Category, item Description, and
Supplier Item Number.

¢ In the Date Ranges region, you can enter date ranges for the
following dates: Order, Approved, Promised, Need By, and
Closed.

¢ In the Status region, you can limit the search by:

— Order Approval status (Approved, In Process, Incomplete,
Pre—-Approved, Rejected, or Requires Reapproval)

— Control status (Open, Closed, Finally Closed, Closed for
Invoicing, Closed for Receiving, or Cancelled)

— Hold status (Yes or No)
— Frozen status (Yes or No)
— Firmed status (Yes or No)

¢ In the Related Documents region, you can limit the search by
Supplier Quote number, Quote number, Quote Line number,
Requisition number, Receipt number, Contract number, Invoice
number, and Paper Requisition number.

¢ In the Deliver To region, you can limit the search by destination
Type (Expense, Inventory, Shop Floor), Deliver To Person,
Organization, Location, and Subinventory.

¢ In the Accounting region, you can limit the search by Period, GL
Date, Charge Account, Budget Account, and whether there are
Active Encumbrances (Yes or No).

Select the Results summary window (Headers, Lines, Shipments,
or Distributions). Depending on the search criteria you have
specified, all summary windows may not be available. For
example, if you specify criteria in the Accounting region, only the
Purchase Order Distributions summary window is available.
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14. Select the Find button to initiate the search and open the
appropriate summary window.

=
Mumber Release Rev [|Description Type Approval Status Order Date
1003646 0 Standard Purc|Iincomplete 16/JAN2001 =
1003640 0 Standard Purc|Approved 15/JAN/200
1003635 0 Standard Purc| Approved 15/ JAN200
1003632 0 Standard Purc|Approved 15/JAN/2001
1003629 0 Standard Purc|Approved 15/JAN/200
1003627 0 Standard Purc| Approved 15/ JAN200
1003626 0 Standard Purc|Approved 15/JAN/200
1003623 0 Standard Purc| Approved 15/JAN200
1003614 0 Standard Purc| Approved 15/ JAN200
1003608 0 Standard Purcflncomplete 15/JAN/2001
L »
Lines Mew Release Mew PO Open
p Toclear existing search criteria:
m  Select the Clear button to clear any existing search criteria.
» Toenter a new release:
m  Select the New Release button to open the Releases window. See:
Entering Release Headers: page 4 — 90.
p Toenter a new purchase order:
m  Select the New PO button to open the Purchase Orders window.
See: Entering Purchase Order Headers: page 4 — 39.
p  To enter purchase order preferences:
m  Select Preferences on the Tools menu to open the Purchase Order
Preferences window. See: Entering Purchase Order Preferences:
page 4 — 33.
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See Also

Overview of Purchase Orders: page 4 -3

Using the Purchase Order Headers Summary Window: page 4 — 23
Using the Purchase Order Lines Summary Window: page 4 — 26

Using the Purchase Order Shipments Summary Window: page 4 — 28
Using the Purchase Order Distributions Summary Window: page 4 — 31

Using the Purchase Order Headers Summary Window

Use the Purchase Order Headers results folder window to:
¢ View purchase order header information.

e Drill down to view purchase order line, shipment, and
distribution information.

e Access the Purchase Orders and Releases windows for entry and
update of documents.

e Access other windows from the Tools menu.

To navigate to the Purchase Order Headers results window:

m |n the Find Purchase Orders window, select Headers in the Results
region and select the Find button to open the Purchase Order
Headers folder window.

To drill down to view purchase order line information:

m  Select the Lines button to drill down to the Purchase Order Lines
results folder window. You can also select View Lines on the Tools
menu to open this window. See: Using the Purchase Order Lines
Summary Window: page 4 — 26.

To enter a new release:

m  Select the New Release button to open the Releases window. If the
current record is a blanket purchase agreement or a planned
purchase order, then you can create a release against it.

= Attention: Depending on how the Function Security is set for
your user responsibility, you may not have access to the New
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Release button. (With Function Security, a system administrator
can limit people’s access to this function.)

To enter a new purchase order:

m  Select the New PO button to open the Purchase Orders window.
See: Entering Purchase Order Headers: page 4 — 39.

Attention: Depending on how the Function Security is set for

IS5y your user responsibility, you may not have access to the New
PO button. (With Function Security, a system administrator can
limit people’s access to this function.)

To open the Purchase Orders or Releases window for the current
order:

m  Select the Open button to open the Purchase Orders window and
query the purchase order on the current line. If the current order is
for a blanket or scheduled release, Purchasing opens the Releases
window and queries the current order. Your options in this
window depend on the status of the order and your approval and
security options. See: Entering Purchase Order Headers: page
4-39

= Attention: Depending on how the Function Security is set for
your user responsibility, you may not have access to the Open
button. (With Function Security, a system administrator can
limit people’s access to this function.)

To drill down to view purchase order shipment information:

m  Select View Shipments on the Tools menu to open the Purchase
Order Shipments results folder window. See: Using the Purchase
Order Shipments Summary Window: page 4 — 28.

To drill down to view purchase order distributions information:

m  Select View Distributions on the Tools menu to open the Purchase
Order Distributions results folder window. See: Using the
Purchase Order Distributions Summary Window: page 4 — 31.

To view acceptances:

m  Select View Acceptances on the Tools menu to open the View
Acceptances window. See: Entering and Viewing Purchase Order
Acceptances: page 4 — 87

Oracle Public Sector Purchasing User’s Guide



See Also

To enter acceptances:

m  Select Enter Acceptances on the Tools menu to open the Enter
Acceptances window. See: Entering and Viewing Purchase Order
Acceptances: page 4 — 87.

To view action history:

m  Select View Action History on the Tools menu to open the Action
History window. See: Viewing Action History: page 8 — 2.

To view invoices:

m  Select View Invoices on the Tools menu to view invoice
information:; See: Invoice Overview, Oracle Public Sector Payables
User’s Guide.

To view receipts:

m  Select View Receipts on the Tools menu to open the Find Receiving
Transactions window. See: Finding Receiving Transactions
(Summary): page 7 — 48.

To enter purchase order control information:
¢ Select Control on the Tools menu to open the Control Document

window. See: Controlling Documents: page 2 — 55.

To enter purchase order preferences:

m  Select Preferences on the Tools menu to open the Purchase Order
Preferences window. See: Entering Purchase Order Preferences:
page 4 - 33

To view procurement card information:

®  In the Purchase Order Headers summary window, which is a folder
window, display the hidden field P-Card Number. See:
Procurement Card Purchase Orders and Releases: page 4 — 146.

Customizing the Presentation of Data in a Folder, Oracle Applications
User’s Guide
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Overview of Purchase Orders: page 4 — 3

Finding Purchase Orders: page 4 — 19

Using the Purchase Order Lines Summary Window: page 4 — 26

Using the Purchase Order Shipments Summary Window: page 4 — 28
Using the Purchase Order Distributions Summary Window: page 4 — 31

Using the Purchase Order Lines Summary Window

Use the Purchase Order Lines results folder window to:
e View purchase order line information.

o Drill down to view purchase order shipment and distribution
information.

o Access the Purchase Orders and Releases windows for entry and
update of documents.

e Access other windows from the Tools menu.

p To navigate to the Purchase Order Lines results window:

®  In the Find Purchase Orders window, select Lines in the Results
region and select the Find button to open the Purchase Order Lines
folder window. You can also navigate to this window by selecting
View Lines on the Tools menu in the Purchase Order Headers
results folder window.

» Todrill down to view purchase order shipment information:

m  Select the Shipments button to drill down to the Purchase Order
Shipments results folder window. You can also select View
Shipments on the Tools menu to open this window. See: Using the
Purchase Order Shipments Summary Window: page 4 — 28

» Toenter a new release:

m  Select the New Release button to open the Releases window. If the
current record is a blanket purchase agreement or a planned
purchase order, then you can create a release against it.
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To enter a new purchase order:

m  Select the New PO button to open the Purchase Orders window.
See: Entering Purchase Order Headers: page 4 — 39.

To open the Purchase Orders or Releases window for the current line:

m  Select the Open button to open the Purchase Orders window and
query the purchase order on the current line. If the current line is
for a blanket or scheduled release, Purchasing opens the Releases
window and queries the current line. Your options in this window
depend on the status of the order and your approval and security
options. See: Entering Purchase Order Headers: page 4 — 39

To drill down to view purchase order distributions information;

m  Select View Distributions on the Tools menu to open the Purchase
Order Distributions results folder window. See: Using the
Purchase Order Distributions Summary Window: page 4 — 31.

To view acceptances:

m  Select View Acceptances on the Tools menu to open the View
Acceptances window. See: Entering and Viewing Purchase Order
Acceptances: page 4 — 87

To enter acceptances:

m  Select Enter Acceptances on the Tools menu to open the Enter
Acceptances window. See: Entering and Viewing Purchase Order
Acceptances: page 4 —87.

To view action history:

m  Select View Action History on the Tools menu to open the Action
History window. See: Viewing Action History: page 8 — 2.

To view invoices:

m  Select Invoices on the Tools menu to view invoice information: See:
Invoice Overview, Oracle Public Sector Payables User’s Guide.
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To view receipts:

m  Select View Receipts on the Tools menu to open the Find Receiving
Transactions window. See: Finding Receiving Transactions
(Summary): page 7 — 48

To enter purchase order control information:

e Select Control on the Tools menu to open the Control Document
window. See: Controlling Documents: page 2 — 55.

To enter purchase order preferences:

m  Select Preferences on the Tools menu to open the Purchase Order
Preferences window. See: Entering Purchase Order Preferences:
page 4 - 33

Customizing the Presentation of Data in a Folder, Oracle Applications
User’s Guide

Overview of Purchase Orders: page 4 - 3

Finding Purchase Orders: page 4 — 19

Using the Purchase Order Headers Summary Window: page 4 — 23
Using the Purchase Order Shipments Summary Window: page 4 — 28
Using the Purchase Order Distributions Summary Window: page 4 — 31

Using the Purchase Order Shipments Summary Window

Use the Purchase Order Shipments results folder window to:
¢ View purchase order shipment information.
o Drill down to view purchase order distribution information.

e Access the Purchase Orders and Releases windows for entry and
update of documents.

e Access other windows from the Tools menu.

Note that this window does not display price breaks.
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To navigate to the Purchase Order Shipments results window:

1. Inthe Find Purchase Orders window, select Shipments in the
Results region and select the Find button to open the Purchase
Order Shipments folder window. You can also navigate to this
window by selecting View Shipments on the Tools menu in the
Purchase Order Headers and Purchase Order Lines results folder
windows.

To drill down to view purchase order distribution information:

m  Select the Distributions button to drill down to the Purchase Order
Distributions results folder window. You can also select View
Distributions on the Tools menu to open this window. See: Using
the Purchase Order Distributions Summary Window: page 4 — 31.

To enter a new release:

m  Select the New Release button to open the Releases window. If the
current record is a blanket purchase agreement or a planned
purchase order, then you can create a release against it.

To enter a new purchase order:

m  Select the New PO button to open the Purchase Orders window.
See: Entering Purchase Order Headers: page 4 — 39.

To open the Purchase Orders or Releases window for the current
shipment:

m  Select the Open button to open the Purchase Orders window and
query the purchase order shipment on the current line. If the
current shipment is for a blanket or scheduled release, Purchasing
opens the Releases window and queries the current shipment.
Your options in this window depend on the status of the order and
your approval and security options. See: Entering Purchase Order
Headers: page 4 — 39

To view acceptances:

m  Select View Acceptances on the Tools menu to open the View
Acceptances window. See: Entering and Viewing Purchase Order
Acceptances: page 4 — 87
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See Also

To enter acceptances:

m  Select Enter Acceptances on the Tools menu to open the Enter
Acceptances window. See: Entering and Viewing Purchase Order
Acceptances: page 4 — 87.

To view action history:

m  Select View Action History on the Tools menu to open the Action
History window. See: Viewing Action History: page 8 — 2.

To view invoices:

m  Select Invoices on the Tools menu to view invoice information: See:
Invoice Overview, Oracle Public Sector Payables User’s Guide.

To view receipts:

m  Select View Receipts on the Tools menu to open the Find Receiving
Transactions window. See: Finding Receiving Transactions
(Summary): page 7 — 48.

To enter purchase order control information:

o Select Control on the Tools menu to open the Control Document
window. See: Controlling Documents: page 2 — 55.

To enter purchase order preferences:

m  Select Preferences on the Tools menu to open the Purchase Order
Preferences window. See: Entering Purchase Order Preferences:
page 4 — 33

Customizing the Presentation of Data in a Folder, Oracle Applications
User’s Guide

Overview of Purchase Orders: page 4 -3

Finding Purchase Orders: page 4 — 19

Using the Purchase Order Headers Summary Window: page 4 — 23
Using the Purchase Order Lines Summary Window: page 4 — 26

Using the Purchase Order Distributions Summary Window: page 4 — 31
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Using the Purchase Order Distributions Summary Window

Use the Purchase Order Distributions results folder window to:
¢ View purchase order distribution information.

e Access the Purchase Orders and Releases windows for entry and
update of documents.

e Access other windows from the Tools menu.

p To navigate to the Purchase Order Distributions results window:

1. Inthe Find Purchase Orders window, select Distributions in the
Results region and select the Find button to open the Purchase
Order Distributions folder window. You can also havigate to this
window by selecting View Distributions on the Tools menu in the
Purchase Order Headers, Purchase Order Lines, and Purchase
Order Shipments results folder windows.

p Toenter a new release:

m  Select the New Release button to open the Releases window. If the
current record is a blanket purchase agreement or a planned
purchase order, then you can create a release against it.

p To enter a new purchase order:

m  Select the New PO button to open the Purchase Orders window.
See: Entering Purchase Order Headers: page 4 — 39.

p To open the Purchase Orders or Releases window for the current line:

m  Select the Open button to open the Purchase Orders window and
query the purchase order on the current line. If the current line is
for a blanket or scheduled release, Purchasing opens the Releases
window and queries the current line. Your options in this window
depend on the status of the order and your approval and security
options. See: Entering Purchase Order Headers: page 4 — 39

» To view acceptances:

m  Select View Acceptances on the Tools menu to open the View
Acceptances window. See: Entering and Viewing Purchase Order
Acceptances: page 4 — 87
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p To enter acceptances:

m  Select Enter Acceptances on the Tools menu to open the Enter
Acceptances window. See: Entering and Viewing Purchase Order
Acceptances: page 4 — 87.

» Toview action history:
m  Select View Action History on the Tools menu to open the Action
History window. See: Viewing Action History: page 8 — 2.
p Toview invoices:
m  Select Invoices on the Tools menu to view invoice information: See:
Invoice Overview, Oracle Public Sector Payables User’s Guide.
» Toview receipts:

m  Select View Receipts on the Tools menu to open the Find Receiving
Transactions window. See: Finding Receiving Transactions
(Summary): page 7 — 48.

p To enter purchase order preferences:

m  Select Preferences on the Tools menu to open the Purchase Order
Preferences window. See: Entering Purchase Order Preferences:
page 4 - 33

See Also
Customizing the Presentation of Data in a Folder, Oracle Applications
User’s Guide
Overview of Purchase Orders: page 4 — 3
Finding Purchase Orders: page 4 — 19
Using the Purchase Order Headers Summary Window: page 4 — 23
Using the Purchase Order Lines Summary Window: page 4 — 26
Using the Purchase Order Shipments Summary Window: page 4 — 28
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Entering Purchase Order Preferences

Use the Purchase Order Preferences window to enter preference
information for purchase order lines, shipments, distributions, and
releases. You can save time and effort by entering valid default values
here. When you save your work in the Lines tabbed region in the
Purchase Orders window, Purchasing creates a shipment using the
organization and ship-to location if you provided valid values in the
defaults region. Then, if it is successful in creating a shipment,
Purchasing creates a distribution using these values. Similarly, when
you save your work in the Purchase Order Shipments window,
Purchasing creates a distribution if it does not already exist and if you
provided a valid organization here. You can update these shipments
and distributions by navigating to the Purchase Order Shipments or
Purchase Order Distributions windows.

Purchasing can create shipments only when it has default information
that meets the following criteria:

e There must be an organization and a location.

e The location must belong to the organization or not be assigned
to any organization.

¢ If the line contains an item (and optionally a revision), that item
(and revision) must be valid in the default shipment
organization.

Purchasing can create distributions only when it has default
information that meets the following criteria:

¢ [f the Destination Type is Inventory, the line must have an item
that is stock enabled in the ship—to organization. Also, if a
default subinventory has been entered, it must be defined in the
ship-to organization.

e The Account Generator must be able to supply the accounts. If
the Destination Type is Expense, you can enter a default charge
account, which overrides any account supplied by the Account
Generator.

¢ If you are using encumbrance accounting, you must enter a
default GL date.

Purchasing uses the preferences you enter in this window for the
current line and all subsequent purchase order lines that you enter
during this user session. Thus, for existing purchase orders, the
defaults apply only to new lines, shipments, and distributions that you
add during this session. If you want to clear the default information,
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either choose Delete Record in the Purchase Order Preferences window
or exit the application. The default values are only valid for the session
in which you are currently working. The are not saved to the database.

» Toenter main preferences:

1. Navigate to the Purchase Order Preferences window by selecting
Preferences on the Tools menu in most of the purchase orders and
releases windows.

EZPurchase Order Preferences (Mision Operations)

Price Type Mlinimum Release Armount

Contract Transaction Mature

MNeed-By | Promised |

Tax Code

Requisition | Regquisition Line

GL Date | Charge Account

Crganization Ship-Ta -

Destination Type Transaction Code

Requestar

Location

Subinventory

In the Main tabbed region, you can enter the defaults described in
the following steps.

2. Select Confirming Order to indicate that this order is confirming a
previous informal order with the supplier.

3. Enter a Price Type from the Lookup Codes window. See: Defining
Lookup Codes: page 1 - 74.

4. For planned purchase orders and blanket purchase agreements,
enter the Minimum Release Amount for a line.
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10.

11.

12.

If you are referencing contract purchase agreement on a standard
purchase order, enter the Contract number. The contract must be
effective; that is, the current date has to be within the effective date
and the expired date of the contract.

If you reference a contract purchase agreement on a standard
purchase order line, Purchasing adds the total amount of the
purchase order line to the total amount of the contract.

Enter the Transaction Nature. See: Defining Lookup Codes: page
1-74.

Enter the Need By date when the requestor needs the item. This
date is printed on the purchase order if you do not provide a
promised-by date. If you are using Purchasing with Master
Scheduling/MRP, you must provide either a need-by date or a
promised-by date for shipments that correspond to purchase order
lines with Master Scheduling/MRP planned items. A need-by date
is also required for Inventory planned items. See: Overview of
Implementing Planning Recommendations, Oracle Master
Scheduling/MRP and Supply Chain Planning User’s Guide.

Enter the Promised By date when the supplier promised delivery of
the items. This date is printed on the purchase order.

Enter the Tax Code for all shipments. The Tax Code overrides the
tax defaulting hierarchy defined in the Purchasing Options
window. See: Defining Tax Defaults Options: page 1 — 55.

Enter the paper Requisition Number for all distributions.
Purchasing automatically copies this number to every distribution
you create for this purchase order line. You can later review
purchase orders based on paper requisitions using the Find
Purchase Orders window. If you enter a requisition number, you
can also enter a Requisition Line number. See: Finding Purchase
Orders: page 4 - 19.

Enter the date you want to post expenses in your General Ledger
for every distribution you create for this purchase order line. You
can enter a GL Date only if you set up your financials system
options to use encumbrance for purchase orders. See: About
Financials Options, Oracle Public Sector Payables User’s Guide. See:
Budgetary Control and Online Funds Checking, Oracle Public Sector
General Ledger User’s Guide.

Enter the Accounting Flexfield that you want to charge for the
expenses. Purchasing uses the account you enter here only for
expense destinations and overrides any account built by the
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Account Generator. See: Using the Account Generator in Oracle
Public Sector Purchasing: page C - 9.

13. Enter the organization. The List of Values displays all valid
receiving organizations.

14. Enter the ship-to location for the shipment.

15. Enter the Destination type to indicate the final destination of the
purchased items:

Expense — The goods are delivered to the requestor at an expense
location. The destination subinventory is not applicable.

Inventory — The goods are received into inventory upon delivery.

16. Enter the Requestor. This is the employee who requests the
quantities on the purchase order distribution lines. Purchasing
copies this name as the requestor for every distribution you create
for this purchase order line.

17. Enter the Deliver To location for all distributions. Purchasing
copies this location to every distribution you create for this
purchase order line. The default is the requestor’s location. You
can pick any location that does not have an organization or any
location whose organization matches the ship—to organization. See:
the online help for the Enter Person window. See: Defining
Locations: page 1 — 24.

18. If the destination type is Inventory, you can enter the Subinventory.
See: Defining Subinventories, Oracle Inventory User’s Guide.

p Toenter project information preferences:

You see a Project Information tabbed region if one of the following is
true:

e Oracle Projects is installed, or

e Oracle Project Manufacturing is installed and Project Reference
Enabled is selected in the Project Manufacturing Organization
Parameters window

The project information you enter is used by Oracle Projects for
destination types of Expense, or by Oracle Project Manufacturing for
destination types of Inventory or Shop Floor. See: Oracle Projects
User’s Guide. See: Oracle Project Manufacturing Implementation Manual.

1. Choose the Project Information tabbed region.

2. Select a Project Number.
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For a Destination Type of Inventory or Shop Floor, you can
optionally enter a Project Number if the Project Control Level is set
to Project in the Project Information tabbed region of the
Organization Parameters window.

For a Destination Type of Expense, you can always optionally enter
a Project Number.

If you entered a Project number, select a Task number.

You must enter a Task number for a Destination Type of Inventory
or Shop Floor, if the Project Control Level is set to Task in the
Organization Parameters window and if you have entered a Project
number.

Enter Expenditure information.

Expenditure information is required only if your Destination Type
is Expense.

e Select the Expenditure Type.

¢ If you chose an Expenditure Type, enter an Expenditure
Organization.

¢ If you chose an Expenditure Organization, select the Expenditure
Item Date.

To apply your preference changes.

Select the Apply button to apply your changes.

Entering Purchase Order Lines: page 4 — 45
Entering Purchase Order Shipments: page 4 — 65
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Entering Purchase Order Distributions: page 4 — 77
Overview of Purchasing Options: page 1 - 45

Purchase Order Defaulting Rules: page 4 — 12
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Entering Purchase Order Headers

Use the Purchase Orders windowv to:

Enter standard and planned purchase orders as well as blanket
and contract purchase agreements

Note: You can also receive blanket purchase agreement lines
electronically from your suppliers through the Purchasing
Documents Open Interface. See: Receiving Price/Sales Catalog
Information Electronically: page 5 — 22.

Enter purchase orders from paper requisitions or without a
requisition

Take approval actions on individual purchase orders and
agreements on-line

If you want to create a release against a planned purchase order or a
blanket purchase agreement, use the Enter Releases window. See;
Entering Release Headers: page 4 — 90.

If you want to place on-line requisitions onto a new or existing
purchase order, use the AutoCreate Documents window. See:
Autocreate Documents Overview: page 6 — 2.

p To enter purchase order headers:

1. Navigate to the Purchase Orders window from the menu:

by selecting the New PO button in the Find Purchase Orders
window or any of its results windows

by selecting the Open button in any of the Find Purchase Order
results windows

by selecting the Open button and then double—clicking the Open
Documents icon in the Notifications Summary window when the
current line is a purchase order

if the PO: Display the AutoCreated Document profile option is
set to Yes, Purchasing opens the Purchase Orders window when
you have completed AutoCreation of a purchase order. See:
Profile Options in Purchasing: page 1 — 103.
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The upper part of the Purchase Orders window has the following
display-only fields:

Created — The system date is displayed as the creation date.

Status — Possible order status values are: Incomplete — The order
has not been approved. Approved — You have approved the order.
You can print it and receive items against it. Requires Reapproval —
You approved the order and then made changes that require you to
reapprove it.

Total — For standard and planned purchase orders, Purchasing
displays the current Total order amount.

Amount Agreed — For blanket and contract purchase agreements
only, Purchasing displays the agreed-to amount for the agreement.
The amount Released value should not exceed the Amount Agreed.
(Note also that if you change the Amount Limit in the Terms and
Conditions window, the Amount Agreed should be equal to or less
than the Amount Limit.)

4-40 Oracle Public Sector Purchasing User’s Guide



Released — For blanket and contract purchase agreements only,
Purchasing displays the current total amount Released. The
amount released is 0.00 until you create releases against the blanket
purchase agreement or reference the contract on a standard
purchase order.

Currency — Purchasing displays the functional currency. This is
overridden by supplier currency information.

P—Card — Purchasing displays a procurement card number if the
purchase order was created from a Self-Service Purchasing
requisition that used a corporate credit card for the purchase. This
field displays if the profile option PO: Use P—Cards in Purchasing is
set to Yes. Only the last four digits are displayed. Procurement
cards can be used for items with a Destination Type of Expense, for
documents that do not contain a Project number, and for standard
purchase orders or releases only.

Enter a unique Purchase Order number. The Revision is displayed
to the right of the number. If you chose automatic purchase order
number generation in your Purchasing Options, the cursor does not
enter this field and the number is generated when you save your
work.

Choose the purchase order Type: Standard Purchase Order,
Planned Purchase Order, Blanket Purchase Agreement, Contract
Purchase Agreement. See: Purchase Order Types: page 4 — 4.

Attention: The names of the above purchase order types can be
modified in the Document Types window. See: Defining
Document Types: page 1 — 87.

Enter the name of the Supplier for this purchase order. To approve
a purchase order, you must provide a supplier.

Attention: You cannot change the supplier once you approve the
purchase order. The purchase order becomes a legal document
when you approve it. To change the supplier after you approve a
purchase order, you must cancel the existing purchase order and
create a new one for the other supplier.

Enter the Site of the supplier you want to use for your purchase
order. If the supplier you choose has only one site, it is defaulted
into this field. Before you can approve a purchase order, you must
provide a site. Once the purchase order is approved, you can
change the supplier site only if the PO: Change Supplier Site profile
option is set to Yes. And only sites with the same currency as the
previous site can be used. If you change the supplier site, the
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revision will be incremented, and will require reapproval. You
cannot enter the supplier site until you have entered a supplier.

You can optionally enter the name of the Contact at the supplier
site. If the supplier you choose has only one contact name, it is
defaulted into this field. You cannot enter a contact until you have
entered a supplier site.

6. Enter the Ship To and Bill To locations for the purchase order. If
you entered a supplier and supplier site, the Ship To and Bill To
defaults reflect the locations you assigned to the supplier or
supplier site. You can accept these values or change them to other
locations. See: Purchase Order Defaulting Rules: page 4 — 12

7. If the Enforce Buyer Name option in your Purchasing Options is set
to Yes, your name is displayed as the Buyer, and you cannot change
this value. Otherwise, you can enter the name of any buyer. See:
Defining Control Options: page 1 — 49.

8. For blanket and contract purchase agreements only, enter the total
Amount Agreed. This is the amount you have agreed to spend
with the supplier.

9. Enter a Description of the purchase order. These comments are for
internal use only and do not print on the purchase order. You can
enter up to 240 characters. If you want to add unlimited notes, use
the Attachments feature. See: Attaching Notes to Purchasing
Documents: page 1 — 44.

10. For standard and planned purchase orders and blanket purchase
agreements, enter line information for the header you have just
created. See: Entering Purchase Order Line Information: page
4 — 45,

» Toopen the Supplier Item Catalog:

m  Select the Catalog button to open the Supplier Item Catalog. See:

Overview of the Supplier Item Catalog: page 5 - 8.
» Toenter currency information:

m  Select the Currency button to open the Purchase Order Currency

window. See: Entering Currency Information: page 4 — 58.
» To enter additional purchase order details information:

m  Select the Terms button to open the Terms and Conditions window.
See: Entering Purchase Order Details Information: page 4 — 61.
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To enter shipment information:

m  Select the Shipments button to open the Purchase Order Shipments
window. See: Entering Purchase Order Shipments: page 4 — 65.

To enter price break information:

m  For blanket purchase agreements, you can select the Price Break
button to open the Price Breaks window. See: Entering Purchase
Agreement Price Break Information: page 4 — 75.

To take approval actions:

m  Select the Approval button to open the Approve Documents
window. See: Submitting a Document for Approval: page 2 — 35.

To check funds:

m  Select Check Funds on the Tools menu.

To enter notification controls:

m  Select Notification Control on the Tools menu (For planned
purchase orders, contract purchase agreements, and blanket
purchase agreements). See: Entering Purchase Order Notification
Controls: page 4 — 85.

To enter or view acceptances:

m  Select Acceptances on the Tools menu to open the Acceptances
window. See: Entering and Viewing Purchase Order Acceptances:
page 4 — 87

To view action history:

m  Select View Action History on the Tools menu to open the Action
History window. See: Viewing Action History: page 8 — 2.

To enter purchase order preferences:

m  Select Preferences on the Tools menu. See: Entering Purchase
Order Preferences: page 4 — 33
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p Todisable Payment on Receipt for the purchase order:

m  Select the Terms button. In the Pay On field, choose Null to disable
Payment on Receipt for this document. Choose Receipt to enable
Payment on Receipt. The Pay On field is disabled if the supplier
site is not a Payment on Receipt site. See: Entering Purchase Order
Details Information: page 4 — 61.

» To reaccess a purchase order quickly:

m  Choose Place on Navigator from the Action menu. Choose the
Documents tabbed region in the Navigator to later access the
purchase order more quickly. See also: Using the Navigator’s
Documents Region, Oracle Applications User’s Guide.

Note: Once you place a document in the Navigator, it is the first
thing you see in the Navigator the next time you log into
Purchasing. Choose Functions to return to the Purchasing menu.

See Also

Overview of Purchase Orders: page 4 — 3
Entering Purchase Order Lines: page 4 — 45
Changing Encumbered Documents: page 4 — 135

Procurement Card Purchase Orders and Releases: page 4 — 146
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Entering Purchase Order Lines

Use the Lines tabbed region in the Purchase Orders window to create
purchase order lines.

When you save your work, Purchasing creates shipments and
distributions if sufficient valid default information is available. Use the
Purchase Order Shipments window to review, edit, and create multiple
shipment lines for each purchase order line. See: Entering Purchase
Order Shipments: page 4 — 65.

p To enter a purchase order line;

1. Select the Items tabbed region in the Purchase Orders window.
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2. Enter the purchase line Number for the purchase order line. If you
start a new purchase order line, Purchasing displays the next
sequential line number available. You can accept this number or
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enter any line number that does not already exist. This number is
used for all tabbed regions in the Purchase Orders window.

Enter the line Type for the item. When you create your purchase
order line, you enter a line type as part of your item information.
When you enter a line type, Purchasing automatically copies the
corresponding defaults. You can change the line type after you
have saved your work, if the change is in the same line type class,
but Purchasing won’t automatically copy the new defaults. If you
change the line type before you save your work, Purchasing
automatically copies the new defaults if the new line type isin a
different line type class.

You can enter predefined items for your purchase order line only
when you specify a quantity based line type. If Bills of Material
and Work in Process are installed and you have defined an outside
processing line type, you can enter that type here to purchase
outside processing. See: Defining Default Options: page 1 — 45.
See: Defining Line Types: page 1 — 84.

Enter the Item you want to purchase. If you enter an item,
Purchasing displays the purchasing category, item description, unit
of measure, and unit price associated with the item. To create a
purchase order line for a one-time item, simply skip the item
number field and enter a purchasing category and an item
description. If you are purchasing outside processing, you can
enter only outside processing items. See: Defining Items, Oracle
Inventory User’s Guide.

Enter the Revision number for the item on the purchase order line.
The Revision number is requried if the item is under revision
control. See: Defining Item Revisions, Oracle Inventory User’s
Guide. See: Inventory Attribute Group, Oracle Inventory User’s
Guide.

Enter the purchasing Category of the item you want to purchase. If
you choose an item, Purchasing displays the purchasing category
for the item. You cannot change the purchasing category if you
choose an item. See: Defining Categories, Oracle Inventory User’s
Guide.

Enter the Description of the item. If you choose an item,
Purchasing displays its description. You can change the item
description only if you set up the item attributes to let you do so.
The full item description for the current line is displayed beneath
the Lines tabbed region.
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10.

11.

12.

13.

14.

Enter the total Quantity you are ordering on the purchase order
line.

Enter the UOM of the item. The unit of measure qualifies the
quantity you enter on the purchase order line. When you choose a
line type, its default unit of measure appears here. When you
choose an item number, its unit of measure overrides the line type
default. You can change the UOM until the item has been received,
billed, or encumbered.

Enter the unit Price for the item. If you choose an item, the default
price is the list price for the item. Otherwise, the default price is
from the line type. The Amount field displays the unit price
multiplied by the quantity.

Enter the Promised date that the supplier promised delivery of the
items. This promised-by date is printed on the purchase order.

Enter the Need By date when the requestor needs the item. This
date is printed on the purchase order if you do not provide a
promised-by date. If you are using Master Scheduling/MRP, you
must provide either a need-by date or a promised-by date for
shipments that correspond to purchase order lines with Master
Scheduling/MRP planned items. A need-by date is also required
for Inventory planned items. See: Overview of Implementing
Planning Recommendations, Oracle Master Scheduling/MRP and
Supply Chain Planning User’s Guide.

Optionally enter the Supplier’s Item number for this item.

Multiple distributions, Promised date, and Need-By date display
as “multiple” at the line level.

Select Reserved to reserve funds for the line.

To view tax information:

After you have entered and saved all tax information, do either or
both of the following:

e Choose Tax Code Summary from the Tools menu to see the total
recoverable and nonrecoverable tax for each tax code in your
document. See: Viewing Tax Code Summary Information: page
4-141.

e Choose Tax Details from the Tools menu to see recoverable and
nonrecoverable tax details for each line, shipment, and
distribution. See: Viewing Tax Details: page 4 — 143.
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p To reaccess a purchase order quickly:

m  Choose Place on Navigator from the Action menu. Choose the
Documents tabbed region in the Navigator to later access the
purchase order more quickly. See also: Using the Navigator’s
Documents Region, Oracle Applications User’s Guide.

Note: Once you place a document in the Navigator, it is the first
thing you see in the Navigator the next time you log into
Purchasing. Choose Functions to return to the Purchasing menu.

See Also

Overview of Purchase Orders: page 4 — 3

Entering Purchase Order Headers: page 4 — 39

Overview of the Supplier Item Catalog: page 5-8

Entering Currency Information: page 4 — 58

Entering Purchase Order Details Information: page 4 - 61
Entering Purchase Order Shipments: page 4 — 65

Entering Purchase Agreement Price Break Information: page 4 — 75
Submitting a Document for Approval: page 2 — 35.

Entering Purchase Order Notification Controls: page 4 — 85
Entering and Viewing Purchase Order Acceptances: page 4 — 87
Viewing Action History: page 8 — 2

Entering Purchase Order Preferences: page 4 — 33

Changing Encumbered Documents: page 4 — 135
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Entering Purchase Order Price Reference Information

Use the Price Reference tabbed region in the Purchase Orders window
to enter pricing information for purchase order lines.

p To enter price reference information:

1.

Select the Price Reference tabbed region in the Purchase Orders
window.

Enter the List Price for the item. If you have entered an item,
Purchasing displays the list price for the item. (See: Defining
Items, Oracle Inventory User’s Guide.) You can accept the default list
price or change it. Use this field to help evaluate your buyers.
Purchasing uses the list price you enter here in the savings analysis
reports. See: Savings Analysis Report (By Buyer): page 9 — 151 and
Savings Analysis Report (By Category): page 9 — 153.

Enter the latest Market Price for the item. If you enter an item,
Purchasing displays the market price for the item. Use this field to
help evaluate your buyers. Purchasing uses the price you enter
here in the savings analysis reports if you do not provide a value in
the List Price field.

Enter the Price Type from your lookup codes. See: Defining
Lookup Codes: page 1 - 74.

For planned purchase orders and blanket purchase agreements
only, check Allow Price Override to indicate that the release price
can be greater than the price on the purchase agreement line. 1f you
allow a price override, the release price cannot exceed the Price
Limit specified on the line. If you do not allow a price override,
Purchasing displays on the release the shipment price from the
purchase agreement and prevents you from updating it. You
cannot enter this field if the line type is amount based.

If you allow price override, enter the Price Limit. This is the
maximum price per item you allow for the item on this agreement
line.

Select Negotiated to indicate that the purchase price is negotiated.
If the actual price is greater than or equal to the list price, then the
field is unchecked as the default. If the actual price is less than the
list price, then the field is checked as the default. You can accept
the default value or change it.

Save your work.
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See Also

Overview of the Supplier Item Catalog: page 5-8

Entering Currency Information: page 4 — 58

Entering Purchase Order Details Information: page 4 - 61

Entering Purchase Order Shipments: page 4 — 65

Entering Purchase Agreement Price Break Information: page 4 — 75
Submitting a Document for Approval: page 2 — 35.

Entering Purchase Order Notification Controls: page 4 — 85
Entering and Viewing Purchase Order Acceptances: page 4 — 87
Viewing Action History: page 8 — 2

Entering Purchase Order Preferences: page 4 — 33
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Entering Purchase Order Reference Document Information

Use the Reference Documents tabbed region in the Purchase Orders
window to enter reference document information for purchase order
lines.

Purchasing lets you reference quotation information on your purchase
orders.

p To enter reference document information:

1. Select the Reference Documents tabbed region in the Purchase
Orders window.
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2. Enter the Contract purchase agreement number. You cannot enter
a contract number until you have entered a supplier in the header,
and the contract must be for this supplier. The contract you choose
must be effective; that is, the current date has to be within the
effective date and the expired date of the contract.
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See Also

If you reference a contract purchase agreement on a standard
purchase order line, Purchasing adds the total amount of the
purchase order line to the total amount of the contract purchase
agreement. Purchasing lists only those contracts with the same
supplier as the one on your standard purchase order.

= Attention: If you have not yet provided a supplier on your

standard purchase order, you cannot choose any contracts for your
purchase order lines. If you want to change the supplier on your
standard purchase order after you reference a contract on your
purchase order lines, you must remove the references to the

contract purchase agreement, or you will not be able to approve the

purchase order. Purchasing lets you change suppliers only on
standard and planned purchase orders with the status Incomplete.

Purchasing displays the Quotation and Quotation Line numbers,
Quotation Type, and Supplier Quotation Number if you select a
quotation from the Supplier Item Catalog or Supplier-Item
Attributes windows.

3. Save your work.

Overview of the Supplier Item Catalog: page 5-8

Entering Currency Information: page 4 — 58

Entering Purchase Order Details Information: page 4 — 61

Entering Purchase Order Shipments: page 4 — 65

Entering Purchase Agreement Price Break Information: page 4 — 75
Submitting a Document for Approval: page 2 — 35.

Entering Purchase Order Notification Controls: page 4 — 85
Entering and Viewing Purchase Order Acceptances: page 4 — 87
Viewing Action History: page 8 - 2

Entering Purchase Order Preferences: page 4 — 33
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Entering Purchase Order Miscellaneous Information

Use the More tabbed region in the Purchase Orders window to enter
miscellaneous information for purchase order lines.

p To enter miscellaneous information:

1. Select the More tabbed region in the Purchase Orders window.
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2. Enter a Note to the Supplier for the purchase order header. You
can enter up to 240 characters. If you want to enter unlimited
notes, use the Attachments feature. See: Attaching Notes to
Purchasing Documents: page 1 — 44

3. Enter the UN identification Number for the item on the purchase
order line. The default, if present, is from the item record. See:
Defining UN Numbers: page 1 - 71.

4. Enter the Hazard Class for the item on the purchase order line. If
you enter a UN number, Purchasing displays the corresponding
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hazard class. The default, if present, is from the item record. See:
Defining Hazard Classes: page 1 - 70.

5. Select Capital Expense to indicate that the purchase is a capital
expenditure.

6. Enter the Transaction Nature. See: Defining Lookup Codes: page
1-74.

7. Save your work.

See Also

Overview of the Supplier Item Catalog: page 5-8

Entering Currency Information: page 4 — 58

Entering Purchase Order Details Information: page 4 - 61

Entering Purchase Order Shipments: page 4 — 65

Entering Purchase Agreement Price Break Information: page 4 — 75
Submitting a Document for Approval: page 2 — 35.

Entering Purchase Order Notification Controls: page 4 — 85
Entering and Viewing Purchase Order Acceptances: page 4 — 87
Viewing Action History: page 8 — 2

Entering Purchase Order Preferences: page 4 — 33
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Entering Purchase Agreement Information

Use Terms in the Purchase Orders window to enter additional
information for blanket purchase agreement lines and headers.

» Toenter additional agreement information on the header:

1. From the Purchase Orders window, select Terms.
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2. Choose the Payment term. An example of a payment term is Net
30.

Choose a Freight term. An example of a freight term is Prepaid.

4. Choose a Carrier. An example of a carrier is Rail.

5. Choose an FOB point. An example of an FOB point is Origin.
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In the Pay On field, select Receipt if you want an invoice to be
created automatically for this document when you run Payment on
Receipt, or Null if you do not. Receipt is defaulted in this field if
the supplier site is set up as a Payment on Receipt site in the
Supplier Sites window. If the supplier site is not set up as a
Payment on Receipt site, this field is disabled, and you cannot
change it. You can update the Pay On field again on a release (if
the supplier is a Payment on Receipt site). See: Payment on
Receipt: page 9 - 66.

Save your work.

» Toenter additional agreement line information:

1.

In the Agreement tabbed region of the Purchase Orders window
(when you’ve selected a Type of Blanket Purchase Agreement),
enter the Minimum Release Amount against this purchase
agreement line.
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See Also

Enter the Quantity Agreed. This is printed on your purchase
orders. Purchasing does not automatically compute the quantity
agreed from the amount agreed. Use the Amount Agreed field to

provide agreed amounts.

3. Enter the Amount Agreed. Purchasing does not automatically
compute the amount agreed from the quantity agreed.

4. Optionally enter an Expiration Date to prevent ordering of the item

after that date.

If the item on the agreement has expired but already exists on an
open release, you can still use the release. However, the expired
line item will not be used for sourcing, and any future releases you
create will not allow using the expired item. (If you use

Self-Service Purchasing, expired line items are also not available in

the catalog.)

5. Select Cumulative Pricing if you want Purchasing to choose the
price break by adding the current release shipment quantity to the

total quantity already released against the purchase agreement line.

Otherwise, Purchasing chooses the price break by using the
individual release shipment quantity.

6. Save your work.

Overview of the Supplier Item Catalog: page 5 -8

Entering Currency Information: page 4 — 58

Entering Purchase Order Details Information: page 4 — 61

Entering Purchase Order Shipments: page 4 — 65

Entering Purchase Agreement Price Break Information: page 4 - 75
Submitting a Document for Approval: page 2 — 35.

Entering Purchase Order Notification Controls: page 4 — 85
Entering and Viewing Purchase Order Acceptances: page 4 — 87
Viewing Action History: page 8 — 2

Entering Purchase Order Preferences: page 4 — 33
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Entering Currency Information

4 -58

Use the Currency window to enter and change currency information
for purchase orders, RFQs, and quotations.

For purchase orders, you can change currency information until the
purchase order is approved or encumbered. Note that changing the
purchase order supplier to one that uses a different currency overrides
any information you have entered in this region.

To enter currency information:

Navigate to the Currency window by selecting the Currency button
in the Purchase Orders, RFQs, and Quotations windows.

sCurrency (Vision Operations) - 1003667 X

Rate Type
EEIGRREIE 16/JAN/2001

Purchasing displays the functional Currency from your Set of
Books, and you can accept or change the currency. If you change
the currency, you must update the unit price on all lines to reflect
what that price would be at the new currency.

You can enter a Rate Type only if the currency for this document is
different from your functional or base currency. The default is the
currency rate type from the Purchasing Options window.

Purchasing supplies you with one of two predefined currency rate
types: User or EMU Fixed. A rate type of User means that you can
enter a conversion rate between the foreign currency (or
transaction currency in a document entry window) and the base
currency (or functional currency, defined in your set of books). A
rate type of EMU Fixed means that if either your transaction
currency or your functional currency is Euro (the European

Oracle Public Sector Purchasing User’s Guide



Monetary Unit currency) and the other is another European
currency, Purchasing automatically enters a conversion Rate Date
and Rate for you that you cannot change.

You can define additional currency rate types in the Daily
Conversion Rate Types window, and you can enter User or one of
your additional types as the default. Note that you cannot approve
a purchase order without a rate type if you are not using your
functional currency.

The default Rate Date is the current date. Purchasing uses this date
to obtain the currency conversion rate from your conversion
definitions and displays the rate if it finds one.

If the rate type is User, you can enter the conversion rate between
the foreign currency and your functional currency. This rate
corresponds to the value of your foreign currency in your
functional currency. For example, if your functional currency is US
Dollars, the foreign currency is British Pounds, and 1 British Pound
equals 2 US Dollars, you should enter 2 in this field. For other rate
types, when you enter a rate date for which a rate has been
defined, Purchasing displays the rate.

p To cancel your entries and return:

Select the Cancel button to cancel your entries and return to the
window from which you accessed the Currency window.

» Toapply your entries:

Select the Done button to apply your entries.
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See Also

Purchase Order Defaulting Rules: page 4 — 12
Defining Purchasing Options: page 1 — 45
Defining Currencies, Oracle Public Sector General Ledger User’s Guide

Defining Conversion Rate Types, Oracle Public Sector General Ledger
User’s Guide

Entering Daily Rates, Oracle Public Sector General Ledger User’s Guide
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Entering Purchase Order Details Information
Use the Terms and Conditions window to enter terms and conditions
information for purchase orders.
p Toenter purchase order terms information:

1. Navigate to the Terms and Conditions window by selecting the
Terms button in the Purchase Orders window.
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2. For planned purchase orders, blanket purchase agreements, and
contract purchase agreements, enter the Effective start date for the
purchase order. A starting date is necessary if you are using a
warning delay on notification controls. You cannot associate a
purchase order line with a contract that is not yet effective. You
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also cannot create a release with a date that is before the
corresponding blanket purchase agreement or planned purchase
order effective date.

For planned purchase orders, blanket purchase agreements, and
contract purchase agreements, enter the Effective expiration date
for the purchase order. This date must be later than the start date
and later than any existing releases. You cannot associate a
purchase order line with a contract that has expired. You also
cannot create a release with a date that is after the corresponding
blanket purchase agreement or planned purchase order expiration
date.

Enter the Payment terms for the purchase order. Purchasing
displays default payment terms that you can accept or change. See:
Defining Payment Terms, Oracle Public Sector Payables User’s Guide.

Enter the Freight terms for the purchase order. Purchasing displays
default freight terms that you can accept or change. See: Defining
Lookup Codes: page 1 - 74

Enter the freight Carrier for shipment of the purchase order.
Purchasing displays a default freight carrier that you can accept or
change. See: Defining Freight Carriers, Oracle Inventory User’s
Guide.

Enter the FOB point for the purchase order. Purchasing displays a
default free on board (FOB) designation that you can accept or
change. See: Defining Lookup Codes: page 1 - 74.

Optionally select a value in the Pay On field to enable or disable
Payment on Receipt for this document.

Receipt is defaulted in this field if the supplier site is set up as a
Payment on Receipt site in the Supplier Sites window. Receipt
means that Payment on Receipt will automatically generate an
invoice for this purchase order.

Select Null if you do not want Payment on Receipt to automatically
create an invoice for this document. If the supplier site is not set
up as a Payment on Receipt site, this field is disabled, and you
cannot change it. See: Payment on Receipt: page 9 — 66.

You can update the Pay On field again on a release (if the supplier
is a Payment on Receipt site).

Select Acceptance Required to indicate that the supplier must
accept the purchase order. If you select this check box, you can
enter the due By date, when you require the supplier to return an
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10.

11.

12.

13.

14.

15.

16.

acceptance for your purchase order. See: Entering and Viewing
Purchase Order Acceptances: page 4 — 87.

Select Confirming Order to indicate that the purchase order is a
confirming order. A confirming order is an order that you are
submitting formally to confirm a verbal order already placed with
the supplier. For confirming orders, Purchasing prints the
following on the purchase order header: This is a confirming
order. Do not duplicate.

Select Firm to indicate that the purchase order is firm. Firm your
purchase order when you want to indicate to Master
Scheduling/MRP or your manufacturing application that it should
not reschedule this purchase order shipment.

Select Supply Agreement if you want Oracle Supplier Scheduling to
communicate releases against this blanket purchase agreement to
suppliers.

Supplier Scheduling can communicate releases against a blanket
purchase agreement only when this option is selected.

For planned purchase orders, blanket purchase agreements, and
contract purchase agreements, enter the Amount Limit (for the
total of all releases) and the Minimum Release Amount that can be
released against this purchase order. For blanket and contract
purchase agreements, the Amount Limit must be equal to or
greater than the Amount Agreed. Enter Effective from and to dates
to limit the agreement controls by time.

Enter a Price Update Tolerance only if you are importing
price/sales catalog information through the Purchasing Documents
Open Interface.

The Price Update Tolerance specifies the maximum percentage
increase allowed to an item’s price on this document when your
supplier sends updated price/sales catalog information through
the Purchasing Documents Open Interface. This field affects only
those documents imported through the Purchasing Documents
Open Interface. See: Setting a Price Tolerance in a Price/Sales
Catalog Update: page 5 — 25.

Enter a Supplier Note and a Receiver Note. You can enter up to
240 characters in these fields.

Save your work.
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See Also

Purchase Order Defaulting Rules: page 4 — 12
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Entering Purchase Order Shipments

Use the Shipments window to enter multiple shipments for standard
and planned purchase order lines and to edit shipments that
Purchasing automatically created for you. A purchase order shipment
specifies the quantity, ship—to organization and location, date you want
your supplier to deliver the items on a purchase order line, and country
of origin for the items. When you save your work, Purchasing creates
distributions if sufficient valid default information is available and if
there are no existing distributions.

p To enter purchase order shipment information:

1. Forstandard and planned purchase orders, you can navigate to the
Shipments window by selecting the Shipments button in the
Purchase Orders window.

%Shipmems (\Vision Operations) - 1003666

Shipments

Original
~ Num  GOrg  Ship-To LIOM  Quantity Promised Date MNeed-By Prarmise
B v V1 New York (Each [2 19/JAN/2001

(Gl C1118 c1118

The first tabbed region in the Shipments window is the Shipments
tabbed region. In addition to the enterable fields discussed in the
following steps, this region displays the UOM, the Original
Promise date (if the Promised date has already been changed, the
original promised date is displayed here), the Charge Account, the
line Amount, and a check box to indicate whether funds have been
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Reserved. See: Budgetary Control and Online Funds Checking,
Oracle Public Sector General Ledger User’s Guide.

Enter the line Number for the shipment line. If you enter a new
shipment line, Purchasing displays the next sequential line number
available. You can enter any line number that does not already
exist.

Enter the ship—to Organization. If you entered an item, you can
pick only organizations in which the item is defined. If you entered
a revision number on the purchase order line, then the item
revision must also be defined in the organization. Note that you
cannot update the organization once you have saved your work if
the shipment has distributions. See: Purchase Order Defaulting
Rules: page 4 - 12

Enter the Ship-To location for the shipment. You can pick any
location that does not have an organization or any location whose
organization matches the organization in the previous field. See:
Purchase Order Defaulting Rules: page 4 — 12.

Enter the Quantity for the shipment. This value must be greater
than 0. The default is the quantity from the corresponding
Purchase Order Line. If you decrease this quantity, Purchasing
automatically defaults the quantity ordered of the next line to the
total quantity that you have not yet placed on a shipment line. The
UOM is displayed to the right of the Quantity.

Enter the date that the supplier Promised delivery of the items.
This promised date is printed on the purchase order shipment. The
default is from the Purchase Order Preferences window.

Enter the Need By date when the requestor needs the item. This
date is printed on the purchase order if you do not enter a
promised date. The default is from the Purchase Order Preferences
window. If you use Purchasing with Master Scheduling/MRP, you
must provide a need-by date for purchase order shipments with
Master Scheduling/MRP planned items. You must also provide a
need-by date for Inventory planned items. See: Overview of
Implementing Planning Recommendations, Oracle Master
Scheduling/MRP and Supply Chain Planning User’s Guide.

Optionally choose or change the Country of Origin.

The Country of Origin is the country in which an item is
manufactured.

The Country of Origin displayed here defaults from the Approved
Supplier List, if it is defined there. If not, it defaults from the
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supplier site in the Supplier Sites window. Otherwise, this field is
blank. You can leave it blank or select a country.

If you do not know the originating country, you can enter or
change the Country of Origin later on the receipt.

9. Note that Taxable is selected if a Tax Code is associated with the
item.

If there is no Tax Code for the item, Taxable is not selected. You
cannot change the Taxable check box independently of the Tax
Code.

10. Enter or use the default Tax Code for taxable items.

The tax code defaults from the following sources, in the following
order:

e The Purchase Order Preferences window. If you have specified a
preferred tax code in this window, Purchasing defaults this tax
code onto the purchase order shipment.

e The Tax Defaults region in the Purchasing Options window. If
you have specified a tax defaulting hierarchy in this window,
Purchasing searches for and defaults the tax code based on that
tax defaulting hierarchy. See: Defining Tax Defaults Options:
page 1 - 55.

Accept the default tax code or select another. You cannot override
the tax code if the profile option Tax: Allow Override of Tax Code is
set to No, if the shipment has been received, or while funds for the
document are reserved if you use encumbrance accounting.

If on the purchase order you change a tax source, such as Supplier
or Site, then Purchasing does not redefault a new Tax Code on the
current shipment, but does default it on new shipments. The same
is true even after you override the Tax Code: Purchasing does not

redefault it on existing shipments when you change a tax source.

Note: If you change the Tax Code after already creating
distributions for the shipment, the associated Recovery Rate on
those distributions is not redefaulted for the new Tax Code.

For an overview of tax in Purchasing, see: Tax Defaults in
Purchasing: page 4 — 138.

11. Save your work.
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To display and enter more shipment information:

1.

Select the More tabbed region in the Purchase Order Shipments
window.

Enter the Receipt Close Tolerance percent for your shipments.
Purchasing automatically closes a shipment for receiving if it is
within the receiving closing tolerance at the receiving close point.
You need to set the receiving close point in the Purchasing Options
window. See: Defining Control Options: page 1 —49.

Enter the Invoice Close Tolerance percent for your shipments.
Purchasing automatically closes a shipment for invoicing if it is
within the invoicing closing tolerance at billing, when Payables
matches invoices to purchase orders or receipts. See: Defining
Control Options: page 1 -49

Select one of the following options for Match Approval Level:

Two-Way: Purchase order and invoice quantities must match
within tolerance before the corresponding invoice can be paid.

Three-Way: Purchase order, receipt, and invoice quantities must
match within tolerance before the corresponding invoice can be
paid.

Four-Way: Purchase order, receipt, accepted, and invoice quantities
must match within tolerance before the corresponding invoice can
be paid.

If you enter an item, the default value for this field comes from the
item information at the organization level. If not defined there, the
default comes from the item information at the master level. If you
do not enter an item, the default is from your Purchasing Options.

See: Receiving Controls, Options, and Profiles: page 7 - 8.

Select an Invoice Match Option:

Purchase Order: Payables must match the invoice to the purchase
order.

Receipt: Payables must match the invoice to the receipt.

Choose Receipt if you want to update exchange rate information on
the receipt or if you want your accounting to use exchange rate
information based on the receipt date. (If you use Periodic Costing,
you must match to the receipt to ensure accurate cost accounting.)

The Invoice Match Option defaults from the Supplier Sites window.
You can change the Invoice Match Option on the shipment until
you receive against the shipment.
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Note: The Invoice Match Option and the Match Approval Level
are independent options. You can perform whichever Invoice
Match Option you want regardless of the Match Approval Level.

See: Entering Purchase Order Matched Invoices, Accounts Payable
User’s Guide.

Select Accrue at Receipt to indicate that the items on this purchase
order line accrue upon receipt. Inventory destined items always
accrue upon receipt. For expense items, if the Accrue Expense
Items flag in the Purchasing Options window is set to Period End,
the items cannot accrue upon receipt, and you cannot change the
shipment level default. If the Accrue Expense Items flag is set to
At Receipt, the default is to accrue upon receipt, but you can
change it to Period End. See: Defining Accrual Options: page
1-48.

Attention: If you are using Cash Basis Accounting, you should
use the Purchasing Options window to set the Accrue Expense
Items flag to Period End, and you should not select Accrue on
Receipt in this window.

Select Firm to firm the purchase order shipment. Firm your
purchase order when you want to indicate to Master
Scheduling/MRP or your manufacturing application that it should
not reschedule this shipment.

Save your work.

To display status information:;

Select the Status tabbed region in the Purchase Order Shipments
window.

For each shipment, Purchasing displays the Status and the quantity
Ordered, Received, Cancelled, and Billed.

To enter receiving control information:

Select the Receiving Controls button to open the Receiving Controls
window. See: Entering Purchase Order Receiving Controls: page
4-71.

To enter purchase order distribution information:

Select the Distributions button to open the Distributions window.
See: Entering Purchase Order Distributions: page 4 — 77.
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p Toview tax information:

m  After you have entered and saved all tax information, do either or
both of the following:

e Choose Tax Code Summary from the Tools menu to see the total
recoverable and nonrecoverable tax for each tax code in your
document. See: Viewing Tax Code Summary Information: page
4-141.

e Choose Tax Details from the Tools menu to see recoverable and
nonrecoverable tax details for each line, shipment, and
distribution. See: Viewing Tax Details: page 4 — 143.

See Also

Entering Purchase Order Preferences: page 4 — 33
Changing Encumbered Documents: page 4 — 135

Processing Periodic Acquisition Costs, Oracle Cost Management User’s
Guide
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Entering Purchase Order Receiving Controls

Use the Receiving Controls window to enter receiving control
information for purchase orders and releases. Note that controls you
enter here apply to specific purchase orders/releases and override the
receiving controls you enter in the Receiving Options window. See:
Receiving Controls, Options, and Profiles: page 7 - 8

» To enter purchase order receiving controls:

1. Navigate to the Receiving Controls window by selecting the
Receiving Controls button in the Shipments window for purchase
orders and in the Releases window for releases.
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F2= Receiving Controls

Receipt Date
Days Early
Days Late
Action

Last Accept Date

Over Receipt Quantity
Talerance

Action

Miscellaneous

"l Allow Substitute Receipts
Receipt Routing
Enforce Ship Ta

2. Enter the maximum acceptable number of Days Early and Days
Late for receipts.

3. Enter the Action for receipt date control. This field determines
how Purchasing handles receipts that are earlier or later than the
allowed number of days selected above. Choose one of the
following options:

None — Receipts may exceed the allowed days early or late.
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Reject — Purchasing does not permit receipts outside the selected
number of days early or late.

Warning — Purchasing displays a warning message but permits
receipts outside the selected number of days early or late.

Purchasing displays the Last Accept Date, which is the last date
when the shipment can be received. This is the promised date plus
the number of days late allowed.

4. Enter the maximum acceptable over—receipt Tolerance percent.

5. Enter the Action for Overreceipt Quantity control. This field
determines how Purchasing handles receipts that exceed the
quantity received tolerance. Choose one of the following options:

None — Receipts may exceed the selected tolerance.

Reject — Purchasing does not permit receipts that exceed the
selected tolerance.

Warning — Purchasing displays a warning message but permits
receipts that exceed the selected tolerance.

6. Select Allow Substitute Receipts to indicate that receivers can
receive substitute items in place of ordered items. You must define
substitute items before you can receive them. See: Defining Item
Relationships, Oracle Inventory User’s Guide

7. Enter the default Receipt Routing that you assign goods: Direct
Delivery, Inspection Required, or Standard Receipt. You can
override this routing during receipt by changing the destination
type, if the RCV: Allow Routing Override user profile option is
enabled. See: Profile Options in Purchasing: page 1 — 103.

8. Enter the Enforce Ship To location option to determine whether the
receiving location must be the same as the ship-to location.
Choose one of the following options:

None — The receiving location may differ from the ship-to location.

Reject — Purchasing does not permit receipts when the receiving
location differs from the ship-to location.

Warning — Purchasing displays a warning message but permits
receipts when the receiving location differs from the ship-to
location.

p To cancel your entries:

m  Select the Cancel button to cancel your entries and return to the
original window.
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» Toapply your entries:

m  Select the OK button to apply your entries and return to the
original window.

See Also

Defining Receiving Options: page 1 — 58
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Entering Purchase Agreement Price Break Information

Use the Price Break window to enter price break information for
blanket purchase agreement lines.

p To enter price break information:

1. Navigate to the Price Break window by selecting the Price Break
button in the Purchase Orders window.

%Price Breaks (\Vision Operations) - 1003667

Price Breaks

- Mum  Org  Ship-To Cluantity Break Price Discount [ %)
| I( V1 |[V1-New York City 10 714.83

L= C1118 C1118

2. Enter aline Number for the shipment line. Purchasing displays the
next available line number as the default.

3. Enter the ship to Organization. If you entered an item, you can
select only organizations in which the item is defined. If you
entered a revision number on the purchase order line, then the item
revision must also be defined in the organization. See: Purchase
Order Defaulting Rules: page 4 - 12.

4. Enter the Ship To location for the price break. You can select only
locations for this organization or locations for which no
organization is defined.
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5. Enter the minimum Quantity that must to ordered to obtain this
price break. The shipment quantity is displayed as the default.

6. Enter the Break Price at this quantity. Purchasing calculates the
Discount % for you.

7. You can optionally enter a Discount % to have the Break Price
calculated for you.

8. Save your work.

See Also

Entering Purchase Order Lines: page 4 — 45
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Entering Purchase Order Distributions

Use the purchase order Distributions window to enter distribution
information for purchase order shipments or to view distributions that
Purchasing has automatically created for you. You can enter multiple
distributions per shipment line. You can also enter information about
paper requisitions in this window.

p To enter purchase order distribution information:

1. Navigate to the Distributions window by selecting the
Distributions button in the Shipments window. The Shipments
window is accessed from the Purchase Orders window. You begin
in the Destination tabbed region.

% Distributions (Vision Operations) - 1003666

Destination

Mum  Type Reqguestor Deliver-To Subinventaory Quantity

| h Inventany 2

Account Description

-8 Operations.Balance Sheet.Inventory R Budget
Operations.Balance Sheet.Accounts Pe =-"H Operations.Vision Operations In.Invoic

Cutside Processing

2. Enter the line Number for the distribution line. If you enter a new
distribution line, Purchasing displays the next sequential line
number available. You can enter any line number that does not
already exist.

3. The destination type determines the final destination of the
purchased items. Choose one of the following options:
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Expense — The goods are delivered to the requestor at an expense
location. The destination subinventory is not applicable.

Inventory — The goods are received into inventory upon delivery.
You can choose this option only if the item is stock enabled in the
ship-to organization.

Shop Floor — The goods are delivered to an outside processing
operation defined by Work in Process. You can choose this option
only for outside processing items.

Enter the Requestor and Deliver To location for this distribution. If
the destination type is Inventory, you can also enter the
Subinventory.

Enter the Quantity of the purchase order shipment that you want to
charge to the Accounting Flexfield. The default value comes from
the quantity you enter in the Shipments window. If you decrease
the default quantity, Purchasing automatically defaults on the next
distribution line the total quantity you have not yet assigned to a
distribution line.

Enter the Charge Account. When you save your changes in this
window, Purchasing uses the Account Generator to automatically
create the following three accounts for each distribution:

e Charge: the account to charge for the cost of this item
e Accrual: the AP accrual account
e Variance: the invoice price variance account

If you are using encumbrance control, Purchasing also creates the
following account for each distribution:

e Budget: the encumbrance budget account

The Account Generator creates these accounts based on predefined
rules. See: Using the Account Generator in Oracle Public Sector
Purchasing: page C - 9.

If the destination type is Expense, the default charge account you
enter in the Purchases Order Preferences window overrides the
charge account supplied by the Account Generator, and you can
update the charge account here.

For outside processing lines, the cursor does not enter this field
during initial entry, since the Account Generator cannot build
accounts until you have entered the Resource Sequence in the
Outside Processing window.

Change or accept the default Recovery Rate for taxable items.
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The recovery rate is the percentage of tax that that your business
can reclaim for credit. The recovery rate defaults in based on the
Tax Code in the purchase order Shipments window and the setup
in the Financials Options window.

You can change the recovery rate if the profile option Tax: Allow
Override of Recovery Rate is set to Yes, if the shipment has not yet
been received, or while funds for the document are not reserved (if
you use encumbrance accounting). Depending on the setup in the
Financials Option window and the type of tax, only certain
recovery rates may be allowed. See: Recoverable Tax, Oracle Public
Sector Payables User’s Guide

If on a purchase order you change a tax source, such as Supplier,
Site, or Tax Code, then Purchasing does not redefault a new
Recovery Rate on the current distributions, but does default it on
new distributions.

You can choose to use a different recovery rate for different
distributions, even if they use the same tax code.

For an overview of tax in Purchasing, see: Tax Defaults in
Purchasing: page 4 — 138.

Enter the GL Date you want to use when you reserve your funds.
You can enter a GL Date only if you set up your financials system
options to use encumbrance or budgetary control for purchase
orders. The default is the current date. See: About Financials
Options, Oracle Public Sector Payables User’s Guide. See: Budgetary
Control and Online Funds Checking, Oracle Public Sector General
Ledger User’s Guide.

If you enter a date that belongs to two separate accounting periods,
Purchasing automatically creates a journal entry in the first
accounting period that contains this date. See: Controlling
Purchasing Periods: page 1 —93.

The Reserved check box indicates whether you successfully
reserved funds for this purchase order distribution. You reserve
your distribution when you approve your purchase order. You
cannot change any purchase order distribution that you have
already encumbered unless you explicitly unreserve the funds in
the Approve Document window. See: Submitting a Document for
Approval: page 2 — 35. See: About Financials Options, Oracle
Public Sector Payables User’s Guide See: Budgetary Control and
Online Funds Checking, Oracle Public Sector General Ledger User’s
Guide.
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p To enter distribution detail information:

1.

Select the More tabbed region.

The Online check box indicates whether this distribution is part of
an on-line requisition. If so, Purchasing displays the requisition
number and line number.

If this distribution comes from an on-line requisition, Purchasing
displays the Requisition Number and Line number, you cannot
update this field. If this distribution does not come from an on-line
requisition, enter the paper requisition number in this field. The
default is the paper requisition number from the Purchase Order
Preferences window.

Purchasing displays the Budget Account, Accrual Account, and
Variance Account numbers supplied by the Account Generator.

Enter the Rate Date for the currency. Purchasing uses this date to
obtain the currency conversion rate from your conversion
definitions. You cannot enter this field when you edit a purchase
order created in your base currency. See: Defining Purchasing
Options: page 1 —45. See: Entering Daily Rates, Oracle Public Sector
General Ledger User’s Guide.

Note: The Rate Date is a required field for a foreign currency
purchase order, to complete the approval process.

You can enter the conversion Rate between the foreign currency
and the base currency only when the rate type is User. If you
entered a rate date for which a conversion rate is defined,
Purchasing displays that rate and you cannot change it.

p Toview tax information:

After you have entered and saved all tax information, do either or
both of the following:

e Choose Tax Code Summary from the Tools menu to see the total
recoverable and nonrecoverable tax for each tax code in your
document. See: Viewing Tax Code Summary Information: page
4-141.

e Choose Tax Details from the Tools menu to see recoverable and
nonrecoverable tax details for each line, shipment, and
distribution. See: Viewing Tax Details: page 4 — 143.
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To enter project information:

You see a Project tabbed region if one of the following is true:
e Oracle Projects is installed, or

¢ Oracle Project Manufacturing is installed and Project Reference
Enabled is selected in the Project Manufacturing Organization
Parameters window

The project information you enter is used by Oracle Projects for
destination types of Expense, or by Oracle Project Manufacturing for
destination types of Inventory or Shop Floor. See: Oracle Projects
User’s Guide. See: Oracle Project Manufacturing Implementation Manual.

1. Choose the Project tabbed region.
2. Select a Project Number.

For a Destination Type of Inventory or Shop Floor, you can
optionally enter a Project Number if the Project Control Level is set
to Project in the Project Information tabbed region of the
Organization Parameters window.

For a Destination Type of Expense, you can always optionally enter
a Project Number.

3. If you entered a Project number, select a Task number.

You must enter a Task number for a Destination Type of Inventory
or Shop Floor, if the Project Control Level is set to Task in the
Organization Parameters window and if you have entered a Project
number.

4. Enter Expenditure information.

Expenditure information is required only if your Destination Type
is Expense.

e Select the Expenditure Type.

¢ If you chose an Expenditure Type, enter an Expenditure
Organization.

¢ If you chose an Expenditure Organization, select the Expenditure
Date.

5. Note that the distribution Quantity that will be charged to the
project should already be entered for you.

If you change the Quantity here, then the distribution Quantity on
the purchase order line changes as well.
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6. Note that a Unit Number field is visible if Project Manufacturing is
installed.

If the item is under model/unit effectivity control, you must select
an end-item model Unit Number. This field is disabled if the item
is not under model/unit effectivity control. See: Model/Unit
Effectivity, Oracle Project Manufacturing Implementation Manual.

Note: You can also view the Unit Number as a hidden field in the
Purchase Order Distributions summary window.

7. Save your work.

The Charge, Budget, Accrual, and Variance accounts in the
Account Description region are generated automatically. See:
Using the Account Generator in Oracle Public Sector Purchasing:
page C-9.

» To enter outside processing information:

m  Select the Outside Processing button to open the Purchase Order
Outside Processing window. See: Entering Outside Processing
Information: page 4 — 83.

See Also
Entering Purchase Order Shipments: page 4 — 65

Changing Encumbered Documents: page 4 — 135
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Entering Outside Processing Information

Use the Outside Processing window to review and enter outside
processing information for document lines.

p To enter outside processing information:

1. Navigate to the Outside Processing window by selecting the
Outside Processing button in the Requisitions window and the
Purchase Orders Distributions window when you’ve selected a
Type of Outside Processing. See: Entering Requisition Lines: page
3-60. See: Entering Purchase Order Distributions: page 4 — 77.

£ Outside Processing (1) - Distribution 1

N OSP JOBG

Operation ST TS
Sequence Sequence
LIk

Department Resource Gty

Unit Type embly Gty

2. Enter the Job or repetitive Assembly that uses this outside
processing operation. For an assembly, you can also enter the
production Line. Use this to choose a schedule with the earliest
first unit start date.

3. Enter the operation Sequence number of the outside processing
operation. Purchasing displays the operation Code and the
Department.

4. Enter the Sequence number of the resource the outside processing
operation uses. Purchasing displays the resource UOM and
Quantity. Purchasing also displays the Unit Type and Assembly
Quantity.
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p To cancel your entries:
m  Select the Cancel button to cancel your entries and return to the
window from which you came.
» Toapply your entries:

m  Select the Done button to apply your entries and return to the
window from which you came.

See Also

Requisitioning Outside Process Items, Oracle Work in Process User’s
Guide

Creating Outside Processing Purchase Orders, Oracle Work in Process
User’s Guide
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Entering Purchase Order Notification Controls

Use the Notification Controls window to enter notification controls for
planned purchase orders, contract purchase agreements, and blanket
purchase agreements. For these documents, you can establish
expiration and release control notification conditions and specify the
number of days before the condition is met that you want to be
notified. When the notification conditions are met, Purchasing sends
you an alert, using Oracle Alert (or e-mail).

p To enter notification controls

1. Select Notification Controls on the Tools menu in the Purchase
Orders window to open the Notification Controls window and
display any existing controls. The Notification Controls option is
active on the menu only when there is no unsaved information for
the purchase order.

EZ Notification Controls - 1003667

Effective

_ Conditian Jelay - Frarm Ta 4 Armount
| |JAmount Released 16/JAN/2001 27/FEB/2001 - 1,000.00
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|
|
|

=
o
=
m

Cancel

2. Enter one of the following notification Conditions:

Amount Not Released — If you choose this condition, you can
optionally specify effective and expiration dates, but you must
specify the amount not released.
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Amount Released — If you choose this condition, you can optionally
specify the effective and expiration dates, but you must specify the
amount released.

Expiration — Before you can use this condition, you must have
specified an expiration date for the purchase order in the Details
window. If you choose this condition, you must enter an effective
date, and you can optionally enter an expiration date.

3. Enter the Warning Delay. This is the number of days before the
expiration date that you want to be alerted. The warning delay is
applicable only to the Expiration condition and helps you calculate
the effective date.

4. Purchasing calculates the Effective Date based on your warning
delay and the expiration date, but you can change this date. The
effective date is required for the Expiration condition.

5. Purchasing displays the Expiration Date from the Terms and
Conditions region as the default, but you can change this date.

= Attention: If you do not enter an expiration date and your
condition continues to be met, the alert will be issued forever.
Therefore, we recommend entry of an expiration date.

6. The Percent field is applicable only when you have already entered
an order line. For the Amount Released (or Not Released)
conditions, you can enter a percentage of the order line total, and
Purchasing calculates the amount.

7. When the amount released (or not released) reaches the Amount
you enter here, Purchasing sends you an alert. If you have already
entered an order line, Purchasing calculates the percentage and
displays it in the Percent field.

8. Select the Done button to save your work and return to the
Purchase Orders window.
p Tocancel your entries:

m  Select the Cancel button to cancel your entries and return to the
Purchase Orders window.

See Also
Using Oracle Alert in Oracle Public Sector Purchasing: page B — 2
Entering Purchase Order Headers: page 4 — 39
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Entering and Viewing Purchase Order Acceptances

Use the Acceptances window to view and enter purchase order
acceptances from your suppliers. The original copy of the purchase
order you send to the supplier is a legal offer to buy. A binding
purchase contract does not exist until the supplier accepts your offer
either by performing the contract or formally accepting the offer by
returning an acceptance document to you.

You indicate on your standard purchase orders, purchase agreements,
and releases whether you require your suppliers to accept your orders
by a specific date. Purchasing notifies you in the Notifications
Summary window of the orders for which the suppliers have not
responded by the acceptance due date.

» Toview acceptances:

®  Navigate to the Acceptances window by selecting Acceptances
from the Tools menu in the Purchase Orders and Releases windows
when you do not have a purchase order open. Purchasing displays
the Acceptances window with all previously accepted purchase
orders for review.

p To enter acceptances:

1. Navigate to the Acceptances window by selecting Acceptances
from the Tools menu in the Purchase Orders and Releases
windows.
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You can accept only purchase orders and releases that you
approved at least once and that are not closed.

In the Action field, enter the results of your supplier follow-up.
You can easily record the type of follow-up you performed such as
Follow-up telephone call, Follow-up letter, or Fax follow-up. You
can also use this field to record the outcome of the follow-up such
as Will call back, No answer, Schedule slippage, or Cannot fulfill
order.

Enter the Revision number. The default is the current revision.
Purchasing removes the notification from the Notifications
Summary window only when you record the acceptance of the
most recent revision.

Enter the Action Date for the acceptance transaction. Today’s date
is the default, but you can enter any date.

Enter the Accepted By person. Your name is the default.

Select Accepted to indicate that the supplier accepted the purchase
order. If you accept the most recent revision, Purchasing removes
the acceptance requirement and the acceptance date from your
purchase order or release. Purchasing also deletes the
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corresponding notification from the Notifications Summary
window if any late acceptance notification exists for this order.

7. Enter an Acceptance Type for the acceptance. You can define your
own acceptance types, or use one of the following that Purchasing
provides. See: Defining Lookup Codes: page 1 - 74.

Accepted All Terms — The supplier accepted all the terms of the
purchase order.

On Schedule — The supplier agreed to meet the delivery dates on the
purchase order.

Unacceptable Changes — The supplier made modifications to the
terms of the purchase order that you do not find acceptable.

See Also

Entering Purchase Order Headers: page 4 — 39
Entering Release Headers: page 4 — 90
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Entering Releases

Entering Release Headers

Use the Releases window to enter, edit, and approve releases against
blanket purchase agreements or planned purchase orders.

p» Toenter release headers:

1. Navigate to the Releases window by selecting Releases from the

menu or selecting the New Release button in the Find Purchase
Orders window.

%Releases (Vision Operations) - 1003667, 1
STl 1003667 0 alease QI OO
= S8 Supplier A =S SUPPLIER A SITE
= Stock, Ms. Pat Status

B Firmed H| ance Required

Shipments

— Source ——

Mum  Line Shipment LIOK Quantity Promised

a

2. Enter the PO number for the release you want to create. The list of
values displays all blanket and planned purchase order numbers
that have been approved, the document type, status, supplier,
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buyer, and effectivity date range. When you select a purchase
order, Purchasing displays the Supplier, Site, and Currency for that
order. Purchasing also displays the Status of the release and the
current Total amount of the release.

Note: Purchasing displays a P-Card number if the purchase order
used one. A procurement card purchase order is created from a
Self-Service Purchasing requisition that used a corporate credit
card for the purchase. This field displays if the profile option PO:
Use P—Cards in Purchasing is set to Yes. Only the last four digits of
the procurement card are displayed. Procurement cards can be
used for items with a Destination Type of Expense, for documents
that do not contain a Project number, and for standard purchase
orders or releases only.

Purchasing displays the next Release number available. You can
change the release number to any number that does not already
exist.

Enter the Created date. The default is the system date, but you can
change this.

If the Enforce Buyer Name option in the Purchasing Options
window is set to Yes, your name is displayed as the Buyer, and you
cannot change this value. Otherwise, you can enter the name of
any buyer. See: Defining Control Options: page 1 — 49.

Select Firmed to firm your release shipment when you want to
indicate to Master Scheduling/MRP or your manufacturing
application that it should not reschedule this release shipment
automatically.

Select Acceptance Required to indicate that you want to require the
supplier to accept your release

If acceptance is required, enter the Due-By date when you require
the supplier to return an acceptance for your purchase order.

Optionally select a value in the Pay On field to enable or disable
Payment on Receipt for this document.

The value in this field defaults from the Pay On field in the Terms
and Conditions window for the blanket purchase agreement. The
agreement receives its default value from the Supplier Sites
window. Unless this field was changed on the agreement, Receipt
is defaulted in this field if the supplier site is set up as a Payment
on Receipt site in the Supplier Sites window. Receipt means that
Payment on Receipt will automatically generate an invoice for this
release.
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Select Null if you do not want Payment on Receipt to automatically
create an invoice for this document. If the supplier site is not set
up as a Payment on Receipt site, this field is disabled, and you
cannot change it. See: Payment on Receipt: page 9 — 66.

10. Enter release shipment line information in the Shipments tabbed
region. See: Entering Purchase Order Shipments: page 4 — 65

To take approval actions:

m  Select the Approve button to open the Approve Documents
window. See: Submitting a Document for Approval: page 2 — 35.

To enter receiving control information:

m  Select the Receiving Controls button to open the Receiving Controls
window. See: Entering Purchase Order Receiving Controls: page
4-71.

To enter release distribution information:

m  Select the Distributions button to open the Distributions window.
See: Entering Release Distributions: page 4 — 100.

To view blanket purchase agreement information:

m  Select the Agreement button to view blanket agreement
information for the release.

To enter and view acceptances:

m  Select Acceptances on the Tools menu to open the Acceptances
window. See: Entering and Viewing Purchase Order Acceptances:
page 4 - 87

To view action history:

m  Select View Action History on the Tools menu to open the Action
History window. See: Viewing Action History: page 8 — 2.

To enter purchase order preferences:

m  Select Preferences on the Tools menu. See: Entering Purchase
Order Preferences: page 4 — 33
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See Also

Entering Release Shipments: page 4 — 93
Entering Release Distributions: page 4 — 100

Procurement Card Purchase Orders and Releases: page 4 — 146

Entering Release Shipments

Use the Shipments tabbed region to enter shipment lines for planned
and blanket releases and to edit shipments that Purchasing
automatically generated for you. (See: Automatic Release Generation:
page 4 — 106) A purchase order shipment specifies the quantity, ship—to
location, date you want your supplier to deliver the items on a
purchase order line, and country of origin for the items.

p To enter release shipment information:
1. Navigate to the Shipments tabbed region in the Releases window.

The first tabbed region is the Shipments region. In addition to the
enterable fields discussed in the following steps, this region
displays the UOM, the Originally Promise date (if the Promised
date has been changed, the original promised date is displayed
here), the Charge Account, the shipment Amount, and a check box
to indicate whether funds have been Reserved. See: Budgetary
Control and Online Funds Checking, Oracle Public Sector General
Ledger User’s Guide.
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2. Enter the line Number for the shipment line. If you enter a new
shipment line, Purchasing displays the next sequential line number
available. You can enter any line number greater than zero that
does not already exist.

3. Enter the source Line number. The list of values includes the item
number, revision, and description.

4. For scheduled releases only, you can enter the source Shipment.
This is the planned purchase order shipment against which you
want to issue a release. The details from the shipment are used as
defaults for the scheduled release shipment.

5. Enter the ship—to Organization. If you picked a line with an item,
you can pick only organizations in which the item is defined. If
you picked a revision number on the purchase order line, the item
revision must also be defined in the organization. For scheduled
releases (against planned purchase orders), you cannot change the
default organization from the planned purchase order shipment.
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10.

Note that you cannot update the organization once you have saved
your work.

Enter the Ship-To location for the shipment. You can pick any
location that does not have an organization or any location whose
organization matches the organization in the previous field. See:
Purchase Order Defaulting Rules: page 4 — 12 For blanket releases,
Purchasing defaults the ship-to location from the Release Header
zone. For scheduled releases, Purchasing gets default information
from the planned purchase order shipment.

Enter the Quantity for the shipment. This value must be greater
than zero.

Enter the Price you want to use for this shipment. Purchasing
displays the actual price for the shipment from the purchase order
line price for the item. The actual price defaults from the purchase
agreement line.

You can use list of values to choose purchase agreement price
breaks. If your purchase agreement has price breaks, the quantity
entered here determines what break price is defaulted into the Price
field. The cursor does not enter this field when you are editing an
existing line.

If you allow price override for this purchase order line in the
Purchase Orders window, the release price cannot exceed the price
limit specified for the line. If you allow price override but did not
enter a price limit, Purchasing does not check the shipment price
for the releases. If you do not allow price override, Purchasing
displays the shipment price from the purchase agreement and
prevents you from navigating to this field. This field can be
defaulted from the purchase agreement price breaks if you have
entered a sufficient quantity.

Enter the date that the supplier Promised delivery of the items.
This promised date is printed on the release.

Enter the Need By date when the requestor needs the item. This
date is printed on the release if you do not enter a promised date.
The default is from the Purchase Order Preferences window. If you
use Purchasing with Master Scheduling/ MRP, you must provide a
need-by date or promised date for shipments that correspond to
purchase order lines with Master Scheduling/MRP planned items.
You must also provide a need-by date or promised date for
Inventory planned items. See: Overview of Implementing
Planning Recommendations, Oracle Master Scheduling/MRP and
Supply Chain Planning User’s Guide.
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11.

12.

13.

Optionally choose or change the Country of Origin.

The Country of Origin is the country in which an item is
manufactured.

For a scheduled release, the Country of Origin defaults from the
planned purchase order. For a blanket release, the Country of
Origin defaults from the Approved Supplier List, if it is defined
there. If not, it defaults from the supplier site in the Supplier Sites
window. Otherwise, this field is blank. You can leave it blank or
choose a country.

If you do not know the originating country, you can enter or
change the Country of Origin later on the receipt.

Note that Taxable is selected if a Tax Code is associated with the
item.

If there is no Tax Code for the item, Taxable is not selected. You
cannot change the Taxable check box independently of the Tax
Code.

Enter or use the default Tax Code for taxable items.

The tax code defaults from the following sources, in the following
order:

e The Purchase Order Preferences window. If you have specified a
preferred tax code in this window, Purchasing defaults this tax
code onto the release shipment.

e The planned purchase order shipment. If you are creating a
release shipment from a planned purchase order and a tax code
exists on the planned purchase order shipment, Purchasing
copies this tax code onto the release shipment.

e The Tax Defaults region in the Purchasing Options window. If
you have specified a tax defaulting hierarchy in this window,
Purchasing searches for and defaults the tax code based on that
tax defaulting hierarchy. See: Defining Tax Defaults Options:
page 1 - 55.

You can accept the default tax code or select another. If you need
additional help with how tax defaulting works in Purchasing, see:
Tax Defaults in Purchasing: page 4 — 138.

You cannot override the Tax Code if the profile option Tax: Allow
Override of Tax Code is set to No, if the shipment has been received,
or while funds for the document are reserved if you use
encumbrance accounting.
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Note: If you change the Tax Code after already creating
distributions for the shipment, the associated Recovery Rate on
those distributions is not redefaulted for the new Tax Code.

For an overview of tax in Purchasing, see: Tax Defaults in
Purchasing: page 4 — 138.

14. Save your work.

To display item information:

Select the Item tabbed region in the Releases window.

For each shipment, Purchasing displays the Item number,
purchasing Category, item Description, and the Supplier Item
number.

To display and enter more shipment information:

1.
2.

Select the More tabbed region in the Releases window.

Enter the Receipt Close Tolerance percent for your shipments.
Purchasing automatically closes a shipment for receiving if it is
within the receiving closing tolerance at the receiving close point.
You need to set the receiving close point in the Purchasing Options
window. See: Defining Control Options: page 1 — 49

Enter the Invoice Close Tolerance percent for your shipments.
Purchasing automatically closes a shipment for invoicing if it is
within the invoicing closing tolerance at billing, when Payables
matches invoices to purchase orders or receipts. See: Defining
Control Options: page 1 — 49

Select one of the following options for Match Approval Level:

Two-Way Matching: Purchase order and invoice quantities must
match within tolerance before the corresponding invoice can be
paid.

Three—-Way Matching: Purchase order, receipt, and invoice
guantities must match within tolerance before the corresponding
invoice can be paid.

Four-Way Matching: Purchase order, receipt, accepted, and invoice
gquantities must match within tolerance before the corresponding
invoice can be paid.

If you enter an item, the default value for this field comes from the
item information at the organization level. If not defined there, the
default comes from the item information at the master level. If you
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do not enter an item, the default is from your Purchasing Options.
See: Receiving Controls, Options, and Profiles: page 7 - 8.

Select an Invoice Match Option:

Purchase Order: Payables must match the invoice to the purchase
order.

Receipt: Payables must match the invoice to the receipt.

Choose Receipt if you want to update exchange rate information on
the receipt or if you want your accounting to use exchange rate
information based on the receipt date. (If you use Periodic Costing,
you must match to the receipt to ensure accurate cost accounting.)

The Invoice Match Option defaults from the Supplier Sites window.
You can change the Invoice Match Option on the shipment until
you receive against the shipment.

Note: The Invoice Match Option and the Match Approval Level
are independent options. You can perform whichever Invoice
Match Option you want regardless of the Match Approval Level.

See: Entering Purchase Order Matched Invoices, Accounts Payable
User’s Guide.

Select Accrue at Receipt to indicate that the items on this purchase
order line accrue upon receipt. Shop Floor and Inventory destined
items always accrue upon receipt, and you cannot change this
default. For expense items, if the Accrue Expense Items flag in the
Purchasing Options window is set to Period End, the items cannot
accrue upon receipt, and you cannot change the default. If the
Accrue Expense Items flag is set to At Receipt, the default is to
accrue upon receipt, but you can change it to not accrue upon
receipt. See: Defining Accrual Options: page 1 —48.

Attention: If you are using Cash Basis Accounting, you should
use the Purchasing Options window to set the Accrue Expense
Items flag to Period End, and you should not select Accrue on
Receipt in this window.

Select Firm to firm the shipment to indicate to Master
Scheduling/MRP or your manufacturing application that it should
not reschedule this release shipment.

Save your work.

To display status information:

Select the Status tabbed region.
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See Also

For each shipment, Purchasing displays the Status and the quantity
Ordered, Received, Cancelled, and Billed.

p To view tax information:

m  After you have entered and saved all tax information, do either or
both of the following:

e Choose Tax Code Summary from the Tools menu to see the total
recoverable and nonrecoverable tax for each tax code in your
document. See: Viewing Tax Code Summary Information: page
4-141.

e Choose Tax Details from the Tools menu to see recoverable and
nonrecoverable tax details for each line, shipment, and
distribution. See: Viewing Tax Details: page 4 — 143.

p To take approval actions:

m  Select the Approve button to open the Approve Documents
window. See: Submitting a Document for Approval: page 2 — 35.

p To enter receiving control information:

m  Select the Receiving Controls button to open the Receiving Controls
window. See: Entering Purchase Order Receiving Controls: page
4-71.

p To enter distribution information:

m  Select the Distributions button to open the Distributions window.
See: Entering Release Distributions: page 4 — 100.

Entering Release Headers: page 4 — 90

Entering Release Distributions: page 4 — 100
Entering Purchase Order Preferences: page 4 — 33
Viewing Action History: page 8 — 2

Processing Periodic Acquisition Costs, Oracle Cost Management User’s
Guide
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Entering Release Distributions

Use the release Distributions window to enter distribution information
for release shipments or to view distributions that Purchasing has
automatically created for you. You can enter multiple distributions per
shipment line. You can also enter information about paper requisitions
in this window.

p To enter release distribution information:

1. Navigate to the Distributions window by selecting the
Distributions button in the Releases window.

%Distrihutiuns (Vision Operations) - 1003667-1, 1

Destination

Destinatian
Mum  Source Type Reguestor Deliver-To Subinventory

| 1| Inventory

Account Description

HiE - Operations.Balance Sheet.Inventory R Budget
AEEI Operations.Balance Sheet.Accounts Pe Vel Operations. Vision Operations In.Invoic
Dutside Processing

2. Enter the line Number for the distribution line. If you enter a new
distribution line, Purchasing displays the next sequential line
number available. You can enter any line number greater than zero
that does not already exist.

3. Forscheduled releases only, enter the Source (the planned purchase
order distribution you want to release).

4. The Destination Type determines the final destination of the
purchased items. Choose one of the following options:
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Expense — The goods are delivered to the requestor at an expense
location. The destination subinventory is not applicable.

Inventory — The goods are received into inventory upon delivery.
You can choose this option only if the item is stock enabled in the
ship-to organization.

Shop Floor — The goods are delivered to an outside processing
operation defined by Work in Process. You can choose this option
only for outside processing items.

Enter the Requestor and Deliver To location for this distribution. If
the destination type is Inventory, you can also enter the
Subinventory.

Enter the Quantity of the purchase order shipment that you want to
charge to the Accounting Flexfield. The default value comes from
the quantity you enter in the Shipments region. If you decrease the
default quantity, Purchasing automatically defaults on the next
distribution line the total quantity you have not yet assigned to a
distribution line. This quantity is printed on the release.

Enter the Charge Account. When you save your changes in this
window, Purchasing uses the Account Generator to automatically
create the following three accounts for each distribution:

e Charge: the account to charge for the cost of this item
e Accrual: the AP accrual account
e Variance: the invoice price variance account

If you are using encumbrance control, Purchasing also creates the
following account for each distribution:

e Budget: the encumbrance budget account

The Account Generator creates these accounts based on predefined
rules. See: Using the Account Generator in Oracle Public Sector
Purchasing: page C - 9.

You cannot create or update these accounts manually unless the
destination type is Expense. In this case, the default charge account
you enter in the Purchases Order Preferences window overrides
charge account supplied by the Account Generator, and you can
update the charge account in this zone.

For outside processing lines, the cursor does not enter this field
during initial entry, since the Account Generator cannot build
accounts until you have entered the Resource Sequence in the
Outside Processing window.
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Enter or accept the default Recovery Rate for taxable items.

The recovery rate is the percentage of tax that your business can
reclaim for credit. The recovery rate defaults in based on the Tax
Code on the release shipment.

You can change the recovery rate if the profile option Tax: Allow
Override of Recovery Rate is set to Yes, if the shipment has not yet
been received, or while funds are not reserved for the document (if
you use encumbrance accounting). Depending on the setup in the
Financials Options window and the type of tax, only certain
recovery rates may be allowed. See: Recoverable Tax, Oracle Public
Sector Payables User’s Guide

If you change the tax code on the document, Purchasing does not
redefault a new recovery rate on the current distributions, but does
default it on new distributions.

You can choose to use a different recovery rate for different
distributions, even if they use the same tax code.

For an overview of tax in Purchasing, see: Tax Defaults in
Purchasing: page 4 — 138.

Enter the GL Date you want to use when you reserve your funds.
You can enter a GL Date only if you set up your financials system
options to use encumbrance or budgetary control for purchase
orders. The default is the current date. See: About Financials
Options, Oracle Public Sector Payables User’s Guide. See: Budgetary
Control and Online Funds Checking, Oracle Public Sector General
Ledger User’s Guide.

If you enter a date that belongs to two separate accounting periods,
Purchasing automatically creates a journal entry in the first
accounting period that contains this date. See: Controlling
Purchasing Periods: page 1 — 93.

The Reserved check box indicates whether you successfully
reserved funds for this purchase order distribution. You reserve
your distribution when you approve your purchase order. You
cannot change any purchase order distribution that you have
already encumbered unless you explicitly unreserve the funds in
the Approve Document window. See: Submitting a Document for
Approval: page 2 — 35. See: About Financials Options, Oracle
Public Sector Payables User’s Guide See: Budgetary Control and
Online Funds Checking, Oracle Public Sector General Ledger User’s
Guide.

10. Save your work.
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p To enter distribution detail information:
1. Select the More tabbed region.

The Online check box indicates whether this distribution is part of
an on-line requisition. If so, Purchasing displays the requisition
number and line number.

2. If this distribution comes from an on-line requisition, Purchasing
displays the Requisition Number and Line number, and you cannot
update this field. If this distribution does not come from an on-line
requisition, enter the paper requisition number in this field. The
default is the paper requisition number from the Purchase Order
Preferences window.

Purchasing displays the Budget Account, Accrual Account, and
Variance Account numbers supplied by the Account Generator.

3. Enter the Rate Date for the currency. Purchasing uses this date to
obtain the currency conversion rate from your conversion
definitions. You cannot enter this field when you edit a purchase
order created in your base currency. See: Defining Purchasing
Options: page 1 —45. See: Entering Daily Rates, Oracle Public Sector
General Ledger User’s Guide.

4. You can enter the conversion Rate between the foreign currency
and the base currency only when the rate type is User. If you
entered a rate date for which a conversion rate is defined,
Purchasing displays that rate and you cannot change it.

5. Save your work.

p Toview tax information:

m  After you have entered and saved all tax information, do either or
both of the following:

e Choose Tax Code Summary from the Tools menu to see the total
recoverable and nonrecoverable tax for each tax code in your
document. See: Viewing Tax Code Summary Information: page
4-141.

e Choose Tax Details from the Tools menu to see recoverable and
nonrecoverable tax details for each line, shipment, and
distribution. See: Viewing Tax Details: page 4 — 143.

p To enter project information:

You see a Project tabbed region if one of the following is true:
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e Oracle Projects is installed, or

e Oracle Project Manufacturing is installed and Project Reference
Enabled is selected in the Project Manufacturing Organization
Parameters window

The project information you enter is used by Oracle Projects for
destination types of Expense, or by Oracle Project Manufacturing for
destination types of Inventory or Shop Floor. See: Oracle Projects
User’s Guide. See: Oracle Project Manufacturing Implementation Manual.

1. Choose the Project tabbed region.
2. Select a Project Number.

For a Destination Type of Inventory or Shop Floor, you can
optionally enter a Project Number if the Project Control Level is set
to Project in the Project Information tabbed region of the
Organization Parameters window.

For a Destination Type of Expense, you can always optionally enter
a Project Number.

3. If you entered a Project number, select a Task number.

You must enter a Task number for a Destination Type of Inventory
or Shop Floor, if the Project Control Level is set to Task in the
Organization Parameters window and if you have entered a Project
number.

4. Enter Expenditure information.

Expenditure information is required only if your Destination Type
is Expense.

o Select the Expenditure Type.

¢ If you chose an Expenditure Type, enter an Expenditure
Organization.

¢ If you chose an Expenditure Organization, select the Expenditure
Date.

5.  Note that the distribution Quantity that will be charged to the
project should already be entered for you.

If you change the Quantity here, then the distribution Quantity on
the release line changes as well.

6. Note that a Unit Number field is visible if Project Manufacturing is
installed.

If the item is under model/unit effectivity control, you must select
an end-item model Unit Number. This field is disabled if the item
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is not under model/unit effectivity control. See: Model/Unit
Effectivity, Oracle Project Manufacturing Implementation Manual.

Note: You can also view the Unit Number as a hidden field in the
Purchase Order Distributions summary window.

7. Save your work.

The Charge, Budget, Accrual, and Variance accounts in the
Account Description region are generated automatically. See:
Using the Account Generator in Oracle Public Sector Purchasing:
page C-9.

See Also

Entering Release Headers: page 4 — 90
Entering Release Shipments: page 4 — 93
Viewing Action History: page 8 — 2

Entering Purchase Order Preferences: page 4 — 33
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Automatic Release Generation

Major Features

You can minimize purchase order administrative costs by automatically
creating releases for both manually entered and imported requisitions.

Purchasing provides you with the features you need to satisfy the
following basic needs. You should be able to:

e Automatically create a release when you source your items from
a single supplier using a single blanket purchase agreement.

o Specify for each blanket agreement whether you want to create
approved releases automatically, create releases automatically
but require manual approval, or require the use of the
AutoCreate Documents window to create releases.

¢ Run the Create Release process automatically as part of the
Requisition Import process.

Flexible Sourcing Definitions

When you are defining your sourcing rules and Approved Supplier List
entries, you can also define how you want your releases generated.
Automatic Release automatically converts approved requisition lines to
approved blanket purchase releases based on the sourcing rules and
Approved Supplier List entries. Automatic Release/Review
automatically converts approved requisition lines to blanket releases.
Buyers can then review and modify these releases before approving
them. Release Using Autocreate lets buyers use the AutoCreate
Documents window to collect, review, and optionally modify
requirements before creating and approving their releases. See:
Autocreating Documents Overview: page 6 — 2.

You can define a different release generation method for each item and
supplier. For frequently purchased items, you can set up Purchasing to
automatically create and approve releases. For expensive or critical
items, you can let Purchasing create the releases, while you review and
approve them in a separate step. For infrequent purchases, your
buyers can take more control by using the AutoCreate Documents
window to combine requests.

You must set up a suggested blanket purchase agreement in the
Approved Supplier List window so that Purchasing can use the price
and ship-to information when it is generating releases against the
agreement. See: Defining the Supplier/Item Attributes: page 5 - 51.
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Generate Releases Automatically

The Create Releases process generates releases when the following
criteria are met:

e The requisition is sourced to an approved blanket purchase
agreement that is not on hold

e The Approved Supplier List entry for the item, supplier, and
agreement must be active, and the Release Generation method
must be Automatic Release or Automatic Release/Review in the
Approved Supplier List window

e The source agreement is still active and the release will not put
the agreement over the amount limit

e The release amount must be greater than the minimum line
release amount

e The supplier on the source agreement is active and not on hold

e The requisition line is Approved (and Reserved, if requisition
encumbrance is active)

e The requisition line is not cancelled, closed, or already on a
purchase order

e The line type of the requisition line is quantity based

Note: If the release generation method in the Approved Supplier List
window is Automatic Release or Automatic Release/Review, then the
Create Releases process creates the release. If the release generation
method is Release Using AutoCreate, then the PO Create Documents
workflow tries to create the release; if it cannot, then you must use the
AutoCreate Documents window to create the release.

If the release generation method is Automatic Release, the process sets
the status to Approved and updates the action history. Otherwise, the
process sets the status to Incomplete and updates the notifications.

Purchasing automatically creates releases for requirements entered by
any source: Work in Process, Master Scheduling/ MRP, Inventory
Planning, purchase requisitions, or external systems.

For foreign currency blanket purchase agreements, the automatic
release process uses the rate on the agreement as the default rate for the
release and translates the functional unit price on the requisition into
the foreign currency price. Automatically generated releases use the
price retrieved by sourcing, which is price break sensitive but does not
consider the quantity already released against the blanket purchase
agreement.
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See Also

The Create Releases process creates a release for each source blanket
purchase agreement, with a release shipment for each requisition line
and a release distribution for each requisition distribution. If release
archiving is set to Approve, the process updates the archive table for
the release, shipments, and distributions. See: Create Releases Process:
page 9 — 36.

If you’ve set up a tax defaulting hierarchy in the Tax Defaults region of
the Purchasing Options window, the appropriate tax codes
automatically default onto the release shipments created by the Create
Release process. See: Defining Tax Defaults Options: page 1 — 55.

Variable Release Generation Frequency

You can determine how often Purchasing creates releases by using the
Submit Requests window to set the Create Releases process to run
automatically at any frequency you desire. You can also use the Submit
Requests window to run the process manually.

Optionally, you can set the profile PO: Release During Reqlmport to
create releases each time you run the Requisition Import process. For
example, when you implement planned orders as requisitions in the
MRP Planner Workbench, you can automatically create the releases at
the same time you create the requisitions. As part of the Requisition
Import process, Purchasing automatically creates (and optionally
approves) releases for all blanket-sourced, approved requisitions, not
just those created by the Requisition Import run.

AutoCreate Documents Overview: page 6 — 2

Workflow for Creating Purchase Orders or Releases: page C — 204
Profile Options in Purchasing: page 1 — 103

Automatic Sourcing: page 5 - 30

Create Releases Process: page 9 — 36

Requisition Import Process: page 9 — 144

Submitting a Request, Oracle Applications System Administrator’s Guide
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Copying Purchase Orders

You can copy the following purchase order types from one document to

the other:

From

To

Standard purchase order

Standard purchase order

Blanket purchase agreement

Blanket purchase agreement

Planned purchase order

Planned purchase order

Bid quotation (Bid quotation class)

Standard or planned purchase order

Self-defined Bid quotation (Bid
quotation class)

Standard or planned purchase order

Catalog or Standard quotation
(Catalog quotation class)

Blanket purchase agreement

Self-defined Catalog or Standard
quotation (Catalog quotation class)

Blanket purchase agreement

For example, if you want to renew a blanket purchase agreement that
contains hundreds of lines, you can copy the previous agreement to a
new agreement and change the effectivity dates.

To copy documents:

1. Query the document you want to copy from the Purchase Orders,
Purchase Order Summary, or Quotations windows.

2. With the document selected, choose Copy Document from the

Tools menu.

Purchase Orders

4-109



% Copy Document
From

BN Standard Purchase Order
LDoacument number gL

BN R S TS Standard Purchase Order
Document numhber

| Copy Attachments

3. Selectan eligible To Document Type.

You can change the To Document Type only if you’re copying from
a Bid class quotation.

4. Select other options if needed.

Document Number: Enter a document number only if you use
manual numbering. If you use automatic numbering, a document
number will be created for you after you choose OK. You cannot
use the Copy Documents window to modify documents by
copying from one document to another with the same document
number.

Copy Attachments: Check this box to copy an attachment from any
level of the document.

5. Choose OK.

Purchasing creates and displays the new document. The document
is an exact copy of the original except for the Promised By and

Need By dates; if these dates are past dates, they change to today’s
date on the new document. Effectivity dates, if any, do not change.

If you are copying a cancelled document, the Note to Supplier field
will be blank. This is because a cancelled document changes the
Note to Supplier to an explanation that the document was
cancelled. Therefore, when you copy the cancelled document, the
Note to Supplier is left blank.
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6. Modify the document if you need to.
7. Save and approve the document.

If information in the document you have just copied is invalid or
outdated—for example, if a supplier or account is inactive or
invalid—a message window appears after you choose Approve.
Use this window to help you identify and correct invalid or
outdated fields in the new document you’re creating. You cannot
approve the document until you update these fields appropriately.

See Also

Defining Document Types: page 1 — 87
Types of Quotations and RFQs: page 5 -6
Copying Quotations from RFQs: page 5 — 89
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Printed Purchase Order Overview

Multilingual Support

Major Features

Purchasing formats your purchase orders to be printed on a standard
purchase order form. This section explains how Purchasing prints the
purchase order information. You can use the standard format or
customize the report to meet your needs.

If you use Multilingual Support (MLS), you can print most of the fields
on the following reports in another language:

e Printed Purchase Order Report (Landscape)
e Printed Purchase Order Report (Portrait)
e Printed RFQ Report (Landscape)
e Printed RFQ Report (Portrait)
¢ Printed Change Orders Report (Landscape)
¢ Printed Change Orders Report (Portrait)
See: Submitting a Request, Oracle Applications User’s Guide.

Note: You can print item descriptions in other languages only
for inventory items for which translations have been entered. If
you change the item description on the document, it does not
print in the translated language.

Portrait and Landscape Formats

Purchasing lets you print your purchase orders in portrait or landscape
format. Use the Submit Requests window to choose either the Printed
Purchase Order Report (Landscape) or the Printed Purchase Order
Report (Portrait). The explanations that follow describe both portrait
and landscape characteristics. See: Submitting a Request, Oracle
Applications User’s Guide.

Printed Change Orders Report

In addition to the Printed Purchase Order Report, you can also use the
Submit Requests window to choose the Printed Change Orders Report
in portrait or landscape formats. This prints only the changes between
revisions of purchase orders, but is otherwise identical to the Printed
Purchase Order Report. When you have purchase orders with many
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lines, you can print only pertinent change information to send to the
supplier. If a modification to the purchase order shipment causes the
purchase order revision to change, the Printed Change Orders Report
prints the revised shipment, line, and header. If the modification is to
the line, the report prints the revised line and header. If only the
header is modified, the report prints only the header. Note that the
report does not include purchase orders for which only the distribution
is modified.

Brief Notes

Purchasing prints the brief notes to supplier that you attach to the
purchase order header or line. These notes can contain up to 240
characters. Purchasing automatically wraps the notes after 103
characters per line for landscape orientation and 75 for portrait. These
notes may wrap in the middle of a word to ensure the correct line
count for each page.

Attachments

Purchasing prints all text attachments with a usage of Supplier on the
purchase order. These notes contain up to 64K characters per note.

You can attach as many notes as you want to the purchase order
headers and lines. Purchasing also prints text attachments to the items.
Purchasing prints 78 characters per line and automatically wraps to the
next line. The note appears on the purchase order exactly as you enter
it. See: Attaching Notes to Purchasing Documents: page 1 — 44.

Facsimiles

If you have installed CommercePath, or any facsimile software that is
compatible with the CommercePath Fax Command Language (FCL),
Purchasing can automatically send facsimiles of the Printed Purchase
Order Report (Portrait and Landscape) and Printed Change Orders
Report (Portrait and Landscape). See: Printed Change Orders Report
(Landscape): page 9 — 74 or Printed Change Orders Report (Portrait):
page 9 — 77. See: Printed Purchase Order Report (Landscape): page

9 — 80 or Printed Purchase Order Report (Portrait): page 9 — 83.

Purchase Agreements

Purchasing prints Purchase Agreement on all your blanket purchase
agreements. Purchasing prints Purchase Agreement Release on all
your releases.

Purchasing also prints the following messages on contract and blanket
purchase agreements. If you provide effective dates on your contract
or blanket purchase agreements, Purchasing prints EFFECTIVE FROM
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[start effective date] TO [end effective date]. If you provide an
effective start date without an effective end date, Purchasing prints
only EFFECTIVE FROM ([start effective date]. If you provide an
effective end date without an effective start date, Purchasing prints
only EFFECTIVE TO [end effective date].

Cancelled Orders

Purchasing automatically indicates whether you cancelled any part of
your purchase order. If you cancel the purchase order header,
Purchasing prints the following cancellation message at the top of the
purchase order and does not print cancellation messages for lines or
shipments:

e This purchase order CANCELLED on: [date]

If you cancel a purchase order release, Purchasing prints the following
cancellation message:

e This release CANCELLED on: [date]

If you cancel a blanket purchase agreement line without cancelling the
corresponding header, Purchasing prints the following cancellation
messages:

e This purchase order line CANCELLED on: [date]
e Original quantity ordered: [quantity]
e Quantity CANCELLED: [quantity]

If you cancel a purchase order shipment without cancelling the
corresponding purchase order line, Purchasing prints the following
messages. Purchasing also prints these messages for each shipment if
you cancel the corresponding purchase order line.

e This shipment CANCELLED on: [date]
¢ Original shipment quantity: [quantity]
e Quantity CANCELLED: [quantity]

See: Controlling Documents: page 2 — 55.

Confirming Orders

You designate whether a purchase order is a confirming order when
you enter the purchase order header information. If you select
Confirming Order in the Purchase Order Details window, Purchasing
automatically prints CONFIRMATION — DO NOT DUPLICATE.
See: Entering Purchase Order Details Information: page 4 — 61.
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Foreign Currency

If you designate that a purchase order is in a different currency than
your base currency, Purchasing prints All prices and amounts on this
order are expressed in: [foreign currency]. You designate the currency
when you create the purchase order.

Acceptances

If you require an acceptance from your supplier, Purchasing prints the
following message: Please formally accept this order by: [acceptance
date]. You designate whether you require an acceptance when you
create the purchase order. When you indicate that you require an
acceptance, you also provide an acceptance date by which you expect
your supplier to respond. See: Entering and Viewing Purchase Order
Acceptances: page 4 — 87.

UN Number

If you associate a UN number with a purchase order line, Purchasing
prints UN Number: [UN number and description]. The UN number
and description can contain up to 240 characters. Purchasing prints 87
characters per line for landscape orientation (60 for portrait) and
automatically wraps to the next line. See: Purchasing Hazardous
Materials: page 1 - 67.

Hazard Class

If you associate a hazard class with a purchase order line, Purchasing
prints Hazard Class [hazard class name]. Purchasing prints up to 87
characters per line for landscape orientation (60 for portrait). See:
Purchasing Hazardous Materials: page 1 - 67.

Contract Purchase Agreement References

Purchasing prints the following message for each standard purchase
order line that references a contract number: This PO line references
contract PO# [contract number]. You associate a contract purchase
agreement number with a standard purchase order line when you
create the purchase order.

Quotation References

Purchasing prints the following message for each purchase order line
that references a quotation number: This PO line references
Quotation #: [supplier quotation number] Line: [line number] Your
Quotation #: [purchase order quotation number]. You associate a

Purchase Orders 4 -115



quotation number with a purchase order line when you create the

purchase order.

Automatic Table Update

Purchasing automatically updates the item history table when you
print your purchase order for each revision. Purchasing records the
item, supplier, quantity, unit of measure, price, and purchase order
number. This information is available when you view last price and
history information. See: Overview of the Supplier Item Catalog: page

5-8.

Printed Purchase Order Diagram Descriptions

The following descriptions include both portrait and landscape

explanations.

PO Number

Revision

Page

Ship To

Bill To
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Purchasing prints the purchase order number. If
the order is a release, Purchasing prints a dash (=)
after the purchase order number followed by the
release number. (12 characters, portrait and
landscape)

Purchasing prints the purchase order revision. (4
characters, portrait and landscape)

Purchasing prints the page number. (3 characters,
portrait and landscape)

The ship to information contains up to 3 lines of
address. After the address, Purchasing prints the
city, state (or province), and zip code on the line 4.
On line 5, Purchasing prints the country.
Purchasing prints the ship to location even if it is
the same as the bill to location. (portrait — 28
characters for line 1 through 4 lines, 25 characters
for line 5; landscape — 30 characters for lines 1
through 4, 25 characters for line 5)

The bill to information contains up to 3 lines of
address. After the address, Purchasing prints the
city, state (or province), and zip code on the line 4.
On the line 5, Purchasing prints the country.
(portrait — 28 characters for line 1 through 4 lines,
25 characters for line 5; landscape — 30 characters
for lines 1 through 5)



Supplier

Customer
Account

Supplier No.
Date Of Order/
Buyer

Revised Date/
Buyer

Payment Terms

Ship Via

FOB

Freight Terms

Purchasing prints the supplier name on line 1.
Purchasing then prints up to 3 lines of address. On
line 5, Purchasing prints the city, state (or
province), and zip code. Purchasing prints the
country on line 6. (portrait — 40 characters for line
1, 35 characters for lines 2 through 4, 42 characters
for line 5; landscape — 42 characters for line 1, 35
characters for lines 2 through 6)

Purchasing prints the number your supplier
associates with your organization. You provide
this number in the Supplier window. (portrait—13
characters, landscape — 9 characters) See: About
Suppliers, Oracle Public Sector Payables User’s Guide.

Purchasing prints the number for your supplier.
(portrait — 13 characters; landscape — 9 characters)

Purchasing prints the original buyer and creation
date. (portrait — first initial of first name and 10
characters of last name; landscape — first initial of
first name and 11 characters of last name)

If you revise the purchase order and do not change
the name of the original buyer, Purchasing prints
the original buyer’s name and the date of the
revision. If you change the buyer’s name, the new
name is printed. If you have not yet revised the
purchase order, Purchasing leaves this field blank.
(portrait — first initial of first name and 10
characters of last name; landscape - first initial of
first name and 11 characters of last name)

Purchasing prints the payment terms for your
purchase order. (portrait — 27 characters;
landscape — 21 characters)

Purchasing prints the mode of transportation for
the items on the purchase order. (portrait — 22
characters; landscape 22 characters)

Purchasing prints the free on board terms.
(portrait — 28 characters; landscape 20 characters)

Purchasing prints the freight terms code that
explains the condition of the freight charges and
the party responsible for the freight. (portrait — 27
characters; landscape — 21 characters)
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Requestor/ If the standard purchase order is for one requestor

Deliver To only, Purchasing prints the full first and last name
of the requestor. For multiple requestors,
Purchasing prints Many. (portrait — 22 characters;
landscape - 52 characters)

Confirm/ Purchasing prints the contact name and contact

Telephone phone number. (portrait — first initial of first name,
up to 10 characters of last name, 15 characters for
the phone number; landscape — 37 characters for
first and last name combined, 16 characters for the
phone number)

Standard/Planned Purchase Order Components

4-118

Purchasing prints the main text underneath the Item title on the
purchase order. Purchasing first prints header information followed by
line, shipment, and distribution information.

For single shipments with the same ship-to address as the header,
Purchasing pulls all information up to the line level and blanks out the
shipment level entirely, regardless of other factors. For multiple
shipments or a single shipment with a different ship—to address from
the header, Purchasing prints information at both shipment and line
levels.

Standard and Planned Purchase Order Header

Standard and planned purchase orders print the following header
information if it pertains to the purchase order:

o Brief Supplier Note
e Long Supplier Note
e This purchase order CANCELLED on: [date].
¢ CONFIRMATION — DO NOT DUPLICATE
o All prices and amounts on this order are expressed in [foreign
currency].
Standard and Planned Purchase Order Lines

After printing the header information, Purchasing prints the following
line information:

Line Purchasing prints the purchase order line number.
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Item Number/
Description

Delivery Date

Quantity

Unit

Unit Price

Extension

Tax

Purchasing prints your item number first. If you
have an item revision number, Purchasing prints
[revision number]. If you specify a supplier item
number, Purchasing prints (Your #: [supplier item
number]) on the next line. Purchasing then prints
the item description on the following line. (portrait
—wraps after 23 characters per line, landscape —
wraps after 45 characters per line)

Purchasing prints dates only for single shipments.
If you provided a promised date, Purchasing prints
the promised date. If you do not provide a
promised date or a last date, but you provide a
need by date, Purchasing prints the need by date.
Otherwise, this space is blank.

Purchasing prints the quantity of the item you are
ordering if the line type is quantity—based (in
number format 999999999 with any existing
decimal places, portrait and landscape)

Purchasing prints the item unit of measure for
quantity—based items (4 characters, portrait and
landscape)

Purchasing prints the item unit price if the line type
is quantity—based (in number format 999999999999
with any existing decimal places in the precision
associated with the currency, portrait and
landscape)

Purchasing prints the total amount of the line. This
number is the product of the quantity and unit
price. (in number format 9999999999999 with any
existing decimal places in the precision associated
with the currency, portrait and landscape). For
amount-based line types, Purchasing prints the
price extension only for single shipments.

For single shipments, Purchasing prints Y or N to
indicate whether this is a taxable item.

After printing the first line of the purchase order, Purchasing prints the
following if they pertain to the purchase order:

e UN Number: [UN number and description]

e Hazard Class: [hazard class name]

e Brief Supplier Line Note
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e Long Supplier Line Notes
e This PO line references contract PO# [contract number]

e This PO line references your Quotation #: [quotation number]

Standard and Planned Purchase Order Shipments

After printing each line, Purchasing prints the following shipment
information:

e 0 (This symbol indicates a distinct shipment)

e SHIP TO: [ship to address]. If the ship to address is the same as
the one for the purchase order header, Purchasing prints
Address at top of page directly below the SHIP TO: note
without printing the address again. This address contains up to
3 lines of address. On line 4, Purchasing prints the city, state (or
province), state, and zip code. On line 5, Purchasing prints the
country. (35 characters for lines 1 through 5, portrait and
landscape)

After printing the bullet and address to signify a new shipment,
Purchasing prints the following information:

Delivery Date If you provided a promised date, Purchasing prints
the promised date. If you do not provide a
promised date or a last date, but you provide a
need by date, Purchasing prints the need by date.
Otherwise, this space is blank.

Quantity Purchasing prints the quantity of the item you are
ordering for quantity-based items (in number
format 999999999 with any existing decimal places,
portrait and landscape)

Unit Purchasing prints the item unit of measure for
quantity—based items (4 characters, portrait and
landscape)

Extension For multiple shipments of amount-based line

types, Purchasing prints the total amount of the
line. This number is the product of the quantity
and item price override. (in number format
9999999999999 with any existing decimal places in
the precision associated with the currency, portrait
and landscape)

Tax Purchasing prints Y or N to indicate whether this is
a taxable item. For amount-based line types,
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Purchasing prints the tax flag only for multiple
shipments.

If you cancelled a shipment, Purchasing prints the following
information:

This shipment CANCELLED on: [date]
Original shipment quantity: [quantity]
Quantity CANCELLED: [quantity]

Standard and Planned Purchase Order Distributions

After printing each shipment, Purchasing prints the following
distribution information:

DELIVER TO:

[Last Name], [First Name] [Middle Initial] ([quantity ordered]) if
you provided a requestor name on your purchase order
distribution and if there is more than one distribution. (54
characters, portrait and landscape)

Agreement/Release Components

Blanket/Contract Purchase Agreement Header

Purchasing prints the following header information if it pertains to the
purchase order:

Brief Supplier Note
Long Supplier Notes
PURCHASE AGREEMENT

EFFECTIVE FROM ([start effective date] TO [end effective date]
or

EFFECTIVE FROM [start effective date], or
EFFECTIVE TO [end effective date]

Total agreement amount: [amount agreed].
This purchase order CANCELLED on: [date]
CONFIRMATION — DO NOT DUPLICATE

All prices and amounts on this order are expressed in [foreign
currency].
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Blanket Purchase Agreement Lines

After printing the header information, Purchasing prints the following

line information:

Line

Item Number/
Description

Quantity

Unit

Unit Price

Extension

Purchasing prints the purchase agreement line
number

Purchasing prints your item number first. If you
have an item revision number, Purchasing prints
[revision number]. If you specify a supplier item
number, Purchasing prints (Your #: [supplier item
number]) on the next line. Purchasing then prints
the item description on the following line. (portrait
—wraps after 23 characters per line, landscape —
wraps after 45 characters per line)

Purchasing prints the quantity committed of the
item you are ordering for quantity—based items (in
number format 999999999 with any existing
decimal places, portrait and landscape)

Purchasing prints the item unit of measure for
gquantity—based items (4 characters, portrait and
landscape)

Purchasing prints the item unit price for
quantity—based items (in number format
999999999999 with any existing decimal places in
the precision associated with the currency, portrait
and landscape)

Purchasing prints the total amount committed for
the line. This number is the product of the
quantity and unit price. (in number format
9999999999999 with any existing decimal places in
the precision associated with the currency, portrait
and landscape). For amount-based line types,
Purchasing prints the price extension only for
single shipments.

After printing the first line of the purchase order, Purchasing prints the
following information if it pertains to the purchase order:
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UN Number: [UN number and description]
Hazard Class: [hazard class hame]

This purchase order line CANCELLED on: [date]
Original quantity ordered: [quantity]



e Quantity CANCELLED [quantity]
e Brief Supplier Line Note

e Long Supplier Line Notes

e This PO line references your Quotation #: [quotation number]

Blanket Purchase Agreement Release Header

Purchasing prints the following header information if it pertains to the

release:

e Brief Supplier Note from Blanket Purchase Agreement

e Long Supplier Note from Blanket Purchase Agreement
e BLANKET AGREEMENT RELEASE (for blanket releases)
e PLANNED PURCHASE ORDER RELEASE (for scheduled

releases)

e This release CANCELLED on: [date]

¢ All prices and amounts on this order are expressed in [foreign

currency].

Blanket Purchase Agreement Release Lines

After printing the header information, Purchasing prints the following

line information:
Line

Item Number/
Description

Unit Price

Purchasing prints the purchase order line number

Purchasing prints your item number first. If you
have an item revision number, Purchasing prints
[revision number]. If you specify a supplier item
number, Purchasing prints (Your #: [supplier item
number]) on the next line. Purchasing then prints
the item description on the following line. (portrait
—wraps after 23 characters per line, landscape —
wraps after 45 characters per line)

Purchasing prints the item unit price for
quantity—based items (in number format
999999999999 with any existing decimal places in
the precision associated with the currency, portrait
and landscape)

After printing the first line of the purchase order, Purchasing prints the
following information if it pertains to the purchase order:

e UN Number: [UN number and description]
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Hazard Class: [hazard class hame]

This purchase order line CANCELLED on: [date]
Original quantity ordered: [quantity]

Quantity CANCELLED [quantity]

Brief Supplier Line Note

Long Supplier Line Notes

This PO line references your Quotation #: [quotation number]

Blanket Purchase Agreement Release Shipments

After printing each line, Purchasing prints the following shipment
information:

o (This symbol indicates a distinct shipment)

SHIP TO: [ship to address]. If the ship to address is the same as
the purchase order header address, Purchasing prints Address at
top of page directly below the SHIP TO: note without printing
the address again. This address contains up to 3 lines of address.
On line 4, Purchasing prints the city, state (or province), and zip
code. On line 5, Purchasing prints the country. (35 characters for

lines 1 through 3, 74 characters for line 4, and 25 characters for
line 5, portrait and landscape)

After printing the bullet and address to signify a new shipment,
Purchasing prints the following information:

Delivery Date

Quantity

Unit

Unit Price
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If you provided a promised date, Purchasing prints
the promised date. If you do not provide a
promised date or a last date, but you provide a
need by date, Purchasing prints the need by date.
Otherwise, this space is blank.

Purchasing prints the quantity of the item you are
ordering for quantity-based items (in number
format 999999999 with any existing decimal places,
portrait and landscape)

Purchasing prints the item unit of measure for
quantity-based items (4 characters, portrait and
landscape)

Purchasing prints the item price override for
quantity-based items (in number format
999999999999 with any existing decimal places in



the precision associated with the currency, portrait
and landscape)

Extension Purchasing prints the total amount of the line. This
number is the product of the quantity and item
price override. (in number format 9999999999999
with any existing decimal places in the precision
associated with the currency, portrait and
landscape)

Tax Purchasing prints Y or N to indicate whether this is
a taxable item.

If you cancelled a shipment, Purchasing prints the following
information:

e This shipment CANCELLED on: [date]
e Original shipment quantity: [quantity]
e Quantity CANCELLED [quantity]

Blanket Purchase Agreement Release Distributions

After printing each shipment, Purchasing prints the following
distribution information:

e DELIVERTO:

e [Last Name], [First Name] [Middle Initial] ([quantity ordered]) if
you name the requestor. Unspecified ([quantity ordered])
otherwise. (45 characters, portrait and landscape)

Total

Purchasing prints Continued at the bottom of every page except for the
last page of the purchase order. Purchasing prints the sum of the
purchase order lines on the bottom of the last page.
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Document Revision Numbering

You can create multiple revisions of your purchasing documents
(planned and standard purchase orders and blanket and contract
purchase agreements). Use the Document Types window to set
whether each of these documents is archived upon approval or upon
printing. All revisions begin at 0, and Purchasing increments this
revision number by 1 when you make changes to controlled
information and the current revision number is equal to the archived
number. As a result, the first revision that you print might not be 0 if
you are archiving on approval. See: Defining Document Types: page
1-87.

The following examples illustrate the difference between archiving on
approval and on printing:

Archiving on Approval
Action Archive Rev  Current Rev
Step 1. Create purchase order None 0
Step 2. Approve purchase order 0 0
Step 3. Change controlled information 0 1
Step 4. Approve purchase order 1 1
Step 5. Print purchase order 1 1

Table 4-6 (Page 1o0f1)

Archiving on Print

Action Archive Rev  Current Rev
Step 1. Create purchase order None 0
Step 2. Approve purchase order None 0
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Action Archive Rev Current Rev

Step 3. Change controlled information None 0
Step 4. Approve purchase order None 0
Step 5. Print purchase order 0 0
Step 6. Change controlled information 0 1
Step 7. Approve purchase order 0 1
Step 8. Change controlled information 0 1
Step 9. Print purchase order 1 1

Table 4-7 (Page 2 of 2)
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Document Revision Rules

The following table describes the additions and changes that cause
Purchasing to increment document revision numbers;

Standard

Planned

Blanket

Contract

Release

HEADER

Buyer

v

Contact

Confirm

Ship-To

Bill-To

Payment Terms

Freight Carrier /
Ship Via

AN RN Y Y I N A SR

AN RN Y Y Y R NN

AN N N N I N A N R

AN N N N I N O N R N

FOB

AN

AN

Freight Terms

Brief Note to Sup-
plier

Acceptance Re-
quired

Acceptance Due
Date

AN

AN

AN

Amount Limit

Effective Date

Expiration Date

Cancel Flag

AN N I N N

Amount Agreed

R} R ]| ]| N

AU S N N R N

Release Number

Release Date

Confirming Order

Table 4-8 (Page 1 of3)
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Standard

Planned

Blanket | Contract

Release

LINES

Unit Price

Line Number

Item

Item Revision

Item Description

Payment Terms

Quantity

Unit of Measure

Source Quotation
Header

A I N I N I N I N . N O N O N I N

AN I N I N I N I N L N O N O N I N

RS RS]SE]]]S

Source Quotation
Line

A

A

AN

Hazard Class

UN Number

Contract Number

Supplier Item
Number

A N I N N

A N N N

AN NI G A N

Brief Note to  Sup-
plier

AN

AN

AN

Price Type

Quantity Agreed

Amount Agreed

Closed Code

Cancel Flag

S| | ] X S

Table 4-8 (Page 2 of 3)
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Standard

Planned

Blanket

Contract

Release

PRICE
BREAKS

Ship-To Location

Quantity

Break Price

Price Break Num-
ber

AN I N I N N

SHIPMENT

Shipment Number

Ship-To

Quantity

Promise Date

Need-By Date

Last Acceptance
Date

AN I N I N I N I N A N

AN I N I N I N I N N

AN N I N I N O N R N

AN I N I N I N I N N

Taxable

AN

AN

AN

AN

Shipment Price

Cancel Flag

DISTRIBU
TION

Quantity

Requestor

Distribution
Number

Table 4-8 (Page 3 of 3)
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Documents are unapproved when you add or change specific
information, regardless of whether the revision is incremented. Almost
all changes that cause the revision to be incremented also unapprove
the document, as does placing the document on hold. However, if you
change the line level Brief Note to Supplier, cancel the document or its
entities, or change the Firm Demand flag or receiver note, the

document does not require reapproval.
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Controlled changes unapprove either the document header alone, or
both the header and its shipments. However, you can continue to
receive against approved shipments even when the header is
unapproved.

You can also control whether—or how much of—a revision (for
example, to Quantity) requires the document to undergo the entire
approval process or to be instantly approved. See: Workflow Processes
for Approving Change Orders: page C — 168.

The following table describes the additions and changes you can make
that cause Purchasing to unapprove a document.
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Standard

Planned

Blanket

Contract

Release

HEADER:
Unapproves
Header

Buyer

v

Contact

Confirm

Ship-To

Bill-To

Payment Terms

Ship via

FOB

Freight Terms

Brief Note to
Supplier

RS S]SSER] R )R] ]S

RS S]SSER] R )R] ]S

RS S]SSESR] R )R] ]S

A NI N I N N I N N N I N I N N

Acceptance Re-
quired

AN

AN

AN

AN

Acceptance Due
Date

AN

Amount Limit

Effective Date

Expiration Date

Amount Agreed

AN I N I N N

Release Number

Release Date

Table4-9 (Page 1 of3)
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Standard

Planned

Blanket

Contract

Release

LINE
Unapproves
Header

Unit Price

Line Number

Item

Item Revision

Item Description

Item Category

Quantity

Unit of Measure

Source Quota-
tion Header

A I N I N I N I N I N I N I N I N

AN I N I N I N I N I N O N O N I N

AN I N I N I N I N I N O N O N I N

Source Quota-
tion Line

A

A

A

Hazard Class

Contract
Number

Supplier Item
Number

AN

UN Number

Price Type

Price Limit

Quantity Agreed

Amount Agreed

Brief Note to
Supplier

AN N N A L L N

Promised Date

AN

Need-By Date

Capital Expense

Table 4-9 (Page 2 of 3)
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Standard | Planned | Blanket | Contract | Release
Ship-To v
Location
PRICE
BREAKS: Quantity
Unapproves
Header Break Price
Discount
Shipment Num- | v v v
ber
Ship-To v v (4
Quantity v v v
SHIPMENT: | Promise Date v v v
Unapproves
Header and | Need-By Date (4 v v
Shipment
Last Acceptance | v/ (4 v
Date
Taxable (Header | v/ v v
only)
Shipment Price v
Distribution 4 4 v
Number (Head-
er Only)
DISTRIBU -
TION: Quantity
Unapproves
Requestor
Header and
Shipment (Header Only)
Charge Account
Subinventory

Table 4-9 (Page 3 of 3)
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Changing Encumbered Documents

See Also

You can make changes to a purchase order for which funds have
already been reserved (or encumbered). You do this by temporarily
unreserving the document, making the desired changes, and reserving
the document again. The Unreserve action takes place at the header
level only; it affects all lines on a purchase order, and changes the
document’s status to Requires Reapproval.

Note: If the appropriate approver modifies an encumbered
requisition, Purchasing unreserves the requisition
automatically.

To make changes to an encumbered purchase order:
1. Choose the Approve button.

The Approve Document window appears.
2. Select Unreserve.

The Unreserve option is available only if funds are currently
reserved for at least one line in your document.

Enter an Unreserve Date that falls within an open reserve period.
Choose OK.

Make your changes to the document and choose Approve again.

IS T o

In the Approve Document window that appears, select Reserve to
reserve funds again for the document.

7. Select Submit for Approval and choose OK to resubmit the
document for approval.

Submitting a Document for Approval: page 2 — 35
Document Reapproval Rules: page 4 — 130

Overview of Encumbrance Accounting, Oracle Public Sector General
Ledger User’s Guide
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Drop Shipments

See Also

Oracle Order Management and Oracle Public Sector Purchasing
integrate to provide drop shipments. Drop shipments are orders for
items that your supplier ships directly to the customer either because
you don’t stock or currently don’t have the items in inventory, or
because it’s more cost—effective for the supplier to ship the item to the
customer directly.

Drop shipments are created as sales orders in Order Management. The
Purchase Release concurrent program or workflow in Order
Management creates rows in the Requisition Import tables in
Purchasing. Then Purchasing’s Requisition Import process creates the
requisitions. Drop shipments are marked with the Source Type of
External in Order Management and Supplier in Purchasing.

When the drop shipment has been sent to the customer, the supplier
can confirm the shipment through a phone call, an invoice, or an
Electronic Data Interchange (EDI) document, such as an Advance
Shipment Notice (ASN).

When you receive confirmation of a drop shipment, create a receipt
against the shipment, even though you have not received the item
physically (because your customer has received it directly). Even if
your supplier sends an invoice, create the receipt for it. This creates
inbound and outbound material transactions in your system for
accounting purposes.

Drop shipments support a Destination Type of Expense or Inventory
only.

You can handle returns of drop shipments using standard Order
Management or Purchasing functionality. There are different ways you
may want to handle returns depending on whether the customer
returned the item to you or directly to the supplier.

Note: You should not drop-ship internal sales orders.

Drop Shipments, Oracle Order Management User’s Guide
Drop-Ship Order Flow, Oracle Order Management User’s Guide
Drop-Ship Return Flow, Oracle Order Management User’s Guide
Purchase Release, Oracle Order Management User’s Guide
Advanced Shipment Notices (ASNSs): page 7 — 16
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Returns: page 7 - 77
Entering Receipt Header Information: page 7 — 33
Entering Receipt Lines: page 7 - 35

Requisition Import Process: page 9 — 144
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Tax Defaults in Purchasing

You enter tax information on your Purchasing documents, using the
Tax Code and Recovery Rate fields. Each tax code has an associated
tax rate in Payables that determines the tax amount for an item. You
also associate a recovery rate with each tax code. The Recovery Rate is
the percentage of tax that your business can reclaim for credit.

Tax information defaults onto requisitions, purchase orders, and
blanket releases if you have set up tax codes and corresponding
recovery rates. For example, you can associate a tax code for each
item, supplier, or supplier site. Then you can use the Tax Defaults
tabbed region of the Purchasing Options window in Purchasing to
specify which source—such as item, supplier, and supplier site—from
which to default the tax code onto your Purchasing documents.

You can override the tax code if the profile option Tax: Allow Override of
Tax Code is set to Yes. You can override the recovery rate if the profile
option Tax: Allow Override of Tax Recovery Rate is set to Yes.

If you use partially recoverable tax, you can view the recoverable and
nonrecoverable tax for each tax code in your document by choosing
Tax Code Summary from the Tools menu. You can view recoverable
and nonrecoverable tax for each line, shipment, and distribution by
choosing Tax Details from the Tools menu.

Duplicating Tax Functionality from Previous Releases

Tax Codes

Purchasing preserves your tax defaults from previous releases. That is,
Purchasing continues to default tax from the ship-to location if you
don’t set a tax defaulting hierarchy in the Tax Defaults region of the
Purchasing Options window. (Note that a Tax Code defined in the
Purchase Order Preferences window overrides this tax defaulting
hierarchy.)

You can set up Purchasing to default tax codes based on your public
sector needs. You set up the Tax Defaults hierarchy in the Tax Defaults
tabbed region of the Purchasing Options window to determine the
following:

¢ Which sources you use for tax codes

e The order in which Purchasing searches the sources to find a
valid tax value
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A Tax Code defined in the Purchase Order Preferences window
overrides any tax defaults you set in the Tax Defaults region of the
Purchasing Options window. See: Entering Purchase Order
Preferences: page 4 — 33.

For instructions on defining the Tax Defaults hierarchy, see: Defining
Tax Defaults Options: page 1 — 55.

How Tax Code Defaults Affect Purchasing Documents

The tax defaults you select in the Tax Defaults region of the Purchasing
Options window default in the Tax Code field of the following
windows and processes in Purchasing:

¢ Shipments window for standard and planned purchase orders
e Requisition lines in the Requisitions window

e Purchase order line shipments created by the AutoCreate
Documents window

e Shipments tabbed region in the Releases window (for blanket
releases)

¢ Release shipments created by the Create Releases process

e RFQ Shipments window (for Bid or Standard RFQs) or RFQ
Price Breaks window (for Catalog RFQs)

¢ Quotation shipments window (for Bid or Standard quotations)
or Quotation Price Breaks window (for Catalog quotations)

If you change the tax code of a tax source (for example, the Tax Code in
the Invoice Tax tabbed region of the Supplier Sites window),
Purchasing does not update your existing documents with the new tax
code; it updates only new documents you create.

If you’ve set up a tax defaulting hierarchy in the Tax Defaults region of
the Purchasing Options window, the appropriate tax codes
automatically default onto blanket release shipments created by the
Create Releases process and onto documents you autocreate.

When creating a release from a planned purchase order, the tax code on
the planned purchase order shipment overrides the tax defaults in the
Purchasing Options window.
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Recovery Rate

The tax recovery rate defaults on Purchasing documents based on the
tax code and the setup in the Financials Options window. The Recovery
Rate field is used in the following windows:

¢ Requisition Distributions (for purchase requisitions)

e Purchase order Distributions (for planned and standard
purchase orders)

e Release Distributions

The recovery rate is the percentage of tax your business can reclaim for
credit. The nonrecoverable portion of the tax is included in the
following:

e Encumbrance accounting and receipt or period-end accrual
accounting

e Approval limit amounts
See: Overview of Receipt Accounting: page 7 — 101

Recovery rates can be used for sales, user—defined, and offset taxes.
See: Recoverable Tax, Oracle Public Sector Payables User’s Guide.

See Also

Partially Recoverable Tax, Oracle Public Sector Payables User’s Guide
Tax Control Methods, Oracle Public Sector Payables User’s Guide
Tax Recovery Rules, Oracle Public Sector Payables User’s Guide
Viewing Tax Summary Information: page 4 — 141

Viewing Tax Details: page 4 — 143

Entering Requisition Lines: page 3 - 60

Entering Requisition Distributions: page 3 — 67

Entering Purchase Order Shipments: page 4 — 65

Entering Purchase Order Distributions: page 4 — 77

Entering Release Shipments: page 4 — 93

Entering Release Distributions: page 4 — 100

Entering Taxes on Invoices, Oracle Public Sector Payables User’s Guide
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N
Viewing Tax Code Summary Information

Use the Tax Code Summary window to view tax lines totaled and
grouped by tax code. When you enter or change the Tax Code on a line
or the Recovery Rate on a distribution, the tax information in the Tax
Code Summary window is recalculated once you save the document.

Use this window to view, not change, tax information. To change tax
information, change the Tax Code or the Recovery Rate fields in the
document entry window if the profile options Tax: Allow Override of Tax
Code and Tax: Allow Override of Tax Recovery Rate are set to Yes, if funds
for the purchase order or release are not currently reserved (if you use
encumbrance accounting), and if the shipment has not yet been
received.

p Toview a summary of tax information in the document:

m  Choose Tax Code Summary from the Tools menu, from the
Requisitions, Purchase Orders, or Releases windows, or their
corresponding Shipments or Distributions windows.

%Tax Code Summary

Document Mumber  gLLE S % Total Tax 142.97

Armaount 1.429.67
oval Amount 1,558.34

Monrecov g
Tax Code axed Amount ¥ Total Tax
Account Tax 1,429.67 142 97

I S ]

The top region displays the total tax amounts in the document:
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See Also

Nonrecoverable
Tax

Recoverable Tax

Total Tax
Amount

Approval
Amount

Based on the recovery rate on the distribution, the
total tax in the document that cannot be reclaimed
for credit.

Based on the recovery rate on the distribution, the
total tax in the document that can be reclaimed for
credit.

Nonrecoverable Tax + Recoverable Tax.
The total document amount, excluding tax.

Amount + Nonrecoverable Tax.

The bottom region lists all of the tax codes used in your document and
the tax information for each:

Tax Code

Taxed Amount

Nonrecoverable
Tax

Recoverable Tax

Total Tax

The Tax Code from the Requisitions, purchase
order Shipments, or Releases window. The tax
code defaults from the following sources, in this
order: the Purchase Order Preferences windowy, if
you are creating a standard or planned purchase
order or blanket release; the planned purchase
order shipment if you are creating a release from a
planned purchase order; the Tax Defaults region in
the Purchasing Options window.

The total net Amount, excluding tax, for all lines
with this tax code.

Based on the Recovery Rate on the distribution, the
total tax that is not recoverable, for all lines with
this tax code.

Based on the Recovery Rate on the distribution, the
total tax that is recoverable, for all lines with this
tax code.

Nonrecoverable Tax + Recoverable Tax for all lines
with this tax code.

Tax Defaults in Purchasing: page 4 — 138

Tax Control Methods, Oracle Public Sector Payables User’s Guide

Tax Recovery Rules, Oracle Public Sector Payables User’s Guide
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N
Viewing Tax Details

Use the Tax Details window to view all tax information for each line.
When you enter or change the Tax Code on a line or change the
Recovery Rate on a distribution, the tax information in the Tax Details
window is recalculated once you save the document.

Use this window to view, not change, tax information. To change tax
information, change the Tax Code or the Recovery Rate in the
document entry window if the profile options Tax: Allow Override of Tax
Code and Tax: Allow Override of Tax Recovery Rate are set to Yes, if funds
for the purchase order or release are not currently reserved (if you use
encumbrance accounting), and if the shipment has not yet been
received.

p To view tax details:

1. Choose Tax Details from the Tools menu, from the Requisitions,
Purchase Orders, or Releases windows, or their corresponding
Shipments or Distributions windows.

EE Tax Details

Document Mumber  JLHIELTES

EE 128.67 Armount 1.429.67
7 14.30 Approval Amount 1,558.34

MNonrecoverable Recoverable Approval
Arnount Tax Tax Arnount

1,429.67 128.67 14.30

Lire Mum [ tern [SREE

2. Choose to display all lines, shipments, or distributions in the
document.

The top region displays the total tax amounts in the document;
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Nonrecoverable
Tax

Recoverable Tax

Amount

Approval
Amount

Based on the recovery rate on the distribution, the
total tax in the document that cannot be reclaimed
for credit.

Based on the recovery rate on the distribution, the
total tax in the document that can be reclaimed for
credit.

The total document amount, excluding tax.

Amount + Nonrecoverable Tax.

The bottom region displays detailed tax information for each line,
shipment, or distribution:

Tax Code

Amount

Nonrecoverable
Tax

Recoverable Tax

Approval
Amount

Recovery Rate

Charge Account

Oracle Public Sector Purchasing User’s Guide

(Displayed in the Shipments tabbed region for
purchase orders and the Lines tabbed region for
requisitions) The Tax Code from the Requisitions,
purchase order Shipments, or Releases window.
The tax code defaults from the following sources,
in this order: the Purchase Order Preferences
window, if you are creating a standard or planned
purchase order or blanket release; the planned
purchase order shipment if you are creating a
release from a planned purchase order; the Tax
Defaults region in the Purchasing Options window.

The total line, shipment, or distribution amount,
excluding tax.

Based on the recovery rate on the distribution, the
total tax for this line, shipment, or distribution that
is not recoverable.

Based on the recovery rate on the distribution, the
total tax for this line, shipment, or distribution that
is recoverable.

Amount + Nonrecoverable Tax for this line.

(Displayed in the Distributions tabbed region only)
The percentage of tax that is recoverable for this
distribution.

(Displayed in the Distributions tabbed region only)
The account number from the distribution line.



See Also

Tax Defaults in Purchasing: page 4 — 138
Tax Control Methods, Oracle Public Sector Payables User’s Guide

Tax Recovery Rules, Oracle Public Sector Payables User’s Guide

Purchase Orders 4 -145



Procurement Card Purchase Orders and Releases

A procurement card (or P-Card) is a corporate credit card issued to an
employee so that the employee can purchase items directly from a
supplier. Procurement card numbers are provided on Self-Service
Purchasing requisitions only. After the requisition is created in
Self-Service Purchasing, a purchase order or release is generated in
Purchasing by either the PO Create Documents workflow or by you
using AutoCreate, depending on how you’ve set up Purchasing.

Procurement card purchase orders are approved and transmitted to the
supplier like any other purchase order. They are approved through the
approval workflows in Purchasing, and you transmit them to the
supplier through facsimile, Oracle e-Commerce Gateway, or other
method as usual. (The procurement card information itself is
transmitted to the supplier through e-Commerce Gateway, through the
outbound purchase order transaction.) Upon receiving the purchase
order, the supplier transmits the procurement card information to the
procurement card issuer (for example, a bank). The credit card issuer
then sends transaction files back to Oracle Public Sector Payables,
which automatically generates accounting distributions and creates
invoices to pay the issuer.

If a supplier rejects a procurement card order, the buyer can notify the
requester of the rejection. The buyer can cancel the purchase order and
ask the requester to resubmit the requisition, or re-send the purchase
order using a different form of payment.

In Purchasing, you see a procurement card number on a procurement
card requisition line in the AutoCreate Documents window (as a
hidden field), and in the Purchase Orders, Releases, and Purchase
Order Headers windows (if PO: Use P-Cards in Purchasing is set to Yes).

You cannot create a procurement card purchase order or release
manually. Purchasing creates a procurement card purchase order or
release through the PO Create Documents workflow or the AutoCreate
Documents window, depending on your Purchasing setup. See:
Workflow Setup Options: page 1 — 95.

Procurement card purchase orders and releases can be created only
from requisition lines in Self-Service Purchasing. To use procurement
card purchase orders or releases in Purchasing, you must set up
procurement card functionality in both Self-Service Purchasing and
Payables.

For information on setting up procurement card functionality, see the
Self-Service Purchasing Implementation Manual and the Oracle Public
Sector Payables User’s Guide.
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Self-Service Purchasing

REQUISITIONER

- P-Card details default -
Enter requisition —» o —» Complete requisition
onto requisition

l Workflow
Approval
Purchasing
BUYER v

Create P-Card order

using AutoCreate Verify P-Card / open
(or let Workflow create it transactions
automatically)

I

Transmit to supplier

Payables

P-Card / invoice

SUPPLIER

P-Card validation
and authorization

Inform buyer of
rejection

CARD
ISSUER

‘ Process order

Ship order
Receive order/
Reconciliation

Procurement card purchase orders:

e Cannot be used with encumbrance accounting.

e Can be used for items with a Destination Type of Expense only.
e Cannot be used for documents that contain a Project number.

e Can be used for standard purchase orders or releases only.

e Are not available for invoice matching or invoice creation.

¢ Do not accrue on receipt. See: Receiving, below.

e Transmit the procurement card number to the supplier through
e—-Commerce Gateway, through the outbound purchase order
transaction. See: Running the EDI Purchase Order Outbound
Extract Program, Oracle e-Commerce Gateway User’s Guide.
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Approval

Receiving

Invoicing

Requisitions and purchase orders that contain procurement card items
are routed through the same approval process as any other document,
unless you modify the approval workflow to treat them differently.

After a procurement card purchase order or release is approved, it is
automatically closed for invoicing if you use the Two-Way match
approval level.

You receive a procurement card order like any other. However,
procurement card items do not accrue upon receipt. Payment and
accounting for procurement card orders are already handled in
Payables, which imports the credit card transaction files from the credit
card issuer. If you accrue upon receipt, Purchasing accrues upon
receipt all items except procurement card items. You cannot change the
Accrue at Receipt check box in the Shipments window for procurement
card purchase orders or releases.

Similarly, at period-end, Purchasing does not accrue or roll over
procurement card orders to General Ledger.

Since invoices for procurement card purchase orders are created
through credit card transaction files that are imported from the credit
card issuer into Payables, note the following:

e Procurement card purchase orders are not available for invoice
matching in Payables.

e Procurement card shipment lines are automatically closed after
approval if you use the Two-Way match approval level. (If you
use Three-Way or Four-Way match approval levels, you can still
receive or inspect against the shipment.)

e Payment on Receipt does not generate invoices automatically for
procurement card orders, even if the supplier is set up as a Pay
on Receipt site in the Supplier Sites window. A supplier site can
be both a Pay on Receipt site and a Procurement Card Site;
however, if the supplier site is a Pay on Receipt site, invoices will
be generated automatically for all orders received from that
supplier site when you run Payment on Receipt, except those
that include procurement card information.
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e Advance Shipment Notices (ASNSs) that contain billing
information (sometimes known as Advance Shipment and
Billing Notices, or ASBNs), if they also contain procurement card
information, are not automatically converted into invoices as
they normally would be upon receipt.

See: Procurement Card Integration, Oracle Public Sector Payables User’s
Guide.
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Supply Base
Management

CHAPTER

T his chapter tells you everything you need to know about Supply
Base Management, including:

e Overview of Sourcing, RFQs, and Quotations: page 5 -2
e Overview of the Supplier Item Catalog: page 5-8

e Receiving Price/Sales Catalog Information
Electronically: page 5 — 22

e Overview of Automatic Sourcing: page 5 - 30
e Approved Supplier List: page 5 — 42

e Entering RFQs: page 5 - 57

e Entering Quotations: page 5-74

e Copying Quotations from RFQs: page 5 -89
e Approving Quotations: page 5 — 92

e Defining Supplier Lists: page 5-98

e Managing Buyer Workload: page 5 - 100
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Overview of Sourcing, RFQs, and Quotations

Purchasing provides you with request for quotation (RFQ), and
quotation features to handle your sourcing needs. You can create an
RFQ from requisitions, match supplier quotations to your RFQ, and
automatically copy quotation information to purchase orders.
Purchasing provides complete reporting to control your requests for
guotations and evaluate supplier responses.

¢ |dentify requisitions that require supplier quotations and
automatically create a request for quotation.

o Create a request for quotation with or without approved
requisitions so that you can plan ahead for your future
procurement requirements.

e Record supplier quotations from a catalog, telephone
conversation, or response from your request for quotation. You
can also receive quotations electronically.

e Review, analyze, and approve supplier quotations that you want
available to reference on purchase orders and requisitions. You
should be able to evaluate your suppliers based on quotation
information.

o Receive automatic notification when a quotation or request for
quotation approaches expiration.

¢ Review quotation information on-line when creating purchase
orders or requisitions and copy specific quotation information to
a purchase order or requisition.

o ldentify a supplier that you want to use only for receiving RFQs
and quotations. You can later be able to access purchase history
to help you decide if the quotations are acceptable.

o Hold all purchasing activity on a supplier at any time. You can
still match invoices to approved purchase orders or receipts for
this supplier. You can release a supplier hold at any time.

o Create, change, and review supplier information on-line. You
can enter supplier site information, supplier contacts, and
supplier-specific delivery information.

e Review the purchase history for a specific item. You can identify
the suppliers you used in the past, quantities you ordered, and
pricing information. You can match this information to specific
purchase orders.
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Major Features

¢ Simplify the sourcing of commonly purchased items. You can
define requisition templates for your commonly purchased
items. Requestors can use these requisitions templates to create
simple, pre-sourced requisitions.

¢ Source the items for which you negotiated purchase agreements
automatically. If you created sourcing rules and Approved
Supplier List entries for the items, supplier information is
entered automatically in the Requisitions window when you
create requisitions. You can also place supplier information for
items onto blanket purchase order releases.

e Specify planning constraints, such as lead time, minimum order
quantity, or fixed lot multiples, for each supplier site for an item
so that if a supplier cannot currently meet your demand, Supply
Chain Planning automatically uses another supplier that you
specify. See: Defining the Supplier/Item Attributes: page 5 - 51.

Electronically Received Catalog Information

You can receive price/sales catalog information electronically from
your supplier through the Purchasing Documents Open Interface. The
information is imported directly as blanket purchase agreement lines or
catalog quotations. See: Receiving Price/Sales Catalog Information
Electronically: page 5 — 22.

Flexible Document Numbers

Purchasing identifies each RFQ or quotation with a unique document
number. You decide whether you want to enter document numbers
manually or have the numbers assigned automatically.

Sourcing Power

Purchasing lets you source your items so you can negotiate the best
deals with your suppliers. You can create requests for quotations,
record the results, and reference the corresponding quotation when
creating your purchase order. You can also review historical purchase
prices so that you can evaluate how to purchase your items more
effectively.

Supplier Defaulting

For each supplier, you can define default preferred ship—to locations,
freight terms and carriers, free—on-board information, tax names, and
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payment terms to be used when you enter purchase orders. You can
always override any default.

Supplier Purchasing Hold

You can prevent purchasing activity on specific suppliers at any time
by using the Suppliers window to provide a reason for holding the
supplier. You cannot approve any purchase order for a supplier on
hold; however, you can receive and match against approved purchase
orders or receipts for a supplier on hold. You can release a hold at any
time.

AutoCreating RFQ and Quotation Information

You can AutoCreate RFQs directly from requisitions. You can also
Copy quotations directly from RFQs to facilitate recording responses
from your suppliers. See: Copying Quotations from RFQs: page 5 — 89.
(If you receive catalog information from your supplier electronically,
that information is sent automatically in the form of a catalog
quotation. See: Receiving Price/Sales Catalog Information
Electronically: page 5 - 22.)

Request for Quotation Requirement

You can identify whether a request for quotation is necessary for a
specific item or requisition line.

Supplier Lists

Purchasing lets you create supplier lists so that you can predefine
groups of suppliers to whom you want to send RFQs. You can
establish supplier lists according to criteria you define (item,
manufacturing category, geographic location, or other) and you can
combine supplier lists to produce many copies of your RFQ
automatically.

Note: If the Oracle Public Sector Payables profile option
AP:Enter Alternate Fields is enabled, alternate fields will
appear on designated windows like Enter Suppliers.

See: Profile Options in Payables, See Oracle Public Sector Payables User’s
Guide
Purchasing History

Purchasing lets you review your purchase price history information to
help you source your items better. You can either review all historical
prices for a particular item or the last prices you paid for a specific item
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RFQs and Quotations

by quantity. You can review the detailed information of the purchase
order corresponding to this last price.

Flexible, Custom Notes

Purchasing lets you quickly add extended Notes and instructions to
your RFQs and quotations. You can include standard notes or create
your own custom notes. You can use as much descriptive text as you
need.

Automatic Sourcing

Automatic sourcing automatically defaults sourcing information onto
the requisitions, blanket purchase orders, or quotations you create. You
can easily assign any item with an item number to a specific blanket
purchase agreement or quotation you created. Purchasing
automatically assigns the name of the supplier for the blanket purchase
order and quotation to any requisition for this item. (If you receive
catalog information from your supplier electronically—and you
specified sourcing rules to be sent electronically also—then the
sourcing rule and Approved Supplier List entry for this supplier is
entered in your system automatically.) See: Automatic Sourcing: page
5-—30. See: Approved Supplier List: page 5 — 42.

A request for quotation (RFQ) is sent to a supplier to request pricing
and other information for an item or items. A quotation is the
supplier’s response to that RFQ. Some examples of how you send an
RFQ to a supplier include creating an RFQ in the RFQs window and
sending it by facsimile, making a phone call, or using Oracle Supplier
Management Portal. One way a supplier can send a quotation,
whether or not in response to an RFQ, is through the Purchasing
Documents Open Interface. (See: Receiving Price/Sales Catalog
Information Electronically: page 5 - 22.) If you don’t receive quotations
electronically from your supplier, you can create the quotation
manually using the Quotations window, or copy the quotation from an
RFQ. (See: Copying Quotations from RFQs: page 5 - 89.)

Using Quotation Information on Your Documents

Purchasing lets you use your quotation information when you build
purchase orders.
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Using Quotation Information for a Purchase Order

When you create a purchase order (manually or from requisitions), you
can use the Supplier Item Catalog window to retrieve quotation
information. (The Supplier Item Catalog window can include
quotations sent to you by your supplier through the Purchasing
Documents Open Interface. See: Receiving Price/Sales Catalog
Information Electronically: page 5 — 22.) Purchasing provides all your
approved quotation shipment information for a specific item or
manufacturing category. You can copy this quotation shipment to an
existing blanket purchase agreement or standard purchase order when
you add this item or purchasing category to a purchase order line. You
can sort this quotation information according to your needs, using
criteria such as price or quantity. You can easily evaluate the source
that is best for an item.

After you select the quotation shipment you want to use, Purchasing
copies the item unit price, quantity, unit of measure, supplier product
number, inspection required status, receipt required status, quotation
number, quotation type, and supplier quotation number on your
purchase order. Purchasing also copies the quotation item description
on your purchase order if you define your items to do so.

Purchasing automatically warns you when the terms and conditions of
the quotation are different from the terms and conditions of your
purchase order. The original purchase order terms and conditions
remain unchanged.

Using Partial Quotation Information on a Requisition

When you enter an item or purchasing category on a requisition line,
you can use the Supplier Item Catalog window to access quotation
shipment information for the item or category. After you select the
guotation shipment you want to use, Purchasing automatically copies
the item unit price, quantity, unit of measure, supplier product number,
supplier name, supplier site, and supplier contact to your requisition
line. Purchasing also copies the quotation item description on your
purchase order if you define your items to do so.

Types of Quotations and RFQs

There are three types of quotations and RFQs that come with
Purchasing by default:

e Catalog: Used for high—volume items or items for which your
supplier sends you information regularly. A Catalog quotation
or RFQ also includes price breaks at different quantity levels.
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e Standard: Used for items you’ll need only once or not very often,
but not necessarily for a specific, fixed quantity, location, and
date. For example, you could use a Catalog quotation or RFQ
for office supplies, but use a Standard quotation or RFQ for a
special type of pen you don’t order very often. A Standard
quotation or RFQ also includes price breaks at different quantity
levels.

e Bid: Used for a specific, fixed quantity, location, and date. For
example, a Bid would be used for a large or expensive piece of
equipment that you’ve never ordered before, or for an item that
incurs transportation or other special costs. You cannot specify
price breaks for a Bid quotation or RFQ.

For all three types, you can define effectivity dates at the header level.
For Catalog and Standard quotations, you can also specify effectivity
dates for individual price breaks. (For a Bid, you cannot specify
effectivity dates at the shipment level.)

You can also define your own RFQ or quotation types using the
Document Types window. See: Defining Document Types: page 1 — 87.
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Overview of the Supplier Item Catalog

The Supplier Item Catalog provides a simple mechanism for locating
items and their source information for the purpose of creating purchase
order and requisition lines. You can open the catalog from an existing
requisition or purchase order and add lines to that document.
Alternatively, you can open the catalog from the Navigator and search
for item information from there.

Search Supplier Item Catalog Window

Purchasing displays the Search Supplier Item Catalog window whether
you invoke the Supplier Item Catalog from the menu or from a
requisition or purchase order.

To invoke the Supplier Item Catalog from a requisition or purchase
order, select the Catalog button when the cursor is in the Lines tabbed
region.

The Supplier Item Catalog does not support Outside Processing.
However, you can open the Catalog from an outside processing line in
a requisition or a purchase order to find other items.

In the search windowy, lists of values show only valid values. For
example, inactive suppliers are not displayed.

The ”Item description contains the words” field is used for keyword
searches. If you search for ”desk executive mahogany”, you get any
item whose description includes all three words. In this case you could
widen the search by removing "mahogany” and/or ”desk.” The words
in the description do not have to occur in the order listed, so searches
on "desk executive” and “executive desk” would get the same result:
all items whose description included both of the words.

The Deliver To Organization and Location (when invoked from the
menu or a requisition) are the Ship To Organization and Location when
the window is invoked from a purchase order. Lists of values display
deliver—to or ship—to values, as appropriate. For query purposes, the
deliver—to actually uses the associated ship-to information.

Supplier Item Catalog Window

5-8

There are four tabbed regions in the upper screen of this folder
window, but Function Security can be used to determine whether a
user will be able to see all of them. A profile option (PO: Default
Supplier Item Catalog Option) determines which of these tabbed
regions is the default when the catalog opens from the menu and for
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Using the Order Pad

the first time in a user session that the catalog opens from a requisition
or purchase order. If you close the catalog and reopen it from a
purchase order or requisition during the same session, the default
source region is the last one previously open. The regions are:

Negotiated Long term agreements with a supplier that support

Sources repetitive buys: Blanket purchase agreements,
quotations, and planned purchase orders. This
tabbed region is a folder.

Prior Purchases Actual past buys: Standard purchase orders,
scheduled releases, blanket releases. This tabbed
region is a folder.

Sourcing Rules Sourcing rules. There are + and - iconic buttons
just below the region box. Select the + icon or
Expand Sourcing Rules on the Tools menu to
display source documents for the rule in a folder
region. Use the —icon or Collapse Sourcing Rules
on the Tools menu to collapse the region displaying
the documents. You must be in the documents
region to add to the Order Pad or to select a price.

Requisition Requisition Templates. The PO: Legal Requisition

Templates Type profile option governs whether templates for
supplier and internally sourced lines are displayed.
This tabbed region is a folder.

Open the Supplier Item Catalog window by choosing Catalog in the
Requisitions window to view and use the Order Pad. (The Order Pad
is not available when you open the Supplier Item Catalog from the
Purchase Orders window.) Use the Add (down arrow) button, select
Add to Order Pad on the Tools menu, or double click to highlight the
selected line in a source region and add it to the Order Pad. Validation
takes place at this point, and if there is a problem, Purchasing displays
a message window with an explanation. Depending on the problem,
you may or may not be permitted to add the line. Also, if Disposition
messages are enabled for the Purchasing Inventory organization, they
are displayed as lines and added to the Order Pad.

When you add to the Order Pad, you must specify the following
information. Defaults for this information are defined in the Order Pad
Options window.

¢ Deliver-To organization (if you opened the catalog from the
menu or a requisition)
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Order Pad Options

e Ship-To organization (if you opened the catalog from a purchase
order)

e Deliver-To location (if you opened the catalog from the menu or
a requisition)

e Ship-To location (if you opened the catalog from a purchase
order)

o Destination Type (Expense or Inventory)
e Subinventory (if the Destination Type is Inventory)

o Need-By date (if the item is planned in the destination
organization)

e Quantity. The quantity must be greater than zero. It defaults to
1 or the quantity on the requisition/purchase order line if a
quantity was specified and if the first record was added to the
Order Pad.

If you are adding to the Order Pad from Negotiated Sources or
Sourcing Rules and enter a quantity less than an existing price

break quantity, Purchasing opens a Decision window and asks
whether you want to increase the order quantity to reduce the

unit price.

Use the Remove (eraser) button, Remove from Order Pad on the Tools
menu, or Clear Record to remove selected lines from the Order Pad.
When you remove a line from the Order Pad, Purchasing returns it to
the source region and unhighlights the line. To support return a line to
its source tabbed region, Purchasing does not permit Clear Record in
the source tabbed regions or Clear Block in the Order Pad.

You enter Order Pad defaults and options in the Order Pad Options
window. Navigate to the Order Pad Options window by opening the
Supplier Item Catalog from a requisition and choosing the Options
button while you are on the Order Pad. (Note: The Order Pad is not
available when you open the Supplier Item Catalog from the Purchase
Orders window.) The Order Pad Options window includes the Copy
Option tabbed region, where you can specify the Supplier, Supplier
Site, Supplier Contact, FOB, Carrier, Payment Terms, and Freight Terms
to be copied to the purchase order header.
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Order Pad Total

For each line on the Order Pad, Purchasing displays the extended price
in that line’s currency. To see the total Order Pad amount in your
functional currency, open the Order Pad Total window by selecting the
Order Total button.

Select Price Only Option

As a mutually exclusive alternative to the Order Pad, there is a Select
Price Only check box at the top right of the screen when you have
opened the Supplier Item Catalog from a requisition or a purchase
order. If the requisition or purchase order line is saved, when you open
the Catalog, you must use Select Price Only. This check box can be
enabled only if nothing has been added to the Order Pad. If this check
box is selected, the Add (down arrow), Order Total, and Options
buttons are disabled and the Select button is enabled. You can then
select prices for inclusion on a requisition or purchase order.

See Also

Profile Options in Purchasing: page 1 - 103

Customizing the Presentation of Data in a Folder, Oracle Applications
User’s Guide

Finding Supplier Items: page 5 - 11
Using the Supplier Item Catalog tabbed regions: page 5 — 15
Entering Order Pad Options (from Requisitions): page 5 - 19

Finding Supplier Items

Use the Search Supplier Item Catalog window to enter search criteria
for supplier items.

Depending on the function security assigned to your responsibility, you
have varying levels of access to information. A responsibility defines
an application user’s current privileges while working with Oracle
Applications. See: Function Security for Purchasing: page 1 - 112.

If you enter an item with Purchasing Enabled =N’ and with Internal
Orders Enabled ="Y’, the item is valid for an internal order, but you
cannot search for this item in the Supplier Item Catalog. If you want to
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be able to search the Supplier Item Catalog, the item must have
Purchasing Enabled ="Y".

To enter search criteria:

1

Navigate to the Search Supplier Item Catalog window by selecting
Suppler Item Catalog from the menu. Also, the Search Supplier
Item Catalog window is displayed when you select the Catalog
button in the Requisitions and Purchase Orders windows.

¢ 7] M

Supplier

B Sourced Suppli Inly Supplier ltem

_
G

Enter optional search criteria as described in the following steps:

Enter the Commodity. This is used to locate matching stored
categories on Purchasing document lines.

Enter the Requisition Template. This is enabled only if the window
is accessed from the menu or from the Requisitions window.

Enter the Category Set. This is used to find predefined items
associated with a specific category set. If you access this window
from the Requisitions or Purchase Orders windows, the default is
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10.

11.

12.

13.

the Purchasing category set. If you enter a category set, you can
also further restrict the search by entering a Category.

Enter the Item number. If you access this window from the
Requisitions or Purchase Orders window, the default is the item on
the originating document line. If you enter an item, you can also
further restrict the search by entering an item Revision number.

Enter the item Description. If you access this window from the
Requisitions or Purchase Orders window, the default is the
description on the originating document line.

Enter key words separated by spaces in the Item description
contains the words: field to find item descriptions containing all the
specified words. The search is not case sensitive, nor does it
consider the sequence of the words.

Enter the Supplier. If you access this window from the
Requisitions or Purchase Orders window, the default is the
supplier on the originating document line. If you enter a supplier,
you can enter a supplier Site.

Enter the Supplier Item number. If you access this window from
the Requisitions or Purchase Orders window, the default is the
supplier item number on the originating document line.

Select Approved Suppliers Only to get only records where the
supplier and the item exist in a current sourcing rule and
Approved Supplier List entry.

Enter the Due Date to get documents that are current as of this date
or future effective. If you access this window from the Requisitions
or Purchase Orders window, the default is the due date on the
originating document line.

Enter the Line Type. If you access this window from the
Requisitions or Purchase Orders window, the default is the line
type on the originating document line.

Enter the UOM. If you access this window from the Requisitions
or Purchase Orders window, the default is the UOM on the
originating document line.

Attention: Since catalog quotations in the Negotiated Sources and
Sourcing Rules tabbed regions can have different units of measure

on the line and the price break, Purchasing performs the following

test on the UOM you enter in this field:

If a UOM exists on the shipment, Purchasing returns rows where
this matches the search value. If no UOM exists on the shipment,
Purchasing returns rows where the line UOM matches the search
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5-14

value. We do this because if you add to the Order Pad from a row
with a different UOM on the price break, this is the UOM we copy
to the Order Pad.

14. Enter the Organization. If you access this window from the menu
or the Requisitions window, the field title is Deliver-To
Organization. If you access this window from the Purchase Orders
window, the field title is Ship—To Organization. The defaults are
from the originating document line, deliver—to from the requisition
and ship-to from the purchase order.

15. Enter the Location. If you access this window from the menu or
the Requisitions window, the field title is Deliver-To Location. If
you access this window from the Purchase Orders window, the
field title is Ship—To Location. The query is based on the ship-to
location associated with the deliver—to location. The defaults are
from the originating document line, deliver-to location from the
requisition and ship-to location from the purchase order.

16. Enter the Currency. If you access this window from the Purchase
Orders window, the default is the currency from the purchase
order line.

» Toclear existing search criteria:

m  Select the Clear button to clear any existing search criteria.

» Toinitiate the search:

m  Select the Find button to initiate the search and open the Supplier
Item Catalog window.

p To close the Search Supplier Item Catalog window:

m  Select the Close Catalog button to close the Search Supplier Item
Catalog window. This button is available only when you have
accessed this window from the Requisitions or Purchase Orders
windows; when you close the catalog window, you return to your
originating document window.

Note that you must select either Find or Close Catalog before you
can return to the originating document. While the Search Supplier
Item Catalog window is open, you cannot:

e Exit to the menu
¢ Navigate to the originating document

e Save your work
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See Also

Overview of the Supplier Item Catalog: page 5 -8

Defining Categories, Oracle Inventory User’s Guide

Defining Category Sets, Oracle Inventory User’s Guide

Defining Items, Oracle Inventory User’s Guide

About Suppliers, Oracle Public Sector Payables User’s Guide

Using the Calendar to Enter Dates, Oracle Applications User’s Guide
Defining Line Types: page 1 — 84

Defining Units of Measure, Oracle Inventory User’s Guide

Representing Internal and External Organizations, Oracle Human
Resources User’s Guide.

Site Locations, Oracle Human Resource Management Systems User’s Guide

Defining Currencies, Oracle Public Sector General Ledger User’s Guide

Using the Supplier Item Catalog Tabbed Regions

Use the Supplier Item Catalog window to:

e Review results of your search in the tabbed regions of the Search
Supplier Item Catalog window.

o Select prices from the tabbed regions for placement onto
requisition and purchase order lines.

e Place source lines from the tabbed regions onto the Order Pad,
where you can modify them before placing them onto requisition
and purchase order lines or onto new requisitions.

The Supplier Item Catalog window has four tabbed regions
(Negotiated Sources, Prior Purchases, Sourcing Rules, and Requisition
Templates), but Function Security controls which are present. A profile
option (PO: Default Supplier Item Catalog Option) determines which
of these tabbed regions is the default, but this applies only to regions
permitted by Function Security.
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Close Catalog

The query based on your search criteria is executed in the currently
displayed alternative results region in the Supplier Item Catalog
window. As you change tabbed regions, a query is executed in each
tabbed region using the original search criteria. Search criteria are
considered only in tabbed regions in which they are relevant.

For example, if your original search criteria consisted of a requisition
template and a key word, the query in the Negotiated Sources tabbed
region would ignore the requisition template.

p Toreview the tabbed regions:

®  Navigate to the Supplier Item Catalog window by selecting the
Find button in the Search Suppler Item Catalog window. You can
also navigate to the Search Supplier Item Catalog window by
selecting the Catalog button in the Requisitions and Purchase
Orders windows.

The Negotiated Sources tabbed region is a folder. As installed, it
displays the Supplier, Item, Commodity, item Description, Supplier
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Item number, Line UOM, Line Price, Break Quantity, and Break
Price.

The Prior Purchases tabbed region is a folder. As installed, it
displays the Order Date, Supplier, Item number, Commodity, item
Description, UOM, Price, Supplier Item number, and Quantity.

The Sourcing Rules tabbed region displays the Item number, Rank,
Supplier, Rule number, and the rule Effective date range. You can
expand and collapse sourcing rule lines either by selecting the +
and - icons or from options on the Tools menu. When you expand
a sourcing rule line, Purchasing opens a folder window that, as
installed, displays the Rank, Commodity, Supplier Item, Line
UOM, Line Price, Break Quantity, and Break Price for documents
referencing the rule.

The Requisition Templates tabbed region is a folder. As installed, it
displays the Supplier, Item number, Commodity, UOM, Price,
Source Type, Supplier Item number, Template name, Template
Description, and Buyer.

p To select prices from the tabbed regions:

1.

Select the Select Price Only check box, if you opened the Supplier
Item Catalog from a requisition (the target document.). If you
opened the Supplier Item Catalog from a purchase order, the Select
Price Only check box is already selected, and you cannot deselect
it. You cannot use the Order Pad if you have checked Select Price
Only. You cannot use the Order Pad if you opened it from a
Purchase Order window.

Move the cursor to the desired line in one of the tabbed regions.

Select the Select button to copy the price of the current line to your
target document.

p To use the Order Pad:

1.

Open the Supplier Item Catalog by choosing the Catalog button on
a requisition or purchase order. You can access the Order Pad only
when you open the Supplier Item Catalog from a requisition or
purchase order.

Select the Down Arrow to place the current line in the open tabbed
region onto the Order Pad. The cursor moves to the Order Pad,
where you can select the Eraser icon to return the current line to its
original tabbed region.
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See Also

3. You can enter or edit the following fields for an Order Pad line:
Quantity, Price, Need-By date, Organization, Location, Destination
Type, and Subinventory.

4. Select the Select button to add the order pad lines to the requisition
or purchase order from which you accessed the catalog. This also
closes the Supplier Item Catalog window.

To enter order pad options and defaults:

m  Select the Options button to open the Order Pad Options window.
See: Entering Order Pad Options (from Requisitions): page 5 - 19.

To view the current order pad total:

m  Select the Order Total button to open the Order Pad Total window.
This window displays the Functional Currency and the current
total amount on the order pad.

To close the Supplier Item Catalog window:

m  Select the Close Catalog button to close the Supplier Item Catalog
windows. This button is available only when you have accessed
this window from the Requisitions or Purchase Orders windows;
when you close the Search Supplier Item Catalog and the Supplier
Item Catalog windows, you return to your originating document
window.

Note that you must either Select information to copy back or Close
Catalog before you can return to the originating document. While
the Supplier Item Catalog window is open, you cannot:

Exit to the menu

Navigate to the originating document

Clear the window

Save your work

Overview of the Supplier Item Catalog: page 5-8
Using the Search Supplier Item Catalog Window: page 5 - 11
Entering Requisition Lines: page 3 - 60

Site Locations, Oracle Human Resource Management Systems User’s Guide
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Customizing the Presentation of Data in a Folder, Oracle Applications
User’s Guide

Entering Order Pad Options (from Requisitions)

Use the Order Pad Options window to enter order pad defaults and
options. You access this version of the window when you have opened
the Supplier Item Catalog from a requisition.

p To enter order pad defaults and options:

1. Navigate to the Order Pad Options window by selecting the
Options button in the Supplier Item Catalog window.
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Select the default option:

Default From Previous Line — Defaults for Order Pad lines are from
the previous line on the Order Pad. (The first line on the Order Pad
uses defaults from this window.)
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Default From Options — Defaults for Order Pad records come from
this window.

Enter the default Need-By date.

Enter the default Destination Type: Expense or Inventory.
Enter the default Organization.

Enter the default Location.

Enter the default Requestor.

© N o g &~ »

For the Destination Type of Inventory, enter the default
Subinventory.

9. Enter the default Expense Charge Account.

» To apply the defaults:

m  Select the OK button to apply the defaults and return to the
Supplier Item Catalog window.

See Also

Overview of the Supplier Item Catalog: page 5 -8

Site Locations, Oracle Human Resource Management Systems User’s Guide
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Receiving Price/Sales Catalog Information Electronically

5-22

Your supplier can send you the latest price/sales catalog information
and responses to requests for quotation through the Purchasing
Documents Open Interface. The Purchasing Documents Open Interface
processes catalog data in the Oracle Applications interface tables to
ensure that it is valid before importing it into Purchasing. One way to
import catalog data into the Purchasing Documents Open Interface,
and finally into Purchasing, is through Electronic Data Interchange
(EDI). EDI programs import the catalog information into Purchasing
directly as blanket purchase agreement lines or catalog quotations,
whichever you choose. You can also choose to have the programs
automatically populate the item master and/or apply sourcing rules to
the imported item information. If you import price/sales catalog
information as blanket purchase agreement lines, you can also specify
release generation methods. You can import new documents, replace
existing documents entirely, or update existing documents.

The catalog information is sent by the supplier in the form of a "’flat
file.” Your supplier can send you flat files with any of three kinds of
action codes: Original, Replace, or Update. An Original file is one in
which all the catalog information is new to your system. A Replace file
replaces already—created blanket purchase agreement lines or catalog
guotations with new documents containing new price/sales catalog
information. (The Purchasing Documents Open Interface program
replaces the old documents by invalidating their effectivity dates; then
it creates new documents with the new price/sales catalog information
and the old effectivity dates.) An Update file updates existing blanket
purchase agreement and catalog quotation lines without replacing the
documents entirely. It updates the unit Price, item Description, unit of
measure (UOM), Price Breaks, Expiration Date, and the supplier URL
descriptive flexfield if you use one.

Note: An Update submission does not update the UOM on an
agreement line for which an open release exists. Instead, it
uses the Expiration Date field to expire the line on the
agreement, and creates a new line with the updated UOM,
which will be used on future releases.

The Purchasing Documents Open Interface also imports price breaks.
In an updated price/sales catalog, if the supplier updates an item’s
price, the Purchasing Documents Open Interface deletes the item’s
price breaks since they are no longer current with the new price. If the
supplier sends new price breaks for an existing line, the current price
breaks are deleted and the new price breaks sent by the supplier are
created.
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How Sourcing Works

The Purchasing Documents Open Interface supports the Oracle
e—Commerce Gateway transmissions of the price/sales catalogs (ANSI
X12 832 or EDIFACT PRICAT) and responses to RFQs (ANSI X12 843
or EDIFACT QUOTES).

For e-Commerce Gateway to distinguish between Original, Replace,
and Update action codes, you need to set up code—conversion
categories and values in e-Commerce Gateway. See: Defining Code
Conversion Categories, Oracle e-Commerce Gateway User’s Guide. See:
Defining Code Conversion Values, Oracle e-Commerce Gateway User’s
Guide.

Other setup includes making sure that default category sets are set up
appropriately for both Purchasing and Inventory, setting Purchasing
profile options, and allowing updating of the item master if you want
to update the item description in the item master as well as on the
blanket purchase agreement or quotation. For complete instructions on
setup requirements, see the Oracle Manufacturing, Distribution, Sales and
Service Open Interfaces Manual.

When you import price/sales catalog information into Purchasing, you
have the option of choosing Yes or No in the Create Sourcing Rules
field in the Parameters window to enable Purchasing to create sourcing
rules out of the supplier, item, and document information that the
supplier sends.

Original and Replacement Price/Sales Catalogs

In an original or replacement price/sales catalog, if you choose to
create sourcing rules, Purchasing checks if a sourcing rule is assigned to
the item at the item level and does the following:

¢ If no sourcing rules exist for the item, Purchasing generates a
sourcing rule automatically, allocating 100 percent to the supplier
importing the information.

¢ If a sourcing rule exists for the item, Purchasing compares the
effectivity dates of the incoming document with those of the
existing sourcing rule for the item. To ensure that only one
sourcing rule is used for the item, Purchasing does the following:

— If the effectivity dates of the incoming document are the
same as the existing sourcing rule’s effectivity dates,
Purchasing checks to see if the supplier is in the sourcing
rule. If not, Purchasing adds the supplier to the existing
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sourcing rule with an allocation of 0 percent. Later, you can
query the sourcing rule and define your own percentage
splits between suppliers.

— If the effectivity dates of the incoming document are
different than the existing sourcing rule’s effectivity dates,
but are within or overlap the existing effectivity dates, then
a new sourcing rule is not created, so as not to conflict with
the existing sourcing rule.

— If the effectivity dates of the incoming document do not
overlap the existing sourcing rule’s effectivity dates,
Purchasing updates the item’s sourcing rule with the new
effectivity dates, adding the supplier at an allocation of 100
percent.

e Purchasing checks for an Approved Supplier List entry for the
item and supplier/site combination. If an entry exists,
Purchasing adds the document to the entry. If an entry does not
exist, Purchasing creates a new entry with the new source
document.

Updated Price/Sales Catalogs

In an Update submission, if the supplier sends you a new line with new
sourcing information, the new sourcing information is added to the
document. If the supplier expires a line, the sourcing information on
the expired line is not deleted, since that sourcing rule may be in use
elsewhere. If the supplier sends new sourcing information for an
already existing line, that sourcing information is ignored; Purchasing
does not allow existing sourcing rules to be updated, nor does it create
new sourcing rules for already existing lines, unless the line is expired.

Running the EDI Price/Sales Catalog Inbound Program, Oracle
e—Commerce Gateway User’s Guide

Running the EDI Response to Request for Quote Inbound Program,
Oracle e-Commerce Gateway User’s Guide

Purchasing Documents Open Interface: page 9 — 108
Setting a Price Tolerance in a Price/Sales Catalog Update: page 5 - 25

Oracle Manufacturing, Distribution, Sales and Service Open Interfaces
Manual
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Setting a Price Tolerance in a Price/Sales Catalog Update

You can set a price update tolerance that specifies the maximum
percentage increase allowed to an item’s price when your supplier
sends updated price/sales catalog information through the Purchasing
Documents Open Interface. This price update tolerance affects only
those documents imported through the Purchasing Documents Open
Interface. If the tolerance is exceeded, you receive a notification for
each affected document and can accept or reject the price increase
through the Exceeded Price Tolerances window. You can also access
this window through the notification.

Purchasing performs the price update tolerance check against the price
on the current revision of the document. The price tolerance check is
performed only on updated price/sales catalogs and only on line price
increases (not price breaks).

To set the price tolerance:

m  Define a price update tolerance at any of the following levels;
Purchasing uses the first tolerance it finds, in this order: on the
agreement in the Terms and Conditions window, at the
item-supplier level in the Supplier—Item Attributes window, at the
commodity-supplier level in the Supplier-Item Attributes window,
and at the system level in the PO: Price Tolerance (%) for Catalog
Updates profile option.

Example  If you set the Price Update Tolerance to 20 at the item—-supplier

See Also

level in the Supplier-Item Attributes window (and you haven’t set
the price tolerance on the agreement), a price increase of more than
20 percent for that item and supplier will send the buyer a
notification. If you set the Price Update Tolerance to 20 on the
agreement, a price increase of more than 20 percent on that
document will issue a notification.

A price tolerance of 0 means you are alerted of every price increase.
No tolerance means that you are not alerted of any price increase.

Receiving Price/Sales Catalog Information Electronically: page 5 — 22

Monitoring Price Increases in a Price/Sales Catalog Update: page 5 — 26
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Monitoring Price Increases in a Price/Sales Catalog Update

Use the Exceeded Price Tolerances window to accept or reject price
increases to blanket purchase agreements and catalog quotations sent
by your supplier through the Purchasing Documents Open Interface.

This window displays price increases only to those documents received
through the Purchasing Documents Open Interface and only if you
define a Price Update Tolerance at one of four levels. See: Setting a
Price Tolerance in a Price/Sales Catalog Update: page 5 — 25.

Purchasing performs the price update tolerance check against the price
on the current revision of the document. The price tolerance check is
performed only on updated price/sales catalogs and only on line price
increases (not price breaks).

p To accept or reject price increases:
1. Navigate to the Exceeded Price Tolerances window.

This window is available in the Purchasing menu. You can also
navigate to this window from the notification. The price increase
notification is titled Price tolerance exceeded during BLANKET update
or Price tolerance exceeded during QUOTATION update. Select the
notification, and then choose the document icon to open the
Exceeded Price Tolerances window.

You receive a notification for each affected document.
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EE Exceeded Price Tolerances
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Description Current Price || Mew Price

Accept All Eeject All Price Breaks

The updated document’s header information is displayed at the
top of the Exceeded Price Tolerances window. Its lines whose price
updates exceeded the price tolerance are displayed below. You
cannot change the price here, but simply accept or reject it.

Document Status: Approval Status of Approved or Incomplete
entered in the Parameters window when importing the price/sales
catalog, for your reference. You cannot change this field.

Rev — Item revision number.

Current Price: The current price of the item in Purchasing, on the
blanket purchase agreement or quotation.

New Price: The updated price in the price/sales catalog
submission. This price has exceeded your price tolerance.
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Increase (%): Percentage by which the price of the item was
exceeded over the price on the current blanket purchase agreement
or quotation in Purchasing.

Tolerance (%): The price tolerance that is set in Purchasing for this
item.

Price Increase: The difference between the current price on the
blanket purchase agreement or quotation in Purchasing and the
updated price in the price/sales catalog submission.

2. Choose Price Breaks to view price break changes, if any.

The Price Breaks window is a view-only window.

B Price Breaks g

Current Price Breaks New Price Breaks

(TET Y Break FPrice Discoun ~ Quantity Break Price Discour

]

|

l '
| |

3. Inthe Action column of the Exceeded Price Tolerances window,
choose Accept or Reject to accept or reject each price update. Or
choose Accept All or Reject All to accept or reject all price updates.

Accept: The price update to the document line is accepted.

Reject: The price is not updated on the document. Any other
changes to the line—to the item Description, UOM, Expiration
Date, or URL descriptive flexfield—have already been made. Only
the price update is not made. If you’ve customized the price/sales
catalog workflow, you can enable the Reject action to send the
supplier a notification that the price update for this item has been
rejected. See: Price/Sales Catalog Notification Workflow: page
C-262.

Note: The revision of the document is not updated until you
accept all line updates (if the profile option PO: Archive Catalog
on Approval is set to Yes).
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Attention: Depending on how the function security is set for

IS5y your user responsibility, you may not have access to the Action
field. (With function security, a system administrator can limit
people’s access to this function to view-only.)

4. Save your work.

See Also

Receiving Price/Sales Catalog Information Electronically: page 5 — 22

Oracle Manufacturing, Distribution, Sales and Service Open Interfaces
Manual
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Overview of Automatic Sourcing

5-30

Purchasing lets you automatically source online requisitions with
blanket purchase agreements or quotations you create. You can easily
assign any item with an item number to a specific blanket purchase
agreement or quotation. Purchasing automatically assigns the name of
the supplier for the blanket purchase agreement and quotation to any
requisition for this item.

To achieve automatic sourcing, use the Sourcing Rule and Sourcing
Rule/Bill of Distribution Assignments windows to create sourcing
rules. Optionally use the Approved Supplier List and Supplier-Item
Attributes windows to specify source document information for a
particular item, supplier, and site.

Defaulting Sourcing Information

For requisitions, if you define a blanket purchase agreement or
guotation as the source document for your item, and define and assign
sourcing rules, Purchasing provides the following sourcing information
for your requisition line: Buyer, Supplier, Site, Contact, Phone,
Supplier Item Number, Document Type (Blanket or Quotation) Source
Document, Source Line Number, and RFQ Required (Yes or No). Once
you save the requisition line, Purchasing also defaults the price from
the source document. You can later review the sourcing information in
the AutoCreate Documents window before placing the requisition line
onto a purchase order.

For standard purchase orders, if you define a quotation as the source
document for the item, and define and assign sourcing rules,
Purchasing provides the following sourcing information for the
purchase order line; Contract, Quotation, quotation Line, Quotation
Type, and Supplier Quotation number. Purchasing also defaults the
price from the source document.

A requisition with a quotation as a source document becomes a
standard purchase order. A requisition with a blanket purchase
agreement as a source document becomes a release.

Purchasing defaults sourcing information from the blanket purchase
agreement or quotation except under the following conditions:

e The document is not approved.

e The blanket purchase agreement is frozen or cancelled, or the
purchase agreement line is cancelled.

o The document is not active.
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¢ You have copied sourcing information back to the requisition
from the Supplier Item Catalog.

Sourcing by Item or Item Category

In the Approved Supplier List and Sourcing Rule windows, you source
at an item or commodity level. That is, you provide sourcing
information for a particular item at the item level, or for a category of
items at the commodity level.

For both one-time and inventory items, if no sourcing rule is provided
at the item level in the Sourcing Rule/Bill of Distribution Assignments
window, Purchasing automatically defaults the supplier or supplier site
from the category-level sourcing rule if there is one.

The same is true of supplier statuses. If you debar a supplier for a
specific commodity (category) in an Approved Supplier List entry, the
supplier is prevented from supplying all items within that commodity.
(Note: If you approve a supplier for a commaodity, the item-specific
status for the supplier still takes precedence.)

Sourcing Globally or Locally

In the Approved Supplier List and Sourcing Rule windows, you also
choose whether to exercise the sourcing information at a global or local
level. A sourcing rule assigned at the global level in the Sourcing Rule
/ Bill of Distribution Assignments window is valid for all operating
units. A global ASL entry in the Approved Supplier List window is
valid for all inventory organizations in an operating unit. A local
sourcing rule or ASL entry is valid only for the organization that you
were in or that you chose when creating the sourcing rule or ASL entry.

Local entries take precedence over global ones. For example, if you
have a global sourcing rule that says to use Supplier A for an item for
all organizations in your agency, and a local sourcing rule for the same
item that says to use the local Supplier Z only for your organization,
Purchasing defaults Supplier Z on requisitions or purchase orders
created in your organization. Local entries are the default in the
Approved Supplier List window.

Defining Allocation Percentages

When creating sourcing rules in the Sourcing Rule window, you must
define allocation percentages. Master Scheduling/MRP uses these
allocation percentages when creating planned orders, which Purchasing
imports as requisitions through Requisition Import. In a group of
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requisitions imported from Master Scheduling/MRP, the requisitions
show the percentage allocation you define. In other words, at the end
of a planning period, a group of orders to those suppliers
approximately equals the percentage split you defined. However,
when you create an individual requisition in Purchasing, Purchasing
sources to the supplier with the highest allocated percentage. The
Approved Supplier List (ASL) entry for that supplier is then referenced
in order to pick up source document information (from a blanket
purchase agreement or quotation), if source documents exist. If a
percentage allocation is the same for some suppliers, and you have
ranked the suppliers in the Sourcing Rule window, Purchasing sources
to the one with the highest rank.

Specifying Planning Constraints

The Supplier-Item Attributes window lets you optionally specify the
capacity of individual supplier sites to supply specific items. Supply
Chain Planning allocates planned orders taking these capacity
constraints into account. For example, you define and assign a
sourcing rule that says an item can come from either of two suppliers
this year. In the sourcing rule, you also rank the suppliers so that
Planning prefers Supplier 1 over Supplier 2. However, if the capacity
of Supplier 1 in the Planning Constraints tabbed region of the
Supplier-Item Attributes window includes a four—day lead time, but
there is a need-by date of one day, Supply Chain Planning
automatically defaults Supplier 2 onto planned orders if Supplier 2 has
a lead time of less than one day. (If no suppliers can meet your
demand, Supply Chain Planning uses the top-ranked supplier.)

In addition to lead time, you can define receiving schedules, minimum
order quantities and fixed lot multiples, capacity per day, and tolerance
fences. See: Defining the Supplier/Item Attributes: page 5 — 51.

These planning constraints apply to planned orders only.

See Also
Setting Up Automatic Sourcing: page 5 - 32
1

Setting Up Automatic Sourcing

Use the Sourcing Rules windows to default a supplier and optionally a
supplier site on your requisition or purchase order line. Use the

5-32 Oracle Public Sector Purchasing User’s Guide



Approved Supplier List if you also want to default source document
information from a blanket purchase agreement or quotation on your
requisition or purchase order line for an item-supplier combination.

By defining and assigning sourcing rules, Purchasing actively defaults
the appropriate supplier onto your document as soon as you enter an
item or commodity.

To default the supplier, site, and source document information:

1. Set the profile option PO: Automatic Document Sourcing.

Setting this profile option to Yes means that Purchasing
automatically searches for the most current blanket purchase
agreement or quotation for an item-supplier combination, and
defaults the information from this document onto a newly created
document line. This method is useful if you do not want to
maintain the most current source documents in the Approved
Supplier List, particularly if you receive these documents regularly
from your suppliers through the Purchasing Documents Open
Interface. If you set this profile option to Yes, you do not have to
specify source documents in the Approved Supplier List.

Note that if an item on a requisition is associated with both a
blanket purchase agreement and a quotation, Purchasing uses the
blanket purchase agreement even if the quotation was created more
recently.

Setting this profile option to No means that Purchasing defaults
sourcing information onto a newly created requisition or purchase
order line only from those documents you have specified in the
Approved Supplier List. This method is useful if you prefer to
maintain and update the Approved Supplier List with documents
that you choose.

2. If you set the profile option in the previous step to No, create a
source document (a blanket purchase agreement or quotation) and
then tie the document to an Approved Supplier List entry.

See: Defining the Supplier and Commodity/Item Combination:
page 5 — 47. Then see: Defining the Supplier/Item Attributes: page
5-51.

If you set the profile option in the previous step to Yes, you do not
have to perform this step, although you can if you want to.
Purchasing still uses the source documents in the Approved
Supplier List if they are the most current, and uses documents
outside the Approved Supplier List if they are not.
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Note: When Use Approved Supplier is checked for an item in the
Master Items window, you cannot approve the source document
until the supplier is in the Approved Supplier List. Therefore, if
Use Approved Supplier is checked for an item, create the
Approved Supplier List entry and source document in the
following order:

— Create an Approved Supplier List entry (this is the
approved supplier you are enforcing for the item).

— Create and save a source document.

— Return to the Approved Supplier List window and tie the
source document to the supplier.

Define and assign sourcing rules as described in To default just the
supplier and the supplier site below.

p To default just the supplier and the supplier site:

1.

Make sure you have satisfied the prerequisites for defining and
assigning sourcing rules:

o Define items. See: Defining Items, Oracle Inventory User’s Guide.

o Create suppliers and supplier sites in the Suppliers window. See:
About Suppliers, Oracle Public Sector Payables User’s Guide.

o Set the profile options MRP: Sourcing Rule Category Set and
MRP: Default Sourcing Assignment Set. See: Purchasing Profile
Options: page 1 - 103.

Use the Sourcing Rule window to define sourcing rules. See:
Defining Sourcing Rules: page 5 — 36.

Note: Some of the fields in the Sourcing Rule window may
already be completed for you if your supplier sends you
catalog information electronically. See: Receiving Price/Sales
Catalog Information Electronically: page 5 - 22.

Use the Sourcing Rule/Bill of Distribution Assignments window to
assign your sourcing rules to particular items or organizations.
See: Assigning Sourcing Rules and Bills of Distribution: page 5 — 39.

Attention: When you enter an Assignment Set name in the

ISy Sourcing Rule/Bill of Distribution Assignments window, note

that Purchasing can use only one assignment set—the one that
is specified in the profile option MRP: Default Sourcing
Assignment Set. (Note that the User level for the profile option
takes precedence.)
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Troubleshooting

Although creating and assigning a sourcing rule in the Sourcing
Rule windows is all you need to do to default a supplier and
supplier site onto your documents, you can still also create
approved suppliers in the Approved Supplier List window. For
example, if you checked Use Approved Supplier in the Master
Items window when defining an item, you must define the supplier
in the Approved Supplier List window.

If you want to verify the sourcing rule, create a requisition for the
item to verify that the Supplier and Site default. If the sourcing rule
is local, make sure the Organization field on the requisition is the
organization in which the sourcing rule was created.

If you encounter any problems with automatic sourcing after you set it
up, the following solutions may help.

Purchasing is not using the sourcing rules defined in the Sourcing
Rule/Bill of Distribution window

Make sure that you have done both of the following:

e Assigned the sourcing rules to an assignment set in the Sourcing
Rule/Bill of Distribution Assignments window.

e Made sure that the Assignment Set name in this window
matches the assignment set name in the profile option MRP:
Default Sourcing Assignment Set.

Purchasing can use only one assignment set at a time, so if
Purchasing is not using your sourcing rules, they may belong to
another assignment set. For the MRP: Default Sourcing
Assignment Set profile option, choose the assignment set name to
which your sourcing rules are assigned in the Sourcing Rule/Bill
of Distribution Assignments window.

Also make sure that the profile option MRP: Default Sourcing
Assignment Set isn’t also set at the User level. The User value for profile
options takes precedence over System Administrator level values. If
you believe that Purchasing is not using the correct Assignment Set,
check if the profile option is also set at the User level.

Source document information is not defaulting onto my requisition
or purchase order

Assuming you have defined and assigned sourcing rules, the problem
could be one of the following:
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See Also

o Make sure you have followed the instructions in the following
two sections: Defining the Supplier and Commodity/Item
Combination: page 5 — 47 and Defining the Supplier/Item
Attributes: page 5 - 51. Make sure that, for the item, the supplier
and site in the Approved Supplier List matches the supplier and
site in the sourcing rule.

e The Approved Supplier List entry may be local. In the
Approved Supplier List window, choose the Record Details
tabbed region and note the Global field. If the Global field is set
to No, then the sourcing information specified for the item is
used only locally, by your organization or the organization that
originally created the Approved Supplier List entry, and other
organizations will not receive the source document information.
Likewise, if there are two Approved Supplier List entries for an
item, and one is local and the other is global, the local entry takes
precedence for your organization.

e Sometimes you may see just one, Global entry in the Approved
Supplier List window, but local versions of that entry are visible
only in the Supplier-Item Attributes window. Recall that a local
entry takes precedence over a global one and is used only by the
organization in which it was created. In the Approved Supplier
List window, choose the Attributes button. If local entries exist,
the Create Local button will be dimmed.

Setting Up and Implementing Sourcing Strategies, Oracle Master
Scheduling/MRP and Supply Chain Planning User’s Guide

Sourcing Rules and Bills of Distribution, Oracle Master Scheduling/MRP
and Supply Chain Planning User’s Guide

Overview of Automatic Sourcing: page 5 - 30

Defining Sourcing Rules

You can define sourcing rules that specify how to replenish items in an
organization, such as purchased items in plants. Sourcing rules can
also specify how to replenish all organizations, as when the entire
enterprise gets a subassembly from a particular organization.

If there is a conflict between a sourcing rule and a bill of distribution,
the sourcing rule takes precedence. For instance, if you assign a bill of
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distribution to AUS that tells it to source a part from NYC, AUS can
still define a sourcing rule to source the part from SAC. In this case,
the local sourcing rule overrides the bill of distribution.

p To define a sourcing rule:

1. Navigate to the Sourcing Rule window.

5 Sourcing Rule (V1)

MName Al Orgs FlPlanning Active
G Hard Drive Sourcing Rule [ !]] ® g - Copy From...

Effective Date

~ From Date
J|30:2PR/2000

Shipping Organization - T
pping g Allocation %

~ Type Supplier

2. Enter a unique sourcing rule name.

3. Indicate whether this sourcing rule is used for all organizations
(global) or a single organization (local).

If the sourcing rule is local, you must enter an organization hame;
otherwise, your current organization will be the receiving
organization.

4. Choose Copy From to copy the effectivity dates and shipping
organization from another sourcing rule into this one.
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5. Enter effectivity dates. You must enter a start date, but entering an
end date is optional.

6. For each range of effectivity dates, you can include multiple
shipping organizations. For each shipping organization you want
to include, select a sourcing type to specify whether you make, buy,
or internally transfer the item. You can also copy a list of shipping
organizations from an existing sourcing rule.

If you enter a customer organization as the receiving organization,
then you cannot select a supplier organization as the shipping
organization.

Note: Suppliers and supplier sites are predefined in Oracle Public
Sector Payables. (See: About Suppliers, Oracle Public Sector
Payables User’s Guide.)

7. Enter an allocation percentage for each shipping organization.
Allocation percentage includes the number of planned orders
issued to the part for the entire the planning horizon. Your total
allocation may not exceed 100.

If the allocation percentage for all the shipping organizations
included within a range of effectivity dates equals 100, Planning
Active is checked. If the sourcing rule is not planning active, the
planning process will not use the rule to assign planned orders.

Note: You cannot set the allocation percentage to less than or
greater than 100 for sourcing rules that are already assigned in
assignment sets.

8. Enter a numeric rank value to prioritize each sourcing type.

If you have two sources with the same allocation percentage,
planned orders are sourced from the highest rank first.

9. Select a shipping method, such as FEDEX, UPS, or rail. (See:
Defining Shipping Methods, Oracle Inventory User’s Guide.)

10. Save your work.

p To copy shipping organizations from an existing sourcing rule:

This feature allows you to include long, previously defined lists of
shipping organizations without manual entry.

1. Select a sourcing type to specify whether you make, buy, or
internally transfer the item.

2. Choose Copy Shipping Orgs From.
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3. Inthe Find window, select a sourcing rule that includes the
shipping organizations you want to duplicate in this new sourcing
rule.

4. Choose OK.

p To purge asourcing rule:
1. Select a sourcing rule name.

2. Choose Purge.

Assigning Sourcing Rules and Bills of Distribution

Once you have defined your sourcing rules and bills of distribution,
you must assign them to particular items and/or organizations. These
assignments are grouped together in assignment sets. This is where
your various sourcing strategies define a particular supply chain
network.

Each assignment set to represents selection of organizations and/or
items you want planned. To influence the planning process, you must
include an assignment set in your plan options.

In an assignment set you can assign your sourcing rules and bills of
distribution at different levels, as follows:

e an item across all organizations

¢ asingle item in an inventory organization

e all items in an inventory organization

e categories of items

e categories of items in an inventory organization
¢ all organizations

These levels allow you to assign a replenishment rule to as many or as
few items as possible. For example, a category of items could be
defined as packaging material, and a sourcing rule that identifies the
suppliers could be assigned.

p Toassign asourcing rule or bill of distribution:

1. Navigate to the Sourcing Rule/Bill of Distribution Assignments
window.
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2. Enter an assignment set name and description.

Note: The assignment set name specified in the profile option
MRP: Default Sourcing Assignment Set is the only one that
Purchasing uses. If you want this assignment set to be used by
Purchasing, update the profile option with this assignment set
name, or create an assignment set that matches the profile option.

3. Select an Assigned To type. See: Assignments Hierarchy, Oracle
Master Scheduling/MRP and Supply Chain Planning User’s Guide.

Note: You can assign a sourcing rule or bill of distribution to a
category only if the profile option MRP: Sourcing Rule Category Set
is set. See: Profile Options in Purchasing: page 1 — 103.

4. Enter an organization name, if the Assigned To type requires one.

Note: You cannot assign customers modelled as organizations to a
global sourcing rule.

5-40 Oracle Public Sector Purchasing User’s Guide



5. Enter an Item/Category if you selected Item or Item-Org as the
Assign To type.

6. Enter the sourcing rule or bill of distribution as the Type.
7. Enter the name of the sourcing rule or bill of distribution.

8. Save your work.

To purge a sourcing rule or bill of distribution:
1. Select an assignment set name.

2. Choose Purge.
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Approved Supplier List

All procurement organizations maintain lists that associate the items
and services they buy with the companies who supply them, either
formally or informally. Data stored in a controlled, global repository
containing relevant details about each ship—from/ship-to/item
relationship, is known as an Approved Supplier List (ASL). This
repository includes information about all suppliers with business
statuses including Approved, Debarred, or New.

Use the Approved Supplier List and Supplier-Item Attributes windows
to specify blanket purchase agreements or quotations as source
documents for a particular item and supplier or particular item
category (commodity) and supplier. Purchasing automatically defaults
this source document information, such as the Buyer, supplier Contact,
and Supplier Item Number, for the item or commodity onto the
requisition line. Standard purchase orders get source document
information from quotations. Requisitions get source document
information from blanket purchase agreements or quotations. See:
Defining the Supplier and Commodity/Item Combination: page 5 — 47.
See: Defining the Supplier/Item Attributes: page 5 — 51.

Note: Purchasing can also search for the most current source
documents for you, without your setting up the Approved Supplier
List, if you set the profile option PO: Automatic Document Sourcing to
Yes. See: Setting Up Automatic Sourcing: page 5 — 32.

See Also

Overview of the Approved Supplier List, Oracle Supplier Scheduling
User’s Guide

Supply Chain Planning, Oracle Master Scheduling/MRP and Supply Chain
Planning User’s Guide

Overview of Automatic Sourcing: page 5 - 30

ASL Repository Maintenance

Through maintenance of the Approved Supplier List repository the
following goals are realized:

e Supports Supplier Certification programs by providing a single
store of information regarding a supplier’s current status.
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ASL Public Sector Needs

Helps design engineers achieve higher quality designs at a lower
total cost through the re-use of preferred suppliers in new
designs. Avoids supply base proliferation or unnecessary design
dependence on difficult’ suppliers.

Eliminates redundant sourcing efforts within departments, and
across organizations. Facilitates a more global approach to
contract negotiation.

Provides immediate procurement visibility when a supplier is
assigned an unfavorable status. This 'early warning’ can help
prevent problem replication in multiple organizations.

Complies with external Quality System process requirements like
1SO 9001/9002.

Provides storage for general data attributes that are unique to
the supplier/item intersection.

Maintains lists of supplier ’candidates’ by commodity or item for
future consideration.

Using Oracle Public Sector Purchasing Approved Supplier List, you

e Set approval/certification status at the appropriate level for your

business. For example, approve a supplier for a given
commodity (e.g. 'Office Supplies’) for expense purchases while
approving a specific supplier/site for each production item.

e Approve suppliers (they perform their own manufacturing),

distributors (they represent manufacturers), and manufacturers
(they manufacture items marketed and sold by distributors).

Define global or local ASL entries. All organizations should be
able to specify their own attributes (information about the
supplier/item relationship) even if the supplier/item status is
defined as a global record. This enables individual
ship—to-organizations to determine, for example, whether they
are ready to perform supplier scheduling, their purchasing unit
of measure, their default item price, etc.

Link the primary supplier item number with your internal item
number. This designated item will default to Purchase Order
and Requisition lines.
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See Also

o Specify a Review By date indicating a proactive, planned review
of the business with a longstanding supplier partner.

e Review ASL information in a flexible inquiry format.

¢ Define your own approval statuses and associate them with
specific business rules.

e Control procurement activity by preventing purchase order
approval or supplier schedule confirmation for certain
supplier/item combinations.

e Control whether Sourcing Rules must be comprised of approved
suppliers.

o Define reference information, including planning constraints
such as lead time, for the supplier/item combination.

o Disable ASL entries. See: Defining the Supplier and
Item/Commodity Combination: page 5 — 47.

Setting Up Automatic Sourcing: page 5 - 32

Overview of Supplier Scheduling, Oracle Supplier Scheduling User’s
Guide

Sourcing Rules and Bills of Distributions, Oracle Master Scheduling/ MRP
and Supply Chain Planning User’s Guide

Bucket Patterns, Oracle Supplier Scheduling User’s Guide
Defining Supplier Lists: page 5 - 98

Defining Ship-to Organization Level Defaults and Controls, Oracle
Supplier Scheduling User’s Guide

Defining the Supplier/Item Attributes: page 5 - 51

Defining Approved Supplier Statuses: page 5 — 45

View Approved Suppliers: page 5 - 55

Defining the Supplier and Item/Commodity Combination: page 5 — 47
Defining Sourcing Rules: page 5 — 36

Defining Bills of Distributions, Oracle Master Scheduling/MRP and
Supply Chain Planning User’s Guide
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Defining Approved Su

pplier Statuses

You can create any number of Approved Supplier Statuses to describe
the condition of the Approved Supplier, ranging from fully Approved
(the supplier has demonstrated the ability to satisfy rigorous quality,
cost, and delivery requirements over a sustained period) to Debarred
(no business is allowed with this supplier for a particular item or
commodity), or New if you have never placed a purchase order with
the supplier.

Note: If you debar a supplier for a specific commodity
(category) in the Approved Supplier List, the supplier is
prevented from supplying all items within that commodity.
However, if you approve a supplier for a commodity, the
item-specific status for the supplier still takes precedence.

Each Approved Supplier Status can have business rules applied to
manage the characteristics of the status. You can prevent or allow
certain business rules for each status, change the name of a status, or
create a status of your own. For example, the default status of
Approved allows all the default business rules: PO Approval, Sourcing,
Schedule Confirmation, and Manufacturer Linking. But you could
change the Approved status to prevent one of the Business Rules.
Likewise, you can create your own status with your own combination
of Business Rules.

In the Status field in the Approved Supplier List window, Purchasing
lets you choose among these supplier statuses. Defining your own
supplier statuses in this window is optional.

To define Approved Supplier Statuses:
1. Navigate to the Approved Supplier List Statuses window.
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%Apprw&d Supplier List Statuses
Approved Supplier List Default

_ otatus Description Inactive On

| | Approved Approved for business

|i Debarred Future husiness disallowed

New Supplier

L Approved for business

Business Rules
~ Caontral Rule Description
PO Approval Purchase Order Approval

Sourcing Sourcing

Schedule Confirmation |Supplier Schedule Confirmation

Manufacturer Link Manufacturer Link to Distributor

2. Enter a unique Status name.
3. Enter a status Description to convey the meaning of the status.

4. Optionally check Approved Supplier List Default to set this status
as a default.

This is the status that appears as the default for suppliers you add
to the Approved Supplier List window. (You can change a
supplier’s status from within the Approved Supplier List window.)

Note: You can only have one Approved Supplier Status as a
default.

5. Optionally choose a date for Inactive On to set the time when the
status will no longer be active.

Existing Approved Supplier List entries still use the status you
inactivate today. New entries you create, however, will not.
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6. If you choose to apply Business rules to the Approved Supplier
Status, choose a Control. By choosing a Control, you either Allow
or Prevent the Business Rule.

7. Select a Business Rule.

e PO Approval — Enables you to allow or prevent purchase order
approvals sourced to this supplier.

e Sourcing — Enables you to allow or prevent sourcing to this
supplier.

¢ Schedule Confirmation — Enables you to allow or prevent
schedule confirmation for this supplier in Supplier Scheduling.

e Manufacturer Link — In the Approved Supplier List window, you
choose a Business from one of the following: Direct (Supplier),
Manufacturer, or Distributor. If you have a Distributor defined
in the Approved Supplier List window, this Business Rule
enables you to allow or prevent linking to the Manufacturer also
defined in the Approved Supplier List window.

8. Save your work.

See Also

Defining Planners Oracle Master Scheduling/MRP and Supply Chain
Planning User’s Guide

Defining the Supplier and Item/Commodity Combination

Prerequisites

U Define items. See: Defining Items, Oracle Inventory User’s Guide.

L Create suppliers and supplier sites in the Suppliers window. See:
About Suppliers, Oracle Public Sector Payables User’s Guide.

» To define the supplier and item/commodity combination:

1. Navigate to the Approved Supplier List window.
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2. Inthe Organizations window that appears, choose the ship-to
organization for which you want to define Approved Supplier List
(ASL) entries.

&= Approved Supplier List (v1)

Commuadity ltern

CM99927 High Power Drive

Suppliers

Key Attributes

Disabled
Business Supplier Site Status

_ | Supplier Item Manufacturer
B oirect Supplier A SUPPLIER A S |New r

Attributes

3. Choose one of the following options to which you want to assign a
supplier:

e Item — Assigns a supplier to a particular item.

e Commodity — Assigns a supplier to a group of items belonging
to a category (or commodity).

4. Select an Item or Commodity.
5. Choose a Business from the following:
o Direct (Supplier): Company sells their products directly to you

If you choose Direct, choose the supplier Name and optionally,
the Site.
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= Attention: The supplier Name and Site, if you specify one,

10.

must match the sourcing rule Supplier and Site to default the
supplier information or source document information
successfully. See: Defining Sourcing Rules: page 5 - 36.

e Manufacturer: Company manufactures and sells through
distributors

If you choose Manufacturer, choose the Manufacturer Name.
e Distributor: Company sells products made by manufacturers

If you choose Distributor, choose the distributor Name and
optionally, the Site. You must associate the Distributor with a
Manufacturer, meaning you must define a Manufacturer before
you define its Distributor.

Choose the supplier’s approval Status.

Use one of the default Statuses provided, or choose a status of your
own if you defined other statuses in the Approved Supplier List
Statuses window. See: Defining Approved Supplier Statuses: page
5-45.

If you debar a supplier for a specific commodity, the supplier is
prevented from supplying all items within that commodity.
However, if you approve a supplier for a commodity, the
item-specific status for the supplier still takes precedence.

Optionally choose the supplier item number.

For Suppliers and Distributors, this supplier item number defaults
to your purchase order and requisition lines, and is used to
validate the source documents.

Optionally choose a Review By date.

You can use this date to determine when a proactive business
review will be performed for the supplier.

Choose the Record Details tabbed region.
Choose one of the following in Global:

e Yes - This ASL entry is valid for all inventory organizations in
your operating unit.

e No - This ASL entry is local—that is, valid only for the
organization you chose in the Organizations window when you
first navigated to the Approved Supplier List window.

Note: If you have two ASL entries for the same item or
commodity—one Global entry that applies to all organizations in
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See Also

your agency and one local entry that applies only to your
organization—the local entry takes precedence.

11. Save your work.

12. Optionally specify additional information, such as Supplier
Scheduling, source documents, and capacity details for the ASL
entry.

See: Defining the Supplier/Item Attributes: page 5 - 51.

To disable an ASL entry that you no longer want to use:

1. Inthe Approved Supplier List window, identify the line (ASL
entry) you want to disable.

2. Inthe Key Attributes tabbed region, select the Disabled check box
for the line.

The item—supplier combination in this ASL entry is inactive for
new documents that you create. Note that disabling an ASL entry
is not the same as debarring a supplier. Debarring a supplier
prevents sourcing to that supplier for that item or for all items in
that commodity. Disabling an ASL entry disables just that line. You
will still be able to source to that supplier if a separate ASL entry
for the supplier is enabled.

If you disable a local ASL entry, Purchasing uses the Global entry
instead, if there is one.

To re—enable a supplier and item/commodity combination:
m  Deselect the Disabled check box.

The item—-supplier combination in this ASL entry is now active for
new documents you create.

Overview of Automatic Sourcing: page 5 - 30
Defining Sourcing Rules: page 5 — 36
Assigning Sourcing Rules and Bills of Distribution: page 5 — 39

Setting Up and Implementing Sourcing Strategies, Oracle Master
Scheduling/MRP and Supply Chain Planning User’s Guide

Defining the Supplier/Item Attributes: page 5-51
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Defining the Supplier/ltem Attributes

Use the Supplier-Item Attributes window to specify additional
information for the Approved Supplier List entry, including source
document, Supplier Scheduling, and planning constraint information.

p To define the supplier and commodity/item attributes:

1. Navigate to the Supplier-Item Attributes window by choosing the
Attributes button in the Approved Supplier List window.

Additional Information: The Create Local button creates a
copy of an existing global Approved Supplier List entry and
makes it local to your organization. The Create Local button is
not available if you are already creating a local entry or if a
local entry for the item (in this or the Approved Supplier List
window) already exists.

% Supplier-item Attributes (V1)

Create Local

LGl CM99927 Comrmodity _
=ETEES Supplier A =N SUPPLIER A S

Source Documents

— Effective

Ling Status Fram

2. Choose the Purchasing UOM.
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3. Choose the Release generation Method from the following options:
e Automatic Release/Review: automatically generate releases.

e Automatic Release: automatically generate approved releases
with a status of 'Incomplete.’

¢ Release Using AutoCreate: use the AutoCreate window to create
releases.

4. Enter a Price Update Tolerance only if you are importing
price/sales catalog information through the Purchasing Documents
Open Interface.

The Price Update Tolerance specifies the maximum percentage
increase allowed to a price for this item/supplier combination
when the supplier sends updated price/sales catalog information
through the Purchasing Documents Open Interface. This field
affects only those documents imported through the Purchasing
Documents Open Interface. See: Setting a Price Tolerance in a
Price/Sales Catalog Update: page 5 — 25.

5. Optionally choose the Country of Origin.

The Country of Origin is the country in which an item is
manufactured. You can choose a Country of Origin if you specified
a supplier Site in the Approved Supplier List window.

The Country of Origin is defaulted onto purchase orders for this
item/supplier combination. However, you can change or enter the
Country of Origin on the purchase order or later on the receipt.

6. Choose one of the following attribute groupings from the tabbed
region:

e Source Documents: lets you associate specific quotations or
blanket purchase agreements with the supplier/item
combination.

e Supplier Scheduling: lets you associate Supplier Scheduling
information with the supplier/item combination. You can
choose this option if you specified an item and a supplier site.

o Capacity Constraints: lets you specify capacity constraints for
the supplier/item combination. You can choose this option if
you specified an item and a supplier site.

» If you chose Source Documents:

Note: Setting the profile option PO: Automatic Document Sourcing to
Yes enables Purchasing to default source documents automatically if
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you prefer that rather than specifying source documents here. See:
Setting Up Automatic Sourcing: page 5 — 32.

1. Enter a unique Seq (Sequence) Number.

The Sequence Number is used internally. It does not affect the
order with which Purchasing uses the source documents. If you
enter more than one source document, Purchasing uses a blanket
purchase agreement over a quotation, even if the quotation was
created more recently. If there are only blanket purchase
agreements or only quotations, Purchasing uses the one that was
created most recently.

2. Select a Document Type from the following:
e Blanket
¢ Quotation

A requisition with a quotation as a source document becomes a
standard purchase order. A requisition with a blanket purchase
agreement as a source document becomes a release. Standard
purchase orders get source document information only from
quotations.

If you are creating a Blanket as a source document for Oracle
Supplier Scheduling, make sure the Supply Agreement option is
selected for the blanket purchase agreement in the Terms and
Conditions window. See: Entering Purchase Order Details
Information: page 4 — 61. Supplier Scheduling can communicate
releases against a blanket purchase agreement only when this
option is selected.

3. Choose a Document Number.

If Purchasing does not let you enter a particular document number,
it may be because the document is frozen, canceled, or not
approved, or the agreement line is canceled. A quotation must be
active.

4. Choose a Line Number.
The Status and Effective Dates, if any, are displayed.

5. Save your work.

If you chose Supplier Scheduling:

1. Optionally check Enable Planning Schedules and/or Enable
Shipping Schedules is you want to build Planning and/or Shipping
Schedules.
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If you check Enable Planning Schedules and/or Enable Shipping
Schedules, you can choose an assigned Scheduler.

Check Enable AutoSchedule if you want your schedule
automatically built.

If you check Enable Planning Schedules and Enable AutoSchedule,
you must choose the following:

¢ Plan Bucket Pattern
e Plan Schedule Type

If you check Enable Shipping Schedules and Enable AutoSchedule,
you must choose the following:

e Ship Bucket Pattern
e Ship Schedule Type

If you check Enable Planning Schedules and Enable Authorizations,
you can optionally choose up to four Resource Authorizations with
their associated timefences.

Save your work.

If you chose Planning Constraints:

The information you enter here is used by Supply Chain Planning for
planned orders. See: Overview of Supply Chain Planning Logic, Oracle
Master Scheduling/MRP and Supply Chain Planning User’s Guide.

1.

In the Processing Lead Time field, enter the number of lead days it
takes to receive this item after ordering it.

Choose a Delivery Calendar pattern to define the dates upon which
the supplier delivers to this organization.

This calendar is independent of your workday calendar.

Choose Order Modifier options to indicate ordering constraints, if
any:

Minimum Order quantity: The minimum quantity you can order.
Fixed Lot Multiple: The incremental quantity you can order on top
of the Minimum Order quantity. For example, if the Minimum
Order quantity is 100 and the Fixed Lot Multiple is 10, you must

order at least 100, and if you order more than that, you must order
110, 120, and so on.

Create one or more entries in the Capacity area to indicate what the
capacity is during a certain period or periods:
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See Also

From Date: The date from which the capacity constraints take
effect.

To Date: The date (optional) until which the capacity constraints
take effect.

Capacity per Day: Quantity of units per day. This field is required if
a From Date is entered.

5. Create one or more entries in the Tolerance Fences area to indicate
how the capacity fluctuates depending on how many days in
advance you order:

For example, if you enter 12 Days in Advance and a Tolerance % of
2, you can exceed the supplier’s capacity by 2 percent if you order

12 days in advance. You must specify a Tolerance % if you specify
Days in Advance.

AutoScheduling, Oracle Supplier Scheduling User’s Guide
Resource Authorizations, Oracle Supplier Scheduling User’s Guide
Defining Sourcing Rules: page 5 - 36

Assigning Sourcing Rules and Bills of Distribution: page 5 — 39

Setting Up and Implementing Sourcing Strategies, Oracle Master
Scheduling/MRP and Supply Chain Planning User’s Guide

Defining the Supplier and Commodity/Item Combination: page 5 — 47

View Approved Suppliers

Use the Approved Supplier List Summary window to view all the
Approved Supplier List entries. When you select and open a line in the
Approved Supplier List Summary window, the Approved Supplier List
window for that supplier appears.

To view the Approved Supplier List:

1. Navigate to the Approved Supplier List Summary window from
the menu. The Search Approved Supplier List window opens.

2. Optionally choose or enter data into the available fields to further
define your search.
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Note: Check Include Global Entries to specify that Global Entries
are to be included.

3. Choose Find to begin the search.

Note: You can choose Clear to erase the data from the form to
redefine your search, or choose New to navigate to the Approved
Supplier List window to define new approved suppliers.

4. Choose a record to view then choose Open to view the Approved
Supplier List window.
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Entering RFQs

Entering RFQ Headers

Use the RFQs window to:
e Enter and edit a request for quotation (RFQ)

¢ Review and edit an RFQ you autocreated from on-line
requisitions

Each RFQ consists of header, line, and shipment information. You can
send the RFQ to as many suppliers you want and decide how much
item information to provide to the suppliers.

For information on the difference between RFQs and quotations, and
the different types of RFQs and quotations, see: RFQs and Quotations:
page 5 - 5.

Note: Whether or not you send an RFQ, suppliers can send you
catalog quotations electronically, through the Purchasing Documents
Open Interface. See: Receiving Price/Sales Catalog Information
Electronically: page 5 — 22.

Prerequisites

U Before using this window you should perform the following:

e Define suppliers and supplier sites. See: About Suppliers, Oracle
Public Sector Payables User’s Guide.

e Define supplier lists. See: Defining Supplier Lists: page 5 - 98.
e Define locations. See: Defining Locations: page 1 — 24.
e Define buyers. See: Defining Buyers: page 1 - 27.

¢ Define unit of measure classes. See: Defining Unit of Measure
Classes, Oracle Inventory User’s Guide.

e Define units of measure. See: Defining Units of Measure, Oracle
Inventory User’s Guide.

e Define payment terms. See: Defining Payment Terms, Oracle
Public Sector Payables User’s Guide.
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» Toenter RFQ header information:

1. Navigate to the RFQs window by selecting RFQs from the menu.
Purchasing displays today’s date as the Created date and the
functional Currency from your set of books.

%RFQS (\ision Operations) - [New]
Mumber _ Type
Ship-To Bill-To

Currency

Rey Category Description

2. Enter a unique number for the RFQ. In the Purchasing Options
window, you can choose whether RFQ numbers are numeric or
alphanumeric and whether Purchasing automatically generates
them when you save your changes. See: Defining Numbering
Options: page 1 - 53.

3. Inthe Type field, enter one of the document names defined for
RFQs. The list of values lists the Document Type (Document
Name) and Quotation Class from the Document Types window.
For existing RFQs, the list of values includes only RFQs with the
same Quotation Class. See: Defining Document Types: page 1 - 87.
See also: Types of Quotations and RFQs: page 5 - 6.
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10.

11.

Enter the Ship—To and Bill-To locations for the items on the RFQ.
See: Defining Locations: page 1 — 24.

Use the Status field to control the status of the RFQ:
In Process — The initial status when you create the RFQ.

Active — Choose this status when the RFQ is complete and you are
ready to send it to your suppliers. Only Active RFQs are printed.

Printed — The status assigned to the RFQ when you have printed at
least one copy of it. You must change the status to Active if you
want to reprint the RFQ.

Closed — Choose this status to close the RFQ when all suppliers
have responded or when you no longer want responses. When you
close an RFQ, Purchasing deletes all follow up notifications
associated with it.

Enter the Due Date when you want your suppliers to reply.
Purchasing prints the reply due date on the RFQ. Purchasing
notifies you if the current date is between the RFQ reply due date
and the close date and if the RFQ is Active. Purchasing knows that
a supplier replied to an RFQ if you enter a quotation for this
supplier referencing the RFQ. See: Viewing and Responding to
Notifications: page 2 — 31. See: Entering Quotation Headers: page
5-74.

Enter the Reply/Receive Via code for the method you want the
supplier to use to send the quotation. For example, by mail,
telephone, or FAX. See: Defining Lookup Codes: page 1 - 74.

Enter the Close Date for the RFQ. Purchasing prints the close date
on the RFQ. Purchasing notifies you if the current date is between
the RFQ reply due date and the close date and if the RFQ is Active.
Purchasing warns you when you enter a quotation against this RFQ
after the close date. See: Viewing and Responding to Notifications:
page 2 — 31.

Select Require Quote Approval to enforce approval of any
quotation referencing this RFQ before the quotation can be used for
a purchase order.

Purchasing displays your name as the Buyer. You can forward the
RFQ to another buyer by choosing the name of this buyer from the
list of values. The buyer you enter receives all notifications
regarding this RFQ.

Enter the beginning and ending Effectivity Dates for the supplier
quotation.
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Entering RFQ Lines

12. Enter RFQ lines in the Lines tabbed region: See: Entering RFQ
Lines: page 5 - 60.

To enter supplier information:

m  Select the Suppliers button to open the RFQ Suppliers window.
See: Entering RFQ Supplier Information: page 5 - 63

To enter currency information:

m  Select the Currency button to open the Currency window. See:
Entering Currency Information: page 4 — 58.

To enter terms and conditions information:

m  Select the Terms button to open the RFQ Terms window. See:
Entering RFQ Terms Information: page 5 — 65.

To enter shipment information:

®  When the Quotation Class of the header Type is Bid, you can select
the Shipments button to open the RFQ Shipments window. See:
Entering RFQ Shipment Information: page 5 — 66.

To enter price break information:

®  When the Quotation Class of the header Type is Catalog, you can
select the Price Break button to open the Price Breaks window. See;
Entering RFQ Price Break Information: page 5 - 69.

Use the Lines tabbed region in the RFQs window to enter and edit RFQ
lines.

To enter an RFQ line:

1. Select the Lines tabbed region in the RFQs window.
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%RFO_S (Vision Operations) - [New]
Nurmber ([ Type o[- 11 102/JAN2001
Ship T Bl To Siatie [

ue Date

=T Stock, Ms. Pat
Currency m [ ﬂ ]

Cluate Effectivity fLEAR IR = 16/ JAN2002

Rev Categaory Description

e [ S

2. Enter a unique Number for the RFQ line.

3. Enter the line Type for the item. When you enter a line type,
Purchasing automatically copies the corresponding purchasing
category, unit, and unit price. You can enter predefined items only
when you choose a quantity based line type. Purchasing defaults
the value you define in the Purchasing Options window. See:
Defining Default Options: page 1 — 45. See: Defining Line Types:
page 1 - 84.

4. Enter the Item for your RFQ line. Purchasing retrieves the item
description, purchasing category, and unit of measure. If you do
not enter a predefined item, you must provide a purchasing
category and item description for the RFQ line. For amount based
line types, the cursor does not enter this field. See: Defining Items,
Oracle Inventory User’s Guide.

5. Enter the Revision number for the item on the requisition line.
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6.

Enter the purchasing category for your RFQ line. If you enter a
predefined item, Purchasing supplies the purchasing category.

Enter the item Description for your RFQ line. If you enter an item,
Purchasing supplies the item description. You can set up the item
definition so that you can override the item description for this

particular RFQ. See: Defining Items, Oracle Inventory User’s Guide.

Enter the UOM for your RFQ line. If you enter an item number,
Purchasing supplies the unit of measure. For amount based line
types, the cursor does not enter this field.

Enter an optional Target Price for the RFQ line. You may want to
provide a target price on the RFQ line for negotiation purposes.
For amount based line types, Purchasing uses a target price of 1.

10. Enter the supplier’s number for the item.

11. Save your work.

p Toenter additional RFQ line information:

1.

© © N o 0

Select the More tabbed region in the RFQs window. You can enter
optional information in the fields described in the following steps.

Enter a unique line number for your RFQ line. Purchasing defaults
the next available line number.

Enter the UN Number for the item on the RFQ line. See: Defining
UN Numbers: page 1 - 71.

Enter the Hazard class for the item on the RFQ line. If you enter a
UN number, Purchasing displays the corresponding hazard class if
one has been defined. See: Defining Hazard Classes: page 1 - 70.

Enter the Minimum Order Quantity for the item on the RFQ line.
Enter the Maximum Order Quantity for the item on the RFQ line.
Optionally enter a Project Number.

Optionally enter a Task Number.

Enter a note to the supplier about this item. This note prints on the
RFQ.

10. Save your work.
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» To copy RFQs to quotations:

m  Select Copy Document on the Tools menu to open the Copy
Document window. See: Copying Quotations from RFQs: page
5-89.

See Also

Entering RFQ Headers: page 5 - 57

Entering RFQ Supplier Information: page 5 - 63
Entering RFQ Terms Information: page 5 — 65
Entering RFQ Shipment Information: page 5 — 66
Entering RFQ Price Break Information: page 5 - 69
Entering Currency Information: page 4 — 58

Oracle Projects User’s Guide

Oracle Project Manufacturing Implementation Manual

Entering RFQ Supplier Information

Use the RFQ Suppliers window to:

e Enter the suppliers to which this RFQ will be sent. You can also
delete suppliers from the RFQ until you have printed the RFQ
for them.

e Review the supplier activity.

p Toenter RFQ supplier information:

1. Navigate to the RFQ Suppliers window by selecting the Suppliers
button in the RFQs window. For each supplier that you enter,
Purchasing displays the Printed and Responded dates as well as
the Count of the number of times the RFQ has been printed. The
Responded date is the receipt date recorded for the quotation from
the supplier.
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Include In Mext RFQ Printing

Supplier Site Contact Printed Count Respol
Supplier A SUPPLIER A |Contact, A

[

O E e

Add Fram List. .

The Include In Next RFQ Printing check box is checked when you
add a supplier. You can postpone printing the RFQ for a supplier
by deselecting the check box. After you print the RFQ for a
supplier, Purchasing deselects this field. If you want to reprint the
RFQ for a supplier, you must use this window to select the field
again.

2. Enter a unique sequence number for the supplier on the RFQ
Suppliers list. Purchasing uses this sequence humber to print your
RFQs for these suppliers.

3. Enter the name of the active Supplier you want to place on the RFQ
Supplier list. The list of values displays the supplier name,
number, Tax ID number, and VAT number.

4. Enter the Supplier Site you want to place on the RFQ Supplier list
for this supplier. You can choose only sites that you defined as
RFQ Only suppliers. You cannot enter the same supplier site twice.

5. Enter the name of the Contact for this site

6. If you want to postpone printing the RFQ for a supplier, you can
deselect Select for Printing.

7. Save your work.
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p To add suppliers from supplier lists:

1.

See Also

Select the Add From List button in the RFQ Suppliers window to
open the Supplier Lists modal window. This window is a
display-only version of the Supplier Lists window, but includes
only the Supplier List name, Description, and a Count of the
number of suppliers on the list. See: Defining Supplier Lists: page
5-98.

Select any supplier list for which you want to copy all suppliers to
the RFQ. Suppliers already on the RFQ are omitted.

Select the Apply button to close the window and add these
suppliers to the RFQ. Otherwise, you can select the Cancel button
to return to the RFQ Suppliers window without adding suppliers
from a list.

Save your work.

Entering Currency Information: page 4 — 58

Entering RFQ Headers: page 5 - 57

Entering RFQ Lines: page 5 - 60

Entering RFQ Terms Information

Use the RFQ Terms window to enter terms and conditions information
for RFQs.

» Toenter RFQ terms and conditions information:

1.

Navigate to the RFQ Terms window by selecting the Terms button
in the RFQs window. All terms and conditions information is
optional. The defaults are from the Financial Options window.
See: Defining Financials Options, Oracle Public Sector Payables
User’s Guide.
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2. Enter the Payment terms for the RFQ. Purchasing displays default
payment terms that you can accept or change. See: Defining
Payment Terms, Oracle Public Sector Payables User’s Guide.

3. Enter the Freight terms for the RFQ. Purchasing displays default
freight terms that you can accept or change. See: Defining Lookup
Codes: page 1 - 74

4. Enter the freight Carrier for shipment of the RFQ. Purchasing
displays a default freight carrier that you can accept or change.
See: Defining Freight Carriers, Oracle Inventory User’s Guide.

5. Enter the FOB point for the RFQ. Purchasing displays a default
free on board (FOB) designation that you can accept or change.
See: Defining Lookup Codes: page 1 - 74.

6. Enter a Note To Supplier. You can enter up to 240 characters in this
field.

7. Save your work.

See Also

Entering RFQ Headers: page 5 — 57
Entering RFQ Lines: page 5 - 60

Entering RFQ Shipment Information

Use the RFQ Shipments window to enter and review shipment
information for Bid RFQs.
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Attention: Use this window to request as many shipment

ISy guotations as you want. You might want to provide multiple
shipments if you want to receive quotations from your suppliers
for different ship-to locations, quantities, or other criteria.

p Toenter RFQ shipment information:

1. Navigate to the RFQ Shipments window by selecting the
Shipments button in the RFQs window. This button is available
only when the RFQ header Type has a Quotation Class of Bid. See:
Entering RFQ Headers: page 5 - 57.

%RFQ Shipments {(Vision Operations) - 100084

Shipments

Last Accept
Mum  Org Ship To UOM Price Date

11 vi  |Atlanta Each |714.83

M C1118 C1118

2. Inthe Shipments tabbed region, enter the shipment Number.
Purchasing supplies shipment numbers in increments of one.

3. Enter the Organization.

4. Enter the Ship-To location for the quotation shipment. Purchasing
defaults the ship—to location from the RFQ header.

5. Enter the Quantity for which you want to receive a quotation from
your supplier.

6. Enter the shipping UOM for the RFQ shipment line. You may want
the supplier to ship the item in different units of measure
depending on the quantity ordered. Purchasing defaults the unit of
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11.

measure from the RFQ line. For amount based line types, the field
is not applicable.

Enter the unit Price for the RFQ shipment line. Leave this field
blank if you want the supplier to provide a price independent of
the price you want. For amount based line types, the cursor does
not enter this field, and the price is set to 1.

Enter the Last Accept Date.
Enter the Need-By date.
Select Firm to indicate that the bid is firmed.

The Approved check box indicates that there is an approved
quotation shipment referencing this line.

Save your work.

» Toenter additional RFQ shipment information:

1.
2.

Select the More tabbed region in the RFQ Shipments window.

Enter the shipment number. Purchasing provides shipment
numbers in increments of one.

Note that Taxable is selected if a Tax Code is associated with the
item.

If there is no Tax Code for the item, Taxable is not selected. You
cannot change the Taxable check box independently of the Tax
Code.

Enter or use the default Tax Code for taxable items.

The tax code defaults from the following sources, in the following
order:

e The Purchase Order Preferences window. If you have specified a
preferred tax code in this window, Purchasing defaults this tax
code onto the RFQ shipment.

e The Tax Defaults region in the Purchasing Options window. If
you have specified a tax defaulting hierarchy in this window,
Purchasing searches for and defaults the tax code based on that
tax defaulting hierarchy. See: Defining Tax Defaults Options:
page 1 - 55.

You can accept the default tax code or select another. If you need
additional help with how tax defaulting works in Purchasing, see:
Tax Defaults in Purchasing: page 4 — 138.
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Choose the Match Approval Level. The default is from the
Purchasing Options window. See: Defining Default Options: page
1-45,

Two-Way — Purchase order and invoice quantities must match
within tolerance.

Three-Way — Purchase order, receipt, and invoice quantities must
match within tolerance.

Four-Way — Purchase order, receipt, inspection, and invoice
gquantities must match within tolerance.

Enter the Quantity Received Tolerance. The default is from the
Receiving Options window. See: Defining Receiving Options: page
1-58.

Enter the Quantity Received Exception option. See: Defining
Receiving Options: page 1 — 58.

None — Receipts may exceed the selected tolerance.
Reject — Receipts cannot exceed the selected tolerance.

Warning — The receiver gets a warning message, but receipts can
exceed the tolerance.

Save your work.

Entering RFQ Headers: page 5 - 57
Entering RFQ Lines: page 5 - 60

Entering RFQ Price Break Information

Use the RFQ Price Breaks window to enter pricing information for
RFQs.

Attention: Use this window to request as many price breaks as
you want. You can provide multiple price breaks if you want to
receive quotations from your suppliers for different terms, ship-to
locations, or quantities.
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p Toenter RFQ price break information:

1. Navigate to the RFQ Price Breaks window by selecting the Price
Breaks button in the RFQs window. This button is available only
when the RFQ header Type has a Quotation Class of Catalog.

%RFQ Price Breaks (Vision Operations) - 100083

Price Break

_ — Effective
Discount

- Mum  UOM Quantity Frice Ory Ship-To (%] From
I Each |1 714.83 HYDE

=l C1118

2. Inthe Price Break tabbed region, enter the line Number.
Purchasing supplies line numbers in increments of one.

3. Enter the Quantity at this price.

4. Enter the shipping UOM for the RFQ price break line. You may
want the supplier to ship the item in different units of measure
depending on the quantity you order. Purchasing defaults the unit
of measure from the RFQ line.

5. Enter the unit Price for the RFQ price break line. You might want
to provide price discounts to indicate to the supplier the prices you
would like to receive. Leave this field blank if you want the
supplier to provide a price independent of the price you want

6. Enter the Organization.

7. Enter the Ship—To location for the quotation line shipment.
Purchasing defaults the ship—to location from the RFQ header.

8. Enter the Discount percentage from the unit price for the RFQ line.
If you enter a unit price and break price for this line, Purchasing
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11.
12.
13.

14.

15.

16.

17.

does not automatically calculate the discount. You should provide
either a break price or a discount, not both. If you enter both
values for the RFQ, Purchasing prints only the break price on the
RFQ. If you provide a discount without providing a break price,
Purchasing prints the discount on the RFQ.

Enter the Effective Date when you want to be able to start using the
quotation from your supplier. If you leave this field blank,
Purchasing applies the quotation effective date from the RFQ
Header window. You can also enter lead time information instead
of date information.

Enter the Expiration Date when you no longer need the quotation
from your supplier. If you leave this field blank, Purchasing
applies the expiration date from the RFQ header.

Enter the Lead Time for this RFQ line.
Enter the UOM you want to use to define the lead time.

Enter the Payment Terms for the RFQ. Purchasing prints these
terms on the RFQ only if they are different from the terms on the
RFQ header. The default is the payment terms from the RFQ
header.

Enter the Freight Terms for the RFQ. Purchasing prints these terms
on the RFQ only if they are different from the freight terms on the
RFQ header. The default is the freight terms from the RFQ header.

Enter the FOB point for your RFQ Line. Purchasing prints this FOB
point on the RFQ only if it is different from the FOB point on the
RFQ header. The default is the FOB name from the RFQ header.

Enter the freight carrier for your RFQ. Purchasing prints this
carrier on the RFQ only if it is different from the carrier on the RFQ
header. The default is the carrier from the header.

The Approved check box indicates that there is an approved
quotation shipment referencing this line.

Save your work.

To enter additional RFQ price break information:

1.
2.

Select the More tabbed region in the RFQ Price Breaks window.

Enter the line number. Purchasing provides line numbers in
increments of one.

Note that Taxable is selected if a Tax Code is associated with the
item.
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If there is no Tax Code for the item, Taxable is not selected. You
cannot change the Taxable check box independently of the Tax
Code.

Enter or use the default Tax Code for taxable items.

The tax code defaults from the following sources, in the following
order:

e The Purchase Order Preferences window. If you have specified a
preferred tax code in this window, Purchasing defaults this tax
code onto the RFQ shipment.

e The Tax Defaults region in the Purchasing Options window. If
you have specified a tax defaulting hierarchy in this window,
Purchasing searches for and defaults the tax code based on that
tax defaulting hierarchy. See: Defining Tax Defaults Options:
page 1 - 55.

You can accept the default tax code or select another. If you need
additional help with how tax defaulting works in Purchasing, see:
Tax Defaults in Purchasing: page 4 — 138.

Choose the Match Approval Level. The default is from the
Purchasing Options window. See: Defining Default Options: page
1-45.

Two-Way — Purchase order and invoice quantities must match
within tolerance.

Three-Way — Purchase order, receipt, and invoice quantities must
match within tolerance.

Four—-Way — Purchase order, receipt, inspection, and invoice
guantities must match within tolerance.

Enter the Quantity Received Tolerance. The default is from the
Receiving Options window. See: Defining Receiving Options: page
1-58.

Enter the Quantity Received Exception option. See: Defining
Receiving Options: page 1 — 58.

None — Receipts may exceed the selected tolerance.
Reject — Receipts cannot exceed the selected tolerance.

Warning — The receiver gets a warning message, but receipts can
exceed the tolerance.

Save your work.
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Entering RFQ Headers: page 5 - 57
Entering RFQ Lines: page 5 - 60
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Entering Quotations

Entering Quotation Headers

Use the Quotations window to:

Enter and edit quotations

Review and edit quotations you copied from RFQs

For information on the difference between RFQs and quotations, and
the different types of RFQs and quotations, see: RFQs and Quotations:
page 5-5.

Note:

You can also receive catalog quotations electronically from your

suppliers through the Purchasing Documents Open Interface. See:
Receiving Price/Sales Catalog Information Electronically: page 5 — 22.

Prerequisites

O Before using this window you should perform the following:

Define suppliers and supplier sites. See: About Suppliers, Oracle
Public Sector Payables User’s Guide.

Define supplier lists See: Defining Supplier Lists: page 5 — 98.
Define locations. See: Defining Locations: page 1 — 24.
Define buyers. See: Defining Buyers: page 1 — 27.

Define unit of measure classes. See: Defining Unit of Measure
Classes, Oracle Inventory User’s Guide.

Define units of measure. See: Defining Units of Measure, Oracle
Inventory User’s Guide.

Define payment terms. See: Defining Payment Terms, Oracle
Public Sector Payables User’s Guide.

p To enter quotation header information:

1. Navigate to the Quotations window by selecting Quotations from
the menu. Purchasing displays the functional Currency from your
set of books.
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MNumber
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S 16/JAN2001
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S SUPPLIER A SITE

1- New York Ci

2 16/JAN2002

Rey Category Description

Enter a unique number for the quotation. In the Purchasing
Options window, you can choose whether quotation numbers are
numeric or alphanumeric and whether Purchasing automatically
generates them when you save your changes. See: Defining
Numbering Options: page 1 — 53.

In the Type field, enter one of the document names defined for
guotations. The list of values lists the Document Type (Document
Name) and Quotation Class from the Document Types window.
For existing quotations, the list of values includes only quotations
with the same Quotation Class. See: Defining Document Types:
page 1 —87. See also: Types of Quotations and RFQs: page 5 - 6.

If you copied this quotation from an existing RFQ, Purchasing
displays the corresponding RFQ number, which you can override.

You can also manually provide an RFQ number. Purchasing
verifies the supplier and supplier site you provide and lets you
choose from a corresponding list of RFQs. If you want to enter a
guotation as a response to an RFQ for a supplier you did not
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provide on the RFQ supplier list, you need to modify the RFQ
supplier list first. 1f you change the supplier or supplier site
information on this quotation after you enter an RFQ number,
Purchasing removes the RFQ number, and you must re-enter it.
See: Entering RFQ Supplier Information: page 5 - 63.

If you enter the number of an RFQ for which you already entered a
response for this supplier and supplier site, Purchasing displays a
warning message but permits your entry.

Attention: If you are entering a quotation that is a response to an
RFQ you previously sent to the supplier, you need to provide this
RFQ number to indicate to Purchasing that the supplier responded.

Enter the Supplier for this quotation. When you enter a supplier
name, Purchasing uses the default terms, conditions, and currency
information for this supplier in the Quotation Terms and Currency
windows. The list of values displays the supplier name, number,
Tax ID number, and VAT number.

Enter the supplier Site for this quotation. You do not need to
provide a supplier site for a quotation. When you enter a supplier
site, Purchasing uses the default terms, conditions, and currency
information for this supplier site in the Quotation Terms and
Currency windows.

Enter a supplier Contact for this quotation.

Enter the Ship—To and Bill-To locations for the items on the
guotation. See: Defining Locations: page 1 — 24.

Use the Status field to control the status of the quotation:

In Process — The initial status when you create the quotation.
Purchasing sends you notifications that the quotation is awaiting
completion.

Active — Choose this status when the quotation is complete and you
are ready to approve it. Only Active quotations can be approved.

Closed — When you enter a quotation, you provide an expiration
date for it. Purchasing sends you a notification when the quotation
approaches expiration using the warning delay you provided in the
quotation header. You can manually close the quotation to
acknowledge the notification. If you do not acknowledge the
notification by closing the quotation, the status of your quotation is
still Active. You cannot use Closed quotation information on
purchase orders.

10. Enter the Supplier Quote number.
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11. Select Approval Required to indicate that approval is required to
purchase goods based on this quotation.

12. The Response Date is the date you actually received the quotation.
Purchasing defaults today’s date as the response date, but you can
change this date.

13. Enter the beginning and ending Effective Dates for the quotation.

14. Purchasing displays your name as the Buyer. You can forward the
guotation to another buyer by choosing the name of this buyer
from the list of values. The buyer you enter receives all
notifications regarding this quotation.

15. Enter quotation lines in the Lines tabbed region. See: Entering
Quotation Lines: page 5 - 78.

To approve the quotation:

m  Select the Approve button to open the Approve Entire Quotation
window. See: Approving Entire Quotations: page 5 — 95.

To enter currency information:

m  Select the Currency button to open the Currency window. See:
Entering Currency Information: page 4 — 58.

To enter terms and conditions information:

m  Select the Terms button to open the Quotation Terms window. See:
Entering Quotation Terms Information: page 5 - 80.

To enter shipment information:

®  When the Quotation Class of the header Type is Bid, you can select
the Shipments button to open the Quotation Shipments window.
See: Entering Quotation Shipment Information: page 5 — 82.

To enter price break information:

®  When the Quotation Class of the header Type is Catalog, you can
select the Price Breaks button to open the Price Breaks window.
See: Entering Quotation Price Break Information: page 5 — 84.
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Entering Quotation Lines

Use the Lines tabbed region in the Quotations window to enter and
edit quotation lines.

Attention: If your supplier gives you a single quotation that is

ISy independent of the quantity you order, you must still provide at
least one shipment quotation since you approve quotation
information by shipment rather than by line. Therefore, if your
supplier provides you with a base unit price only, you can enter the
base unit price here, but you must also provide a shipment with the
same base unit price.

» Toenter a quotation line:

1. Select the Lines tabbed region in the Quotations window.

%Quntatiuns {Vision Operations) - 100112
Mumber Type
Supplier )
Ship-To Bill-To

Description

equired

=i e 16/ AN/2001 S 16/JAN2002

Rey Category Description
MISC.MISC C1118

W= C1118 C1118

2. Enter a unique Number for the quotation line.
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10.
11.

Enter the line Type for the item. When you enter a line type,
Purchasing automatically copies the corresponding purchasing
category, unit, and unit price. You can enter predefined items only
when you choose a quantity based line type. Purchasing defaults
the value you define in the Purchasing Options window. See:
Defining Default Options: page 1 —45. See: Defining Line Types:
page 1 - 84.

Enter the Item for your quotation line. Purchasing retrieves the
item description, purchasing category, and unit of measure. If you
do not enter a predefined item, you must provide a purchasing
category and item description for the quotation line. For amount
based line types, the cursor does not enter this field. See: Defining
Items, Oracle Inventory User’s Guide.

Enter the Revision number for the item on the requisition line.

Enter the purchasing Category for your quotation line. If you enter
a predefined item, Purchasing supplies the purchasing category.

Enter the item Description for your quotation line. If you enter an
item, supplies the item description. You can set up the item
definition so that you can override the item description for this
particular quotation. See: Defining Items, Oracle Inventory User’s
Guide.

Enter the UOM for your quotation line. If you enter an item
number, Purchasing supplies the unit of measure. For amount
based line types, the cursor does not enter this field.

Enter the unit Price for the quotation line. For amount based line
types, Purchasing uses a target price of 1.

Enter the supplier’s number for the item.

Save your work.

To enter additional quotation line information:

1.

Select the More tabbed region in the Quotations window. You can
enter optional information in the fields described in the following
steps.

Enter a unique line number for your quotation line. Purchasing
defaults the next available line number.

Enter the UN Number for the item on the quotation line. See:
Defining UN Numbers: page 1 — 71. If you enter a UN number,
Purchasing displays the corresponding hazard class if one has been
defined.
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4. Enter the Hazard class for the item on the quotation line. See:
Defining Hazard Classes: page 1 - 70.

5. Enter the Minimum Order Quantity for the item on the quotation
line.

6. Enter the Maximum Order Quantity for the item on the quotation
line.

7. Optionally enter a Project Number.
8. Optionally enter a Task Number.
9. Enter a Note From Supplier about this item.

10. Save your work.

To approve the quotation:

m  Select the Approve button to open the Approve Entire Quotation
window. The Approve button is disabled if the quotation is not
active and doesn’t have at least one shipment. See: Approving
Entire Quotations: page 5 - 95.

Entering Currency Information: page 4 — 58

Entering Quotation Headers: page 5 - 74

Entering Quotation Terms Information: page 5 - 80
Entering Quotation Shipment Information; page 5 — 82
Oracle Projects User’s Guide

Oracle Project Manufacturing Implementation Manual

Entering Quotation Terms Information

Use the Quotation Terms window to enter terms and conditions
information for quotations.

To enter quotation terms and conditions information:

1. Nav